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Search fundamentals review

Welcome to the Search Advertising Advanced Exam Learning Center.

Much of the material covered in this exam is unique from that covered in the Fundamentals Exam. However, the

Search Advanced exam reviews some concepts from Fundamentals as well.

Review the Fundamentals covered in this section is highly recommended while studying for the Search Advertising

Advanced exam. Good luck!



Organizing campaigns and ads in your account

Now that you've mastered your first ad, you're on your way to creating many more, right? Before you do, it's important to know the three-layer
design of AdWords. Understanding the relationship between these layers of your account will help you organize your ads, keywords and ad groups
into effective campaigns that target the right audience.

How AdWords is organized
AdWords is organized into three layers: account, campaigns, and ad groups.

1. Your account is associated with a unique email address, password, and billing information.
2. Your ad campaign has its own budget and settings that determine where your ads appear.
3. Your ad group contains a set of similar ads and the words and phrases, known as keywords, that you want to trigger your ads to show.

Account

Unique email and password
Billing information

Campaign Campaign
Budget Budget
Settings Settings
Ad Group Ad Group Ad Group Ad Group
Ads Ads Ads Ads
Keywords Keywords Keywords Keywords

Watch this video

Organize Your AdWords Account to Maximize Your Success

Learn how to organize your AdWords account to save time and grow sales. Find out what account structure is, why it matters and how to set up your account
for success. Read more about organizing your account at http://goo.gl/PUcJg. Subscribe to AdWords Help on YouTube
http: //www.youtube.com/learnwithgoogle.

Why you should organize your ads into ad groups and campaigns

When people are searching online and they type a word or phrase, they're looking for information that's closely tied to those words. For example, if Eric types
"digital cameras" and he sees an ad for film reels, he probably won't click the ad.

To show ads that are relevant to the searches of people you're trying to reach, bundle related ads with related keywords. In other words, create ad groups. A
collection of ad groups forms a campaign. Your campaign is the master control for your ad groups where you can choose how much you're willing to spend on
clicks or conversions from your ads, the networks and geographical locations where you want your ads to show, and other top-level settings that affect clusters
of ad groups.



Example

Let's say you own an online electronics store and you create an AdWords account so you can begin to advertise the products that you sell. At the
account level you can choose who else you'd like to have access to your AdWords account, and your preferred payment method. The top-most
layer of your account might look as follows:

Account

Online electronics store

You've decided to advertise your inventory of televisions and cameras and create two separate campaigns for each. Splitting your account into two
campaigns ensures that you can devote at least half of your online advertising budget to each product area.

Campaign Campaign

Televisions Cameras

Focusing on your camera campaign, you might create various ad groups for different types of cameras like digital cameras and compact cameras.

Ad Group Ad Group Ad Group Ad Group

Flat Screen TVs Plasma TVs Digital Cameras Compact Cameras

Within a particular ad group, such as digital cameras, you choose keywords that are very closely linked to your ad text. Types of keywords you
might try are different brands, models, and prices for digital cameras.

Tying it all together, your overall account structure might look like this:

Account

Online electronics store

Campaign Campaign
Budget Budget
Televisions Cameras
Ad Group Ad Group Ad Group Ad Group
Flat Screen TVs Plasma TVs Digital Cameras Compact Cameras

Tip

A common method for organizing an AdWords account is to organize it the way your website is structured.

Seeing your account organization at a glance

Once you've created your first campaign, you'll see an "All online campaigns" panel appear on the left side in the Campaigns tab of your AdWords account.
From this panel, you can see at a glance how your campaigns and ad groups are organized. This folder structure also allows you to quickly move around your

account.




Tip

Start organizing your campaigns and ad groups as you create them.

Reorganizing your account after you've created several campaigns and ad groups wipes out all the valuable data you've accumulated, possibly
affecting how your ads perform.

AdWords account limits
These are the limits for an AdWords account:

e 10,000 campaigns (includes active and paused campaigns)

e 20,000 ad groups per campaign

e 20,000 ad group targeting items per ad group (such as keywords, placements, audience lists, and product targets)
o 300 display ads per ad group (includes image ads)

e 50 text ads per ad group

o 4 million active or paused ads per account

o 5 million ad group targeting items per account (such as keywords, placements, audience lists, and product targets)
« 1 million campaign targeting items per account (such as geo target and campaign-level negative keywords)

e 10,000 location targets (targeted and excluded) per campaign, including up to 500 proximity targets per campaign
e 20 shared negative placement lists per account

e 65,000 placements per negative placement list

e 20 shared negative keyword lists per account

e 5,000 keywords per negative keyword list

e 100,000 active legacy ad extensions per account

o 1.3 million references to legacy ad extensions per account*

e 100,000 active upgraded ad extensions per account

e 10,000 ad group references to upgraded ad extensions per account**

o 10,000 campaign references to upgraded ad extensions per account**

* *For example, suppose you have one campaign that uses a legacy sitelink extension. Then you add three more campaigns, each sharing the same legacy
sitelink extension. Now, your account has four references to one active legacy ad extension.

e **For example, let's say you have one campaign that uses an upgraded sitelink extension. Then you add one more campaign and one more ad group,
each sharing the same upgraded sitelink extension. Now, your account has 1 active upgraded ad extension, two campaign references to an upgraded ad
extension, and one ad group reference to an upgraded extension.

Most advertisers don't reach this limit. Many accounts are best organized by creating one campaign and several ad groups within that campaign, and two or
three ads and 10-35 keywords within each ad group.

If your ad groups are close to reaching their keyword limit, we'll place a notice in your account. Learn more about keyword limits and how to create an effective
keyword list.



Using keyword matching options

« Use matching options with your keywords to help control which searches can trigger your ad.

« When choosing the appropriate match type for a keyword, we typically recommend starting with
broad match to maximize your potential to show your ads on relevant searches.

e Use the search terms report to monitor which keyword variations triggered your ads.

Keyword match types help control which searches can trigger your ad. For example, you could use broad match to

show your ad to a wide audience or you could use exact match to hone in on specific groups of customers.

In general, the broader the keyword matching option, the more traffic potential that keyword has. Conversely, the
narrower the keyword matching option, the more relevant that keyword will be to someone's search. Understanding
these differences can steer you in choosing the right keyword matching options and can help you improve your

return on investment.

About keyword match types

-

How To Use Keyword Match Types on the Search Network

Learn about the different keyword match types (broad, phrase, exact, and negative) and how selecting the right
ones for your keywords can help you reach your AdWords goals. Find a takeaway article that you can keep as a
reference guide here: http://goo.gl/Ck3xYG Subscribe to AdWords Help on YouTube:

http://www.youtube.com/adwordshelp
Each match type, which is specified by a special symbol, will trigger your ad to show for a customer's search in
different ways.

The chart below serves as an introduction to the different match types, ordered from broad to narrow. We'll give

more information on each option in the sections below.



Match type Special Example Ads may show on searches Example
symbol keyword that searches
Broad match none women's hats include misspellings, buy ladies hats
synonyms, related searches,
and other relevant variations
Broad match +keyword +women's contain the modified term (or woman's hats
modifier +hats close variations, but not
synonyms), in any order
Phrase match "keyword" "women's are a phrase, and close buy women's
hats" variations of that phrase hats
Exact match [keyword] [women's hats] are an exact term and close women's hats
variations of that exact term
Negative match -keyword -women are searches without the term baseball hats

How keyword match types work

Here's an overview of each match type, in order from broad to narrow:

= | Broad match

This is the default matching option. With broad match, your ad may show if a search term contains your
keyword terms in any order, and possibly along with other terms. Your ads can also show for close
variations of your keywords.

Sticking with the broad match default is a great choice if you don't want to spend a lot of time building your
keyword lists and want to capture the highest possible volume of ad traffic. You can use it with negative

keywords to avoid highly irrelevant traffic.

| Example

Broad match keyword Ads may show on searches for

women's hats women's hats

buy ladies hats



womens caps
hats for girls
womans hats

Buy red hats for women

Broad match modifier

You can add a modifier, the plus sign on your keyboard (+), to any of the terms that are part of your broad
match keyword phrase. By adding a modifier, your ads can only show when someone's search contains
those modified terms, or close variations of the modified terms, in any order. The modifier won't work with
phrase match or exact match keywords.

Unlike broad match keywords, modified broad match keywords won't show your ad for synonyms or related
searches. For this reason, it adds an additional level of control. Using broad match modifier is a good choice

if you want to increase relevancy even if it means you might get less ad traffic than broad match.

L Example

Broad match Ads may show on searches Ads won't show on searches
modifier for for
+women's +hats women's hats helmets for women

buy women's hats women's visors

Hats for women

Phrase match

With phrase match, your ad can show when someone searches for your exact keyword, or your exact
keyword with additional words before or after it. We'll also show your ad when someone searches for close
variations of that exact keyword, or with additional words before or after it.

Using phrase match can help you reach more customers, while still giving you more precise targeting. In
other words, your keywords are less likely to show ads to customers searching for terms that aren't related
to your product or service.

To use a phrase match keyword, simply surround the entire keyword with quotation marks. For example,
"women's hats".



L Example

Phrase match Ads may show on searches Ads won't show on searches
keyword for for
"women's hats" women's hats girls hats

buy women's hats womens baseball hats

woman's hats
Women's hats

Exact match

With exact match, your ads can appear only when someone searches for your exact keyword, without any
other terms in the search. We'll also show your ad when someone searches for close variations of that
specific keyword.

Unlike phrase match, if someone searches for additional words before or after your exact keyword, your ad
won't show. Using exact match means that your keywords are targeted more precisely than broad match or
phrase match.

To use an exact match keyword, simply surround the entire keyword with brackets. For example, [women's
hats].

| Example
Exact match Ads may show on searches Ads won't show on searches
keyword for for
[women's hats] women's hats buy women's hats

woman's hats women's hats on sale

Negative match

You can use negative match to prevent your ad from showing to people searching for certain terms. Your ad
won't show if a search term contains the keyword term you define with a minus sign (-) prefix. Negative

keywords are an especially useful way to filter out irrelevant traffic and thus prevent unwanted clicks.



You can use negative keywords in conjunction with other match types. For example, you could use an exact

match negative keyword to prevent your ad from showing to people who searched for that exact keyword.

| Example

If your keyword is women's hats and you add the negative keyword -women your ad won't
appear for any searches that contain the word women.

Negative match Ads may show on searches Ads won't show on searches
keyword for for
-women girls' hats hats for women
sun hats women's hats
-"women's hats" girls' hats women's hats
women's baseball hats buy women's hats

woman's hats

Women's hats

-[women’s hats] buy women's hats women's hats

women's hats on sale woman's hats

It's important to keep in mind that you should only add the minus sign (-) prefix to the keyword

that you don't want to trigger your ad, like -baseball as shown in this example.

To create negative keywords, go to your keyword table in your account and look for the Negative keywords
link below your keyword table. When you create a negative keyword (or make one from an existing keyword
by adding the negative symbol), it will show up there.
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Tip
Depending on the product or service you advertise, there are a few terms you might want to

add as negative keywords to your ad group: "free," "course" or "class," and "job." Adding
these terms will help prevent showing your ads when people search for free items or services,

courses or classes related to your keywords, or jobs that might include your keywords.

Keep in mind

¢ Keywords aren't case-sensitive, which means they're matched without regard to uppercase or lowercase
letters. For example, you don't need to enter women's hats and Women's Hats as keywords -- just women's
hats will cover both.

¢ You can use keyword match types with campaigns that show ads on the Search Network or both the Search

Close keyword variations

We'll automatically show your ads for close variations of your keywords to maximize your potential to show your
ads on relevant searches. Close variations include misspellings, singular and plural forms, acronyms, stemmings
(such as floor and flooring), abbreviations, and accents. So there's no need to separately add close variations as

keywords.

If you don’t want your ads to show on close variations of your exact match or phrase match keywords, you can

narrow your exact match and phrase match targeting.



- How to narrow your exact match and phrase match targeting

To narrow your exact match and phrase match targeting, you'll need to choose one of the following

campaign types when you create your campaign or already be using one of these campaign types:

e "Search Network only - All features"

e "Search & Display Networks - All features"

Learn about the different campaign types available. If you have a different campaign type, you won't be able
to restrict your matching options.

How to Change AdWords Exact and Phrase Match options

Learn how to restrict your exact match and phrase match targeting so that close variants do not trigger your
ads. Read more about using exact match at http://goo.gl/4wDWW. Subscribe to AdWords Help on YouTube
http://www.youtube.com/learnwithgoogle.

Follow these steps to restrict exact and phrase matching:

1. Sign in to your AdWords account at http://adwords.google.com/.

2. Click the Campaigns tab.

3. If you'd like to restrict your exact and phrase matching for a new campaign, click + New campaign. If
you'd like to restrict your exact and phrase matching for an existing campaign, select that campaign
and click the Settings tab.

4. Scroll to the "Advanced settings" section. Click the Keyword matching options link. Keep in mind that
if you don't see the link, it might be because you can only restrict your exact and phrase matching for
certain campaign types, like "Search Network only - All features."



5. In the "Exact and phrase match" section, select Do not include close variants.

How to choose the right keyword match types

When choosing the appropriate match type for a keyword, we typically recommend using a "broad-to-narrow"
strategy. Start off with broad match keywords to maximize your potential to show your ads on relevant searches.
Monitor your keywords' performance over time and make your keyword match types more specific if you find that

your ad is showing up for too many irrelevant variations of your keywords.

Once your broad matches have gathered impressions and clicks, review the search terms report to monitor which

keyword variations triggered your ads. A few tips on using the information in the report:

e Look at the "Match type" column to see how closely the search terms that triggered your ads on Google are
related to the keywords in your account. This information will give you an idea of which match types you might
want to use for your keywords. For example, if you find that most of the variations shown in your search terms
report are irrelevant to what you're advertising, consider making your keyword match types more specific.

¢ Add new search terms with high potential as keywords.

¢ Weed out any terms that aren't as relevant to your business by adding them as negative keywords.



Using broad match

When you use broad match, your ads automatically run on relevant variations of your keywords, even if these terms aren't in your keyword lists. This
helps you attract more visitors to your website, spend less time building keyword lists, and focus your spending on keywords that work.

Broad match is the default match type that all your keywords are assigned if you don't specify another match type (exact match, phrase match, or negative
match). The Google AdWords system automatically runs your ads on relevant variations of your keywords, including synonyms, singular and plural forms,
possible misspellings, stemmings (such as floor and flooring), related searches, and other relevant variations.

Example
Broad match keyword: Ads may show on searches for:

low-carb diet plan carb-free foods
low-crab diets
low calorie recipes
Mediterranean diet plans
low-carbohydrate dietary program

How broad match can help you
You can set any or all of your search-targeted keywords to broad match to help you do the following:

* Spend less time building keyword lists: You don't have to think of every possible keyword variation -- our system does the work for you. That's a time
saver, since roughly 20 percent of the searches Google receives each day are ones we haven't seen in at least 90 days. This unpredictable search behavior
can make it nearly impossible for you to create a keyword list using only exact match that covers all possible relevant searches.

* Spend your money on keywords that work: If your ad receives no clicks on a particular keyword variation, our system will quickly stop showing your
ads for that and similar search terms. This prevents you from accruing click charges for keyword variations that aren't working and helps you focus on the
keywords that work.

When other options might be more helpful

e Your Quality Score helps determine where your ad shows, and broad match keywords may contribute to a low Quality Score if your keywords appear
relevant for too many search terms. For example, consider the one-word keyword "hose" (and one-word keywords are almost always too general). You
may sell garden hoses, but your keyword will also be relevant to search terms for automotive hoses, hosiery, fire hoses, and more.

o You'll generally achieve a higher Clickthrough rate (CTR) with exact and phrase match because your ads include the exact terms your customers are
searching on.

Use broad match modifier for more control over broad match

Adding modified broad match keywords can increase campaign clicks and conversions, while providing more precise control than broad match. Modified broad
match lets you specify that certain broad match keyword terms, or their close variants, must appear to trigger your ad. Close variants include misspellings,
singular/plural forms, abbreviations and acronyms, and stemmings (such as "floor" and "flooring"). Variants don't include synonyms or related searches.

Tips

e We suggest using a combination of two or more keyword match types to run an effective ad campaign. If you use broad and phrase match, for
example, you'll reach a broader audience while also controlling who can see your ad.

« If you want to make sure your ads don't show for a certain search term, add that term to your ad group or campaign as a negative keyword.

e Pausing or deleting a keyword won't stop one of your active broad-matched keywords from "expanding" to that term. For example, if your ad
group contains the broad-matched keywords flowers and tulips, and you pause the keyword tulips, your ads could still potentially show for the
search term tulips, since it's similar to the active broad-matched keyword flowers.



Using broad match modifier

You can add a modifier to your broad match keywords to specify that certain words must be included in someone's search term to trigger your ads.
Since broad match modifier allows you to target searches that include at least one of your keywords, it can help increase how relevant your traffic is
to your ads, and thus improve your clickthrough (CTR) and conversion rates. To create a broad match modifier, just add a plus symbol (+) in front
of one or more words in your broad match keyword.

By default, AdWords uses the broad match option to target searches that include any combination of the words that comprise your keyword term, as well as
searches containing synonyms or other variations of those words (such as related searches). So although a broad match keyword like tennis shoes might send
a lot of relevant click traffic to your site, you might reach more searches than you originally intended.

With a broad match modifier, you're able to control and know exactly how your keyword would be broadened by requiring that certain keyword terms must be
a part of your potential customer's search. If you specify that you want your ad to only show when someone's search includes both tennis and shoes, for
example, then your ad suddenly becomes more relevant to potential customers searching for tennis shoes. This targeted reach can help your keywords achieve
a higher clickthrough rate (CTR), which in turn can help your site get more paying customers or other conversions.

How broad match modifiers impact traffic and clicks

Modifiers add more specificity to your broad match keywords, and therefore narrow their reach. So, while using a broad match modifier can increase the
relevance of your keywords, it in turn can decrease your expected traffic.

Here are some best practices if you want to get additional relevant clicks:

e Leave your existing broad match keywords active (rather than modifying or deleting them).

o Add new modified broad match keywords to existing campaigns in a separate ad group to make it easy to compare new and existing keywords based on
observed performance.

o If you've primarily used broad match keywords, consider adjusting your bids as you add more relevant modified broad match keywords. A higher cost-
per-click (CPC) bid may increase your click volume and conversions.

o If you've primarily used exact and phrase match, adding modified broad match keywords may help you to reach more customers while retaining control
over which search terms match your keywords.

Keep in mind that the broad match modifier feature only works when used with broad match keywords. If you want the increased click and conversion rates
that can result from phrase or exact match keywords, you can try creating a separate ad group, and adding the corresponding modified broad match keyword
for each phrase or exact match keyword.

If you currently have... ..You could add this modified broad match keywords to get additional relevant clicks
"buy blue suede shoes" +buy +blue +suede +shoes

"purchase blue suede shoes" +purchase +blue +suede +shoes

"shop suede shoes" +shop +suede +shoes

"blue suede shoes" +blue +suede +shoes

"suede blue shoes"
"suede shoes blue"

Setting up broad match modifiers

Just add a plus symbol (+) in front of one or more words in your broad match keyword. Each word preceded by a plus sign has to appear in someone's search
exactly or as a close variant. Close variants include misspellings, singular and plural forms, abbreviations and acronyms, and stemmings (like "floor" and
"flooring"). Synonyms (like "quick" and "fast") and related searches (like "shoes" and "boots") aren't considered close variants.

Tip

Don't leave space between the plus sign (+) prefix and the word you're modifying!

e Correct: Heather +shoes
* Incorrect: + leather + shoes
o Incorrect: Heather+shoes



To create a new broad match modifier from scratch, follow these steps:

. Sign in to your AdWords account at https://adwords.google.com.

. Click the Campaigns tab.

. Under All online campaigns,click the name of the campaign or ad group that you'd like to edit.
. Click the Keywords tab.

. Click the + Keywords button.

v A W N

6. Enter your broad match keyword, with a plus sign (+) preceding the word or words you want to to appear in your potential customer's search exactly or as
a close variant.

7. Click Save.

To add a modifier to an existing broad match keyword, follow these steps:

1. Repeat steps 1-4 above to get to the Keywords tab.
2. Click a keyword to edit it inline.
3. Add the plus sign (+) prefix to any word(s) you want to include as required terms.




4. Click Save.



Account, campaign, and ad group
performance

AdWords is organized into three layers (levels): account, campaigns, and ad groups. By familiarizing
yourself with the different levels of your AdWords account, you can easily find the exact performance data
you're looking for.

Keeping the three levels in mind, you can customize your view of your performance data to make it as broad or
specific as you want. To help you navigate, the side panel of your AdWords account starts with the broadest level -
- "All online campaigns" -- and narrows in focus as it moves downward. After clicking on an individual campaign,
you'll see the ad groups contained in each one.

Your account is associated with a unique email address, password, and billing information. For reporting
purposes, though, it's helpful to think of your account as a collection of campaigns. If you want to see performance
data for your entire account, click All online campaigns in the side panel of your AdWords account. Totals for all of

the rows are listed at the bottom of your statistics table.

= See data for your entire account

See statistics for your entire account to get a quick overview of your overall AdWords performance.

Sign in to your AdWords account at http://adwords.google.com £
Click the Campaigns tab.
Click the Dimensions tab.

Click the View button to select the time period that you'd like to use to organize your statistics.

o » 0N~

Once your statistics table looks the way you want, just click the download button | #, ' to download it

as a report.

An individual ad campaign has its own budget and settings that determine where your ads appear, and is made
up of a collection of ad groups. Each of your campaigns is listed in the side panel of your AdWords account, and

they also appear when you click the Campaigns tab in the middle of your screen.
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- See campaign data

1. Sign in to your AdWords account at http://adwords.google.com [

2. Click the Campaigns tab.

3. Click the name of the campaign that interests you to see how its ad groups are performing. To view
specific campaigns for your report, click the Filter button to set up a campaign filter.

4. Once your statistics table looks the way you want, just click the download button | #, | to download it

as a report.

Your ad group contains a set of similar ads and the words and phrases, known as keywords, that you want to
trigger your ads to show. When you click on a campaign, AdWords will show you a view of the campaign's
performance broken out by its individual ad groups. You can also see ad group data by clicking the Ad groups tab
in the middle of your screen.

Google AdWords

- See ad group data



1. Sign in to your AdWords account at http://adwords.google.com [4
2. Click the Campaigns tab.
3. Pick the ad groups that interest you.

o To include all the ad groups from a specific campaign, click the campaign name in the table. You'll be
taken to the "Ad groups" tab for that campaign.

o To include all the ad groups in your account, click the Ad groups tab while viewing "All online
campaigns.”

o To include specific ad groups from different campaigns, first click the Ad groups tab while viewing "All

online campaigns." Then click the Filter button to set up an ad group filter.

Example

Let's look at how a business might set up its AdWords campaigns and ad groups. The account

belongs to a chocolate maker (yum!) who wants to advertise its products to increase online sales.

The owners decide to organize their advertising efforts into two campaigns. One campaign promotes
their new line of chocolate bars, and the second promotes their holiday gift boxes. They split each
campaign into targeted, relevant ad groups. One of the ad groups for the chocolate bar campaign is
dedicated to the company's popular raspberry bar. Another is dedicated to a caramel bar, and a third

to a chocolate bar infused with ginger. Here's what this account looks like:
Account:

Chocolate Maker

Campaign 1: Campaign 2:

Chocolate bars  Valentine's Day gift boxes

Ad groups: Ad groups:

Raspberry bar  30% off gift boxes

Caramel bar Free shipping on gift boxes
Ginger bar Luxury Valentine's chocolate

Each ad group can have multiple ads within it. This helps the chocolate maker compare performance
for different ad text, for example, and see whether one version resulted in more clicks or sales than
another.

Once you're familiar with the structure of your AdWords account, you can view and customize the data in your
statistics table, and download reports to monitor the performance of your campaigns, individual campaigns, and ad

groups -- as well as your ads and keywords.



Understanding ad position and Ad Rank

Ad position is the order in which your ad shows up on a page. For example, an ad position of "1" means that your ad is the first ad on a page. In
general, it's good to have a high ad position because it's likely that more customers will see your ad. Ads can appear on the top of a search results
page, on the side of the page, or on the bottom of the page.

How ad position is determined

Ad position is determined by your Ad Rank in the auction. Your Ad Rank is a score that's based on your
bid and your Quality Score. If you're using the cost-per-click bidding option, your bid is how much
you're willing to pay for a single click on your ad. Your Quality Score is a measurement of how relevant

— and useful your keyword, ad text, and landing page are to what a user is searching for.

8 |

— To improve your ad position, you can increase your bid, or you can focus on improving your Quality
A Score. See the "Next steps" section below for more information about Quality Score and how to

optimize your ad position by improving your ad quality.

[

AdWords Video: Understanding Ad Rank

Learn about how Ad Rank is determined and how to increase your ads' chances of ranking high.

AdWords essential

The auction: how Google decides which ads to show and their order

Keep in mind

Because of the diversity of websites on the Google Display Network, average position may be less useful in optimizing for performance on this network. If
you want to measure performance on the Display Network, we recommend focusing on metrics such as conversions and ROI Read more on how to
evaluate ad performance on the Display Network.

Video: How to optimize your Ad Position

In this video you'll learn how to optimize your ad position

How ads cycle through the search result pages

Ads cycle through the search result pages based on their Ad Rank. The ad with the highest Ad Rank appears in the first
eligible position on the search results page. The ad with the second-highest Ad Rank appears beneath it, and so on down

[
*

the page.

When a customer browses to subsequent search result pages (for example, they click Next to see additional pages of
search results), the following two rules typically apply for which ads are eligible to show where:



« "Top" placement (top of the page): All high-ranking ads are eligible to show in the top positions, provided they exceed a certain Quality Score and
cost-per-click (CPC) bid threshold. Up to three ads can show in the top positions on each page.

o "Other" placement (side or bottom of the page): The side and bottom of a search results page is recorded as "Other" in your AdWords statistics,
and can show up to eight ads. Typically, ads that haven't previously appeared in the side or bottom placements are eligible to appear in the side or bottom.
For example, if an ad appeared on the side of Page 1, it typically won't appear on the side for Page 2 or later.

Here's an example to help you understand how ads cycle through the search result pages.

Ads 1-25 are available to show for a certain search term, and ads 1-7 are eligible for the top spots. The ads can be ranked on the page like this:

Page Top spots "Other" spots
Pagel  Ads1-3 Ads 4-11
Page2 Ads1i,2 4 Ads 3, 12-18

Page3 Ads1,2,5 Ads 19-25

Note

Because Quality Score and thresholds are recalculated on every page, ads may sometimes appear in a top spot on one page and then again in an "Other"
spot on a subsequent page (or appear in the "Other" spot on one page, and then again in a top spot on the next page). An ad typically will only be shown
once in an "Other" spot and will not appear again in that spot on subsequent pages.

Where to find your average ad position

In your AdWords account, you can easily see what your average ad position is. Let's walk through the steps to view your average position:

1. Sign in to your AdWords account at http://adwords.google.com.

2. Click the Campaigns tab at the top.

3. Look for the Avg. Pos. column in the statistics table. If you don't see this column in your table, you can add this column by clicking the Columns button in
the toolbar above the statistics table.

You can also click the Ads or Keywords tab to see your average position by ads or by keywords. To see how often your ads have appeared on the top of the
page, on the side of the page, or on the bottom of the page, you can segment your data.



Actual cost-per-click (CPC)

Your maximum cost-per-click (max CPC) bid is the most you'll typically be charged for a click, but you'll often be charged less -- sometimes much less. That
final amount you're charged for a click is called your actual CPC.

Actual CPC is often less than max CPC because with the AdWords auction, the most you'll pay is what's needed to rank higher than the ad position immediately
below yours. To understand how this works, it's important to understand the concepts of Quality Score and Ad Rank. Your Quality Score is a measure of how
relevant and useful your ad and landing page are to the people who see it. It's based on your click-through rates and other factors. We combine your Quality
Score with the CPC bid for an auction to determine something called Ad Rank. Each advertiser’s Ad Rank is then used to determine where the ad appears (or
whether it appears at all).

o If the advertiser immediately below you bids US$2.00, and if that advertiser's ad is the same quality as yours, you'd typically need to bid a penny more
than US$2.00 to rank higher than that advertiser. With AdWords, that's the most you'll pay (about US$2.01), whether your bid is US$3.00, US$5.00 or
more, unless your campaign targets interest categories on the Display Network.

o If the advertiser immediately below you bids US$2.00 and has a higher quality ad than you, you'll pay about a penny more than what's required to match
that advertiser's higher Ad Rank, but never more than your maximum CPC bid (unless you're setting bid adjustments or using Enhanced CPC).

o Note that the minimum Ad Rank required for ads above search results is generally greater than the minimum Ad Rank required for ads beside search
results. As a result, the cost-per-click (CPC) when you appear above search results could be higher than the CPC if you appear beside search results, even
if no other advertisers are immediately below you. Although you may pay more per click, top ads usually have higher click-through rates and give you
access to certain ad extensions (like sitelinks) and other features available only in top ad positions. As always, you're never charged more than your max
CPC bid.

e For certain ads on the Google Display Network, you may pay more or less than the exact amount required to rank higher than the advertiser immediately
below you. Learn more about the Display Network ad auction.

More about cost-per-click bidding
Understanding ad position



Ad Formats

Ad Formats

Text ad

What makes up a text ad

Tips for creating successful text ads

Using stand-alone shopping ads for your products
Set up your Product Listing Ads campaign

Using Dynamic Search Ads

Create targets for Dynamic Search Ads

Ad Extensions

Location Extensions

Enhance your ad using extensions

Show ads with your Google+ page endorsements
Link Google Places and AdWords

Benefits of using Google Places

How seller ratings work

Show additional links below your ad text



Text ad

The standard type of AdWords ad. A text ad typically includes a link to your website and a description or promotion of your product or service.

e Text ads include a title that's also a clickable link to your webpage, one or two lines of text, and your website address shown in green.

o These ads can appear on Google search results pages and across the Google Network. Text ads might look different on the Display Network.

e Text ads are sometimes known as "sponsored links" because the title links to the advertised website.

o Here are a few things that great text ads do: highlight what makes your business or product unique; include prices, promotions, or exclusive offers; have a
clear call to action; and use at least one of your keywords in your ad text.



What makes up a text ad

All online ads are essentially clickable messages that connect customers with a website.

Text ads, the simplest version of a clickable message, contain three components: a headline, display URL,
and a description. Let's look at the components of the sample ad below:

Advertise with Google Headline
adwords.google.com Display URL
Want fast results? Description

Create your ad campaign today!

Text ads in Google AdWords must meet the following length requirements:

Example ad Max Length Max Length
(most languages) (double-width* languages)
Headline: Example Website 25 characters 12 characters
Description line 1: Summer sale 35 characters 17 characters
Description line 2: Save 15% 35 characters 17 characters
Display URL.: 35 characters 17 characters

www.example.com

Note

You can make longer text ads if you're targeting certain countries or regions: Azerbaijan, Belarus, China, Hong
Kong, Japan, Kazakhstan, Kyrgyzstan, Russian Federation, South Korea, Taiwan, Tajikistan, Turkmenistan,

Ukraine, and Uzbekistan. Learn how to create longer text ads.

Headline

The first line of your ad is the one that customers are most likely to notice. If you really want your headline to stand

out, consider including keywords. People are more likely to notice headlines that match what they're searching for.



In our sample ad, the keyword "advertise" should get the attention of people who are searching for ways to

advertise online. We can show up to 25 characters in your headline.
Display URL

Appearing in green, this line of your ad shows the address of the website that you're promoting. AdWords lets you
choose a brief but meaningful display URL to give people who see your ad a clear idea of where it'll take them
when they click on the link. Behind the scenes, you can also assign your text ads a longer destination URL, which
takes the person who clicks your ad to a precise location on the same website that's relevant to the ad itself.
People can only see the display URL in your ad and not the destination URL.

Long display URLs

We can show up to 35 characters of your display URL due to limited space. For languages that use double-width
characters, like Chinese (simplified or traditional), Japanese, or Korean, we can show up to 17 characters of your
display URL. If your display URL is longer than the maximum character length, we'll shorten your display URL when

we show your ad.

= Display URLs enhanced with website links

You might see that the Display URL of your text ad includes a set of links that show the locations of pages
on your website. We call these links breadcrumbs - inspired by the trail of breadcrumbs Hansel left through
the woods to find his way back home in the Grimm's fairy tale "Hansel and Gretel." These breadcrumb links

help customers easily navigate to relevant sections of your website.

For some advertisers, we'll automatically add breadcrumbs to ads that appear at the top or bottom of
Google search results, helping to make your ads more relevant to customers. Customers can click an

individual breadcrumb link to quickly navigate to the page or section of your website that they find relevant.

Example

Let's say a customer wants to buy a pair of sandals and she searches for "womens sandals".

We might show her the following ad enhanced with breadcrumbs:
Ads - Why these ads?

Womens Shoes - Designer styles, Discount prices
www.exampleshoes.com » Womens Shoes » Sandals
Save Up To 50% Off Designer Brands. Free Shipping, Free Exchanges!

Deciding that she might want to see more than just sandals, she clicks the "Womens Shoes"
breadcrumb link. She looks at the boots and sandals that you sell -- and finds shoes that she
loves! -- so she decides to buy a pair of brown leather boots and hot pink sandals from your

website.



How to show breadcrumbs with your ads

You can edit your website's code and add breadcrumb annotations to show your ad with breadcrumbs.
Remember, you're in control of the code that's used on your website to create breadcrumbs. Since we use
the breadcrumb annotations from the landing page of your ad to create the breadcrumb links, you're also in
control of which breadcrumbs are shown with your ad or whether breadcrumbs are shown at all. Learn more

about how you can modify your website code to show breadcrumbs [£.

Bradcrumbs and costs

We'll charge you each time a customer clicks any link on your ad, regardless of whether the link clicked is
the headline of your ad or a breadcrumb link. You can decide the maximum amount you'd like to pay for a

click by setting a cost-per-click (CPC) bid.
View your breadcrumb performance data

You can use segments to see how your breadcrumbs are performing. To see the number of times someone
clicked your breadcrumb links to visit your website, select the Ads tab and segment your data by "Click

type". Your performance data will be included in the "Breadcrumb"” click type.

Description

The final lines of your text ad are where you describe the product or service you're advertising. Space is limited, so
choose your words carefully to highlight the most important details and benefits. We can show up to 35 characters

for each description line.

Keep in mind that text ads on the Google Display Network might look different.

Using special characters with your ads

You can write your ads in a number of supported languages. Most non-English characters, including tildes,
umlauts, and cedillas, will appear correctly in your ads, including the display URL.

For languages that use double-width characters, like Chinese (simplified or traditional), Japanese, or Korean, your
text ads will appear on Google search results the same way that they appear in your account. Keep in mind that
your headline, description lines, and display URL should meet our character limits. We recommend you preview
your ads to make sure you're satisfied with how they appear. And remember to check your ads using the Ad

Preview and Diagnosis tool rather than searching on Google.



Tips for creating successful text ads

It's not easy fitting everything you want to say about your business in just a few words. Start by taking a moment to consider what you want to do
with your ad. Then use the six guidelines in this article to create an ad that's accurate, to-the-point, and engaging — and hopefully brings you lots of
clicks!

Watch this video

AdWords Writing Tips: Ads That Attract Customers

Three tips to write AdWords ads that attract customers. Learn how to write ads that will catch your customers' eyes and clicks. Read more about how to create
a new text ad http://goo.gl/gotti Subscribe to AdWords Help on YouTube http://www.youtube.com/learnwithgoogle

 Highlight what makes your business, product, or offer unique
Free shipping? Large selection? Tell people! Highlight features or areas that make your business stand out from the competition.

. Include prices, promotions, and exclusives
If you have something special to offer, make sure your customers see it. People are usually searching to make a decision about something. Give them
what they need to help make their decision. For example, if you're offering a 10% discount for a limited time, or have an exclusive product, don't
forget to tell your customers!

‘x Tell your customers what they can do
Are you selling? Tell them what they can buy. Are you offering? Tell them what they'll receive. Strong verbs like Purchase, Call today, Order, Browse,
Sign up, or Get a quote tell your customers what they can expect to do when they arrive at your website.

E,‘ Include at least one of your keywords in your ad text
Successful text ads tend to contain words that match a person's search. Including one of your keywords in your ad text can catch the attention of the
people who searched for the keyword, and show that your ad is related to what they want. Additionally, the keyword you use will appear in bold in
your ad, just like it does in the search results, making it more obvious how relevant your ad is. Let's say you include the keyword digital cameras in
your ad's headline, like "Buy Digital Cameras," and a customer searches for digital cameras. Your ad's headline will appear in bold, like "Buy Digital
Cameras." Your ad's headline could also appear in bold if a customer searched for buy SLR cameras, like "Buy Digital Cameras," since "buy" and
"cameras" match words in the customer's search term.

*d

Match your ad to your landing page

Take a look at the page on your website that you're linking to, which is called the /anding page. Make sure the promotions or products in your ad are
included in that page. Tell people what they can expect when they click the ad. If visitors don't find what they expect to see when they reach your site,
they might leave.

[* Appeal to customers viewing your ad on a mobile device
When customers are on-the-go, certain information might be more useful to them (like your store location or phone number) or a particular message
might grab their attention. If you're running an enhanced campaign, try using call extensions (also known as click-to-call) or location extensions to give
customers the information they need to take action while they're on the move. Also, consider creating additional ads tailored for mobile devices, like
text that highlights mobile-specific specials or discounts or a mobile-optimized display URL.

Experiment
Create three to four ads per ad group, trying out different messages to see which performs the best with your customers. AdWords can automatically



show the better-performing ads within an ad group more often. This removes the guesswork and lets you build on what you've learned from your
experiments.

For example, if the three things that make your business stand out are free shipping, seasonal discounts, and pre-order exclusives, make different ads
highlighting each of those features, and see which one works better.

Tip

Capitalizing the first letter of each word in the title of your ad helps make the words stand out.

Example

You own a camera store and want to sell your excess 8 megapixel cameras to make room for new merchandise. To find customers who are
specifically searching for this camera, you decide to run a 20% off promotion. Here's what your ad could look like:

8 Megapixel Cameras

www.example.com

20% off Digital Cameras.

Free Delivery. Buy Today!

Successful text ads tend to contain words that match a person's search and tell them what they can expect when they click on the ad. Notice how
the capital letters in the "8 Megapixel Cameras" ad make the words stand out.



Using stand-alone shopping ads for your products

Product Listing Ads are a unique ad format that allows you to include specific product information like an image, title, price, promotional message,
and your store or business name. Product Listing Ads appear in their own box on Google Search, separate from text ads.

To begin using Product Listing Ads, you'll need both an AdWords account and a Google Merchant Center account. Then you'll need to link the two
accounts. Your Merchant Center account lets you manage your product information, while your AdWords account helps you manage your ads and
campaigns. Now you can create and deliver attractive and relevant Product Listing Ads to potential customers. If you don't have one already, create
an Adwords account today.

Before you create Product Listing Ads, learn more about the following:

The benefits of using Product Listing Ads
How Product Listing Ads work

What Product Listing Ads look like

Where Product Listing Ads appear

How much Product Listing Ads cost
Advertising guidelines for Product Listing Ads

e o o o o o

Note

Product Listing Ads are available in the following countries: Australia, Brazil, Canada, the Czech Republic, France, Germany, India, Italy, Japan, the
Netherlands, Russia, Spain, Switzerland, the U.K., and the U.S.

Benefits of Product Listing Ads

« More traffic and leads: Many businesses experience significantly higher clickthrough rates (CTR) with Product Listing Ads compared to text ads
shown in the same location for Google Shopping searches. In some cases, advertisers have experienced double or triple standard clickthrough rates.

* Better qualified leads: As a merchant, you can increase the quality of your leads by featuring product information directly in your ads to help shoppers
make informed purchase decisions. This makes shoppers more likely to complete a purchase on your site.

o Easy management: With product targeting, you won't need to use keywords. Just create product targets in your AdWords Product Listing Ad
campaigns and AdWords will use the attributes you've defined in your Merchant Center feed to show your offers on relevant searches.

« Broader reach: More than one of your Product Listing Ads can appear for a given customer search and, if relevant, a Product Listing Ad and a text ad can
also appear at the same time. This means your reach with shoppers for a single search could double.

How Product Listing Ads work

Product Listing Ads use your existing Merchant Center product feed -- not keywords -- to decide how and where to show your ads. We'll use the information
in this product feed when we show your listings that are relevant to a customer's search on Google Search and Google Shopping, so we recommend you
always keep your product feed up-to-date. You'll also set up product targets to control which products are shown with your ads for a given campaign. Learn
more about Merchant Center product feeds.

You'll use these AdWords campaign settings to create your Product Listing Ad campaigns:

o Campaign type: Product Listing Ads are eligible to appear on Google Search and Google Shopping, which are part of the Google Search Network, so
you'll want to choose the "Search Network only" campaign type, then select the Product Listing Ads option.

o Networks: Here you can choose to have your Product Listing Ads also appear on Google Search Partner websites

« Bidding: Manual bidding is the most common setting for Product Listing Ads, though other bidding options are available. With manual bidding, you can

set your own bid amounts and control the maximum cost for each click on your ad.

Ad scheduling: You can use ad scheduling to specify certain hours or days of the week when you want your Product Listing Ads to show.

.

What Product Listing Ads look like

Product Listing Ads show a set of relevant products for a given search. The products appear with additional information like a product image, price, and the
merchant name, without the need for you to create unique ads for each product you sell. Their appearance may change as we experiment with the best display
options for this format.

For example, here's what Product Listing Ad search results might look like after a Google search for "fish bowl:"



Shop for fish bowl on Gooale Sponsored @
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1-Gallon Fish...  Plastic Fish Glass Fish Fish hotel Fluted Fish
$5.97 Bowl - Round... Bowl-1/2Ga... $34.89 Bowls - 4.6"
Fish Habitats $10.22 $7.99 Fun Fish Bowls  §6.82

Fish Bowls Ex... Pets That Swim Tiny Fish Tanks

Shop by price: Up to $15 $15-$30 $30 — $50 Over $50

Where Product Listing Ads appear

Product Listing Ads appear in their own box on Google Search, separate from text ads. They may appear at the same time as text ads, so that a single Google
Search results page could show both Product Listing Ads and text ads.

Example

If you sell ballet slippers and have a text ad for ballet equipment and a Product Listing Ad for ballet shoes, a customer could see both of your ads
on the same Google Search results page.

We allow a Product Listing Ad to appear at the same time as a text ad because we want to give shoppers access to the full variety of products that match their
search. When a shopper searches for a commercial item online, like a pair of shoes, a video game, or a car, they're usually trying to see all the purchasing
possibilities for the item they're looking for.

We want Product Listing Ads to offer all possible variations available for that item, helping shoppers find the best match before clicking through to make a
purchase. This helps merchants like you close a sale for a more targeted customer search.

How much Product Listing Ads cost

We charge for clicks on your Product Listings Ads on a cost-per-click (CPC) basis. Since Product Listing Ads don't use keywords, you'll use attributes in your
Merchant Center product feed to define product targets. Then you'll set maximum cost-per-click (CPC) bids for your product targets. Just like how bidding
works for AdWords ad formats, you'll only pay the minimum amount necessary to beat the ad position below yours and you'll often pay less than your
maximum bid.

Advertising guidelines for Product Listing Ads
The content of your ad, including text and images (served dynamically from information within your Merchant Center account) should comply with our Product

Ads policies.

Note

Merchant Center policies state that product links should not have redirects. However, you can use redirects with the "adwords_redirect" attribute, which
we'll use when using your product information to show your Product Listing Ads. Learn more about the "adwords_redirect" attribute.



Set up your Product Listing Ads campaign

Once you're familiar with Product Listing Ads and how they work, you're ready to set up your Product
Listing Ads campaign and create product targets for them. You can also review some tips that will help
you set up your campaign depending on your advertising goals.

Click to one of the following sections to get started with your Product Listing Ads campaign:

e Link your Google Merchant Center and AdWords accounts
e Set up your Product Listing Ads campaign

o Create product targets

e Set up product filters

Note

Product Listing Ads are available in the following countries: Australia, Brazil, Canada, the Czech Republic, France,

Germany, India, ltaly, Japan, the Netherlands, Russia, Spain, Switzerland, the U.K., and the U.S.

Link your Google Merchant Center account to your AdWords account

For your Product Listing Ads to show, you'll need to link your Google Merchant Center account to your AdWords
account. Google Merchant Center [£ is a tool that helps you upload your product listings to be used for Google
Shopping, Product Listing Ads, and Google Commerce Search. You can link multiple AdWords accounts to a single

Merchant Center account.
Here's how to link your Merchant Center account to your AdWords account:

1. In your Merchant Center account, click Settings and then click AdWords.

2. Enter your AdWords customer ID. You can find your customer ID at the top of any AdWords page when you're
signed in, near your email address.

3. Click Add.

You'll also need to link your AdWords campaign to your Merchant Center account. We'll show you how to do so in

the next section of this article.



Set up your Product Listing Ads campaign

Create a new Product Listing Ads campaign

Once you've linked your Merchant Center account to your AdWords account, you're ready to set up a new
campaign for Product Listing Ads:

1. Sign in to your AdWords account at https://adwords.google.com £ .

2. Click the Campaigns tab. Then, click +New campaign and select Search Network only. For your

3. Select the radio button next to "Product listing ads" in the campaign type section of the page. If you
don't see the Product Listing Ads option, it might be because this option is available for "Search
Network only" campaigns.



Google Adiiords

. Scroll to the "Ad extensions" section of the page and choose a linked Merchant Center account to

associate with your campaign. If there are no available accounts to link, you'll need to go back to
Merchant Center to complete this step first.

Google Adiiords

5. Click Save and continue.

6. Now, you'll create your first ad group. Within the "Create an ad" section, you have the option to enter
promotional text for your ad. This promotional text will appear with any of the products associated with
this ad group, so make sure that the text is relevant to all the products that you'll be advertising. For



example, let's say your promotion is "Free shipping on orders over $50," and you'd like to promote
products for Brand X and Brand Y shoes. This offer needs to be relevant for your Product Listing Ad

regardless of whether it shows Brand X or Brand Y shoes.

7. Next, you'll add the "All products" target to your ad group by default. You can add more product

targets to this ad group later. (You'll read more about product targets in the next section of this article).

8. Enter a default bid for this ad group under the "Ad group bids" section.
9. Click Save ad group.

Create a new Product Listing Ad in an existing campaign

To set up a Product Listing Ad in an existing campaign, first make sure that the campaign is linked to your
Merchant Center account. We'll show you how to check whether your campaign is linked to your Merchant
Center account in the following steps.

To create a Product Listing Ad in an existing campaign:

1. Sign in to your account at https://adwords.google.com [£ .

2. Select the campaign where you want to create your ad.

3. To make sure that your campaign is linked to your Merchant Center account, click the Ad extensions
tab and select View: Product Extensions from the drop-down menu. In the table, you should see your

Merchant Center account information. If you don't see your Merchant Center account, add it by clicking



+New extension and selecting your account from the "Select extension" drop-down menu. Then, click

Save.

4. Select the Ad groups tab.

5. Click +New ad group and name your ad group.

6. You have the option to enter promotional text for your ad. Your promotional text will appear with any of
the products associated with this ad group, so make sure that the text is relevant to all the products
that you'll be advertising. For example, let's say your promotion is "Free shipping on orders over $50,"
and you'd like to promote products for Brand X and Brand Y shoes. This offer needs to be relevant for

your Product Listing Ad regardless of whether it shows Brand X or Brand Y shoes.

7. Next, you'll add the <strong>All products</strong> target to your ad group by default. You can add
more product targets to this ad group later. (You'll read more about product targets in the next section of

this article)




8. Enter a default bid for this ad group under the "Ad group bids" section.
9. Click Save.

It may take up to 12 hours from the time you update your settings for your Product Listing Ads to appear. If
you're submitting a product feed for the first time, it may take up to two business days for the new feeds to

be reviewed.
Highlight your Product Listing Ads with a promotional message

You can add promotional text to your Product Listing Ads if you want to highlight special information that
applies to all the products you're targeting in a particular ad group. These messages shouldn't be used as
ad text, but rather as actionable alerts for customers to make a specific purchase on your site. Promotional
text is limited to 45 characters, and keyword insertion won't work with this text or the product information

text provided dynamically from your Merchant Center account.

Make sure your promotional text meets the AdWords policies on editorial standards and relevance, clarity,

and accuracy to avoid any unforeseen delays.
Here are a few common mistakes to avoid in your promotions:

¢ Don't use promotional codes with consecutive zeros
¢ Don't capitalize entire words
¢ Don't use double exclamation points

e Don't use symbols or shapes

Examples
Promotional text Allowed? Reason
Use coupon code HALZ for $10 off at ﬁf It's okay to capitalize all the letters in the
checkout promotional code
We are the BEST out there!! (X Promotional text contains excessive capitalization

and double exclamation points

Use coupon code Z0OLZ to save [ X Promotional code contains consecutive zeros
20%
Free 1 day shipping with any q/ It's okay to use consecutive zeros in monetary
purchase of $100 or more values
Lowest price | Discount on all (%] Promotional text contains a symbol

products



Free shipping on orders over $50 ﬁf It's okay to use the dollar sign ($) to indicate

monetary value in promotional text

Buy a second one for 50% off ﬁf It's okay to use the percent (%) symbol in

promotional text

We recommend using promotional text that includes a specific benefit for your potential customer if they
click on your ad. Avoid using vague or general descriptions.

Here are a few examples of less useful product promotions:

e Satisfaction guaranteed
e Certified the best costume retailer in the Bay Area

e Low prices, guaranteed

Create product targets

Product targets allow you to select which products are eligible to show on Product Listing Ads, and they also allow
you to bid differently on different sets of products. You'll need at least one product target in order to run Product

Listing Ads since they tell us what products you want to promote.

When you initially set up your Product Listing Ads campaign or add a Product Listing Ad to an existing campaign, a
product target for all the products in your product feed is created by default. You can create additional product
targets and manage them from the Auto targets tab, which you'll see once you link your Merchant Center account

to your campaign.
Understanding product targets and keywords

Instead of keywords, Product Listing Ads use product targets to determine when items in your Merchant Center
account appear on a search results page. Defining keyword lists for proactive targeting won't have any effect on
your Product Listing Ads or product targets at this time. However, you can use negative keywords to limit the

searches for which your ads will show. Negative keywords can be applied at the ad group or campaign level.

Using the "All products" product target (default product target)

You can create an "All products” product target, which uses all of the products in your Merchant Center product
feed to target your ads, if you don't need to specify a particular subset of your products. This "All products" target

is created by default in any new ad group in a campaign that has a Merchant Center feed associated with it.

Using attributes with your product targets to define sets of products

Product targets are defined using attributes that are set in your AdWords and Merchant Center accounts. Attributes,



like a product's type or condition, define your products in a unique way. If you'd like to bid differently for separate
groups of products or simply organize your campaigns with specific groups of product, then you'll need to create
product targets using the different attributes that we allow.

You can define groups of products choosing attributes from your Merchant Center feed and set which values those
attributes should have for the products you specify. You might need to create additional attributes in your Merchant
Center feed in order to use some product target settings. Once you've defined a group of products in this way,
your Product Listing Ads in the ad group will be eligible to show for any customer searches that are related to the
products you've specified.

Attributes

Here are examples of the attributes you can use:

e id: The identifier (id) for each product in your Merchant Center account.

¢ brand: The product's brand as specified in your Merchant Center account. Example: Google.

e product_type: The product's category. Examples: shoes, high heels, or fridge.

¢ condition: The condition of the product. Examples: new, used, and refurbished.

e adwords_grouping: A custom defined grouping of products. This attribute only accepts one value per
product. You can create your own grouping as you see fit. Examples of custom groupings could be those of
grouping the products per season, per designer, per manufacturer, per year, per model, etc.

¢ adwords_labels: The same as adwords_grouping, but it accepts up to 10 values. You can group your

products in two different concurrent groupings. For example, cars grouped by model and by manufacturer.

Tip

If your campaign is using the CPC pricing method, we recommend that you use adwords_labels.

= How to set up your product targets

Here's how to create a product target:

1. Sign in to your AdWords account at https://adwords.google.com £ .
2. Select the campaign where you want to create your target.

3. Click the Auto targets tab.

4. Click Add product target.



5. Select the ad group where you'd like to create the product target.
6. Select up to three product attributes and enter their corresponding values. These values must match the
values in your Merchant Center feed exactly, or your ads won't be eligible to show for these targets.

7. Click Save.

Tips

¢ You can add multiple product targets to each of your ad groups. You should consider doing so
only if you want to have different promotional messages for each product target.

e Like unique placement and keyword-level bids, you can set bids for your product targets. This
will allow you to specify how much you are willing to pay when a customer clicks on a Product

Listing Ad triggered by a particular target. You can read more about product targets and bids in
the next section.

Tips for setting up your Product Listing Ads campaigns

Depending on your campaign goals, including your bidding strategy and promotional messaging needs, it might
help to set up your Product Listing Ads campaigns according to certain guidelines.



— | Setting up a Product Listing Ads campaign based on your bidding strategy and messaging needs

Bidding
strategy

Bid the same
amount for all

products

Bid the same
amount for all

products

Different bid
for different
sets of

products

Different bid
for different
sets of

products

Messaging needs

No promotional
messages or one
message for all your
products

Different promotional
messages for different

sets of products

No promotional
messages or one
message for all your

products

Different promotional
messages for different

sets of products

Recommended approach

1. Create one ad group.

. Create one product target set on "All Products"

(enabled by default during ad group creation).

. Create one product listing ad.

1. Create multiple ad groups.

. For each ad group, create one product target set with

one product target each.

. Create a corresponding product listing ad per ad

group with promotional messages.

4. Use the same bid or commission for each ad group.

Merchant Center:

¢ Set up your feed data within your Merchant Center

account to define groups of products (such as by

brand, category, etc.).

AdWords:

1. Create one ad group.

. Within the ad group, create the same product targets

to match all the different sets of products with the
distinct bids (CPC) you want.

. Product targets attributes: Use condition, brand,

product_type or adwords_ labels attributes to

create the different product targets.

. Create at least one corresponding product listing ad

for the ad group.

Merchant Center:

¢ Set up your feed data within your Merchant Center

account to define groups of products (such as by

brand, category, etc.)



AdWords:

1. Create multiple ad groups.

2. Create one product target per ad group with a
corresponding product listing ad with promotional
message.

3. Product targets attributes: Use condition, brand,
product_type or adwords labels attributes to
create the different product targets.

4. Indicate your bid or commission for each product
target you've defined.

Tip
If you're doing a CPC implementation, we recommend that you use the adwords labels

attribute because it's more flexible.

= Bidding best practices

Here are a few tips to help you get started with setting bids for your Product Listing Ads:

¢ [f you're using maximum cost-per-click (max CPC) bidding, try setting the same max CPC bid that
you use for your existing text ads and then see how your Product Listing Ads perform.

¢ You can change your bids as often as you'd like. However, consider setting a bid amount and then
seeing how your Product Listing Ads perform. Once you've collected enough data, you can identify how

profitable your product targets are with their current bids. Then, you can adjust your bids accordingly.

Use product filters to restrict which products from your Merchant Center account
appear with your ads

Product filters are a way for you to define which products in your Merchant Center account can appear for your
Product Listing Ads. Be default, we'll match people's searches to relevant products from your entire Merchant
Center product feed. However, if you create a product filter for a group of products that are in your product feed,
then we'll only show products from your product feed that match the filters you've created in your Product Listing
Ads.

Example



Let's say your campaign is linked to a Merchant Center account featuring running shoes, women's
clothing, books, and a range of household appliances. Let's also assume you've properly categorized

your products using the product_type attribute [£.

For this campaign, you want your product ads to include only products from your feed that are in the
category "Women's clothing," so your product filter would have to be: product_type is "Women's
clothing." Once this product filter is set, only women's clothing items are eligible to show on your
Product Listing Ads.

= How to set up product filters

1. Sign in to your account at https://adwords.google.com 4 .
2. Select the campaign where you want to add product filters.
3. Select the Ad Extensions tab. Select Product extensions from the "View" drop-down menu above

statistics table.

Google Adwords
o —

4. If you already have a Merchant Center account associated with your campaign, click on its entry in the
statistics table to edit it. Otherwise, click "New extension" to begin.

5. Check the Filter box in the panel that appears.

6. Select up to 10 "OR" statements as requirements to determine which products from your feed are
eligible to appear in ads in this campaign. You can specify up to five conditions within each "OR"

statement.



Google AdWords

7. Click Save.

Tip
The values you enter in your conditions must match your Merchant Center feed attributes exactly,

or the conditions will not match any products, and Product Listing Ads won't serve for this
campaign.

Setting the company name shown in your ads

The company name displayed in your ads is defined within your campaign's linked Merchant Center
account.

You can change the company name for your Merchant Center account under Settings > General >

Company or organization name (Required).

Learn more about this setting and Merchant Center company name guidelines [ .



Using Dynamic Search Ads

While most search ads use keywords to determine when they show up on Google Search, Dynamic Search Ads differ in that they don't use keywords.
Instead, Dynamic Search Ads automatically show your ad based on the content of your website. This means you don't have to choose keywords, tell
us when you add a page to your website or take it down, or create an ad for each product page of your site. Why are Dynamic Search Ads helpful?
They're easy to maintain, automatically generated, can help you gain additional traffic, and you don't have to create long lists of keywords.

Who should use Dynamic Search Ads
Here are some examples of the types of businesses that are a good fit for Dynamic Search Ads:

o Your website features different products or services.
* You offer listings of services or products that change frequently.
e You sell seasonal product lines or other offerings.

Curious how Dynamic Search Ads have worked for others? You can check out these case studies to learn how Dynamic Search Ads worked for these
businesses:

o Holiday Check
e Qo010
e Soft32

Who shouldn't use Dynamic Search Ads
Dynamic Search Ads may not be the best campaign type for certain businesses. Here are some examples of such businesses:

e Customizable product and gift websites. The Dynamic Search Ads system uses content from your website to target your ads. For websites that sell
customizable or speciality products, it can be challenging for the system to match your ad to the most relevant search term. For example, imagine your
website sells T-shirts, mugs, and posters that feature pictures of puppies. Now, let's say someone wants to adopt a puppy and searches for puppies on
Google. You probably don't want to show your ad to this person because it's likely that she's not interested in what you're advertising.

« Comparison shopping sites and affiliate sites. Generally, websites that show customers a list of products or other offerings from online retailers and
drives traffic to third-party websites aren't a good fit for Dynamic Search Ads.

« Daily deal sites. Websites that feature daily deals aren't the best fit for Dynamic Search Ads. However, we're working on making Dynamic Search Ads
better suited for daily deal sites in the future.

¢ Certain small websites. Websites with a small number of landing pages (for example, less than a few hundred) aren't a good fit for Dynamic Search
Ads.

Why use Dynamic Search Ads
Here are some of the benefits of using Dynamic Search Ads:

e Save time. No more mapping keywords, bids, and ad text to each product on your website. Instead, we'll use Google's organic search index of your
website to determine which searches might be relevant to the products on your website.

o Show relevant ads. When a customer's search is relevant to your product or service, we'll dynamically generate an ad with a headline that includes
words from that customer's search phrase and the landing page in the ad.

o Control your campaign. You can show ads based on your entire website, or specific categories or pages. Or, prevent your ads from showing for
products that are temporarily out-of-stock.

o Capture additional traffic. Dynamic Search Ads can help you gain additional traffic and sales by promoting your business to more customers than you
can reach with a keyword-targeted campaign.

How Dynamic Search Ads work

Instead of keywords, we use content from your website domain to target your ads to searches. To do so, we use Google's organic search index of your website
to determine which searches might be relevant to the products and services offered on your website. This means we don't crawl your website separately. You
tell us whether all pages or just specific sections should be used to target your ads by creating dynamic ad targets. Dynamic ad targets can be your whole
website or specific sections, such as the following:

e Pages belonging to specific categories
o Pages with titles containing certain words
e Pages with URLs containing certain strings of text



e Pages containing certain words

When we find searches that are a match for your dynamic ad targets, we generate an ad text headline with a destination URL that links to the most appropriate
page from your website. The headline is dynamically put together by taking words from the search phrase and content from the landing page chosen for the
ad. The rest of the ad is a template that you wrote when you set up or edited your campaign.

Example
Advertise with Google headline, dynamically generated
www.adwords.google.com ad template, written by you

Want fast results?

Create your ad campaign today!

Dynamic Search Ads and your account

Although Dynamic Search Ads change the way that ads are targeted for searches, they won't impact the way that ads get ranked, the performance of your
keyword-based ads, or the amount of control you have over your account.

o Same ranking. When entering the auction, the ranking of a dynamic search ad is determined in the same way as keyword-based ads. It is based on the
maximum cost-per-click (CPC) bid that you've specified for the dynamic ad target and the dynamic search ad's Quality Score using the same calculations
that are used with other search ads. The cost for a click is based on your ad's Quality Score and the Ad Rank of the ad just below yours, just like with
other search ads.

¢ Works with your keyword-based campaigns. Your dynamic search ads won't show when a customer's search term exactly matches one of your

keywords (this applies to all keyword-based campaigns and accounts that use the same domain as your Dynamic Search Ads campaign). However, we

might show your dynamic search ad instead of your keyword-targeted ad when a customer's search term is a broad match or phrase match to one of your
keywords and when your dynamic search ad has a higher Quality Score. Additionally, the performance of your Dynamic Search Ads won't influence your
keyword-based ads and vice-versa since we handle the history of your Dynamic Search Ads separately from your other ads.

You're still in control. With Dynamic Search Ads, you control the dynamic ad targets, ad templates, bids, and your budget. You can use negative

keywords, like free or returns, just like with traditional campaigns to avoid showing your ads on searches that don't convert into sales. And you can

prevent advertising when specific words or phrases appear on the page, like temporarily out of stock or sold out, when you add dynamic ad target
exclusions to block pages containing these words.

.

« You'll get full reporting. You can view a search terms report to see the terms that people searched for when they clicked your ad, and see the dynamic
headlines and landing pages chosen for those search terms. You can also view a categories report to see how various categories of your website perform.
Additionally, you can see the average clickthrough rate, cost-per-click, and conversion data for your ads.

* Works with ad extensions. You can include any of our ad extensions with your Dynamic Search Ads, showing customers additional business
information like more website page links.



Create targets for Dynamic Search Ads

To show your Dynamic Search Ads to customers, we'll use dynamic ad targets that you create based on
the content of your website. You can set up an all-encompassing dynamic ad target that includes all
pages in your website's domain. We'll also show you 10 themes based on your website content, which we
call categories, that you might want to consider when targeting your ads. You can also create additional
types of dynamic ad targets or block pages with dynamic ad target exclusions.

Ways to target

Dynamic Search Ads automatically show your ad based on the content of your website. This means that instead of
keywords, we use dynamic ad targets to show your ads to customers. With dynamic ad targets, you can choose
all or a subset of pages in your website's domain that'll be used to target your ads to customers. It's important to
keep in mind that Dynamic Search Ads use the landing pages from your website's domain that are indexed in
Google's organic search index.

Here are the five types of dynamic ad targets you can use to refine how we'll show your ads:

¢ All webpages: Every single page in your website's domain.

Example
Let's say you have a website about electronics, www.electronicsexample.com.

To target all pages in www.electronicsexample.com, select the Add all webpages button from the
"Add dynamic ad target" section of the Auto targets tab. Then, click Save.

e Categories: The Dynamic Search Ads system uses Google's organic search index for your website to see the
themes of your website content. Once our system identifies these themes, we create "categories" that you can
target. Entering your own category instead of choosing from AdWords' categories may prevent the system from
properly targeting sections of your website. That's because our system needs to match the landing pages from
your website with the categories that you create, and sometimes it might be difficult for our system to
understand the categories that you create.

L Example



Let's say you have a website about electronics organized into sections for different devices,
which the Dynamic Search Ads system might identify as different categories, like "camera,"
"television," and "video." You might also see subcategories in each category, like "camera

accessories" and "camera models" in the "camera" category.

To target pages by categories, select the Add a group of webpages button from the "Add
dynamic ad target" section of the Auto targets tab. Select "CATEGORY" from the drop-down
menu and you'll see a list of categories identified by our system, like "camera," "television," and
"video." Then, click Save. You'll see a dynamic ad target that looks like "CATEGORY contains

camera".

¢ URLs: Pages with URLs containing certain strings that you specify.

Example

Let's say you want to target all the services-related pages of your electronics website based on
the URL string that appears when you navigate the site. If the URL for the landing page of your
services section is www.electronicsexample.com/services/main/id=64725, then you can target all

URLs that contain the term "services."

To target pages by URL, select the Add a group of webpages button from the "Add dynamic ad
target" section of the Auto targets tab. Select "URL" from the drop-down menu and enter
"services." Then, click Save. You'll see a dynamic ad target that looks like "URL contains

/services/".

¢ Page title: Pages with titles that contain certain words. Don't know what a page title is? Click google.com and

look at the top of your browser window. You should see the page title "Google" at the top.

Example

You might want to target pages with titles that contain certain words, like "cameras."

To target pages by title, select the Add a group of webpages button from the "Add dynamic ad
target" section of the Auto targets tab. Select "PAGE_TITLE" from the drop-down menu and enter

"camera." Then, click Save. You'll see a dynamic ad target that looks like "PAGE_TITLE contains

cameras".

¢ Page content: Pages that contain certain words that you specify.

L Example

Let's say you want to use all pages that contain the word "digital cameras" to target your ads.



To target pages by content, select the Add a group of webpages button from the "Add dynamic
ad target" section of the Auto targets tab. Select "PAGE_CONTENT" from the drop-down menu
and enter "digital cameras." Then, click Save. You'll see a dynamic ad target that looks like
"PAGE_CONTENT contains cameras".

— | Example of how dynamic ad targets work

Think of dynamic ad targets the same way you'd think about operators, which are special search commands
that people use to refine their searches on Google or other search engines. To help you understand how the
Dynamic Search Ads system uses dynamic ad targets to show your ads, check out the following examples
of how operators work on Google search:

All webpages

If someone uses the operator site:google.com, then the organic search index will include all webpages
within the domain google.com. To see an example, click the following link: https://www.google.com/search?
&g=site%3Agoogle.com.

URLs

Let's say someone wants to search for webpages with URLs that contain certain terms. If that person uses
the operator inurl:adwords, then the organic search index will include all webpages with a URL that
contains the term "AdWords". To see an example, click the following link: https://www.google.com/search?
g=site%3Agoogle.com+inurl%3Aadwords

Page title

If someone only wants to see webpages with a certain page title, that person could use the operator
intitle:"adwords help". Then, the organic search index will include all webpages with a title that contains
"AdWords Help". To see an example, click the following link: https://www.google.com/search?
q=site%3Agoogle.com+intitle%3A

Page content

Let's say someone only wants to see webpages with certain content. If that person uses the operator
intext:"dynamic search", then the organic search index will include all webpages with content that contains
"Dynamic Search". To see an example, click the following link: https://www.google.com/search?

q=site%3Agoogle.com+intext: %22dynamic+search%22

Create dynamic ad targets



You can add one or multiple dynamic ad targets to your Dynamic Search Ads campaign.

Keep in mind

Keep in mind that you can include three attributes per dynamic ad target only. For example, if you add the URL
dynamic ad target that includes "camera," then you can only add two more attributes to this ad target. Then,
one attribute could be a page title ad target that includes "digital cameras," and the other could be a page

content ad target that includes "sale."

Here's how to add dynamic ad targets:

1. From your Dynamic Search Ad campaign, click the Auto targets tab.
2. Click the +Add dynamic ad target button.

Google Adior

3. Choose Add all webpages or Add a group of webpages. If you choose the latter, select whether to target by
category, URL, page title, or page content. For specific page titles or page content, add double quotation

marks, like "camera" to terms that you'd like to include.

4. Click Save.



Tips

e To combine any dynamic ad targets, click the Add another link that appears below your first
dynamic ad target.

¢ To target a subdomain, choose to target by "URL" and enter the subdomain you'd like to target. For
example, when you create a dynamic ad target to target a subdomain, it might look like the following:
"URL contains subdomain.example.com."

e Create dynamic ad targets that are more broadly defined to help increase your incremental traffic. If
you create a dynamic ad target with too few indexed landing pages, then your ads might not get any
incremental traffic.

e For enhanced Dynamic Search Ads campaigns, you can set bid adjustments to increase or decrease
your dynamic ad target bids by a percentage. Bid adjustments can give you more control over when
and where your ad is shown. Learn more about how to use bid adjustments with your enhanced

Dynamic Search Ads campaigns.

Block pages with dynamic ad target exclusions

Create dynamic ad targets that exclude pages on your website that you don't want to be used for generating
your ads. For example, you might want to exclude pages that contain words like "out of stock" to prevent

customers from seeing pages on your website that contain products they can't buy.
Here's how to add dynamic ad target exclusions:

1. From the "All online campaigns" page click the Auto targets tab.

2. Click "View" and choose Dynamic ad targets.

3. Scroll to the bottom of the page and click + Exclusions.



4. In the section that expands, click +Add.
5. Assign your dynamic ad target exclusion to an ad group.
6. Choose to exclude pages by category, URL, page title, or page content. For page titles or page content,

add double quotation marks to terms that you'd like to exclude.

Google AdW

7. Click Save. Your new dynamic ad target exclusion should appear in the "Exclusions" section.

Tips
We strongly recommend creating exclusions for pages that contain words like "sold out" or

"unavailable." This will prevent customers from seeing pages on your website that contain

products they won't be able to buy.

Add negative keywords



You can add negative keywords to your Dynamic Search Ad campaign just like how you'd add negative
keywords to any campaign in your account. Even though Dynamic Search Ads don't use keywords, our
system does consider negative keywords when it shows ads to potential customers.

Here's how to add negative keywords:

1. From the "All online campaigns" page, click the Keywords tab.

Google AdWords

2. Scroll down to find the negative keywords section below the main keywords table. Expand the section
by clicking "+".

3. You'll see two tables: "Ad group level" and "Campaign level."



Google AdWords

4. To add negative keywords to an ad group, click the +Add button in the "Ad group level" table. To add
negative keywords to a campaign, click the Add button in the "Campaign level" table.

5. Add your negative keywords, one per line. There's no need to include a negative sign (-) before each
keyword. If you add broad-matched negative keywords, you'll need to add their plural versions. To add
a negative phrase-matched keyword, surround the term with quotation marks, such as "used". To add a
negative exact-matched keyword, surround the term with brackets, such as [used].

6. Click Save.

Example

Let's say you'd like to prevent your ad about electronic devices from showing to someone
searching for used camera or used television. You'd want to add used as a negative keyword
since that person isn't likely to buy your new cameras and televisions.



L ocation Extensions

Display your local business information
Set up location extensions

Tips for setting up location extensions



Display your local business information

« Desktop ads: Location extensions merge your business address and phone number with your ad text.

» Mobile ads: Location extensions allow you to include a link to get directions to your business, and may
also show how far your customer is from your business location.

» Clicks on ads with location extensions will be charged the same cost-per-click (CPC) each time a

customer clicks any link in your ad.

If you have a brick-and-mortar business location, you'll want to make it easy for people to find and visit your
location, not just your website. Like handing someone a business card, location extensions in your ads allow you to
easily share your business address and phone number. Whether you have a single storefront or multiple ones,

location extensions can help attract customers who are interested in businesses in your area.

Example

Let's say you own a bicycle repair shop in downtown Tokyo. With location extensions, a customer
near your store who searches for bike repair can see your ad, along with directions to your business --

and can head to your shop with that flat tire.

How much location extensions cost

Clicks on ads with location extensions will be charged the same cost-per-click (CPC) each time a customer clicks

on any link in your ad.

Sites where location extensions can appear

Location extensions can appear on Google properties such as Google.com, Google Maps, and Search Network
partner sites. They can also appear with ads on m.google.com and the mobile Display Network when viewed on

high-end mobile devices using full Internet-enabled browsers, such as iPhones or Android devices.

Keep in mind that your ads' overall eligibility to appear on a device or network may be influenced by your budget,
targeting settings, Ad Rank, or ad approval status. Location extensions can appear if we detect that the customer
is located near your targeted location, or if we detect location-specific terms in her search, such as New York

coffee shop, that indicate interest in an area you've targeted.



Sites where location extensions can appear

Google Search Network: On the Google Search Network, ads with location extensions can appear as a
standard text ad with your business address and a clickable “Call” button that allows customers to

reach you by phone.

Google Search Network Partner Sites: On Google search partner sites, ads with location extensions
will vary in appearance for each site and also vary according to your network settings. Google search
partners may show versions that have your address information, including on a map. If a Google search
partner isn't able to display the additional address information, ads will appear without the location

extension.

Google Maps: Ads with location extensions are eligible to appear on Google Maps if you also opt in to
advertise with our search partners in your campaign network settings. Get more details on what ads

look like on Google Maps.

Mobile devices: On mobile devices with full Internet browsers, such as iPhones and Android phones,
text ads with location extensions can appear on the mobile Google Search and Display Networks as
well as Google Maps for mobile. The ads will appear with the option to Get Directions to your business
location.

Countries where location extensions are available

Location extensions are available for AdWords advertisers in the following countries:

Argentina
Australia
Austria
Belgium
Brazil
Bulgaria
Canada
Chile
China
Colombia
Croatia
Czech Republic

Denmark

Egypt



e Finland

e France

¢ Germany

¢ Hong Kong
¢ Hungary

e India

e lreland

e Israel

o [taly

e Japan

e Kenya

¢ Liechtenstein
¢ Malaysia

¢ Mexico

¢ Netherlands
¢ New Zealand
¢ Nigeria

¢ Norway

e Poland

e Portugal

¢ Romania

¢ Russia

e Saudi Arabia
¢ Singapore

e Slovakia

¢ South Africa
¢ South Korea
e Spain

e Sweden

e Switzerland
e Taiwan

e Thailand

e Ukraine

e United Arab Emirates
¢ United Kingdom
e United States

e Vietnam

Multiple ad extensions



You can add more than one type of extension to your ad, but keep in mind that some extensions, such as sitelinks,

may override your location extensions. In these instances, we won't show the location extension in your ad.

Also, if you’re using both location and offer extensions and you have a Google Places account linked to your
campaign, the locations from your Google Places account will show automatically on your offer’'s Google Offers
page.

Keep in mind

To add location extensions, you’ll need to use one of the following campaign types:

e “Search & Display Networks - Standard”

e “Search & Display Networks - All Features”
e “Search Network only - Standard”

e “Search Network only - All Features”

¢ “Display Network only - Mobile Apps”

e “Display Network only - All Features”

If you use a different campaign type from the ones listed above, location extensions won’t be available for your

campaign. Learn about AdWords campaign types.



Set up location extensions

» Attract potential customers in your area by adding your address, phone number, and map to your ads
with location extensions.

» Location extensions see a 10% higher clickthrough rate on average.

» Location extensions can also be effective in mobile ads, as two out of three smartphone users visit a
business after searching for local information on their phones.

traveling dog

Ad related to traveling dog (O
i lin - ial
www.travelingdog.net/ -

Looking for dog accessories?
¥ 5 Traveling Dog St., Bronx, NY - (000) 000-0000

To set up location extensions for a new or previously created campaign, you can choose to:

e Link a Google Places account to the campaign
¢ Add an address manually to the campaign
¢ Share an extension from another campaign

A Google Places account is only for business owners, but you don't need to have a Places account to use location
extensions within AdWords.

If you aren't a business owner (and so aren't eligible for a Places account), you can use AdWords Editor or the
AdWords API to enter your location extensions. You can also manually enter up to 100,000 business locations for
your location extensions instead...whew! Just make sure you have permission from the business owner to use their
business locations.



Create, edit, or delete location extensions

Keep in mind

To add location extensions, you’ll need to use one of the following campaign types:

e “Search & Display Networks - Standard”

e “Search & Display Networks - All Features”
e “Search Network only - Standard”

e “Search Network only - All Features”

e “Display Network only - Mobile Apps”

¢ “Display Network only - All Features”

If you use a different campaign type from the ones listed above, location extensions won’t be available for your

campaign. Learn about AdWords campaign types.

Click the relevant option below for detailed instructions:

= | Create a new campaign and add location extensions

Don’t see the option to create location extensions? This feature is accessible only for certain campaign
types.

1. Sign in to your AdWords account at https://adwords.google.com [ .
2. Click the Campaigns tab.
3. Click + Campaign.

Google AdWwords

4. Under Ad extensions > Locations, check the box next to "Extend my ads with location information."



5. Select one or both of the following options:

o Use addresses from a Google Places account: Choose this option to link an existing Google
Places account to your campaign.

o Use manually entered addresses: You can manually enter up to 100,000 business addresses.

6. Click Save and continue when you're ready to continue creating your campaign.

Add location extensions to an existing campaign

Don’t see the option to create location extensions? This feature is accessible only for certain campaign
types.

1. Sign in to your AdWords account at https://adwords.google.com [£ .
2. Click the Campaigns tab.

3. Click the name of the campaign you'd like to edit.

4

. Click the Ad Extensions tab. You'll see the current ad extensions status for your campaign.

Google Aditords




5. Select View: Location extensions from the drop-down menu above the extensions table.

Google AdWords s

6. Click + Extension under either of the following options:

o Use addresses from a Google Places account: Select this option to link an existing Google Places
account to your campaign.

o Use manually entered addresses: You can manually enter up to 100,000 business addresses.

7. Click Save when you're done.

Edit or delete an existing location extension

To change the linked Google Places account for an existing location extension, or edit a manually-entered
location extension, follow the steps below:

1. Sign in to your AdWords account at https://adwords.google.com [£ .
2. Click the Campaigns tab.

3. Click the name of the campaign that you'd like to edit.

4

. Click the Ad Extensions tab. You'll see the current location extensions status for your campaign.

Google Aditords




5. Select View: Location extensions from the drop-down menu above the extensions table.

Google AdWords s

6. To edit the extension, place your cursor over the Google Places account or location you want to change

and click when the pencil icon appears.

Google AdWords

All online campaigns

7. To delete an extension, check the box next to the Google Places account or location and click Delete
above the table.

Google AdWords Hea sonon

| Alloniine campaigns

Sharea orry

Shared extensions: Use existing location extensions from another campaign



Shared extensions allow you to use the same extensions across multiple campaigns, saving you the time
and effort of re-creating extensions one at a time per campaign. Keep in mind that whenever you edit the
shared extension, it'll be updated for all campaigns where it's being used.

Follow these steps to share an extension:

Sign in to your AdWords account at https://adwords.google.com £ .
Click the Campaigns tab.
Click the name of the campaign that you'd like to edit.
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Click the Ad Extensions tab. You will see the current ad extensions status for your campaign.

5. Click + Extension above the table.

Google AdWords r—

6. You'll be able to create a new extension or select an existing extension for this extension type from

within a new window. Select the extension you'd like your campaign to share.



Google AdWords

7. Click Save.

Click-to-call location extensions: Add a clickable phone number

With click-to-call location extensions, customers on high-end mobile devices with full Internet browsers can

click the phone number in your ad with a location extension to make a phone call to your business.
To set up click-to-call location extensions, follow these steps:

1. Create an ad with a location extension and your phone number.
2. Make sure you've opted-in to show your ads on iPhones and other mobile devices with full Internet

browsers. Check which devices you're advertising on from the Settings tab for your campaign.

Filters: Specify Google Places business addresses

While your Google Places account may contain all your business locations, you may sometimes want a
campaign to use only a limited number of addresses from that list. You can filter out locations with certain
business names or categories, so that only the filtered listings in your Google Places account will appear
with your AdWords ads for that campaign.

Example

Let's say you own two restaurants: Bob's Barbecue and Bob's Sushi. You'd like to run a
campaign solely for your barbecue restaurant. To do this, you create a filter and include only the

restaurant where the Business Name equals "Bob's Barbecue."



Set up your filter
To create a filter for your location extensions, follow these steps:

1. Sign in to your AdWords account at https://adwords.google.com [ .
2. Click the Campaigns tab.

3. Click the name of the campaign you'd like to edit.

4

. Click the Ad Extensions tab. You'll see the current location extensions status for your campaign.

Google Adiord

5. Select View: Location extensions from the drop-down menu above the extensions table.
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6. Place your cursor over the extension associated with the Google Places account you want to filter and
click the pencil icon that appears.

Google AdWords
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7. Click the Filter checkbox to set your filter.

Google Adwords s

8. Select your filter settings from the pull-down menus. You can set multiple restrictions within a single
filter. Filters will only work if you've entered information that exactly matches the category you've
chosen. For example, if you enter a restriction for the business name "Bob's Barbecue," you won't filter

out businesses with the name "Bob's Texas Barbecue."

Google AdWords

9. To add more restrictions, click Add Another. To delete a restriction, click Remove.
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10. Click Save when you're done.

Viewing locations that match your filter

After you create a location extensions filter, AdWords will synchronize with your Google Places account, and
retrieve the matching addresses. Wait a few hours, then follow these steps to see what addresses were
matched for that campaign:

1. Click View: Location extensions from the Ad Extensions tab.
2. Expand the link under "Addresses from Google Places."

3. The filter will be listed for the campaign with which it was associated.

Icons: Add a custom icon to your location extension on Google Maps

When you create a location extension, a default icon will be provided for the map marker that appears along
with your ad on Google Maps. You can select another default icon, or you can choose from one of your own
uploaded images.

Sign into your account at https://adwords.google.com 4 .
Click the Campaigns tab.

Click the name of the campaign you'd like to edit.
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Click the Ad Extensions tab. You'll see the current location extensions status for your campaign.



& Campaign: Campaign #1

Select View: Location extensions from the drop-down menu above the extensions table.

Google Adiords

. To edit the extension, place your cursor over the Google Places account or location you want to change
and click when the pencil icon appears.

In the Map Icon section, choose from the following options: Choose another, Upload new, or Use
default.



8. Click Save when you're done.



Tips for setting up location extensions

Now that you're familiar with what location extensions are and how to set them up, we've outlined some
tips below to help you:

e Improve your keywords and ad text
« Decide when to use campaign-level or ad-level location extensions
« Measure your location extensions performance

Keywords and ad text

As with any AdWords ad, the more relevant your keywords and ad text are, the more targeted your ad will be to
customers who may be interested in your business or service. Consider these tips when creating ads with location

extensions:

¢ Broad and phrase match keywords: Your customers might include names of locations along with their
keywords to find businesses in your area. Putting your keywords on broad and phrase match can help match

the keywords to searches that include names of your location, such as your city or region.

Example

John owns a pizzeria in New York. To attract customers searching for restaurants in his
neighborhood, he adds the phrase match keyword "pizza restaurant." When customers search for
"pizza restaurant New York," his phrase match keyword "pizza restaurant" is matched to their
search and his ads can appear.

¢ Local names in keywords: Is your business in a neighborhood or district with a distinctive name? Try
including keywords with these "local" neighborhood names on exact match to be more relevant to your

customers' searches.

Example

John's pizzeria is in the Broadway theater district in New York. To attract customers searching
specifically for restaurants in the Broadway theater district, he adds the exact match keyword

"broadway district pizza" to his keyword list.



¢ Write ad text with your your location extension in mind: Ads with location extensions may appear with a
business address or on a map, which you can emphasize in your ad text. You can also create ads to attract
mobile phone users, who may already be located near your place of business or who are looking to satisfy an

immediate need.

Example

John is using location extensions in his pizzeria ad, and his ad appears with a map that shows his
business location. To highlight how accessible his pizzeria is for those visiting the Broadway
district, he includes the text "Conveniently located near Broadway theaters".

Campaign-level and ad-level location extensions

Location extensions are set at the campaign level by default, but they can also be set at the ad level. You can also
use a combination of both. Compare campaign-level and ad-level location extensions in the section below to see

what works best for your business.

— | Compare campaign-level and ad-level location extensions

Campaign-level location extensions

Campaign-level extensions are ideal if you want to use the same ad settings for the entire campaign. With
campaign-level location extensions, you'll allow Google to automatically match any text ad in your campaign
with the most relevant address in your account, based on where your customer is located or the location that
she's interested in.

In addition, if a customer's search matches one of your keywords, but the customer isn't located in or
interested in a location near one of your business addresses, your ad can still appear without a location

extension. This allows your ad to appear more frequently.
Campaign-level location extensions may be a good fit if:

¢ You want to run the same exact ad text for all your business locations.
¢ You want to use the same landing page for all your business locations.

¢ You want to save time and avoid managing individual pairs of ads and addresses.

Example

Jenna's Pet Store is offering 15% off at all of her pet store locations. Jenna creates a 15% off
promo ad with a campaign-level location extension in a campaign that includes all of her

business locations. Her ad can now appear for any of the locations in her campaign.



Ad-level location extensions

Ad-level location extensions allow you to use different ad settings for each of your business locations in one
campaign. Ad-level extensions allow you to associate a single address with a single ad, which overrides the

campaign-level location extension settings.

You can set up an ad-level location extension for a specific ad if you have already added a campaign-level
location extension to the campaign. When you set up an ad-level location extension, you'll be able to choose
from the locations added at the campaign level.

Your campaign-level location extensions will still be eligible to appear for any ads that don't have ad-level
location extensions.

If your ad has an ad-level location extension, the ad will be targeted to customers within 20 miles of your
business address as well as to customers searching for your keywords and indicating interest in your
business's area. You can also adjust the size of the radius when you create or edit the ad-level location
extension. Your ad won't appear for customer searches that don't match your targeted geographic location,
and the ad won't appear on its own without the location extension.

We recommend that you use ad-level location extensions sparingly, since it can be time-consuming to
manage a large number of them and they aren't supported in our bulk editing tool, AdWords Editor. You

may also see a lower number of impressions for ads with ad-level location extensions.
Ad-level location extensions may be a good fit if:

¢ You want to associate a particular business location with a specific promo or marketing message.

¢ You want to direct each of your ads to a different landing page specific to the business's location.

Example

Mark owns a chain of local grocery stores in Oregon, and he has a different webpage for each
store with store hours and special in-store offerings. Mark uses ad-level location extensions to
direct each of his ads in his campaign to a particular location.

= | Set up ad-level location extensions

To set an address for a specific ad that's different than the addresses you're using at the campaign level,
follow these steps:

1. Sign in to your AdWords account at https://adwords.google.com [£.
2. Navigate to the ad group you want to edit.
3. Click the Ads tab.



4. Click the edit icon next to the ad you want to edit.

5. Click Always show with one address.

Google Adviords

6. Select an address from the list. The addresses available are all eligible to appear for any ad within the

same campaign.

Remove ad-level location extensions

Unlike campaign-level location extensions, unlinking your Places account won't affect any ad-level location

extensions that you might have. To remove an ad-level location extension, follow these steps:

1. First, make sure that you've unlinked your Places account and that you don't have any manually added
addresses in the campaign.
2. Click the pencil icon to edit the ad.

3. Click Use all addresses from campaign.

Google AdWords

4. Click Save.



Review location extensions performance

To review your location extensions performance, click the Ad extensions tab in AdWords. You'll be able to see
how many customers saw the particular address highlighted with a location, and the associated statistics for those
ad views, including click through rate (CTR). Since location extensions help you connect customer's searches with
your physical business, these statistics can help you identify which online searches may be leading to in-store

conversions.

When viewing location extensions metrics, remember that customer behavior in different regions can sometimes
affect your overall ad performance. For example, if customers in Utah are more likely than customers in Florida to
click on links for the Sally's Coffee Shop chain, Sally can expect her ads with addresses in Utah to have a higher
CTR than her ads with addresses in Florida. To see detailed information on where your clicks are coming from,

check out the geographic performance report.

Keep in mind

To add location extensions, you’ll need to use one of the following campaign types:

e “Search & Display Networks - Standard”

e “Search & Display Networks - All Features”
e “Search Network only - Standard”

e “Search Network only - All Features”

e “Display Network only - Mobile Apps”

e “Display Network only - All Features”

If you use a different campaign type from the ones listed above, location extensions won'’t be available for your

campaign. Learn about AdWords campaign types.



Enhance your ad using extensions

e Learn how ad extensions can give customers more reasons to click your ad

Choose the best type of ad extension to meet your business goals
» Get the most value from extensions by understanding pricing, bidding, and targeting options
» Set up your first extension for a campaign or share extensions across campaigns

Video: Examples of ad

extensions

See how a business like Main Street Flowers uses sitelinks, call, offer, and location extensions to enhance its ads.
By adding extra pieces of information about the business to their ads, they're giving customers more reasons to

click.

Giving customers more reasons to click your ad

By including additional business information with your ad, such as your address and phone number, more website
page links, or a special offer, ad extensions offer customers even more reasons to click your ad. Ad extensions
appear with your ad on Google, and in some cases across the Google Display Network. There’s no cost to add
extensions to your campaign but, as always, you’re charged for clicks on your ad, as well as certain user

interactions with ad extensions, such as clicking the call button.

Most ads with extensions appear above search results. This placement often has higher costs-per-click (CPCs)

than CPCs for ads that appear beside search results.

Most ad extensions are created at the campaign level. You can set up extensions while creating your campaign for
the first time, or create new ones within an existing campaign. Certain types of extensions are upgraded with
additional features, for instance, the ability to be created at the ad group level, or to show on your ads without any

setup.



Choosing an ad extension type

Pick an extension based on what action you'd like people on the web to take when they see your ad, and what

type of information you'd like to promote.

SuA

T} Example

Let's say you own a bicycle repair shop in Tokyo and Rie, a customer riding a bicycle near your store,
gets a flat tire. When she searches for "bicycle repair" on her mobile phone, she'll see your ad with a
location extension and phone number. She can click the phone number to call you right away for help,

or click your address to find her way to your location.

Here are the ad extensions you can use to give customers more information about your business:

Location extensions

Help nearby consumers find or call your nearest storefront. Learn more

Traveling Dog- Offcal Site
i avel




Call extensions

Connect users to your business directly by phone. Learn more

Compare Insurance Quotes
www_example com/compare

Save time & money. Compare
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Sitelinks

Promote more pages within your site beyond your main ad landing page. Learn more

Example Pizza Store
www.example.com Get Your Favonte Pizzas! Only At Your Pizza Store

QOrder Online Now Store Locator
Deals in Vour Area  Returning Customer? Order Here

Social annotations

Show how many Google+ page followers your business has on your ads. Learn more

Hotels in Vienna Austria - Hotels up to 50% off
www_example.com/Vienna_Hotels

Save on Hotels in Vienna, Austria

Example.com has 432 880 followers on Google+

Seller ratings

Show your online business ratings in your ad. Learn more



Tia's Ice Cream Store
www.example.com - % dr e 10,159 seller reviews
Delicious ice cream made with the best local ingredients

App extensions

Show a link to your mobile or tablet app right below your ad. Learn more

Example Bank
www.example.com/

Bank where and when you want with
our free Example Bank app.

Download Android App Here

Offer extensions

Promote in-store coupons with your online ads. Learn more

Dfficial Google Lava Lamps
www_googlestore com/lavalamps

Direct from the Googleplex. Free Shipping!
Wiew offer - $10 Off Lava Lamps

= Automatic offer extensions: Promote deals mentioned in your ad text

For some advertisers, you might see that your ad's been enhanced with an automatic offer extension, a link
that's labeled "View this ad's deal." We'll automatically add this link to your ad, allowing you to promote a
deal that's mentioned in your ad text with a link to your landing page and giving customers another reason to
click your ad.

When you create an ad, the AdWords system will scan the ad text to see if there are any terms associated
with deals or special promotions. If your ad includes such terms, then we'll review your ad's text and
destination URL to make sure your advertised deal is available on your landing page and complies with our
policies. If your deal is eligible to appear, we'll show the "View this ad's deal" link below your ad text. Keep
in mind that the link will take customers to the same landing page that's used in your ad's destination URL
or keyword's destination URL.



Example
% p
Let's say you sell stuffed animals and create an ad promoting free delivery on your giant stuffed
bears. When customers search for giant stuffed bears, we might show them the following ad:
Ad related to giant stuffed bears ®
Giant Stuffed Bears | Free Delivery! q
www.example.com/ -
Life-size St;:lﬂud Bears - Handmade Plush Stuffed Animals
View this ad's deal - valid as of Oct 5, 2012
Notes

e Since we use the text and destination URL that you provide to show automatic offer extensions, you're
in control of whether automatic offer extensions are shown with your ad or whether they're shown at all.

¢ Automatic offer extensions are limited to English-language ads only. For example, this means that if your
ad is written in English and targets English-speaking customers in Japan, your ad is eligible to show
automatic offer extensions.

When your ads might appear with automatic offer extensions

In addition to reviewing your ad text to determine that your ads are eligible to appear with automatic offer
extensions, there are other criteria that you must meet for your ad to be eligible to appear with this feature.

Here are the criteria:

¢ Your campaign must be opted into the Google Search Network
¢ Your campaign must target desktop computers

¢ Your ad must be eligible to appear in one of the positions above Google search results

If you want to opt out of automatic offer extensions, you can let us know via this form £ . If you change your

mind, you can always opt back in using the same form.
How automatic offer extensions work with other ad extensions

If your ad is using an ad extension and your ad is also eligible to show automatic offer extensions, then we'll
show that ad extension instead of automatic offer extensions. For example, if your giant stuffed bears ad is
eligible to appear with your sitelink ad extension and it's also eligible to appear with automatic offer

extensions, then we'll show your sitelinks with your ad.

Keep in mind

The following ad extensions are available globally:



¢ Sitelinks
¢ Call extensions that don’t use a Google forwarding number

e Social annotations

To find out if other extensions are available in your location, visit the article for that extension, linked to above.

Understanding your costs

You can add any or all of this extra information to your ads at no extra cost. Yes, free! AdWords only charges you
for each click within the ad and its extensions, up to two clicks per impression.

We'll charge you the same amount each time a customer clicks any link on your ad, regardless of whether the link
clicked is the headline of your ad or the link promoting your deal. You can decide the maximum amount you'd like

to pay for a click by setting a cost-per-click (CPC) bid.

Ad extensions offer more opportunities for your customers to click on and within your ad, but you won’t be charged
for more than two clicks per ad impression. Clicks on some extensions (social and seller rating extensions) aren’t

charged at all and Adwords has processes in place to filter out any duplicate or invalid clicks that we detect.

Understanding your bidding and targeting options

You can choose to show your ads on the Google Search and Display Networks. Most ad extensions can only
appear on Google.com and some Google Search Network sites, such as Google Maps (for location extensions), so

when you set up your campaign you'll need to set a cost-per-click (CPC) bid.

Creating an ad extension

While you can create any ad extension following the general steps described in this article, each ad extension has
its own unique set up, reporting, and best practices. Visit the article for the extension you’d like to create to learn

more (links for each extension are available above).

Keep in mind

Don't see the extension you're looking for? Some extensions are available only for certain campaign types that
have “All features” enabled. You can switch your campaign to "All features" at any time. Keep in mind that

doing so may hide or deactivate some features that affect ad serving

Certain types of extensions, such as social annotations and automatic offer extensions, are created

automatically and don’t require the steps below to manage them.

Creating the first extension in a campaign

Here's how to create the first extension in a campaign using the campaign creation page:



1. Sign in to your AdWords account at https://adwords.google.com £

2. On the Campaigns tab, click the New campaign button and select the type of campaign you'd like to create.

3. You'll be taken to the Settings tab of your new campaign.

4. Under Ad extensions, check the box next to the ad extension type you'd like to add to your new campaign.

o If you've already created an ad extension in another campaign in your account, you can choose to use that
existing extension (this is known as shared extensions). This saves you the time and effort of manually

creating the same extension for a new campaign.

Using a shared extension

When you create a new extension during campaign setup, or later when you add an extension to an existing

campaign, you'll be offered the option to skip some extra steps by using an existing extension. You can also share



multiple types of extensions. For example, if you have call and offer extensions in one campaign, you can share

extensions for both types in a new campaign.

— | See an example: Adding an existing location extension setting to a new campaign.
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¢ Editing shared extensions: When you edit a shared extension, the change will apply across all the campaigns
that share the extensions. If you only want to change one extension for one of the shared campaigns, you
should create a new and separate extension.

¢ Deleting shared extensions: If you have at least one campaign remaining with the extension, deleting the
extensions from other campaigns will simply mean that those campaigns will not be sharing extensions. If you
have only one campaign with the extension and delete the extension, this change is permanent and your
extension settings will not be saved.

+ Using filters for shared location extensions: Filters are included as part of this extension type.



Example

Let's say you create a location extension for Campaign "Men's Shoe Sale" linking to a Google

Places account, and share it with another Campaign "Women's Shoe Sale."

The Google Places account has information of two brands of shops, HappyShoes and
SunnyShoes, and only HappyShoes are having a sale. If you create a filter for "Men's Shoe Sale"
so that your ads will be accompanied only by the addresses of HappyShoes, "Women's Shoe

Sale" will be updated to use the same filter.

¢ Location extensions -- sharing manual addresses: With location extensions, you can either attach a Google
Places feed or manually enter addresses. These manual addresses are also shareable among campaigns.
However, there's currently no way to define a set of manual addresses and share this set among campaigns.
You can share more than one manual address across a campaign, but you'll need to do this one at a time for

each manual address.



Show ads with your Google+ page
endorsements

Google+ makes it easy for people to share web content. When your Google+ page and your ads are
linked, Google can show endorsements for your business from your Google+ followers. These are called
annotations. If you're not already familiar it, check out Google+ for business now.

In enhanced campaigns, your ads can automatically show social annotations - no setup or management
necessary. To show social annotations on non-enhanced campaigns, you can manually set up social
extensions in each campaign.

Here's what's needed for your ad to be eligible to show social annotations:

e Your Google+ page has to have a verified URL.

e The domain of your Google+ page URL has to match the domain of your ad's URL.

« Your Google+ page needs to have recent, high-quality posts and a significant number of followers,
meaning 100 for most businesses.

How social annotations work

AdWords ads that appear on Google and some search partners are eligible to show social annotations when our
system detects an active and verified Google+ page. These annotations will be shown when our system predicts
that they will improve campaign performance. Here's what they look like.

Hotels in Vienna Austria - Hotels up to 50% off
www_example.com/Vienna_Hotels

Save on Hotels in Vienna, Austria

Example.com has 432 880 followers on Google+

Example

You own a restaurant and create a Google+ page for your business. You also create an AdWords
campaign with some ads. When 100 people follow your restaurant's Google+ page, your ads show a

social annotation that says your page has 100 followers.



How social annotations work with AdWords features
Here's how social annotations work with other aspects of your ad campaigns:

¢ Pricing: You'll be charged for standard clicks on your text ads when users click the ad to visit your site. You
won't be charged when a person clicks a +1 button or a link to your Google+ page.

¢ Network: Annotations for ads appear across all AdWords ad formats, on Google and some search partners.
Annotations may not always appear with your ads, but in non-upgraded campaigns, they're more likely to
appear when you use social extensions and connect your Google+ page to your campaigns.

¢ Reporting: Specific reporting on social annotations isn't available, except some limited reporting for manual
social extensions on non-enhanced campaigns.

« Compatibility with other ad tools: Social annotations are automatic for all enhanced campaigns. For non-
enhanced campaigns, social extensions can be added using AdWords only, not AdWords Editor or the
AdWords API.

Advertising guidelines

Please be sure to follow the standard advertising policies [4, including the social interaction incentives policies £

outlined within the AdWords Policy Center. Certain business types aren't eligible to show social annotations.

Add social annotations to an enhanced campaign

When you have an enhanced campaign, social annotations can show automatically with its ads. No setup or
management needed! However, there are a few requirements for your ads to be eligible to show these automatic

annotations:

¢ Your Google+ page has to be linked to your website.
Follow these instructions to link your Google+ page and your website [ if they aren't already linked. This will
allow social annotations to appear, and it'll also help your Google+ page and website be discovered in Google
search.

¢ The domain of your ad's display URL has to match the website URL you've added to your Google+ page.

o For example, George's ad that has a display URL of happysnacks.com/low-carb will match with a
Google+ page that displays the website URL of happysnacks.com because they share the same domain.

o If you have the same site with different top-level or second-level domains for different countries, contact
us and ask us to match these. For example, your ads lead to google.fr and google.co.uk, but your Google+

page displays the URL google.com

¢ Your Google+ page needs to have recent, high-quality posts and a significant number of followers, meaning a

minimum of 100 for most companies.
Keep in mind

¢ Social annotations may not show all the time on your ads. Whether or not they show depends on several



things, including the size of the browser window and what other extensions are showing with your ad.
¢ You can opt out of showing social annotations on the ads associated with your Google+ page by using this
form or contacting us.

— | How to set up a social extension in a non-enhanced campaign

To show social annotations on an existing non-upgraded campaign, manually set up a social extension. All

the requirements for social annotations on enhanced campaigns also apply to manual social extensions.

Sign in to your AdWords account at https://adwords.google.com [ .

Click the Campaigns tab.

Navigate to an existing, non-upgraded campaign.

Go to the Ad extensions tab.

Select the "View: Social Extensions" option from the "View" dropdown menu.

Click the + New extension button.

N o o s~ Db =

Enter the URL of your Google+ page. Ensure you enter the URL correctly - it’'s a common mistake to
enter the URL of your Google+ profile instead of your Google+ page. See the “How to enter your
Google+ page URL” section for details.

| Examples

o URL with a number ID: https://plus.google.com/1234567890
o URL with a brand ID: https://google.com/+GoogleBusiness

8. Click Save and continue.

Keep in mind that the "Ads" tab will not show social extensions beneath the thumbnail preview of your ads.

How to enter your Google+ page URL
How to find the right URL

Sign in to your Google+ account at http://profiles.google.com/me £ .
Choose Pages from the side menu (Pages may also be listed under More).

Select the Google+ page you want.

A on =

Copy the URL in your browser's address bar. This is the Google+ page URL you want to enter when you
set up a social extension.

It's a common mistake to enter the URL of your Google+ profile instead of your Google+ page. Be sure to
check that you're on your Google+ page when you copy the URL. If someone else owns the Google+ page,

like a colleague or client who has given you permission to use the page, browse to this page and copy the



URL.

How to format the URL

Format your Google+ page URL like the one below, with just the domain (green) and number or brand ID

(grey):
https://plus.google.com/1234567890

Remove any extraneous characters like "/" or "/about."



Link Google Places and AdWords

If you have a Google Places account for your business, you can link your Places and AdWords accounts. Linking these accounts lets you include your
business address with your AdWords ads so you can attract more customers -- especially those who are close by and searching for what you're
offering.

Here's an example of an ad enhanced with Google Places information:

Rokok:
1234 Wloert Ave, San Francisco, CA 94100 - 415) 555-1212 o e
Auihenic French Cafe Wi In-Housa Roaster And Baked Goods

Steps to link a Google Places account with AdWords
If you have a Google Places account, you can link it to your AdWords account:

1. Sign in to your AdWords account at https://adwords.google.com.
2. Click the Campaigns tab.

3. If you see the Ad extensions tab in the "All online campaigns" section, click on it. If you don't see the tab, click the triangle, check the box next to "Ad
extensions" and click OK. Then, click the Ad extensions tab.

4. Click the "View" drop-down menu and select "Location Extensions".
5. Click "Addresses from Google Places".
6. Click New extension.

7. In the "Select a campaign" section, choose the ad campaign you'd like to link to your Google Places account.

Gl bttt



8. Check that the email shown in the "Add Google Places account” section is the one you'd like to link to this campaign. If it isn't, click Use a different

account.

9. If you only want to link some addresses in your Places account to be associated with this campaign, check the box next to "Filter," then select how you'd
like to define which addresses to include. You can add multiple conditions by clicking + Add another. For example, you could create filters for a specific
business name in a region to only show one set of your stores.

10. Click Save.

You can repeat this process to link more ad campaigns to this or another Google Places account.



Benefits of using Google Places

Reach millions of Google users, quickly and for free, with Google Places

More people search for businesses online than anywhere else, so it's important to make sure your local business listing can be easily found on Google.com and
Google Maps. With Google Places, creating a great listing takes just a few minutes and doesn't cost a thing.

Edit your listing and speak for yourself

Your business probably already shows up on Google, but you should still verify your listing and make sure its details are accurate and thorough. Your
improvements will start appearing soon after you verify them through Google Places. Also, you can add notifications

Practical and easy to manage

Your Google local business listing is an easy way to maintain an online presence even if you don’t have a website. You can visit Google Places anytime to edit
your information or see how many people have seen and clicked on your listing.

Premium options, all for free

Make your listing really shine with photos and videos; custom categories like your service area, brands you sell and how to find parking; and coupons to
encourage customers to make a first-time or repeat purchase.

Create your listing today using Google Places by following the walkthrough below.
Signing up for Google Places is simple
If you own a business, you probably know the basics. You can add extras like photos and descriptions if you have them handy, or come back to add them later.

At the end of the sign-up, we'll ask you to verify your submission by phone or postcard. We do this to make sure that only the right people are able to change
any public data about your business.

Okay, let's learn more about getting started on Google Places!



Add phone numbers to your ads

If you'd like to encourage your customers to call your business, call extensions (also known as click to
call on mobile devices) allow you to add a phone number to your ad, making it easy for customers to call
you directly. Call extensions also provide you with detailed reporting on the calls you receive from your
ads.

Call extensions have different features depending on what type of device they're showing on:

¢ On high-end mobile devices (such as iPhones and Android devices with full Internet browsers): Your ad will
include a clickable "Call" button, shown to customers who see your ad on Google.com search, Voice search,
Google Mobile App, or Google Maps for Mobile.

¢ On desktop or laptop computers and tablets: Your ad will appear with a phone number, even if the call

extension does not use a forwarding number.

When a customer clicks the phone number on a mobile device that's capable of making a phone call, you'll be
charged the same as for a standard click on the ad. Note that your call extension will be shown only on devices

that allow a user to click and call (and, for example, will not show on iPod Touch devices).

Keep in mind that when you add a call extension to a campaign, it applies to all of your ads within that campaign.

Example

You own a pizzeria in downtown Chicago. With call extensions, a customer who searches for pizza on
her mobile phone can click a button right next to your ad and call right away to order a couple of large

pepperoni pizzas.
Benefits of call extensions

Here are a few benefits of using call extensions:

¢ Measure phone call conversions: Help understand the effectiveness of your ads by tracking how many calls
you receive that last longer than the duration you specify. We highly encourage you to use this feature if you
value call traffic.

¢ Free calls with Google forwarding numbers: There's no charge for using Google forward numbers on mobile,



desktop, and tablet devices.

¢ Customized for different devices: You can create mobile-optimized call extensions to show on mobile
devices, or disable specific call extensions on the devices you choose.

+ Better extension reporting: See how many clicks you receive on each part of your ad when a call extension
appeared, such as clicks to your ad's headline compared to clicks on the call extension. Break these statistics
down by campaign, ad group, or ad.

¢ Flexibility: Call extensions can be added to ad groups as well as campaigns.

¢ In-place editing: Edit your call extension without resetting its performance statistics.

¢ Start/end dates and scheduling: Specify what dates, days of the week, or times of day when your call
extension should appear.

Note

You can use call extensions for campaigns targeting the Display Network. Here are a few things to keep in
mind:

¢ Call extensions targeting the Display Network will only show on high-end mobile phones, not on desktops,
laptops, or tablets. These extensions do not support the use of Google forwarding numbers or the tracking of
calls as conversions.

¢ On the Display Network, call extensions can be set to show as clickable numbers or links, as well as the call-

only format.

Follow steps in your account

Want to add a clickable call button to your mobile ads, or a phone
number to your desktop and tablet ads? Click this link to go to your
account and take a guided, step-by-step tour of how to add call

extensions.

Or, you can read the instructions below.

= How to add call extensions

Here's how to set up call extensions for all ads in the campaign or ad group that you choose:



Sign in to your AdWords account at https://adwords.google.com £ .
Select the campaign or ad group for which you'd like to add call extensions.

Go to the Ad extensions tab. If you can't see this tab, read how to enable the tab.

w0~

In the upper corner, select View: Call Extensions from the drop-down menu.

Google AdWord

5. Next to "Call extension setting," click Edit.

6. In the form that appears, you'll see a picker with phone numbers that you previously set up. You can
either select one of these extensions or create a new one by clicking the +New phone number button.
The following steps will walk you through how to add a new extension.

7. Enter your business phone number and the country where the number is based.

8. In certain countries, you can choose which type of phone number you'll use for your call extension: a
Google forwarding phone number or your own business phone number.

9. Choose whether you'd like your ad to include both your phone number and your website, or just your
phone number. This option affects only mobile devices; on tablets and desktop or laptop computers,
the website and phone number could still appear together.

10. Specify how long a call should be for it to be reported as a conversion. Calls longer than the duration
you specified will be reported as a conversion in the "Phone call conv." column in the Campaigns and
Ad groups tab (under the Conversions menu).

11. You can select this phone number as the preferred extension to show on mobile devices. To do this,
check the box for "Mobile" next to "Device preference."

12. If you'd like to limit when the phone number should be eligible to appear in your ad (such as on specific
days of the week or times of the day), click Start/end dates, scheduling and select the desired timing.

13. Click Save.

Customize call extensions for mobile devices

Extensions show on all devices by default, but there are two ways you can customize call extensions for



mobile and desktop and tablet devices:

¢ You can create mobile-specific phone numbers. For example, if you want people who see your mobile
ad to call a different phone number than those who see your ad on a desktop computer, just add your
mobile-preferred phone number and check the “Mobile” box next to “Device preference” in the “New
phone number” window.

¢ You can limit which devices your phone numbers appear on at the campaign or ad group level. For
example, if you want the phone numbers for a specific campaign to appear only on desktops and
tablets, just edit the “Call extension setting” at the campaign level and select “Desktop and tablet

devices only” next to “Show this extension on.”
Here's how to create mobile-specific phone numbers:

Choose the campaign that has the phone numbers you'd like to edit.
Click the Ad extensions tab.

On the View drop-down menu, choose Call extensions.

Go to the Call extension setting section and click Edit.

You'll see a list of all the phone numbers in this campaign.

Find the phone numbers you want to customize and click the arrow on the right to select.
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On the phone numbers you selected, click the down arrow that appears next to the pencil icon, and

choose Edit.

©

In the form that appears, choose Mobile next to Device preference.
9. Change the phone numbers as needed to optimize for mobile.
10. Click Save.

Tip

You can choose to drive calls only (and not your ad headline, for example) when your ad shows
on mobile devices. Select Just the phone number next to "Show the following links."
However, when your ad appears on other devices, you may still receive headline clicks from
devices like desktops, laptops, tablets, or iPod Touches, which can't place phone calls. On
these devices, users will be directed to the destination URL in the ad. Clicks on your ad’s call

extension or its headline will be charged the same CPC price.

Note

¢ Phone numbers with the device preference set to mobile will be given preference over standard call
extensions on mobile devices.

e Standard call extensions will be given preference over mobile-optimized call extensions of the same
type on desktop and laptop computers.

¢ [f a campaign or ad group has only mobile-optimized call extensions, these may show on desktop and



laptop computers. To avoid this, we recommend having standard call extensions of the same type as

the mobile-optimized call extensions in your campaign.

Tips

¢ You can add up to 20 call extensions to each campaign or ad group.
e If you're in the U.S., U.K., France, or Germany, you can use call extensions with Google forwarding
phone numbers. Find out how to add call extensions with forwarding numbers.

Getting information about your calls

You can get reports on the performance of your ads with call extensions for each ad group and campaign.
For mobile devices, see the number of clicks on the "Call" button. In addition, if you're using Google

forwarding numbers, you can also see the number of valid calls that connected.

Note

When your call extensions are upgraded starting September 23, 2013, the stats will be reset. However,
the historical performance for your legacy extensions will be available until October 23, 2013. If you

would like to retain this historical data, please do so before October 23.

Learn how to view historical data for deleted and/or legacy extensions.

Here's how you can review how many calls you've received for each ad group or campaign:

1. On the Campaigns or Ad Groups tab on the Campaigns page, click the Segment button above the
statistics table.

2. Select Click Type to see which clicks resulted in visits to your website or phone calls.

3. Use "Mobile clicks-to-call" to view how many clicks you received on the phone number in your ads.

4. If you're using Google forwarding numbers, you can also choose to see additional statistics columns to
find out how many calls were connected. Click the Columns button above the statistics table on the
Campaigns or Ad Groups tab, select "Customize columns," and add columns from the "Call details"
category.

Remember that for mobile devices, a click to call is reported as soon as the customer clicks to call your

phone number, regardless of whether or not the call is completed.



—  Using call extensions with location extensions

Call extensions and location extensions can work together or independently. Both features let you add a
phone number to your text ad so customers can more easily reach you. If you're using location extensions
and have also included a phone number in your location extension, your ad can be shown with a "Call"

button as well as a "Get Directions" link.

Example
Let's say you own a chain of restaurants with thousands of locations across the country. To
connect to hungry customers, you can let customers connect with you by phone or see directions

to one of your restaurant locations, and direct those customers to the one nearest to them.

Keep in mind that non-standard cost numbers are available for phone extensions, but not for location
extensions. By "non-standard cost numbers," we usually mean phone numbers that may not be included in

a typical customer's phone plan and for which a call may incur additional charges.

If you have location extensions and call extensions enabled for the same ad, nearby customers will see a
link to the address of your business as listed in the location extension, and the clickable "Call" button will

connect people to the phone number as listed in the call extension.

Tip
For the best mix of local targeting and broader reach, we suggest enabling both location extensions
and call extensions on your ads. Call extensions are most appropriate if you have a national

service center, or if your business isn't tied to a specific physical location.

= How phone numbers work with call extensions

Call extensions can be used with toll-free, standard, mobile, shared-cost, or non-standard cost numbers.
Here are a few things to keep in mind:

e Shared cost phone numbers use a billing method where calls to a particular international phone
number are partially (but not entirely) paid for by the recipient. If you use one of these numbers for your
click to call ad, a disclaimer will appear stating that additional charges may apply.

¢ Non-standard cost numbers are phone numbers that may not be included in a typical customer's
phone plan and for which additional charges may apply. Since the ads don't mention cost-per-minute
charges and because operator rates for these numbers can vary, we'll include a short disclaimer in the

ad text that says "Additional charges may apply" whenever a non-standard cost number is shown in an



ad. The disclaimer will only be shown for non-standard cost numbers, but not for other types of

numbers that appear in click to call ads such as toll-free, standard, or mobile numbers.

Call extensions in Brazil

To enable call extensions in Brazil, make sure you include a carrier code for the carrier of your choice. For
example, instead of "11 5555-1234" use "0XX11 5555 1234" (where "XX" stands for the carrier code). For
toll-free or premium numbers such as 4004 or 0800, no carrier codes are necessary.

See non-standard cost numbers by country

Depending on the country you're in, different non-standard cost numbers may be available for you to use

with call extensions.

Country Non-standard cost numbers

Name

UAE 07000, 07005

Albania 0808

Algeria 0801 10, 0801 11, 0801 12, 0801 13, 0801 14, 0801 15, 0801 16, 0801 17, 0801 18,

0801 19, 0802 10, 0802 11, 0802 12, 0802 13, 0802 14, 0802 15, 0802 16, 0802 17,
0802 18, 0802 19

Armenia 0801, 0802, 0803, 0804
Austria 0810, 0820, 0821, 0828
Bosnia and 082

Herzegovina

Brazil 3003, 4000, 4001, 4002, 4003, 4004, 4005, 4006, 4007, 4008, 4009



Czech
Republic

France

Germany

Great Britain

Greece

Ireland

Israel

Jordan

Lebanon

Liechtenstein

Macedonia

Netherlands

810, 811, 812, 813, 814, 815, 816, 817, 818, 819, 830, 831, 832, 833, 834, 835, 836,
837, 838, 839, 840, 841, 842, 843, 844, 845, 846, 847, 848, 849

0810, 0811, 0819, 0820, 0821, 0825, 0826, 0884, 0890

0180

0843, 0844, 0845, 0870

801, 806, 812, 825

1850, 1890

1-700, 1-809

0810, 0850, 0851, 0852, 0853, 0854, 0855, 0856, 0857, 0858, 0859, 0870, 0871, 0872,
0873, 0874, 0875, 0876, 0877, 0878, 0879

090, 091

900 22, 900 27, 900 28, 900 79, 901 23, 906 66, 0900, 0901, 0906

0801, 0802, 0803, 0804, 0805, 0806, 0807, 0808, 0809, 0810, 0811, 0812, 0813, 0814
0815, 0816, 0817, 0818, 0819, 0820, 0821, 0822, 0823, 0824, 0825, 0826, 0827, 0828,
0829, 0830, 0831, 0832, 0833, 0834, 0835, 0836, 0837, 0838, 0839, 0840, 0841, 0842,
0843, 0844, 0845, 0846, 0847, 0848, 0849, 0850, 0851, 0852, 0853, 0854, 0855, 0856,
0857, 0858, 0859, 0860, 0861, 0862, 0863, 0864, 0865, 0866, 0867, 0868, 0869, 0870,
0871, 0872, 0873, 0874, 0875, 0876, 0877, 0878, 0879, 0880, 0881, 0882, 0883, 0884,
0885, 0886, 0887, 0888, 0889, 0890, 0891, 0892, 0893, 0894, 0895, 0896, 0897, 0898,
0899

100, 101, 102, 103, 104, 105, 106, 107, 108, 109, 690, 691, 692, 693, 694, 695, 696,



Antilles 697, 698, 699

Norway 810 00, 810 01, 810 02, 810 03, 810 04, 810 05, 810 06, 810 20, 810 21, 810 22, 810
23, 810 24, 810 25, 810 26, 810 27, 810 28, 810 29, 810 30, 810 31, 810 32, 810 33,
810 34, 810 35, 810 36, 810 37, 810 38, 810 39, 810 40, 810 41, 810 42, 810 43, 810
44, 810 45, 810 46, 810 47, 810 48, 810 49, 810 50, 810 51, 810 52, 810 53, 810 54,
810 55, 810 56, 810 57, 810 58, 810 59, 810 60, 810 61, 810 62, 810 63, 810 64, 810
65, 810 66, 810 67, 810 68, 810 69, 810 70, 810 71, 810 72, 810 73, 810 74, 810 75,
810 76, 810 77, 810 78, 810 79, 810 80, 810 81, 810 82, 810 83, 810 84, 810 85, 810
86, 810 87, 810 88, 810 89

Pakistan 021 111, 022 111, 025 111, 040 111, 041 111, 042 111, 044 111, 046 111, 047 111, 048
111, 049 111, 051 111, 052 111, 053 111, 055 111, 056 111, 057 111, 061 111, 062
111, 063 111, 064 111, 065 111, 066 111, 067 111, 068 111, 071 111, 074 111, 081
111, 086 111, 091 111, 0232 111, 0233 111, 0235 111, 0238 111, 0242 111, 0243 111,
0244 111, 0292 111, 0293 111, 0294 111, 0295 111, 0296 111, 0297 111, 0298 111,
0453 111, 0454 111, 0457 111, 0459 111, 0542 111, 0543 111, 0544 111, 0546 111,
0547 111, 581111, 582111, 586111, 0604 111, 0606 111, 0608 111, 0722 111, 0723
111, 0726 111, 0822 111, 0823 111, 0824 111, 0825 111, 0826 111, 0828 111, 0829
111, 0832 111, 0833 111, 0835 111, 0837 111, 0838 111, 0843 111, 0844 111, 0847
111, 0848 111, 0852 111, 0853 111, 0855 111, 0856 111, 0922 111, 0932 111, 0937
111, 0938 111, 0939 111, 0942 111, 0943 111, 0944 111, 0945 111, 0946 111, 0963
111, 0965 111, 0966 111, 0969 111, 0992 111, 0993 111, 0944 111, 0995 111, 0996
111, 0997 111

Poland 0801

Réunion 0810, 0811, 0819, 0820, 0821, 0825, 0826, 0884, 0890

Romania 0801

Slovakia 0850, 0851, 0852, 0853, 0854, 0855, 0856, 0857, 0858, 0859, 0860, 0861, 0862, 0863,

0864, 0865, 0866, 0867, 0868, 0869, 0870, 0871, 0872, 0873, 0874, 0875, 0876, 0877,
0878, 0879, 0880, 0881, 0882, 0883, 0884, 0885, 0886, 0887, 0888, 0889, 0890, 0891,
0892, 0893, 0894, 0895, 0896, 0897, 0898, 0899



Spain 901, 902

Switzerland 0840, 0842, 0844, 0848

Tanzania 0840, 0860, 0861



How seller ratings work

The benefit of seller ratings is that they let Google users know about advertisers who are rated well by their customers. This helps customers make
more informed internet browsing and purchase decisions. And it helps you potentially earn more qualified leads, which in turn can increase your
dlickthrough rates.

What seller ratings extensions are

Seller ratings extensions provide customer-submitted ratings information about sellers next to their AdWords ads (currently on Google search result pages and
Google search partners). These reviews primarily reflect customers' buying experience with these businesses, as opposed to particular products. We match
these reviews to your ad by pairing the domain of the display URL to the domain on Google Shopping. Seller ratings can appear on desktop and laptop
computers, and high-end mobile devices with full Internet browsers.

Sarah's Designer Shoe Store Why these ads?

Free Shipping, Free Returns on Large Selection of Discount Shoes

Where the ratings come from

Ratings are based on customer reviews collected by Google Shopping, which aggregates reviews from a broad base of sources across the Internet. Google
Wallet reviews are also included, where applicable. Though the reviews are aggregated on Google Shopping, seller ratings extensions also include reviews for
non-product retailers.

When your ads might appear with seller ratings

Only certain ads are eligible to appear with seller ratings extensions. Once you meet the following criteria, the distribution is automatic and you're opted in to
showing seller ratings with your ads on Google search results and Google search partners. Here are the criteria:

°

Your campaign type should be "Search & Display Networks" or "Search Network only."

.

The customer must be searching on Google.com, Google.co.uk, Google.de, Google.fr, or Google.nl.
You must be an advertiser that provides customers with paid goods or services, or one that enables the buying or selling of products or services by way of

.

a marketplace.
Your business must have at least 30 unique reviews, each from the past 12 months, and a composite rating of 3.5 stars or higher on Google Shopping.

.

o Atleast 10 of these reviews must be in the customer's Google interface language.
o Google Shopping seller ratings consist of an aggregate ratings score with snippets of customer reviews from third-party sites and Google Wallet.

e You don'tneed to have a Google Merchant Center account for your ads to be eligible for seller ratings.

Note that if there's an ad extension plus box (for location extensions, etc.) or sitelinks showing with the ad, seller rating extensions will trigger on the visible
URL line.

If you want to opt out of this feature, you can let us know via this form. If you change your mind, you can always opt back in using the same form.

How much seller ratings cost

Customers on desktop and mobile browsers can click through to see the review of your business and verify the source and statements behind the ratings.
However, you won't be charged for these clicks. Seller ratings receive far fewer clicks than the actual headline for these ads, so customers are unlikely to be
diverted away from visiting your site. The benefit of this feature is the increase in clickthrough rates based on the star rating in the ad itself.

How you can improve your seller ratings and reviews

The best way to improve your ratings is to make sure that your customers receive excellent customer service. Happy customers attract more happy customers,
who are willing to rate you well and tell others about your business or products.

Read the reviews about your business, and be proactive about resolving issues raised by your customers with a result that reasonably satisfies all parties,
including you.

Sometimes reviews will highlight issues that your business has no direct control over. For example, customers may have a problem with your shipping
company, or the quality of goods you sold that you did not manufacture. Since Google Shopping aggregates customer reviews, a few ratings like this should not



meaningfully impact your overall ratings.

To help ensure that customers submit ratings to the right businesses, confirm that Google Shopping review sites display the correct business name and website
URL for your business listing. Your business name and website URL should be consistent across review sites, and should also be consistent with your Google
Merchant Center account if you have one. This helps customers identify the right businesses and helps avoid ratings for other businesses being included within

your own seller ratings.



Show additional links below your ad text

The sitelinks ad extension lets you show links to specific pages on your website beneath the text of your
ads (and in addition to the main landing page), helping customers find what they're looking for on your
site with just one click. Sitelinks appear in ads at the top and bottom of Google search results. You can
activate sitelinks when you select your campaign's settings. You'll be able to edit your link text and URLs
and see how ads that contain sitelinks perform from the Ad extensions tab in your AdWords account.

Example

You own a pizza parlor chain and want to make it as easy as possible for customers to place an order.
By adding sitelinks to your ad, you can help customers get directly to the pages on your website that
they're looking for, or pages that generate the most sales. This ad includes four sitelinks that you can

show below your ad text.

Example Pizza Store - Fresh and Hot
www example com/

Get Your Favorite Pizzas! Only At Your Pizza Store

Order Online Mow  Store Locator
Deals In Your Area  Returning Customer? Order Here

Ads on search results pages displayed on desktop computers and tablets can show from two to six links in
addition to the display URL. Ads on search results pages displayed on mobile phones with full Internet browsers
can show up to four additional links (not available for WAP phones).

In some cases, we might supplement your sitelinks with descriptions that you've provided about those pages.
Either you can add those details yourself when creating or editing sitelinks, or we can automatically use information
within your account related to individual sitelinks -- for example, from various ads in your account. By showing

additional information with your sitelinks, your ads can be more relevant to potential customers.

Why use sitelinks
Here are a few reasons to consider adding sitelinks to your ads:

¢ Show shortcuts: customers quickly see and click to popular or high-converting sections of your website.



¢ Minimize work: Create sitelinks independently from your text ads, activating them from your campaign's
settings page. In other words, you don't need to make new text ads or edit them to include sitelinks.

¢ Update easily: Change link text and URLs whenever you want, keeping ads up-to-date for sales and special
offers.

¢ Flexibility: You can add sitelinks to a campaign or ad group, providing you more control over the specific ads
they show alongside.

¢ Detailed reporting: Find out the number of clicks that occurred on any part of your ad, every time an individual
sitelink appeared. Break down the statistics by campaign, ad group, or ad. Segment your statistics using “This
Extension vs. Other” to see the number of clicks that occurred on the individual sitelink versus another part of
the ad (e.g., the headline, other sitelinks, or another extension).

¢ Data retention: Edit your sitelink without resetting its performance statistics.

¢ Customized sitelinks for mobile:Create mobile-optimized sitelinks to show on mobile devices, or disable
specific sitelinks on the devices you choose.

¢ Scheduling with start and end dates: Specify the dates, days of week, or times of day your sitelinks are

eligible to show.

Keep in mind

Sitelinks are limited to no more than 25 characters in most languages, or 12 characters in double-width
languages. Double-width languages are languages that use double-width characters, like Chinese, Japanese,

and Korean.

Review all sitelink extensions policies.

Upgrading your existing sitelinks

If you're currently using legacy sitelinks, we recommend upgrading them ahead of September 23, 2013, when
AdWords will begin automatically upgrading all legacy sitelink, app, and call extensions. To upgrade, there can't be
more than a thousand existing extensions in these campaigns, because we'll need to be able to upgrade all of your

extensions in a reasonable amount of time.
Before you upgrade your existing sitelinks, here are a few things to keep in mind about the process:

¢ A non-upgraded sitelink will result in several upgraded sitelinks, one per individual link.

¢ Then, these new sitelinks will go through our approval process. Additionally, we'll delete your non-upgraded
sitelink.

¢ Once you upgrade your existing sitelinks, you can monitor their performance by clicking the Ad extensions tab
and selecting "Upgraded" from the drop-down menu.

¢ You'll still be able to see the historical performance data for your non-upgraded sitelinks. To do so, click the
Ad extensions tab and select "Not upgraded” from the drop-down menu. Make sure that you select "All" from

the drop-down menu so you can see your historical performance data in the table.



—  How to upgrade your existing sitelinks

Here's how to upgrade your existing sitelinks in a single campaign:

1. Select the campaign whose sitelinks you'd like to upgrade.
2. Click the Ad extensions tab.

3.
4

. Select Not upgraded from the drop-down menu. (You’ll only see this menu option if you have both

Select View: Sitelink Extensions from the drop-down menu.

legacy and upgraded extensions in your campaign.)

Click the Upgrade button. Here you'll see the "Sitelink extension settings" section and you'll see your
upgraded sitelinks in the campaign-level table.

If you have a large number of campaigns and would like to upgrade all of the sitelinks in them, here's how:

2 T A

Go to the All online campaigns view.
Click the Ad extensions tab.
Next to View, choose Sitelink Extensions from the drop-down menu.

A message bar will appear with a button to Upgrade all Sitelink Extensions.
Click the button.

To see your all upgraded sitelinks, expand the "Sitelink extension settings" section to also see the ad
group level table of sitelink extensions.

Follow along in your account

Click the button below to go to your account and take a guided, step-
by-step tour of how to add sitelinks to your ad.

O o S ——— - -

Or, you can follow the instructions below.

— | Creating and managing sitelinks



Creating new sitelinks

Keep in mind

Don't see sitelinks? This feature is available only for campaigns that are showing on Google

Search. This means in order to use sitelinks, you'll need to choose one of these campaign types

when you create your campaign:

"Search & Display Networks"

e "Search Network only"

Learn about the different campaign types available.

To create campaign-level sitelinks:

o

1. Choose the campaign you'd like to add the extension to.
2. Click the Ad extensions tab.

3.
4

Choose Sitelink Extensions from the View drop-down menu.

. From the drop-down menu next to View, choose Upgraded. (You'll only see this menu option if

you have both legacy and upgraded extensions in your campaign.)
Next to the Sitelink settings link, click Edit

6. You'll see all the sitelinks that are in this account.

o To use an existing sitelink, click the sitelink.

o To create a new sitelink, click the New button.

7. Fill out the sitelink text and URL.

8. The Description field is optional. When you fill out both lines of description, your sitelink may be

eligible to show with these details. Learn more in the Sitelinks with additional detail section
below.

New sitelink
Link name |7
Link URL |7/ httpi/
Device preference 7 [_| Maobile
Description (7| | Line 1

Optienal
Line 2

+| Start/end dates, scheduling




9. Click Save to save your sitelink setting for your campaign.

10. At the bottom of the campaign’s sitelink extension window next to “Show this extension on,”
select the devices where you’d like the sitelinks in the campaign to appear. You can choose to
show the sitelinks across All devices (this is the default setting), or specify Mobile devices only
or Desktop and tablet devices only.

11. Click Save.

Tips

¢ Keep link text short. This increases the amount of links that can show and gives
AdWords more sitelinks to choose from.

e Look at your website's navigation bars for easy sitelink ideas.

e The order of your sitelinks and how they perform factor into how frequently a sitelink is

chosen to show in an ad.

Ad group-level sitelinks
Before you create ad group-level sitelinks, keep the following in mind:

¢ By default, an ad group uses the sitelinks of the campaign it's part of.

¢ If you create one kind of sitelink for an ad group, it will override the same type of campaign-level
sitelink.

¢ You can also disable a sitelink for an ad group. This deletes any sitelink you created in the ad
group and stops any campaign-level sitelink from showing with those ads. In other words, no

sitelink of the selected type will show for the ad group.
To create an ad group-level sitelink:
1. Choose the ad group you'd like to add the sitelink to.
a. Click the Ad extensions tab.

2. Choose View: Sitelink Extensions from the drop-down menu.

3. From the drop-down menu next to View, choose Upgraded. (You’ll only see this menu option if
you have both legacy and upgraded extensions in your ad group.)

4. Next to the Sitelink extension settings link, click Edit.

5. Choose Use ad group sitelink to create sitelinks specifically for the ad group.

6. You'll see all the sitelinks that are in this account.

a. To use an existing sitelink,click the arrow next to the sitelink you'd like to add to the ad

group.
b. To create a new sitelink within the ad group, click the New button.



7. Fill out the sitelink text and URL.
8. The Description field is optional. When you fill out both lines of description, your sitelink may be
eligible to show with these details. Learn more in the Sitelinks with additional detail section

below.

New sitelink
Link name |7
Link URL (7| hitp/ =
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9. Click Save and return to the ad group sitelink extension window.

10. At the bottom of the ad group sitelink extension window next to “Show this extension on,” select
the devices where you’d like the sitelinks in the ad group to appear. You can choose to show the
sitelinks across All devices (this is the default setting), or specify Mobile devices only or
Desktop and tablet devices only.

11. Click Save.

Tips

¢ Choose Use campaign setting to use the campaign sitelinks. Keep in mind that
campaign-level sitelinks will be used for ad groups by default, so this option is only
useful if you'd like to remove a previous setting.

e Choose Disable sitelink extensions to remove the ad group sitelinks and hide the

campaign sitelinks for this ad group. This means that the ad group won't show your

sitelinks.

Editing sitelinks

To edit campaign-level or ad group-level sitelinks:



1. Choose the campaign or ad group that has the sitelink you'd like to edit.

2. Click the Ad extensions tab.

3. Choose View: Sitelink Extension from the drop-down menu.

4. From the drop-down menu next to View, choose Upgraded. (You’ll only see this menu option if
you have both legacy and upgraded extensions in your campaign.)

5. From the Sitelink extension settings section, click Edit.

6. You'll see all the sitelinks in this campaign or ad group. Scroll to the campaign-level or ad group-
level sitelinks to find the sitelink you want to edit. Click the arrow on the right to select.

7. On the sitelink you selected, click the down arrow that appears next to the pencil icon and
choose Edit.

8. Make the changes to the sitelink you selected.

o The Description field is optional. When you fill out both lines of description, your sitelink
may be eligible to show with these details. Learn more in the Sitelinks with additional detalil
section below.

New sitelink
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9. After you're done editing, click Save.

10. The sitelink will be edited for any ad groups and campaigns that share the sitelink.

Tips

¢ Keep link text short. This increases the amount of links that can show and gives
AdWords more sitelinks to choose from.

e Look at your website's navigation bars for easy sitelink ideas.

e The order of your sitelinks and how they perform factor into how frequently a sitelink is
chosen to show in an ad.



—  Deleting a sitelink

To delete a campaign-level or ad group-level sitelink:

Choose the campaign or ad group that has the sitelink you'd like to delete.
Click the Ad extensions tab.
Choose View: Sitelink Extension from the drop-down menu.

Go to the Sitelink extension settings section and click the plusbox to expand the section.

o > 0D =

You'll see all the sitelinks in this campaign or ad group. Scroll to the campaign-level or ad group-
level extensions, hover your cursor over the set of sitelinks that contains the one you'd like to
delete, and click the pencil icon that appears in the upper corner.

6. Under the Selected Sitelink extension heading, click the arrow next to each extension you'd like
to remove from the campaign or ad group. If you're removing the sitelink from a campaign, this
will remove the sitelink for all ad groups under the campaign as well.

7. Click Save when you're done.
To delete all sitelinks of one type from a campaign or ad group:

Choose the campaign or ad group that has the sitelinks you'd like to delete.
Click the Ad extensions tab.
Choose View: Sitelink Extensions from the drop-down menu.

Go to the Sitelink extension settings section and click the plusbox to expand the section.

o~ 0D~

You'll see all the sitelinks in this campaign or ad group. Scroll to the campaign-level or ad group-
level sitelinks that you'd like to delete, and click the checkbox next to them.
6. Click Delete.

= | Customizing a sitelink for mobile devices

Extensions show on all devices by default, but there are two ways you can customize sitelink
extensions for mobile and desktop and tablet devices.

¢ You can create mobile-specific sitelinks. For example, if you have mobile-specific product pages
on your website and want to use a mobile-preferred sitelink to direct users there, just create your
mobile-preferred sitelink and check the “Mobile” box next to “Device preference” in the “New
sitelink” window.



¢ You can limit which devices your sitelink extensions can appear on at the campaign or ad group
level. For example, if you want the sitelinks for a specific campaign to appear only on desktops
and tablets, just edit the extension settings at the campaign level and select “Desktop and tablet

devices only” next to “Show this extension on.”
Here's how to create mobile-specific sitelinks:

Choose the campaign that has the sitelink you'd like to edit.
Click the Ad extensions tab.

On the View drop-down menu, choose Sitelink Extensions.
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From the drop-down menu next to View, choose Upgraded. (You'll only see this menu option if
you have both legacy and upgraded extensions in your campaign.)

Go to the Sitelink extension settings section and click Edit.

You'll see a list of all the sitelinks in this campaign.

Find the sitelink you want to customize and click the arrow on the right to select.
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On the sitelink you selected, click the down arrow that appears next to the pencil icon and
choose Edit.
9. In the form that appears, choose Mobile next to device preference.
10. Change the sitelink, as needed, to optimize for mobile.
11. Click Save.

Note

¢ Sitelinks with the device preference set to mobile will be given preference over standard sitelinks
on mobile devices.

e Standard sitelinks will be given preference over mobile-optimized sitelinks of the same type on
desktop and laptop computers.

e [f a campaign or ad group has only mobile-optimized sitelinks, these may show on desktop and
laptop computers. To avoid this, we recommend having standard sitelinks of the same type as
the mobile-optimized sitelinks in your campaign

= | Scheduling a sitelink

Here's how to narrow the date or time range during which a sitelink could appear:

1. Choose the enhanced campaign that has the sitelink you'd like to edit.



2. Click the Ad extensions tab.

3. Choose View: Sitelink Extensions from the drop-down menu.

4. From the drop-down menu next to View, choose Upgraded. (You’ll only see this menu option if
you have both legacy and upgraded extensions in your campaign.)

5. Go to the Sitelink extension settings section and click Edit.

6. You'll see a list of all the extensions in this campaign.

7. Hover your mouse cursor over the sitelink you want to schedule. Click the down arrow that

appears next to the pencil icon and choose Edit.

o Keep in mind that any change you make affects all campaigns or ad groups sharing this

sitelink. To make the change only for this campaign, choose Copy and edit instead.

8. In the form that appears, click the Start/end dates, scheduling section.
9. Click inside the start and end date boxes to choose the dates when the sitelink should start and
stop appearing.
10. Use the Scheduling section to set the days of the week and times of day a sitelink should
appear. All times are in the time zone of your account.
11. Click Save.

= | Sitelinks format with additional detail

Let's say you're running a campaign with sitelinks. In some cases, we might supplement your sitelinks with

descriptions that you've provided about those pages, so your entire ad unit looks like this example:

Example Pizza Store - Fresh and Hot

WAL BXAMPIE, COm
Get Your Favorite Pizzas! Only At Your Plzza Store
Order Online Mow Store Locator
Pizza, Breadsticks, and Moral Find Location Mearest You
Free 2 liter soda with online order $10 For Any Pizza!
Deals In Your Area Returning Customer? Order Here
Free Breadsticks with Large Pizza Fresh Ingredients, Greal Taste
Order Onling Now. Free Delivery! Easy Ordering For Returning Customers

Either you can add those details yourself when creating or editing sitelinks, or we can automatically use
information within your account related to individual sitelinks -- for example, from various ads in your
account. By showing additional information with your sitelinks, your ads can be more relevant to potential
customers.



How to add descriptions to your sitelinks

When creating a new sitelink or editing an existing sitelink, fill out both lines of the "Description” field

in order for your sitelinks to be eligible to show with those details.

New sitelink
Link name 7
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See the section above for instructions on how to create or edit sitelinks.

How sitelinks with additional detail work automatically

i Example

You've created sitelinks for your pizza restaurant campaign, and your ad can show

sitelinks similar to the following ad:

Example Pizza Store - Fresh and Hot
www_example com/

Get Your Favorite Pizzas! Only At Your Pizza Store

Order Online Mow ~ Store Locator
Deals In Your Area  Returning Customer? Order Here

Now, let's say your account also includes the following text ads:

Example Pizza - Order Online  Neighborhood Example Pizza Store

www.example.com/order www.example.com/flocations
. ; : . \
Pizza, Breadsticks, and More! Find Location Nearest You

Free 2 liter soda with online order $10 For Any Pizza!




Example Pizza - Great Deals Your Favorite Pizza Store

www.example.com/deals www.example.com/return
Free Breadsticks with Large Pizza Fresh Ingredients, Great Taste
Order Online Now. Free Delivery! Easy Ordering For Returning Customers

Since the text ads in your account include information that's similar to your sitelinks, we
might add some of that information to your sitelinks and show potential customers an ad
unit that could look like the following:

Example Pizza Store - Fresh and Hot

WAL BXAMPIE, COm
Get Your Favorite Pizzas! Only At Your Pizza Store
Order Online Mow Store Locator
Pizza, Breadsticks, and More! Find Location Mearest You
Free 2 liter soda with online order $10 For Any Pizza!
Deals In Your Area Returning Customer? Order Here
Free Breadsticks with Large Pizza Fresh Ingredients, Greal Taste
Order Onling Now. Free Delivery! Easy Ordering For Returning Customers

Note: It's important to remember that we'll supplement your sitelinks with information
that you provide. This means that you're in control of the information, such as ad text,

that we show in your sitelink extension.

Keep in mind

We'll only show sitelinks with additional information if your sitelinks campaign meets specific criteria,
including the following:

¢ Your existing ads show with two or three lines of sitelinks and appear above Google search results.
¢ You've filled out additional information for your sitelinks OR we've found other ads in your account that
match your sitelinks.

How much sitelinks cost

The cost of a click on a sitelink equals the cost of a click on the display URL in the same ad. In other words, you'll
be charged the same amount no matter which link in the same ad — destination URL or sitelink — someone clicks.
Sitelinks offer more opportunities for your customers to click on and within your ad, but you won’t be charged for
more than two clicks per ad impression. However, if someone quickly clicks on more than one link while viewing an

ad, this gets treated as a duplicate or invalid click and you won't get charged.

Performance and reports



Let's say you'd like to see how your sitelinks perform, like the number of clicks or impressions that occurred when
your sitelink was shown with your ad. You can use your sitelink performance data to see which sitelinks perform
best and then optimize your sitelinks to help you reach your advertising goals.

Keep in mind

When your sitelinks are upgraded starting September 23, 2013, the stats will be reset. However, the historical
performance for your legacy extensions will be available until October 23, 2013. If you would like to retain this
historical data, please do so before October 23.

Learn how to view historical data for deleted and/or legacy extensions.

= | Monitoring sitelink performance

You can analyze the performance of ads that contain sitelinks from your Ad extensions tab. The clicks

column counts clicks both on your sitelinks and on your ad when your sitelinks appeared with it.
Here's how to see your sitelink performance data:

1. Select a campaign with sitelinks. Then, click the Ad extensions tab.

2. Choose View: Sitelink Extensions from the drop-down menu.

3. You'll see a statistics table that contains data on the entire ad unit's performance when the sitelink
appears. In other words, this data includes the performance of the sitelink, as well as the ad and any
other sitelinks it appeared with.

4. Analyze your performance data to see which sitelinks are performing well and optimize your sitelinks

accordingly.

Segment your performance data

Use segments to take a closer look at individual sitelink performance. We recommend using the "This
Extension vs. Other" segment to compare how many clicks your individual sitelink received versus the other

sitelink or headline that appeared in your ad.
Here's how to segment your data by "This extension vs. Other":

1. Click the Ad extensions tab of a campaign with sitelinks

2. Click View: Sitelink Extensions from the drop-down menu.



3. Click the Segment drop-down menu.

4. Select "This Extension vs. Other".

5. In the table, you'll see a row named "Other" and a row named "This extension." You can compare the
statistics in these two rows to see how your individual extensions are performing and optimize them

accordingly.
Here's how you can compare how many clicks your ad's display URL received versus its sitelinks:

1. From the Ad extensions tab of a campaign with sitelinks, click the "Segment" dropdown menu.
2. Select "Click type."

Google Adwords

Tip
Customize the statistics table to break down your sitelink performance by campaign or ad
group. To do so, click the Columns drop-down menu and choose Customize columns. Within

the Level of detail section, you can add separate Campaign and Ad group columns to the
table by clicking the Add link.

= | Tracking in Google Analytics

Autotagging your links will result in your landing page URLs being recorded with the additional sitelink
parameter.

This means it will appear as a separate entry in your Top Content reports as well as be available for you in
the AdWords section of Traffic Sources.

You can also analyze the performance of this landing page URL in your AdWords campaigns. Use the

secondary dimension to see which ad text and landing page (sitelink) combination works best.



Note: The Goal Set 1 tab is selected, however if Ecommerce Tracking is enabled on your site, you can see

Revenue and Transaction figures.

Why your sitelinks aren't showing

Keep in mind that your ads won't always show sitelinks. Also, when your ads show sitelinks, the format that

appears could vary. For instance, anywhere from two to six sitelinks may appear on desktop ads.

We consider several factors when determining what types of sitelinks we'll display with your ad, and whether we'll
display sitelinks at all. These factors include the following:

e Your keyword's Quality Score.

e The position of your ad on Google search result pages.
¢ The landing page of your ads and sitelinks.

¢ Other ad extensions that are enabled in your campaign.
¢ The search term used by a potential customer.

¢ The relevance of other ads on the page.
The following best practices will help increase your chances of showing sitelinks:

¢ Your sitelink URLs within a campaign or ad group must each direct to a unique landing page, with unique
content. Sitelinks within a campaign that point to the same content won't show.

¢ Your ad should have one of the positions directly above or below Google search results.

¢ Your keyword should have a very high Quality Score.

¢ Your sitelink URLs must direct customers to pages that are relevant to your product or service.

¢ Add the maximum amount of sitelinks you can to your campaign. Your campaign needs a minimum of two
approved sitelinks with different landing pages in order for sitelinks to appear with your ads on desktop or
tablet, and one approved sitelink with a different landing page from your ads to appear on mobile.

o Keep sitelinks text short.

e Make sure your sitelinks are all approved. Check the Status column next to each sitelink to make sure it says
"Approved." Edit or delete any sitelinks that say "Disapproved."

Note

After you create your sitelinks, they might appear with your ads for a few weeks and then stop appearing. This
change might occur because there could be a delay in the review process that we do to make sure your
sitelinks meet our policies. If your sitelinks stop appearing, check the destination URLs of your sitelinks to make

sure that each sitelink in your campaign directs customers to a unique landing page.
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Check and understand Quality Score

Quality Score is an estimate of how relevant your ads, keywords, and landing page are to a person seeing your ad. Having a high Quality Score
means that our systems think your ad, keyword, and landing page are all relevant and useful to someone looking at your ad. You can find out your
Quality Score for any of your keywords, and there are several things you can do to help improve your Quality Score.

Example

Suppose Sam is looking for a pair of striped socks. And let's say you own a website that specializes in socks. Wouldn't it be great if Sam types
"striped socks" into Google search, sees your ad about striped socks, clicks your ad, and then lands on your webpage where he buys some spiffy
new striped socks?

In this example, Sam searches and finds exactly what he's looking for. That's what we consider a great user experience, and that's what can earn
you a high Quality Score. What's more, relevant ads tend to earn more clicks, appear in a higher position, and bring you the most success.

Watch this video

<-‘|

]
What is AdWords Quality Score and Why Does it Matter?

Learn why your keyword Quality Score is key to getting your ads in front of customers. Find out what a Quality Score is, how it's calculated, where it's located,
and how to improve it. Read more about AdWords Quality Score at http://goo.gl/8v2hr. Subscribe Subscribe to AdWords Help on YouTube
http://www.youtube.com/learnwithgoogle.

Checking your Quality Score
You can check your Quality Score by looking within your Keywords tab. There are a couple ways to check your Quality Score, as shown below.
Run a keyword diagnosis:

1. Click the Campaigns tab at the top.

2. Select the Keywords tab.

3. Click the white speech bubble 7 next to any keyword's status to see details about that keyword's Quality Score. You'll be able to see ratings for expected
clickthrough rate, ad relevance, and landing page experience.

Another way to see your Quality Score is to enable the Qual. score column:

1. Click the Campaigns tab at the top.
2. Select the Keywords tab.
3. Look for the Qual. score column in the statistics table. If you don't see this column in your table, you can add this column by doing the following:

o

Click the Columns dropdown in the toolbar above the statistics table.

o Select Customize columns.
Select Attributes.

o Click Add next to Qual. score.
o Click Save.

o




Each keyword gets a Quality Score on a scale from 1 to 10, where 1 is the lowest score and 10 is the highest. We recalculate your Quality Score every time
your ads are eligible for the ad auction, which can potentially happen many times a day. Rather than showing you different Quality Scores throughout the day,
we show you a single Quality Score that gives you an estimate of that keyword's overall quality.

How we calculate Quality Score

Every time someone does a search that triggers your ad, we calculate a Quality Score. To calculate this Quality Score, we look at a number of different things

related to your account. By improving the following factors you can help improve your Quality Score:

3

Your keyword's past clickthrough rate (CTR): How often that keyword led to clicks on your ad

Your display URL's past CTR: How often you received clicks with your display URL

Your account history: The overall CTR of all the ads and keywords in your account

The quality of your landing page: How relevant, transparent, and easy-to-navigate your page is

Your keyword/ad relevance: How relevant your keyword is to your ads

Your keyword/search relevance: How relevant your keyword is to what a customer searches for

Geographic performance: How successful your account has been in the regions you're targeting

Your ad's performance on a site: How well your ad's been doing on this and similar sites (if you're targeting the Display Network)

Your targeted devices: How well your ads have been performing on different types of devices, like desktops/laptops, mobile devices, and tablets — you
get different Quality Scores for different types of devices

How Quality Score affects you

Quality Score is used in several different ways and can affect the following things in your account:

Ad auction eligibility: Higher Quality Scores make it easier and cheaper for a keyword to enter the ad auction.

Your keyword's actual cost-per-click (CPC): Higher Quality Scores lead to lower CPCs. That means you pay less per click when your keyword has a
higher Quality Score.

Your keyword's first page bid estimate: Higher Quality Scores lead to lower first page bid estimates. That means it's easier for your ad to show on
the first page of search results when your keyword has a higher Quality Score.

Your keyword's top of page bid estimate: Higher Quality Scores lead to lower top of page bid estimates. That means it's easier for your ad to show
towards the top of the page when your keyword has a higher Quality Score.

Ad position: Higher Quality Scores lead to higher ad positions. That means your ad can show up higher on the page when your keyword has a higher
Quality Score.

In a nutshell, higher Quality Scores typically lead to lower costs and better ad positions. The AdWords system works best for everybody — advertisers,
customers, publishers, and Google — when the ads we show are relevant, closely matching what customers are looking for. Relevant ads tend to earn more

clicks, appear in a higher position, and bring you the most success.



Understanding landing page experience

Landing page experience refers to how good we think someone's experience will be when they get to
your landing page (the web page they end up on after clicking your ad). You can improve your landing
page experience — and Quality Score — by:

« providing relevant, useful, and original content,
« promoting transparency and fostering trustworthiness on your site, and
» making it easy for customers to navigate your site (including on mobile sites).

Many things can affect your landing page experience. For example, is your landing page relevant to what a visitor is
looking for? Is it easy to find your contact information? Is the page itself easy to navigate? Your landing page

experience affects not only your Quality Score, but also your advertising costs and ad position.

Why landing page experience matters

If you've ever owned a car, you probably know that getting tune-ups can help you get better mileage, prevent
costly mechanical problems, and make your car run better in the long run. Landing pages are kind of like cars —
make sure they're tuned-up properly, and you'll likely get better performance and savings out of them down the

road.

A good landing page experience can help you gain the trust of your customers and keep them coming back to your
site. Get more mileage out of your landing page by making it easier for visitors to make a purchase, sign up for a

newsletter, or do other things you want them to do on your website.

How we determine landing page experience

We use a combination of automated systems and human evaluation to determine landing page experience on your
site. Your ads may show less often if they point to websites that offer a poor user experience based on one or

more of the following factors:
1. Relevant, useful and original content

o Is the purpose of your site clear?
o Is your site actually useful to visitors? Do people feel like they accomplished what they wanted to

accomplish when they clicked on your ad and visited your site?



o How original is the content on your site? What does your site offer that other sites don't?
o Does your site add value to visitors? Do people feel like their time was well spent on your website?

o Does your site provide content that visitors expected to find when they clicked on your ad?
2. Transparency and trustworthiness

o Is your business and contact information easy to find?

o Are you upfront about any information you're collecting from visitors?

o Can people trust that you’ll safeguard the information they give you? Is it clear how that information will be
used to benefit them?

o Can people easily tell what'll happen when they perform an action on your site?

o Do people feel like you're hiding the true purpose of your site, or not telling them what they need to know?

o Can people trust you'll be able to deliver the goods or services they’re looking for?

3. Ease of navigation

o]

Is it easy for people to find what they're looking for (including on mobile sites)?

o Does your site have too many links that might confuse people?

o]

Can people easily find information to learn more or answer questions?

o]

Are there annoying pop-ups, too many ads, or other distractions that get in the way?

= | Excluding your landing pages from review

By default, the AdWords system reviews advertised landing pages to assess landing page experience. If
you don't want some of your landing pages to be reviewed, you can follow the steps below to restrict the
AdWords system from visiting those pages. However, if you do this, you may end up with a significant drop
in Quality Score because we won't have as much information to determine your landing page experience and
relevance. This means your ads may show far less often unless you significantly increase your maximum
cost-per-click (in shorthand, your bid). Even with higher bids, however, it is unlikely your ads would show
very often and may not even show at all. Also note that if you restrict access to your entire site, or if you
restrict access to so many of your landing pages that it makes it difficult for the AdWords system to

meaningfully review your account, your site will be suspended.

While we strongly recommend against restricting our system's automatic review of your landing pages, you

can edit your site's robots.txt file as shown below to avoid a review.

e To prevent the AdWords system from accessing your entire site, add the following to your robots.txt

file:

User-agent: AdsBot-Google

Disallow: /



¢ Some portions of your site may not function as active landing pages for your advertisements, and you
may have reasons to prevent the AdWords system from accessing them. To prevent the AdWords
system from accessing certain parts of your site (for example, inside the directory named

“/shopping_cart/”), add the following to your robots.txt file:

User-agent: AdsBot-Google
Disallow: /shopping_cart/

Note that these instructions apply only to AdsBot-Google. There are other Google-owned bots that review
websites as well (googlebot, for example). In order to avoid decreasing Quality Scores and increasing CPCs
for advertisers who don't intend to restrict AdWords visits to their pages, the system will ignore blanket

exclusions and wildcards (for example, User-agent: *) in robots.txt files.

= Mobile visits to your landing page

The AdWords system will also visit your landing page to evaluate your site as viewed by iPhones and other
mobile devices with full browsers.

Currently, we use the following HTTP User-Agent header to identify AdWords mobile visits:

AdsBot-Google-Mobile (+http://www.google.com/mobile/adsbot.html) Mozilla (iPhone; U; CPU iPhone OS 3 0
like Mac OS X) AppleWebKit (KHTML, like Gecko) Mobile Safari

If you have a distinct, mobile-optimized version of your site, we recommend you configure your server to

show the mobile-optimized site when the AdWords mobile User-Agent is detected.

Viewing your landing page experience
We show you one of three ratings for your landing page experience: Above average, Average, or Below average.

You can view this status by going into your Keywords tab and placing your cursor over the speech bubble next to
the status of any keyword.

+ Above average or Average: If you see either of these two statuses, you're in good shape — your Quality Score
won't be negatively affected by your landing page experience.

+ Below average: This means that your landing page experience is in need of improvement, and your Quality
Score might be lower as a result. You might want to consider some changes to improve your website's landing

page, using the factors discussed in this article as your guide.

Landing page experience vs. Site policies



When we review landing pages, we sometimes come across pages that don't follow our Advertising Policies. For
example, if your landing page happens to contain malware (like a virus), that's a pretty bad landing page. Rather
than giving you a "Below average" landing page experience status, you won't get a score at all. Instead, you'll see
"Not applicable" as your landing page experience status, and any keywords or ads pointing to that website will get
a "Site suspended" status. This status means that your website can't be advertised with AdWords because it

doesn't follow one or more of our site policies.

Site policies refer to the Advertising Policies that must be followed on your landing pages and website in order to
advertise on AdWords. If your landing page or website contains something that we don't allow, like malware or
illegal products, we might suspend your website to protect our customers. When a website is suspended, that
means you won't be able to advertise that suspended website until all policy violations have been resolved.

Improving your landing page experience

If you're trying to improve your landing page experience, it might be time to give your landing pages a tune-up. Try
reviewing the general guidelines below to help you think of ways to improve your landing page experience and get
better performance out of your landing pages down the road.

1. Relevant, useful and original content

o Make sure your landing page is directly relevant to your ad text and keyword.
o Provide useful information on your landing page about whatever you're advertising.

o Try to offer useful features or content that are unique to your site.
2. Transparency and trustworthiness

o Make it easy for visitors to find your contact information.

o If you request personal information from customers, make it clear why you’re asking for it and what you'll
do with it.

o Distinguish sponsored links, like ads, from the rest of your site content.

o Openly share information about your business and clearly state what your business does.
3. Ease of navigation

o Don't make people hunt around for the information they might need.
o Make it quick and easy for people to order the product mentioned in your ad.
o Don’t annoy customers with pop-ups or other features that interfere with their navigation on your site.

o Make sure people can easily find information to learn more about the advertised product.

The AdWords system visits and evaluates landing pages on a regular basis. If you've made significant changes to
improve your landing page experience, it could lead to higher Quality Scores over time. You might not see an
immediate impact, but you may see results within days or weeks.

|



Does Your Landing Page Seal the Deal?

Learn how to go from clicks to customers by directing visitors to the right page of your website. Find out what a

landing page is, how to select the right landing page for your ad, and get tips on creating landing pages that win
you customers.



Create an effective mobile site

People who use high-end mobile devices, like iPhones or Android phones, can see standard AdWords ads and standard websites. Just because
potential customers can see your desktop website on a mobile phone doesn't mean that it's mobile-friendly.

To reach the most mobile customers, it helps to create a mobile website that's tailored to the small screen and makes it easy for people to make a
purchase or take other action on your site.

When designing your site, keep in mind mobile best practices, like simple navigation and highlighting local options of your business. If you'd like to
reach customers with WAP phones, you'll also need to use mobile-friendly code to create your site.

Reaching mobile customers using an HTML website

Regardless of whether you have a mobile website, AdWords will let you show text ads to customers using Google Search on a high-end mobile device, like an
iPhone or Android phone. These "smart phones" have a full Internet browser (like a desktop computer), so a customer who clicks your text ad from the search
results page can visit your standard website.

Keep in mind

If you opt in, make sure that your landing page doesn't contain Flash content. Flash is currently not supported on iPhones or iPads, and has only limited
support on Android and other high-end mobile devices. If our system detects that your landing page has lots of Flash content, we'll automatically limit your
ads from running on high-end mobile devices.

Nowadays, many mobile devices have standard browsers, but some feature phones lack a full browser and can only view mobile-specific webpages. To reach
customers on these devices, you'll need to create a WAP mobile ad and a WAP-friendly mobile website, which we'll talk about more below.

Best practices for designing a mobile site

When creating a mobile website, you'll want to keep in mind a few strategies that best take advantage of the small size of mobile screens and the behavior of
mobile users. These strategies can help make sure your mobile site is a great experience for customers and direct them to take the desired actions on your
site.

Keep it quick

1. Reduce large blocks of text and use bullet points.



2. Compress images to keep them small for faster site loading.

Make it easy to buy something or contact you

1. Reduce the number of steps needed to complete a transaction.
2. Keep forms short, with the fewest number of fields possible.

3.

4. Use click-to-call functionality for all phone numbers.

Use check boxes, lists, and scroll menus to make data entry easier.

Simplify navigation
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. Minimize scrolling and keep it vertical only.

. Use a clear hierarchy in menus and avoid rollovers.

. Help customers navigate between levels with clear back and home buttons.
. Use seven links or fewer per page of navigation.

Help people find and get to your local sites

1.
2.
3.
4.

Have your address or store locator on the landing page.

Include maps and directions. Use GPS to personalise when possible.
Allow customers to check stock at nearby stores.

Make sure your mobile website is being indexed for web search.

Designing sites for WAP mobile phones

While desktop websites typically are written with HTML, a landing page for a WAP device will need to be written in a different coding language. WAP-friendly
mobile websites can be written in a few different markup languages, including XHTML, CHTML, and WML. Each language is compatible with different mobile

devices.

By considering which devices you'd most like your ad to appear on, you can best plan which language or languages you should use to create your mobile

website.

Detailed instructions for creating a website in mobile-friendly code are available in the Webmaster Help Center.

Note

Once you're all set with your mobile website, make sure that the WAP mobile ads you create are set to display in the correct markup language(s) in which
your mobile site is written. You'll see this step while you're creating or editing a WAP ad, under "Specify the markup language in which your mobile website

is written."



About invalid traffic

Invalid traffic refers to clicks and impressions on AdWords ads that we suspect aren't the result of genuine
customer interest. Examples of invalid traffic include clicks and impressions performed by automated
tools, as well as accidental clicks — for instance, if someone double clicks your ad. We don't charge you
for invalid clicks and impressions because we think they have little or no value.

Types of invalid traffic
Below are some types of clicks and impressions that we consider to be invalid:

¢ Accidental clicks that provide no value, such as the second click of a double-click
¢ Manual clicks intended to increase someone's advertising costs

¢ Manual clicks intended to increase profits for website owners hosting your ads

¢ Clicks and impressions by automated tools, robots, or other deceptive software

¢ Impressions intended to artificially lower an advertiser's clickthrough rate (CTR)

How Google protects you from invalid traffic

We help protect advertisers from invalid traffic by working to isolate and filter out potentially invalid clicks before
they ever reach your account reports. Each click on an AdWords ad is examined by our system. Google looks at
numerous data points for each click, including the IP address, the time of the click, any duplicate clicks, and
various other click patterns. Our system then analyzes these factors to try to isolate and filter out potentially invalid
clicks before they ever show up in your account.

More about Google's protection against invalid traffic »

How Google handles invalid traffic

When our system detects invalid clicks on your ads, we automatically filter these out of your reports so that you're
not charged for them. However, you still have the option to view invalid click data if you'd like to. See the section

below about "Viewing invalid click data" for information on how to view invalid click data in your account.

If we find invalid clicks that have somehow escaped our automated detection in the past two months, we'll give
you credit for these clicks. To view these credits for invalid clicks, click the Billing tab. Any invalid click credits

you've received will be labeled "Invalid activity" on the transaction history page and will be credited to you.



If we find any invalid impressions in your account, this data won't affect the CTR used for determining your

keyword's Quality Score.

Viewing invalid click data

You can see the number of invalid clicks your ads have received by adding the Invalid clicks and Invalid click rate
columns when viewing your campaign statistics. Remember that you aren't charged for these clicks, so they don't

affect your account statistics.

1. Click the main Campaigns tab.
2. You can view invalid click data for each of your campaigns, or view the data by time period.

o To view data by campaigns, click the Campaigns tab.
o To view data by time period, click the Dimensions tab. Select the appropriate view by clicking on the
View dropdown in the toolbar above your statistics table. Choose a time period such as "Day of the

week."

Google AdWords

4. Click Performance, then click Add next to the following options:

o Invalid clicks: See the number of invalid clicks filtered during the selected time period.

o Invalid click rate: See the percentage of your total clicks that were filtered during the selected time period.



5. Click Save.

Google Adwords - s

Invalid click data should now appear in your table. If you'd like to download the data, click | &, |in the toolbar

above the table.

More about creating reports »

Monitoring invalid clicks yourself

If you're worried about invalid clicks in your account, there are a number of things you can do to monitor your

account's activity.

* Track invalid clicks in your account statistics: As described in the section above, add the invalid click data
columns to your campaign statistics table to see the number and percentage of invalid clicks in your account.
Remember that you aren't charged for these clicks, so they don't affect your account statistics.

¢ Optimize your account: Your first line of defense against invalid activity is to optimize your account so your
ads receive only the most targeted clicks and impressions. Keep in mind that conversion rate is one of the
best indicators of successful advertising. Identifying and correcting low-conversion areas in your account will
also work towards identifying potential areas of invalid activity.

¢ Monitor your account with Google Analytics: Google Analytics is a free tool that helps you monitor various
aspects of your AdWords account, including conversion rate, visitor behavior, and campaign performance.
Google Analytics provides reports that you can use to refine traffic to your ads. You can also use auto-tagging
to help track the performance of your keywords.

¢ Monitor conversion rates on the Display Network: For campaigns opted into the Display Network, monitor
your ads' conversion rates on Display Network sites with the placement report. If you notice that clicks from
the Display Network aren't converting as well as clicks from Google or the Search Network, consider reducing
your Display Network bids. If you find that a particular Display Network site isn't converting well, consider

excluding it from your campaign.



Low conversion rates

A low conversion rate doesn't always mean that you're getting invalid clicks. A number of different factors
can lead to high levels of traffic but relatively few sales. Here are some common causes of, and solutions to,

low conversion rates:

¢ Changes in market condition, user behavior, and web content may affect your campaign's
performance. Some of our advertisers experience a lower return on investment (ROI) as their industries
face increasing competition within the Internet advertising marketplace. We recommend that you closely
monitor the ROI for each of your keywords and ads and adjust your bids accordingly within the budget
that's right for your business. Learn how bidding strategically can maximize your ROL.

 Sites that are difficult to navigate may drive away potential customers. Consider evaluating your site's
overall design, layout, and functionality. With Google Analytics, you can see if visitors typically leave
your website at a certain point before making a purchase.

¢ Your keywords and ad text may not be specific enough. If you use general keywords and ad text,
someone may arrive at your site expecting to find something you don't offer. Highly targeted keywords
and ad text will help ensure your ads show only to customers interested in your product or service.

¢ Your campaign may not be optimized for the Display Network: If your campaign is opted into the
Display Network but isn't optimized, your ads may appear on Display Network sites that are irrelevant
to the products or services you're advertising. Visitors are more likely to make a purchase on your
website if your ads pertain to the sites they're currently browsing. For the best results, it's important
that each of your ad groups contains a short, specific keyword list focusing on only one product or

service. Learn more about optimizing for the Display Network.

More about better understanding your ad traffic »

Multiple clicks from the same IP address

Multiple clicks from the same IP address don't necessarily suggest invalid activity. There are several

possible reasons why this happens:

¢ Return visits: Individuals may click your ad more than once when comparison shopping or returning to
your site for more information.

¢ Shared IP addresses: Multiple clicks from a single source may be due to an Internet Service Provider
(ISP) assigning identical IP addresses to multiple users. Certain ISPs, such as AOL, distribute a
relatively small number of shared, rotating IP addresses to a large number of users. As a result, multiple
visitors may access your site from identical IP addresses, giving the impression of repeated clicks from

a single visitor.



¢ Web server logs: Your site's web server logs include data for all visitors to your site, not just those who
arrived after clicking an AdWords ad. You may see "Google.com" referrers from visitors who reached
your site via the Google search results and not via your ad. Rest assured that your account is only
charged for clicks your ads receive.

¢ Third-party software: We've found that some reporting software records clicks between pages as a
visitor navigates through your website. As a result, it may appear that you received a large number of
clicks from a single visitor in a short period of time. For a more accurate way to track only AdWords
clicks, we recommend using auto-tagging.

= | Clicks from Google

Some people have asked us whether they're charged for clicks originating from Google IP addresses. No
need to worry about that — clicks on AdWords ads from within Google aren't charged to your account. You
may see this activity in your web server logs, but rest assured, you aren't charged for this activity. This also
applies to Google's web-crawling robots.

Common reasons for increased traffic

Just because you see a spike in the number of clicks or impressions in your account doesn't always mean your
ads are affected by invalid traffic. In most cases, these spikes in traffic are caused by other things.

Examples of why you might see an increase in traffic:

¢ Changes in daily budget: If you raise the daily budget for your campaigns, it'll allow your ads to get more
impressions and — naturally — more clicks.

¢ Changes in maximum CPC for keywords: Raising the maximum CPC (cost-per-click) for one or more of your
keywords might allow your ads to show more often. It might also allow the ads to show in a higher position
than before. That's also true for ads that show on the Display Network — a higher CPC can result in a higher
position and therefore more impressions and clicks.

¢ Adding new keywords: Adding new keywords to your campaign, especially if the keywords are quite general
or correspond to popular search queries, can increase the number of impressions and clicks you get.

¢ Ads are showing on new Display Network sites: If your ad campaign uses automatic placements and has
enough daily budget, your ads' traffic can significantly increase if it starts showing on a new publisher site.

¢ Seasonal trends or news events:Sometimes a sudden increase in interest in a specific topic can cause
increased traffic — for example, if it's a special holiday or if someone famous blogs or talks about a particular
topic.

More about valid reasons for increases in traffic »



Reporting invalid clicks

As mentioned in the section above, there are many common reasons for increased traffic that don't involve invalid

clicks. However, if you suspect that your account is indeed affected by invalid click activity, we'll be happy to
investigate your account.

Our team of specialists will use a variety of different signals including click and impression information to identify
sources of invalid activity. Because of the large number of data points we look at, an investigation into your
account may take several business days to complete. When you request an investigation, please share as much
information as you have about the traffic you're concerned about.

More about requesting a click investigation »
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Overview of adwords tools

AdWords tools can be used for a variety of functions.

« Account management tools help you view, edit, and update your account efficiently.

o Keyword tools provide resources for choosing effective keywords.

* Placement refinement tools enable you to optimize where your ad appears.

« Bid and budget management tools help you make the most of your advertising budget, either by saving you time or providing insight into what you
should bid for your advertising.

* Ad creation tools enable you to create customized ads to promote your business.

« Troubleshooting tools help you figure out how to solve issues that come up in your account. For example, using the disapproved ads filter helps you
quickly find and update ads that aren't running for policy reasons.

We don't expect that every advertiser will find each AdWords tool useful, but we do hope that you'll find value in using the tools that work well for your account.
Using the right tools for your account is like using the right tools when you build a house: They make the job easier, and they improve the quality of the finished
product. Using the right AdWords tools can help improve your ROI and save you time as you manage your account.



See your account history

Have you ever tossed a bunch of ingredients together to make an amazing meal -- maybe with a few other cooks in the kitchen -- and wished you
could go back in time to record the recipe?

Your AdWords account contains a history of changes that lets you see what you've done in the past so you can understand the recipe that led to
success -- and aim for even better results in the future.

By seeing your account statistics alongside the changes in your account, you can understand what events triggered changes in your performance.
You can also customize which changes you'd like to see -- by date, campaign or ad group, user, and type of change.

Video: How to see your account history

In this video we'll show you how to view your account changes using the "Change History" feature.

How to see and use your change history

1. Sign in to your AdWords account at https://adwords.google.com.
2. Click the Tools and Analysis tab and select Change history.
3. On the page that appears, choose what types of changes you want to see. You can filter the changes you'll view in four ways:

Time period: View changes for a particular date range using the drop-down menu in the Within date range section. You can see changes dating back

two years.

Scope: Choose whether to see changes across your entire account, by campaign, or by ad group, using the list on the sidebar.

Tip

o To see changes made at an account level (like adding a new user), click Account changes.
o To see changes made to all campaigns, select All changes.

o Click a campaign name to see only the changes affecting that campaign.

o Within a campaign, click an ad group name to see only the changes affecting that ad group.

User: If multiple users with different logins manage your account, you can use the drop-down menu in the Changed by section to view changes made by

a particular user.

Change type: Use the checkboxes to filter by change type. Check All to see all changes made, or check one or more of the change types to narrow the
results. We'll go over the details of each change type in the next section.

4. To see more information about each change, click Show all details. To simplify the view, click Hide all details.
5. Export your change history by clicking Download.




Account actions tracked in your change history
Here are the various change types tracked in your history:

o Ad: Actions taken to create, edit, pause, resume or delete an ad

¢ Budget: Adjustments to your campaign's budget

e CPC: Adjustments to your maximum cost-per-click (CPC) bids

« Distribution: Changes to the network settings chosen for a campaign

o Keyword: Actions taken to add, pause, resume, or delete keywords; adjustments to a keyword-level maximum cost-per-click (CPC) bid or destination URL
e Status: Actions taken to pause, resume, or delete a campaign or ad group

o Targeting: Adjustments to a campaign's location or language targeting

In addition to changes made directly in your AdWords account, your change history will show changes made via automated rules, AdWords API, and
AdWords Editor.

Your change history doesn't track the following:

e Maximum cost-per-click (CPC) adjustments made by the Budget Optimizer
o Ad approval or disapproval
e Password changes (for security reasons)

Example

Let's say your assistant, Stu, has been a bit scatterbrained about money lately. So you want to see all changes he made to your daily budget and
cost-per-click (CPC) bids last week.

o First, in the list of campaigns in the sidebar of the page, make sure to select All changes.
o Next, in the date drop-down, set it for last week.

« In the "Change types" section, check the boxes labeled Budget and CPC.

e Make sure to pick Stu from the Changed by drop-down.

Don't see any changes?

e There may not have been any changes in that time period, based on the limits you've set. Try widening your options to see changes.
e You just made a change. If it's only been a few minutes, wait a few more and try again.

Using the chart in your change history

If line after line of changes listed makes your eyes swim, take a look at the chart in your change history. Changes are mapped to the chart and you can choose
which statistics to show.

To update the view, click the icon next to "Graph options."

» See different metrics: You can view one or two statistics in the chart. Choose one from the "Primary metrics" drop-down, and add another to compare
to, if you like.

e Zoomin or out: See more or less detail in the chart by clicking "Zoom in" or "Zoom out" in the upper corner.

« Focus on a date range: To see more detail for a specific date range, click and drag on the graph for the dates that interest you.

o See exact numbers: Move your mouse cursor over a point in the chart, and we'll show you specific metrics for that date range.

If there's a significant change to the metric displayed in your chart, and if an event happened that day or the day before, the day will be flagged on the



chart.

e When you click a flag, the list of results below the chart will reload, showing only the events that happened that day. Click Show all changes to see all

events again.
« The flags are numbered, and correspond to the list of dates next to the chart. This list shows the number of events that occurred on each date. Click

Scroll up or Scroll down if you can't see all the dates at once.

Example

Let's say, on June 6, your business was featured in a news article, and impressions spiked. The change history tool will check if any changes
were made in your account on June 6 or June 5. If impressions is one of the statistics you're viewing, your change history will flag one or both of
those days. If you're viewing click-through rate (CTR) only, you may not see any change flagged on the chart, because there weren't significant

changes to CTR in that time period.

Tip

o Like lists? Hide the graph by clicking the "Graph options" icon, then unchecking the box marked "Show graph."



Keyword Tools

Add negative keywords to your campaign



Add negative keywords to your campaign

Negative keywords can help you reach the most interested customers, reduce your costs, and increase
your return on investment (ROI). When you add terms as negative keywords (available for "Search
Network only" and "Search & Display Networks" campaigns) or as keyword exclusions (for "Display
Network only" campaigns), your ad won't show to people searching for those terms or visiting sites that
contain those terms.

With negative keywords, you can:

¢ Prevent your ad from showing to people searching for or visiting websites about things you don't offer.
¢ Show your ads to people who are more likely to click them.

¢ Reduce costs by excluding keywords where you might be spending money but not getting a return.

When you select negative keywords, you'll want to choose search terms that are similar to your keywords, but

signal that people are looking for a different product.

| Example

Let's say you're an optometrist who sells glasses. You'd want to prevent your ad from showing to
someone searching for or visiting webpages that contain terms like "wine glasses" and "drinking

glasses," since that person isn't likely to buy a pair of your eyeglasses.

How to add negative keywords

In this video you'll learn how to keep specific search queries from matching your ads using negative keywords



Follow steps in your account

Click this link to go to your account and see a guided tour that walks

you through each step to add negative keywords to reach the right
customers. Note that this step-by-step flow is available for “Search

Network only” and “Search and Display Networks” campaigns.

Or, you can read the instructions below.

~ Add negative keywords (“Search Network only” or “Search & Display Networks” campaigns)

1. Sign in to your AdWords account at https://adwords.google.com [£ .
2. Click the campaign or the ad group that you'd like to add negative keywords to.

3. Select the Keywords tab.
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4. Scroll down to find the negative keywords section below the main keywords table. Expand the section

by clicking "+".



5. You'll see two tables: "Ad group level" and "Campaign level."

Google AdWords

6. To add negative keywords to an ad group, click the + Add button in the "Ad group level" table. To add
negative keywords to a campaign, click the Add button in the "Campaign level" table.

7. Add your negative keywords, one per line. There's no need to include a negative sign (-) before each
keyword. If you add broad-matched negative keywords, you'll need to add their plural versions, such
as "wines." To add a negative phrase-matched keyword, surround the term with quotation marks. To
add a negative exact-matched keyword, surround the term with brackets. Learn more about using

negative keywords with match types.

Note



Make sure that your negative keywords don't overlap with your regular keywords, because this will

cause your ad not to show.

8. Click Save.

Edit, delete, or download negative keywords ("Search Network only" or "Search & Display Networks"

campaigns)

Once you add negative keywords to your campaigns, you can edit, delete, or download them.
To get started, follow these steps:

1. Select the campaign or the ad group that includes the negative keywords you'd like to edit, delete, or
download.

2. Select the Keywords tab.

3. Scroll down to find the negative keywords section below the main keywords table. Expand the section

by clicking the +Negative keywords link.



Follow these steps to edit your negative keywords:

1. Select the checkboxes next to the negative keywords you'd like edit.
2. Click Edit in the "Ad group level" table or the "Campaign level" table. Make your changes to each
individual negative keyword in the boxes that appear. Select a match type from the drop-down menu to

change each negative keyword's match type.



3. Click Save.
Follow these steps to delete your negative keywords:

1. Select the checkboxes next to the negative keywords you'd like to delete.

2. Click Delete in the "Ad group level" table or the "Campaign level" table.

Follow these steps to download your negative keywords:



1. Select the checkboxes next to the negative keywords you'd like to download.

2. Click Download in the "Ad group level" table or the "Campaign level" table.

3. You'll see a "Download and schedule report" section. Enter a name for your report in the "Report name"
box. Select a format for your file from the "Format" drop-down menu.

4. Click Create.

Exclude keywords ("Display Network only" campaigns)

You can limit the visibility of your ads on the Google Display Network by excluding keywords. When you
exclude keywords from your campaign or ad group, AdWords avoids showing your ads on Display Network
sites that contain those terms.

Your negative keywords don’t have to be comprehensive. For example, to prevent ads from showing on
placements about wine glasses, adding the negative keyword -wine should do the trick. An exception to this
is compound keywords, like “baby spinach.” If you were to just use the negative keyword —-baby, your ad
might still appear on pages that contain the term “baby spinach” because the meaning changes when

“baby” and “spinach” are combined.

If you exclude keywords from an ad group with placements, your ads will be less likely to appear on
placements about the excluded keywords that you've selected. However, excluded keywords aren't as
precise on the Display Network as they are on search, so your ad may still occasionally appear on pages

containing these terms depending on the other keywords in your ad group.



Example

Let's say you select five different shopping websites as placements, then add the negative
keyword -wine to the ad group. Your ad may appear on any of the five websites, but it will be

less likely to appear on pages of those websites that are about wine glasses.

Here's how to exclude keywords:

Sign in to your AdWords account at https://adwords.google.com [ .

Click the campaign or the ad group that you'd like to exclude keywords from.

Click the Display Network tab.

Click the Exclusions link below the statistics tabel. You might need to scroll down to find it.
Click the Keywords tab.

You'll see two tables: "Ad group level" and "Campaign level."
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To exclude keywords from an ad group, click the Add exclusions button in the "Ad group level" table.
To exclude keywords from a campaign, click the Add exclusions button in the "Campaign level" table.
8. Add your keywords, one per line.

Note

Make sure that your excluded keywords don't overlap with your regular keywords, because this will
cause your ad not to show.

9. Click Save.

Tip

Try excluding sites or categories to limit the visibility of your ads.

Get negative keyword ideas

You can run a search terms report to get negative keyword ideas. The search terms report will show you
every search that resulted in your ad being triggered and clicked.

Here's how to run a search terms report:

Sign in to your AdWords account at https://adwords.google.com £ .
Click the campaign or the ad group that you'd like to get negative keyword ideas for.
Click the Keywords tab.

E

Select the checkboxes next to the keywords that you'd like to run a search terms report for, or you can



run a search terms report for all of your keywords. It's best to set the date range menu in the top corner
of the page to the "Last 14 days" or "Last 30 days." That way, you should get enough information to
help you choose ideas.

5. Click the Keyword details button. Click Selected to generate the report for the keywords with marked

checkboxes. Otherwise, select All to generate the report for all the keywords listed.

6. A list of search terms will appear on the page. Check the boxes next to the keywords that you'd like to

add as negative keywords, and click the Add as negative keyword button.

Note

Make sure that your negative keywords don't overlap with your regular keywords, because this will

cause your ad not to show.

7. You can choose to add the negative keywords at the ad group level, or at the campaign level.
8. Click Save.



Keep in mind

¢ Choose your negative keywords carefully. If you use too many negative keywords, then your ads might reach
fewer customers.

¢ Your ads still might show on searches and pages that contain variations of the terms that you select as
negative keywords. Your ads might still show on searches that contain only one of your negative keyword
terms if your keyword terms are more than one word. Let's say you add the negative keyword "wine bottle."

Your ad might still show for searches and pages that contain "stemless wine glasses," "red wine," or "glass

bottle." However, you ad wouldn't show for searches on "red wine bottle," "wine bottle opener," or "bottle
opener for wine."

¢ We still might show your ad when someone searches for a phrase that's longer than 10 words and your
negative keyword follows that 10th word. Let's say your negative keyword is "discount." Your ad can show
when someone searches for "nice clean hotel rooms in Los Angeles close to beach discount" because your
negative keyword is the 11th word in the phrase. On the other hand, we won't show your ad when someone
searches for "nice clean hotel rooms in Los Angeles beach views discount" because your negative keyword is

the 10th word in the phrase.
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Target ads to geographic locations

» AdWords location targeting allows your ads to appear in the geographic locations that you choose:
countries, areas within a country, or a radius around a location.

» Location targeting helps you focus your advertising on the areas where you'll find the right customers,
and restrict it in areas where you don't -- which could help increase your return on investment (ROI)
as a result.

When it comes to advertising on AdWords, consider the real estate adage: "Location, location, location!"
Regardless of how great your ad is, it probably won't perform as well if it doesn't appear in the right places. Reach
your customers where they are and where your business can serve them by using AdWords location targeting. You
can set and then adjust your location targeting settings at any time.

Targeting the right locations for your business

Get guidance on choosing the location targets that are most appropriate for your business.

— | Compare location target types: countries, areas within a country, or radius

See more details below about each location targeting level and the types of businesses that could be a good

fit.
Location Description Types of businesses that Types of businesses that
target could benefit might not benefit
Countries Targeting your ads to a A business that doesn't
. ¢ A national business . .
country or multiple serve all regions or cities.
. serving an entire . .
countries can be a good In this case, you might
. . . country R .
idea if you provide target individual regions or
. e An online retailer e
products and services to cities instead.

hippi ldwid
those large areas. Shipping worldwide

. . . e An international
Targeting entire countries

. business selling to
allows you to receive more

several countries
ad exposure than you



Areas Consider using more A business that is trying to
- . . A business that serves )
within a precise targeting if your reach most of the regions
. , a local neighborhood . s
country business doesn't serve all in a country, with just a
. . , A business with .

regions or cities, or you'd few exceptions (say, all of

. special offers in

like to focus your P the U.S. except for Alaska).

. selected locations . N
advertising efforts on In this case, it might be
. L A business sellin
certain areas within a 9 better to target the whole
. products in selected
country. Depending on the country, and then exclude
regions or cities

country, you can target the other areas.

regions, cities, or postal

codes.
Radius Radius targeting (also A business that only wants

o A business that -
around a known as proximity to reach specific cities,
. . " delivers within a . )

location targeting or "Target a regions, or countries.

would by targeting a few
individual cities or regions

within a country.

radius") allows you to
choose to show your ads
to customers within a
certain distance from your
business, rather than
choosing individual cities,

regions, or countries.

selected radius

A local business
whose customer base
is within a radius

around the business

— | Tips for choosing the right locations for your business

What to consider when choosing your location targets:

¢ Be sure to target the locations where your customers are -- which isn't necessarily the same place that
your business is located. For example, if you own an e-commerce company, target all the locations you
ship to, not just where your business is physically located.

¢ If you target an area that your business isn't located, you won't be able to see your ad when you search
on Google.com. However, you can use the Ad Preview Tool to find your ad.

¢ It's also a good idea to keep your language and location targeting settings consistent. For example, if
you're targeting English-speaking users in England, remember to target the English language, and be

sure that your ads are written in English.



| Example

Adrian wants to advertise his hotel in Spain to English-speaking customers who live in England.

He targets his ads to England and writes his ads in English.

Set up location targeting

Video: How to set location targeting

Watch the video for step-by-step instructions to set up location targeting.

Click an option below for location targeting instructions. Keep in mind that available location target types vary by

country.

Suggested time for task: 5-7 minutes

— | How to target entire countries

Sign in to your AdWords account at http://adwords.google.com £ .
Click the Campaigns tab.

Click the name of the campaign that you'd like to edit.

Click the Settings tab.

a M 0D o=

Click Edit next to Locations.
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8. Click Save to save your settings.

‘= How to target areas within a country

Sign in to your AdWords account at http://adwords.google.com £ .
Click the Campaigns tab.

Click the name of the campaign that you'd like to edit.

Click the Settings tab.

Click Edit next to Locations.

o M b =
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6. Enter the postal code or name of the location that you'd like to target. If you're entering a city name, add
the country name as well. You don't want to target Paris, France, if you're trying to sell cowboy hats to

customers in Paris, Texas.
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7. Click Add to add the location.
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8. Click Save to save your settings.

How to target a radius around a location

Selecting a radius

When you target a radius, we'll show a list of locations that are contained within the radius, also known as
"Locations within this target". It's a good idea to review these locations to make sure that you've captured
the areas that you expected. You'll also have the option to refine your targeting by individually selecting
cities or regions within the radius.

Sign in to your AdWords account at http://adwords.google.com £ .
Click the Campaigns tab.

Click the name of the campaign you wish to edit.

Click the Settings tab.

Click Edit next to "Locations" and click Advanced search.

o o » w0 =

Click Radius targeting.



7. In the search box, enter the address of the location you'd like to use for the center of the radius. Enter

the radius that you'd like to target and select a unit of measurement from the drop-down menu.

8. Click Search to locate the radius on the map.



9. Check the map to make sure you're targeting the correct area. When you're ready, click Add to add the
radius target. You can also select Add all to add all of the individual locations within the radius that
you've selected instead of adding the radius target. If you want to refine the list of areas that you'd like
to reach, you can target only certain locations or exclude some locations from the Locations within this
target list. In some instances, we won't be able to show reach for an area that is too small or because

there isn't enough data for the location.

10. Click Done at the bottom of the window.

11. Click Save to save your settings.



— | Airport location targeting

You also have the ability to target potential customers in more than 350 airports around the world, so you
can reach travelers who are interested in the products and services that you offer. You'll be able to show
your ads to customers in airports on their mobile or tablet devices, or when they indicate their location of
interest as an airport on their desktop devices. Airport targeting is available for locations where we have

high-quality data. Not all airports may be included at this time, but they may be included in the future.

To target an airport, enter the airport code or the full airport name along with the name of the country (e.g.
San Francisco International Airport, United States). See the full list of airports that you can target in AdWords

(select "Airport" as the Target Type).

= About the provided location targeting suggestions

You may have noticed that when you edit your location targeting settings, AdWords suggests other locations
that you might want to target. You can review these suggestions to see if they make sense for your ad

campaign.
Available location targeting suggestions:

¢ Locations that enclose: Enclosing locations are larger areas that contain the location you've selected.
You might consider adding this larger enclosing location if you want to reach a larger audience.

¢ Related locations: Related locations may be near the location that you've entered, have a similar name,
or enclose a location that has a similar name. Related locations can be added to or excluded from your
campaigns.

¢ Nearby locations: Next to the name of a location, you may also see a Nearby link. Nearby locations
are, as you might have guessed, locations that are nearby that you may also consider adding to or

excluding from your campaigns.

Advanced: Targeting multiple locations in bulk

AdWords allows you to add a bulk list of up to 1000 location targets at a time, rather than adding each location

one-by-one. We also offer tools for bulk editing. Click an option below to find out more.



= How to add multiple location targets in bulk

Sign in to your AdWords account at http://adwords.google.com £ .
Click the Campaigns tab.

Click the name of the campaign you wish to edit.

Click the Settings tab.

Click Edit next to "Locations" and click Advanced search.

Click Bulk locations.

N o o s~ Db =

In the box, paste or type the names of up to 1000 locations that you'd like to target, and add locations
from one country at a time. See the list of locations that can be targeted.

o To target more than 1000 locations, you can add location targets in bulk multiple times. For
example, if you'd like to target 1200 locations, add your first 1000 location targets. When you're

done, add the remaining 200 locations.

o To target a city or zip code, include the full name of the country or state as well -- for example,
Oxford, England or 941083, California.

8. Select the country code for this set of locations.
9. Once you've entered your locations, click Search.
10. We'll display all locations that matched your search in the review panel. Review your results, then click

Add all matched locations to target all of the locations that matched your search.

o If you searched for any location targets that weren't found, you'll find them in the box where you
entered the list of locations.

o Selecting Remove all matched locations will remove all locations from the review panel, as well as

from your existing location targets or location exclusions.

11. Under the section "Selected locations"”, you'll see the location targets that you've just added.
12. Click Done.

13. Once you've confirmed your changes, click Save on the Settings tab.

= | Other bulk editing options

¢ AdWords Editor: Our free, downloadable application for managing your AdWords advertising
campaigns offline. Find out how to make bulk changes to location targets in AdWords Editor.

¢ AdWords API: Our AdWords API allows developers to build applications that interact directly with the



AdWords platform. Find out more about AdWords API geo targeting options.

See location target limits for your campaign.



How ads are matched to geographic
locations

AdWords allows you to target customers in the geographic locations that you've chosen, so your ads can

appear in the country, region, or city where you do business. Several factors are considered when

determining where your ad can appear, including search terms, physical location of the searcher, and the

domain being viewed.

= | Geographic targeting on desktop

If your ads are targeted by geographic location, AdWords reviews several different conditions to determine

whether to show your ad:

Location of interest
If we detect geographic areas that someone is interested in, we may show appropriate ads targeted to
those areas, even if the searcher isn't physically located in the location. We may detect a location of

interest if someone takes any of the following actions:

o Includes the name of a recognizable location in her search
o Searches within an area of the map on Google Maps

o Sets a custom location for Google search results

On the Search Network, location-specific terms in customers' searches will take precedence over other
factors when determining where to show your geographically-targeted ad. You can choose whether or

not to target by location of interest in your advanced location options.

Location of interest works only if the location in the search is in the same country where the searcher is
physically located. If you searched for France hotel while located in the United States, you won't see
ads targeted to France even though your search showed interest in France. (You could still see ads for

French hotels that are targeted to the United States, though!)

However, say you're in the United States and search for France hotel on google.fr, the French domain.

We'll identify your location as France because of the domain, and you'll be able to see ads targeted to



France.

Example

Matt is located in California and searches for New York restaurant on www.google.com. He

sees ads targeted to customers in New York because he included New York in his search.

However, if Matt decides to use google.fr to do his search, his location will be identified as

France. He won't be able to see ads that are targeted to New York.

¢ Google domain
Google domains in each country have a unique URL that helps us determine searchers' locations.

¢ Physical location (IP address)
When possible, we determine general physical location based on someone's computer or device
location. That location is usually based on the computer's Internet Protocol (IP) address, which is a
unique number assigned by Internet Service Providers to each computer connected to the Internet. On
the Display Network, we may also use customers' previously detected geographic locations.

* Google profiles
Ads on the Google Display Network may also be targeted using the declared location in customers'
Google profiles, but only when they're signed in to their Google account. If the location on a customer's
Google profile is different than the location determined from her IP address, the customer is eligible to

see ads targeted to both locations.

Geographic targeting on high-end mobile devices

You can also target ads by geographic location on high-end mobile devices, which are mobile devices with

full Internet browsers. AdWords reviews several different conditions to determine whether to show your ad:

¢ Location of interest
If we detect geographic areas that someone is interested in, we may show appropriate ads targeted to
those areas, even if she isn't physically located in the location. We may detect a location of interest if

she does any of the following:

o Includes the name of a recognizable location in her search

o Searches within an area of the map on Google Maps for Mobile

Location-specific terms will take precedence over other factors when determining where to show your

geographically-targeted ad.

¢ Device location

If My Location is enabled, we can get more precise information about searchers' locations when they



use Google. We choose the most accurate source from various methods of detecting device location:

o GPS: Accuracy varies depending on GPS signal and connection.

o Wi-Fi: Accuracy should be similar to the access range of a typical Wi-Fi router.

o Google's cell ID (cell tower) location database: Used in the absence of Wi-Fi or GPS. Accuracy is
dependent on how many cell towers are located within an area and available data, and some
devices don't support cell ID location.

* Physical location (IP address)
If connected to a Wi-Fi network, we may detect the mobile device's IP address to determine physical
location. If the mobile device is connected to a mobile carrier's proxy server, we'll use the carrier IP to
determine the device's location.

¢ Google Search history
Based on the location obtained from a searcher's last few queries, we may estimate her approximate

physical location and serve relevant ads.

Related cities

When you target a city, we may also show your ad to customers in nearby, closely related cities that
normally couldn't be targeted because of low population, insufficient data about the geographic area, or
because city-level targeting isn't available. For example, if you target the city of Portland, we may also show
your ads to searchers in nearby suburbs of Portland.

Ads on Google.cn and Google.com.hk

Location targeting works differently for users who search on google.cn and google.com.hk:

e Users in Hong Kong who search on either google.cn or google.com.hk will see ads targeted to Hong
Kong.

¢ Users outside of Hong Kong who search on either google.cn or google.com.hk will see ads targeted to
China.



Exclude IP addresses

Getting unwanted clicks that are costing you? You can take your ads off certain neighborhoods of the
Internet map, so to speak, by excluding computer or network IP addresses from the Settings tab.

The Settings tab lets you exclude Internet Protocol (IP) addresses by campaign so that all ads in that campaign

are blocked from computers and networks associated with those addresses.

Tip
Are you trying to prevent your ads from showing in certain geographical locations? Try excluding ads

from a geographic location instead of excluding IP addresses.

Why exclude by IP address
Here are some reasons you'd want to exclude by IP address:

¢ Take advantage of the advanced exclusion controls that AdWords provides.
¢ Exclude your competitors' IP addresses.

¢ Limit unwanted impressions and clicks from your company's network.

Example

People working at your company regularly check your website's organic search results, where your
ads sometimes show. Since unwanted ad impressions and inadvertent clicks are costly, you decide to

exclude your company's network IP address.

Keep in mind

To exclude IP addresses, you'll need to use one of the following campaign types:

e "Search & Display Networks - All features"
e "Search Network only — All features"

¢ "Display Network only — All features"

e "Display Network only — Remarketing"



If you have a different campaign type from the ones listed above, you won't be able to exclude IP addresses.
Learn about AdWords campaign types.

How to exclude IP addresses

Here's how to block your ads from showing to certain IP addresses:

1. Sign in to your AdWords account at https://adwords.google.com £ .

2. Under the main Campaigns tab, click the Settings tab.

3. Click the campaign you'd like to exclude IP addresses from.
4. Scroll down to the Advanced settings section, and click the IP exclusions link.

5. Click Edit next to "Manage IP exclusions."



Google AdWords

6. In the box that opens, enter the list of IP addresses you want to exclude. Type just one IP address per line, up

to 500 addresses per campaign.

7. Click Save.

If you'd like to view or edit the IP address you've excluded for a campaign, return to the Settings tab.
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Enhanced cost-per-click (ECPC)

Enhanced cost-per-click (ECPC) is a bidding feature that raises your bid for clicks that seem more likely to
lead to a sale or conversion on your website. That helps you get more value from your ad budget.

Imagine that your job is to stand outside a barber shop and bring in new customers. If a businessman with shaggy

hair comes walking by, you give him a big wave and a hello. If a bald man walks by, not so much.

ECPC does a similar job for your AdWords ads. It's a bidding feature that looks for ad auctions that are more likely
to lead to sales for you, and then raises your max CPC bid up to 30 percent to compete harder for those clicks.
When it sees auctions that don't look promising, it lowers your bid. That way you can get more sales and

conversions out of the ad dollars you spend.

ECPC works on Google, the Search Network, and the Display Network, but isn't available for the "Display Network
only - Mobile Apps" campaign type.

Example
Suppose you sell shoes on your site, and you've set your max CPC for US$1, and you have ECPC

bidding turned on. If the AdWords system sees an auction that looks likely to lead someone to buy
shoes on your site, it might set your bid as high as US$1.30 for that auction (that is, your US$1 max
CPC bid plus 30 percent more).

]

Enhanced CPC

Learn about Enhanced CPC, an automatic AdWords bid management feature designed to increase your

conversions while lowering your costs.

Tip



Save time and effort on managing your bids by trying ECPC bidding as a flexible bid strategy. You'll
be able to apply ECPC bid optimization more strategically to entire campaigns or specific ad groups of

your choice. How to use flexible bid strategies.

How does ECPC know which auctions are promising?

The AdWords system looks for patterns of clicks and conversions and compares them to your past results. If
certain search or keyword combinations lead to more sales, for instance, it will know. That's why, to use ECPC you

have to have conversion tracking turned on, because that's where the data comes from.

ECPC will increase your max CPC bid by up to 30 percent when it sees a good opportunity. It'll also lower your
max CPC by any amount (even more than 30 percent) if it determines a conversion isn't likely, so you'll pay less for
clicks that convert less. If you choose the conversion bid metric that matters most to you on your conversion
settings page, ECPC will focus on either Conversions (one-per-click) or Conversions (many-per-click). If you care
about maximizing sales and track each sale as a conversion, you might choose many-per-click conversions. For

leads, such as a sign-up, you might pick one-per-click.

Tip
Because ECPC will increase your max CPC bid by up to 30 percent when it sees a good opportunity,

don't be surprised if your AdWords report shows average CPCs that are over your max CPC.

How will I know ECPC is helping me?

ECPC double-checks itself by leaving part of your traffic alone to work with your regular max CPC bids. Then it
compares the two sets of results and adjusts accordingly. So when you choose ECPC, you should see conversion

results that are better than, or at least the same as, the results you get without it.

How is ECPC different from Conversion Optimizer?

Both ECPC and Conversion Optimizer work to get you more conversions. The key difference: ECPC works with
the max CPC bid you set, never going more than 30 percent over it. Conversion Optimizer needs no max CPC,

though it does require a CPA bid.

Conversion Optimizer gives you the very best chance to improve your results, but ECPC provides a level of control

and comfort that some people prefer.

Both ECPC and Conversion Optimizer

¢ Use conversion tracking or Google Analytics data from your account
+ Predict a conversion rate for each auction

¢ Adjust your bids to help you win the most promising clicks



ECPC

¢ Works with all your campaign settings and max CPC bids
¢ Can raise bids by up to 30 percent
¢ Works with third-party bidding systems

Conversion Optimizer

e Lets you set either a target CPA or max CPA
¢ Has full freedom to set your CPC bid for each auction
¢ May not work with some API-based bid management solutions

Tip

If your campaign doesn't have conversion tracking turned on, opting into ECPC will have no impact on
your bids.

How to turn on ECPC

Sign in to your AdWords account at https://adwords.google.com [&

From your Campaigns tab, click the name of the campaign you want to work with.
Click the Settings tab.

Find the Bidding and budget section. Next to "Bidding Options," click Edit.

o > 0=

Find Enhanced CPC, and check the box reading "Use my conversion tracking data and bids to optimize for
conversions."

When you choose ECPC, we'll automatically set your ad rotation settings to "optimize for conversions," even if
it's currently set to "optimize for clicks."

Remember that you also must have conversion tracking enabled for ECPC to work.



About Conversion Optimizer

» The goal of Conversion Optimizer is to get you the most conversions given your cost-per-acquisition
(CPA) goals. Rather than focusing on clicks (CPC) or impressions (CPM), Conversion Optimizer
focuses on maximizing conversions.

» With Conversion Optimizer, you can set either a maximum cost-per-acquisition (max. CPA), which is
the most you're willing to pay for each conversion, or a target cost-per-acquisition (target CPA), which
is the average amount you'd like to pay for a conversion.

« Conversion Optimizer will focus either on Conversions (one-per-click) or Conversions (many-per-click)
depending on the bid metrics that you choose on your conversion settings page.

How Conversion Optimizer works

Using historical information about your campaign, Conversion Optimizer automatically finds the optimal equivalent
CPC bid for your ad each time it's eligible to appear. You still pay per click, but you no longer need to adjust your

bids manually to reach your conversion goals.

| Example

Angela sells new and vintage concert T-shirts online. She had been successfully using contextual
targeting to reach potential customers while they spend time on music blogs and read online
entertainment magazines, but she thought there was still room for improvement. So she decided to try
Conversion Optimizer.

Angela knew that, on average, she'd like to pay $5.00 for a conversion on her site, so she set this as
her target CPA bid and then let Conversion Optimizer do the rest. A few weeks later, Angela checked
in on her campaign's performance. She was pleased to discover that her conversion rate improved by
more than 0.5%!

Here are some examples of likely ways Conversion Optimizer accomplished this increase:

e It found that, over time, a blog about '80's bands drove conversions at a high cost by sending Angela
many clicks that weren't translating into conversions. Bid levels for this site were automatically
lowered until Angela's ads stopped appearing on this website, thus freeing up budget for higher
performing websites.

¢ [t found that, across the board, Angela's ads received clicks at lower costs on sites with a heavy



metal band theme. However, clicks from visitors to these websites resulted in a high percentage of
conversions. So, Conversion Optimizer made sure to bid successfully on even more Display Network

sites related to heavy metal bands.

= About recommended bids

Conversion Optimizer provides you with a recommended max. CPA bid and a recommended target CPA bid
to help get you started. It's best to use one of these recommended bids when you start out because these
bids are calculated to help ensure a smooth transition to your new bidding mode. From this starting point,

you can observe your performance and adjust your bid accordingly.

As with CPC bidding, the CPA bid you set is your primary control over how many conversions you'll get and
how much you'll pay for them. You can raise your CPA bid if you want to increase traffic and conversions. If
your average CPA is higher than you prefer, you can lower your bid, which will likely decrease both average

CPA and the number of conversions. Learn how to adjust your CPA bid

— | Requirements for Conversion Optimizer

You'll need to meet the following requirements in order to begin using Conversion Optimizer:

¢ Your campaign uses AdWords Conversion Tracking or cross-account conversion tracking, or is importing
data from Google Analytics [ .

¢ The campaign has received at least 15 conversions in the last 30 days. This conversion history enables
the system to make accurate predictions about your future conversion rate. So, the more data we have,
the more accurate we can be.

¢ The campaign must have been receiving conversions at a similar rate for at least a few days.

At this time, the following AdWords features aren't compatible with Conversion Optimizer:

e Separate Display Network bids. Conversion Optimizer automatically optimizes your bids across the
Search and Display Networks.

e All types of bid adjustments, except mobile device bid adjustments of -100%. Conversion Optimizer
automatically accounts for differences in conversion rates across devices, days, times, and locations.
Because bid adjustments are already built into the technology that Conversion Optimizer uses, it’s not
necessary to set separate adjustments. If you've set bid adjustments for campaigns using Conversion

Optimizer, they won't be applied to your bids - which means you don't need to remove them.



— Increase your campaign's conversions

Here are some ideas for increasing the number of conversions in your campaign:

¢ If you're willing to spend more on your advertising, and you're currently hitting your budget on a regular
basis, you can increase your budget.

¢ If you're willing to spend more on your advertising, but you're not hitting your budget, you can increase
your CPC bids for the ad groups in the affected campaign. Higher bids help increase your Ad Rank,
which leads to greater visibility for your ad. With more visibility, you're likely to get more clicks that lead
to conversions.

¢ If you prefer to keep your costs the same, consider moving the conversion tracking code on your
website. For example, Jean runs an insurance website. Her tracking code is on the page a customer
reaches after signing up for an insurance policy. She decides to move the tracking code to the page that
provides insurance quotes. The conversion data from this page is still meaningful for her business, and
her conversions increase because more customers reach this page than the "Thank you" page. Note: If
you move your conversion tracking code, be sure to wait two weeks before turning on Conversion
Optimizer to allow the system time to adjust.

e Combine your campaign with another campaign for a related product that has a similar conversion rate.
You can use AdWords Editor to copy and paste ad groups between campaigns. Note: If you make this
kind of major change to your campaigns, be sure to wait two weeks before turning on Conversion
Optimizer to allow the system time to adjust.

¢ Opt in to the Google Display Network.

e Add more relevant keywords to your ad groups.

¢ Change your ads or landing page to try to increase your clickthrough rate (CTR) or conversion rate.
In addition, the following campaign characteristics can help increase conversions:

e The campaign is direct-response oriented. For example, the campaign focuses on generating sales on
an e-commerce website.

e The campaign has a well-defined conversion type, such as a completed purchase or signup.

e The campaign has a relatively stable conversion rate, with no major changes (such as redefining the

conversion event or moving the conversion tracking code) within the last two weeks.

= | Tips for Conversion Optimizer success

1. Set either a max. CPA or target CPA bid based on which metric is most familiar to you.
2. Raise your max. or target CPA bid ito increase traffic and conversions. Lower your max. or target CPA
bid if you want to lower your average CPA. Traffic will likely decrease.

3. Start with the recommended CPA bid and modify your bids often to find what's right for you.



10.

Use Conversion Optimizer with existing campaigns. The longer a campaign has used conversion
tracking and the more conversions it's received in the past 30 days, the more data that Conversion
Optimizer can draw upon to make predictions.

Keep in mind that changes in ad performance are natural, and you may need to use Conversion
Optimizer for some time to get an accurate understanding of its effects on your campaign's
performance.

Don't make huge changes to a campaign while running Conversion Optimizer (example: deleting all ad
groups and replacing them with new ones). Do make small changes to your campaign that fit your
business needs (examples: adding/deleting keywords, changing creative, changing landing page).

Don't remove your conversion tracking code from your website or move it to a different location while
running Conversion Optimizer. Doing either of these could result in significant changes in which clicks
lead to reported conversions. As a result, Conversion Optimizer may need up to several weeks to adjust
to these changes.

Compare your CPA and conversion rate before and after using Conversion Optimizer to gauge its impact
on your campaign.

Remember, you can always turn off Conversion Optimizer, and your campaign will revert to the previous
CPC bids you were using.

If you're consistently hitting your budget, increase it to allow more visibility for your ads.

Using Conversion Optimizer effectively for mobile app campaigns

If you're running a campaign to promote mobile app downloads, Conversion Optimizer can help you get the

most downloads for your budget. Here are some suggestions to setting up your campaign:

1.

4.

When you launch your mobile app promotion campaign, avoid overly restrictive campaign settings (too
much location targeting, for example) that could reduce your traffic.

Keep track of your performance over the first two weeks, then exclude sites and categories that aren't
reaching your goals.

Once you've optimized your campaign and reached a sustainable CPA, begin using Conversion
Optimizer, and set a target CPA that's consistent with your performance to date. Note that download
conversion tracking is only available for advertisers promoting Android apps and for existing users of
the AdMob iOS translation service.

Use these targeting methods to further refine your traffic:

o Target new devices

o Add interest categories to your ad groups to reach people interested in products and services
similar to those your business offers

o Use advanced ad scheduling with bid adjustments for specific days of the week and hours of day



— | Changes in traffic or conversion rate

Changes in traffic

If you notice a drop in traffic (clicks and conversions) after turning on Conversion Optimizer, there could be a

few things going on:

¢ Your CPA bid might be too low. If you're using a target CPA bid, compare your bid to the historical
average CPA of your campaign. If your bid is significantly below your historical average CPA, your target
CPA may not be attainable while maintaining reasonable levels of traffic, and you should consider
raising your bid.

¢ Instead of conversions, you may be looking at clicks or impressions. Because Conversion Optimizer
aims to get you more conversions by avoiding traffic that doesn't result in conversions, you may see a
decrease in impressions or clicks while increasing the number of conversions.

¢ Conversion Tracking is disabled. If you delete conversions that you're tracking, then the ads in
campaigns using Conversion Optimizer will stop running. To start showing your ads again, you'll need to
enable Conversion Tracking or switch to manual bidding.

e Your ad group is missing a CPA bid. If your ad group doesn't have a CPA bid, then the ads in this ad
group will stop showing while in Conversion Optimizer. To start showing your ads again, you'll need to

set an ad group CPA bid or switch to manual bidding.
Changes in conversion rate

It's possible to see a drop in conversion rate when you start using Conversion Optimizer. This change may
occur because you're observing an average of the conversion rate across all clicks. For example, suppose
Conversion Optimizer causes your campaign to have an increase in very cheap clicks with slightly lower
conversion rates. If there were no other changes in your campaign, this change in conversion rate would
appear as a decrease. However, the change in cost could have a very positive effect on your campaign's
ROL.

Example

Let’s say you used to get one conversion out of every 10 clicks from a specific website, and
each click cost $1. This would mean you have a 10% conversion rate with a total cost of $10
per conversion. Then, let's say Conversion Optimizer changed your bids so you advertised on a
website where you paid $0.10 per click, but only one in 50 people converted from these. Your

conversion rate would drop to just 2%, but your cost per conversion would also drop to just $5.

L I Did you know...



Conversion Optimizer looks at all Conversion (AdWords) and/or imported Goal Tracking data (Google

Analytics), but it weighs recent data more heavily.



Set up Conversion Optimizer

» Conversion Optimizer uses your Conversion Tracking, cross-account Conversion Tracking, or Google
Analytics data to get you more conversions at a lower cost.

» By optimizing your placement in each ad auction, Conversion Optimizer helps you avoid unprofitable
clicks and gets you as many profitable clicks as possible.

» Conversion Optimizer also makes managing your AdWords bidding a lot easier while maximizing
results.

Getting started with Conversion Optimizer

Before setting up Conversion Optimizer, first make sure you're already importing your conversion data into your
AdWords account either by enabling Conversion Tracking or cross-account conversion tracking, or by importing

your goals and transactions data from Google Analytics [£ .

Your campaign must have received at least 15 conversions in the last 30 days, and must have been receiving
conversions at a similar rate for at least a few days. For best results, we recommend you run Conversion Tracking

for at least two weeks before trying Conversion Optimizer -- longer if you don't have a high volume of conversions.

— | How to enable Conversion Optimizer if using manual bidding

Sign in to your AdWords account at https://adwords.google.com [ .
Select the Campaigns tab.

Select the campaign name.

Select the Settings tab.

Next to "Bid strategy," click Edit.

o » w0
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6. Click the "Focus on Conversions" (Conversion Optimizer) radio button.

7. Under Advanced Options, select either max. CPA or target CPA, and select either "Start with

recommended bid" or select and set a custom bid. For campaigns that promote mobile app downloads,



you can only set a target CPA.

8. Click Save to finish.

— | How to enable Conversion Optimizer if using automatic bidding

Sign in to your AdWords account at https://adwords.google.com £ .
Select the Campaigns tab.

Select the campaign name.

Select the Settings tab.

Next to "Bid strategy," click Edit.

Select the radio button next to "I'll manually set my bid for clicks."
Click Save.

Next to "Bid strategy," click Edit again.

Click the "Focus on Conversions" (Conversion Optimizer) radio button.
Click Save to finish.

© © ©® N o o M Db =
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— | How to disable Conversion Optimizer



Sign in to your AdWords account at https://adwords.google.com £ .
Select the Campaigns tab.

Select the campaign name.

Select the Settings tab.

Next to "Bid strategy," click Edit.

Select the radio button next to your new bidding choice.

Click Save to finish.

N o o s~ Db =

Note

If you disable Conversion Tracking by deleting the conversions that you're tracking, then the ads in
campaigns using Conversion Optimizer will stop running. To start showing your ads again, you'll need to

enable Conversion Tracking or switch to manual bidding.

How to toggle Conversion Optimizer and Enhanced CPC between many-per-click conversions and one-per-
click conversions

You can set Conversion Optimizer and Enhanced CPC to focus on either Conversions (one-per-click) or
Conversions (many-per-click) by choosing a conversion bid metric on the Settings tab for all your

conversions. If you don’t make a selection, Conversion Optimizer will focus on conversions.

You may need to update your bids if you change your conversion bid metric. For example, let’s say a click
results in two sales on average, and you want to pay a $10 average per sale. If you pick Conversions (1-per-
click), you might set a target CPA of $20 per unique bid. If you pick Conversions (many-per-click), you might
set a target CPA of $10. In this example, you should use the second option to set a bid that meets your

business goals and to focus Conversion Optimizer on maximizing the types of sales that matter to you most.

If you change your conversion bid metric, don’t forget to update your conversions columns to view the right
data. For example, if you set your conversion bid metric to Conversions (many-per-click), you should enable
the Conversions (many-per-click) columns to view performance.

How to set up Conversion Optimizer for multiple conversion types and values in a single campaign

Here are some examples of how to handle more complex situations:
More than one conversion type

It's possible that in one of your campaigns you have one conversion type that happens much more

frequently than others. For example, suppose 10% of your online visitors sign up for a mailing list, and your



CPA for this conversion is $2. In addition, 20% of those visitors also make a purchase, for which your CPA is
$10. Conversion Optimizer only considers the first conversion (the signup). To optimize both for the signups
and purchases, set a maximum cost-per-acquisition (CPA) bid that's primarily based on the value of the

signups, plus a slight increase for the purchases. Here's how it works:

Conversion type: Signup

Conversion rate: 10%

Maximum CPA: $2

Conversion type: Purchase

Conversion rate: 20% of the 10% above
Maximum CPA: $10

$2 + (20% of $10) = $4 = your maximum CPA bid

Different CPA values for different products

You have one conversion type (such as purchases), but different CPA values for different products. Your

maximum CPA bid should be the weighted average of these sales. Here's how this works:

Product: Black boots

Percentage of total sales: 75%

Maximum CPA: $20

Product: Purple boots

Percentage of total sales: 25%

Maximum CPA: $50

(75% * 20) + (25% * 50) = $27.50 = your weighted maximum CPA bid

More than one landing page

Your products are mostly on different landing pages. Make sure each product and landing page pair has its

own ad group, and then set a unique maximum CPA bid for each ad group.
Adjustments for seasonal business

Conversion Optimizer can adjust to gradual changes in the conversion rate. However, if your conversion rate
alters dramatically from day to day during a seasonal period, we recommend you monitor performance

closely and adjust your bids accordingly.

For example, a toy manufacturer might experience the following changes during the holiday shopping

season:

¢ More potential customers search for toy-related queries, leading to more ad impressions.
¢ Users are more likely to click on the ads, leading to a higher CTR and more clicks.

e Users who click on the ads are more likely to then make a purchase, leading to a higher conversion rate.



If you're using Conversion Optimizer, it's important to pay attention to the third factor (a sudden increase in
conversion rate). It takes the AdWords system time to learn about and adapt to this kind of change. During a
period following a sudden change in conversion rates, you can compensate by changing your maximum CPA
or target CPA bid. Likewise, you can decrease your maximum CPA or target CPA bid during periods of lower
conversion rates. In comparison, you might do the same thing with a CPC campaign, raising the bids when

conversion rates are higher and lowering the bids when conversion rates drop.

Note: Sudden changes in your conversion rate may cause the AdWords system to over predict the
probability of a conversion and could cause the average CPA to exceed the maximum CPA or target CPA
bid.

Watch this video to learn more about setting up Conversion Optimizer

Conversion Optimizer Tutorial

How you know Conversion Optimizer is working

If you're using Conversion Tracking or have imported your data from Google Analytics, it's likely you're interested in

two metrics:

¢ The number of conversions you get per day

¢ The average cost for each of these conversions (this is your average CPA, or cost-per-acquisition).
Here are three steps for assessing whether Conversion Optimizer is working for you.

Guideline 1: Compare your campaign's conversions and average CPA from before you enabled Conversion
Optimizer to its current performance.

Keep in mind that external factors, such as changes in your competitors' ads, can affect your campaign's key
metrics from week to week. To help determine whether your campaign performance has been affected by changes
you made or by external changes, you might consider comparing changes in the performance of your Conversion
Optimizer campaigns to changes in your other campaigns.

Guideline 2: Look at the performance of your campaign in light of your goals for Conversion Optimizer.
Here are some example goals:

¢ Maintain the same average CPA and get more conversions.



Decrease your average CPA and get more conversions than you would with CPC bidding, given the lower CPA.
¢ Raise your average CPA and get more conversions than you would have while increasing your average CPA the
same amount with CPC bidding.

You can shift your performance according to your primary goal if you're using maximum CPA bids, by raising and
lowering your maximum CPA bid . You can raise your max. CPA bid if you want to increase traffic and conversions.
If your average CPA is higher than you prefer, you can lower your bid, which will likely decrease both average CPA

and the number of conversions.

Guideline 3: Keep in mind that changes in ad performance are natural, and you may need to use the Conversion
Optimizer for some time to get an accurate understanding of its effects on your campaign's performance. For
example, suppose a campaign normally receives 10 conversions per day, and it receives only eight the day after
you start using Conversion Optimizer. This could be part of a normal fluctuation. We recommend watching the
conversion rate for a longer period of time before evaluating whether this is part of a long-term change in campaign
performance.

) Did you know...

If your campaign drops below 15 conversions in 30 days, Conversion Optimizer will remain enabled
unless you turn it off. However, if you choose to disable Conversion Optimizer, you won't be able to

re-enable it until you've reached the requirement.



Troubleshooting for Conversion
Optimizer

You may encounter some of the following problems or limitations when using Conversion Optimizer:

Can't enable Conversion Optimizer:

The Conversion Optimizer relies on historical data collected through AdWords Conversion Tracking, so it isn't
available for new campaigns, campaigns that just started using conversion tracking, or campaigns that have
received fewer than 15 conversions in the last 30 days.

Actual cost-per-acquisition (CPA) exceeding maximum cost-per-acquisition (CPA):

Your actual CPA depends on factors outside of Google's control, so it may exceed the maximum CPA you specify.
The Conversion Optimizer uses historical conversion data to predict the likelihood your ads will convert. However,
your actual conversion rate can be affected by changes to your website and ads, or external factors such as
increased competition. If your actual conversion rate turns out to be lower than the predicted conversion rate, your

actual CPA may exceed your maximum CPA bid.

High average cost-per-acquisition:
If your average CPA is higher than you prefer, you can lower your bid, which will likely decrease both average CPA
and the number of conversions. Conversely, you can raise your maximum CPA bid if you want to increase traffic

and conversions.

Traffic rate decreases after enabling Conversion Optimizer:

If you notice a drop in traffic after turning on the Conversion Optimizer, it's likely the initial maximum CPA bid was
too low. Setting a low maximum CPA bid is equivalent to decreasing the original CPC bids; it can result in lower
position and less traffic on your ads. For this reason, it's best to use the recommended CPA bid provided when
you begin to use the Conversion Optimizer. This bid is calculated to help ensure a smooth transition to your new
bidding mode. Also, since the Conversion Optimizer aims to get you more conversions by avoiding traffic that
doesn't result in conversions, you may see a decrease in impressions or clicks while increasing the number of

conversions.

Conversion rate decreases after enabling Conversion Optimizer:
It's possible to see a drop in conversion rate when you start using Conversion Optimizer because you're observing

an average of the conversion rate across all clicks. For example, suppose the Conversion Optimizer causes your



campaign to have an increase in very cheap clicks with slightly lower conversion rates. If there were no other
changes in your campaign, this change would appear as a decrease. However, the change in cost could have a

very positive effect on your campaign profit.

Compatibility with other AdWords features, the search and Display Network, and third-party ads:

The following AdWords features are not compatible with the Conversion Optimizer:

e Separate Display Network bids (the Conversion Optimizer will automatically optimize your bids across the
search and Display Networks.)
¢ Advanced ad scheduling (basic ad scheduling is supported.)

The Conversion Optimizer does work on the search and Display Networks and with third-party ads. (Note that

AdWords Conversion Tracking is still required in order to use the Conversion Optimizer with third-party ads.)



Using automatic bidding

Automatic bidding allows you to put your bidding on autopilot with the goal of getting the most possible
clicks within your budget. You can also set a cost-per-click bid limit if you don't want to exceed a
particular price for each click. At any time, you can switch to our manual bidding option, which allows you
to choose your own bid amounts instead.

Automatic bidding is the simplest of the AdWords bidding options. You don't need to specify individual bids for
your keywords, ad groups, or placements. Instead, you set a daily budget, and AdWords will help adjust your

cost-per-click (CPC) bids to receive the most possible clicks within your budget.

Automatic bidding is ideal for advertisers who don't want to spend a lot of time setting bids, but would like to get
the most clicks possible for their ads within their budget. If at any time you don't like the bid suggestions, you can

easily switch to using manual bidding which gives you full control to set the bid amounts yourself.

| Example

Liz runs a small travel agency and wants to get people to visit her website. She uses automatic
bidding to help her ads get the maximum amount of clicks within her US$100/day budget, without
managing individual keyword bids.

Tip
Save time and effort on managing your bids by trying Maximize clicks as a flexible bid strategy. You’ll

be able to apply bid optimization more strategically to entire campaigns or specific ad groups and
keywords of your choice. How to use flexible bid strategies.

Set up automatic bidding

How to automatically adjust your bids on AdWords



In this video we'll show you how to automatically adjust your bids by setting up automatic bidding

You can switch to automatic bidding at any time, unless you use the following features:

e "Display Network only - Mobile apps" campaign type
¢ Bid adjustments based on day and time
e Campaigns that use shared budgets

These features are not compatible with automatic bidding.
To set up automatic bidding, simply follow these steps below:

1. Sign in to your AdWords account at https://adwords.google.com £ .
2. In the Campaigns list, click the campaign name.

3. Select the Settings tab.

4. Click Edit next to the bidding option.

Google AdWords

& Campaign: Sweet tea

5. Select "AdWords will set my bids to help maximize clicks within my target budget."



Google Adwords e s

= Campaign: Sweat tea

6. Click Save.

View your automatic bids
To view the automatic bid for your campaign, follow the steps below:

1. Click the Ad groups or Keywords tab.
2. Under the "Default Max. CPC" heading, you'll see the maximum cost-per-click bid that the AdWords system is

using for your campaign, as indicated by the "auto" tag.




CPC bid limits for your campaign

It isn't possible to set individual CPC bids with automatic bidding, but you can set a maximum CPC bid for your
entire campaign. This maximum CPC bid, known as the CPC bid limit, allows you to control the maximum amount
you're willing to pay for each click. For example, if you specify a bid limit of US$1, your CPC bids won't exceed

US$1 for any single click.

If it's important for your business to control the cost of individual clicks on your ad, it's a good idea to specify a
CPC bid limit so you have more control over the cost of each click. Keep in mind, though, that a CPC bid limit can
restrict your ad position or the number of clicks your ads receive.

Example

You sell baseball caps online for US$10. To make a profit, you don't want to pay more than US$1 per
click on your AdWords ads. You set a CPC bid limit of US$1 so your bids won't exceed US$1 when

you use automatic bidding.

If you choose not to set a bid limit, automatic bidding will work as it normally does by automatically choosing the

maximum CPC bids that can allow you to receive the most possible clicks within your budget.

— | Set up CPC bid limits

If you're using automatic bidding and you set a CPC bid limit for your campaign, it will apply to all ad groups

in the campaign.

How to set a CPC bid limit

In this video we'll show you how to add a CPC bid limit to campaigns using automatic bidding

To set a CPC bid limit, follow the steps below:

1. Sign in to your AdWords account.

2. Select campaign that you want to edit.
3. Select the Settings tab.

4. Next to "Bidding option", click Edit.
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5. Enter your bid limit in the field labeled "CPC bid limit."
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6. Click Save.



Tips

¢ If you have enhanced campaigns that are using automatic bidding, you can set bid adjustments that
increase or decrease your bids when your ad is competing to appear on mobile devices and in
specific locations. Bid adjustments can give you more control over when and where your ad appears.
e If you'd like to have more control over your bids, you may be interested in learning how to set CPC

bids for individual keywords or placements.



Cost-per-acquisition (CPA) bidding

Cost-per-acquisition (CPA) bidding is a bidding method that lets you tell AdWords the amount you're willing
to pay for a conversion. It's part of the AdWords Conversion Optimizer feature, which predicts which
clicks are likely to lead to a conversion and automatically sets your bid to try to get you as many
conversions as possible, at the cost-per-acquisition bid you specified. CPA bidding is great because it can
bid differently from auction to auction to get you more customers who are likely to take action on your
website.

Oftentimes, your goal is to get a customer to click your ad and take an action on your website, whether it’s to make
a purchase or sign up for a newsletter. These actions are called conversions (sometimes also referred to as
acquisitions). Unlike cost-per-click bidding, CPA bidding focuses on maximizing conversions, rather than clicks.
You still pay per click, but AdWords will automatically set your bids to help you get more conversions, saving you

effort and time.

CPA bid types

You can use CPA bidding by setting up conversion tracking and turning on Conversion Optimizer for your

campaign. When setting up Conversion Optimizer, you can choose between two types of CPA bids:

+ Atarget CPA bid is the average amount you'd like to pay for a conversion. Some bids will be above this
target and some will be below it, but altogether, the cost per conversion should average to the Target CPA you
set.

¢ A maximum CPA bid (max. CPA bid) is the most you're willing to pay for each conversion, such as a purchase

or sign-up. When you use Conversion Optimizer, most of your bids will be below whatever maximum you set.

We recommend using target CPA since it's easier to track your average conversion costs. Also, people using this

option tend to see more conversions.

Tip
Save time and effort on managing your bids by trying Target CPA bidding as a flexible bid strategy.

You'll be able to apply Target CPA bid optimization more strategically to entire campaigns or specific

ad groups of your choice. How to use flexible bid strategies.



Determining your CPA bid amount

When you set up Conversion Optimizer, we provide a recommended bid, which is calculated to help ensure a
smooth transition to your new bidding mode. The recommended bid is based on your historical performance, so it’s
best to start with the recommended bid, then observe your performance and adjust as necessary. If you set your
max. or target CPA bid to the recommended amount, you should see more conversions without much change to
your existing average CPA. If you set your bid below the recommended amount, you're likely to pay less for each

acquisition, but you'll likely also get less traffic on your ad and fewer conversions.

After you've used Conversion Optimizer for awhile, if your average cost is within an acceptable range, you can raise
your max. CPA bid to get more conversions. If your cost is higher than you'd like, you can lower your bid, which is
likely to lower your average CPA and the number of conversions.

The final amount you're charged

Your actual CPA depends on factors outside Google's control such as changes to your website and ads, or external
factors such as increased competition. So it's possible that your actual CPA may exceed the max. CPA or target
CPA bid you specify. Conversion Optimizer uses historical conversion data to predict the likelihood your ads will
convert. If your actual conversion rate turns out to be lower than the predicted conversion rate, your actual CPA
may exceed your max. CPA or target CPA bid. But because the system is designed to adjust over the long term,

the likelihood of your actual CPA exceeding your bid decreases the longer you use CPA bidding.

How to edit your CPA bid

You provide your first CPA bid when you turn on Conversion Optimizer for your campaign. Once you’ve set it up,

you can update your CPA bid at anytime by following these steps:

Sign in to your AdWords account at https://adwords.google.com £ .

Click the Campaigns tab.

Click the Ad groups tab.

Find the ad group that contains the max. CPA or target CPA bid you want to edit. As you place your cursor
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over the rows, a pencil icon appears. Click the Max. or Target CPA bid to edit it.

o

Enter the amount you'd like to use for your bid.

6. Select Save to finish.

You can also change your max. CPA or target CPA bid for multiple ad groups at the same time. Follow these
instructions:

1. On the "Ad groups" tab, select the checkbox next to the "Ad group" column. This should select all the

checkboxes for every ad group.
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2. Click the Edit menu.

. Select Change bids.

. Select the Max. CPA or Target CPA field from the menu and enter the bid amount you'd like to use for all the
selected ad groups.

. Click Make changes to save.



Troubleshooting Tools

Fix a disapproved ad
Find your ad

Finding your first ads



Fix a disapproved ad

If any of your ads get disapproved, you'll get an alert in your account saying Ads disapproved. You'll also
get an email about this issue. When your ad is disapproved, that unfortunately means it isn't able to run at
the moment. To get your ad up and running, find out which ad was disapproved, and then edit your ad
(and website if needed) so that your ad can get approved.

Find out which ad was disapproved

When one of your ads gets disapproved, we'll send you an email about it. The email will show you a disapproval
reason, and give you a link to see the policy that was violated. You'll find more help near the end of the email,

where you'll see a problem report that shows you exactly which ad was disapproved.
You can also find your disapproved ad by looking in your AdWords account:

Sign in to your AdWords account at https://adwords.google.com [ .
Click Campaigns near the top of your account.

Click the Ads tab.

Look through the Status column to see which ads are disapproved.

Hover over the white speech bubble [1 next to "Disapproved.”
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Click the disapproval reason to learn more about the policy.

= Advanced tip: Enable the Policy details column to see why your ads were disapproved



Another way to see why your ads were disapproved is to enable the Policy details column. This is
especially helpful if you have a lot of disapproved ads and want to see all the disapproval reasons at once,

or if you want to see the approval status of an ad that's currently paused.
Here's how to enable the Policy details column:

Go to the Ads tab in your account.

Click the Columns button in the toolbar above the statistics table.
Click Customize columns.

In the Attributes section, click Add next to "Policy details."

Click Apply.

a M 0N

After following the steps above, you'll now see a Policy details column in your Ads tab. This column shows
you whether your ad is approved or not. If it isn't approved, you'll see one or more disapproval reasons.
Click the disapproval reason to learn more about that policy, then make changes to your ad (and website, if
needed) so that it complies with our policies.

— | Advanced tip: Use filters to find disapproved ads

If you have a large account with many ads, you might find it helpful to use filters to find all your disapproved
ads:

Click Campaigns near the top of your account.

Click the Ads tab.

Click Filter, which appears above the statistics table.

Select Create filter.

Select Approval Status from the first dropdown menu.

Remove the check marks from all checkboxes except the Disapproved checkbox.

Check the Save filter checkbox in case you plan on using this filter again and want to save time.
Click Apply.
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The table will automatically update to show you all of your disapproved ads.

Make changes to your ad or website



Once you know the reason why your ad was disapproved, you can work on editing your ad or website to fix the
policy issue that's preventing your ad from running. In some cases, all you have to do is make changes to your ad
text. In other cases, you may have to edit both your ad and website.

| Example
If you accidentally entered an inaccurate display URL, all you need to do is fix the display URL in your ad.
However, if your website promotes something that we don't allow, you may have to remove that item from

your website first, and then edit your ad to resubmit it for review.

Here's how to edit your ad:

1. Click Campaigns near the top of your account.

2. Click the Ads tab.

3. Place your cursor over the ad that you need to edit. Click on the pencil icon next to your ad, and you'll be able
to edit your ad right there.

4. Make any necessary changes to your ad and click Save.

What to expect next

Once you edit and save your ad, it will automatically be submitted to us for review. The Status column will change
from "Disapproved" to "Under review" or "Eligible."

We review most ads within 1 business day. Some reviews may take longer because some ads require more
complex review. Once we review your ad, its status will be updated in your account to display its current approval
status. If your ad is under review for more than 1 full business day, please be patient! We'll review your ad as soon

as we can. In this case, you can also contact us.



Find your ad

Once you've created your text ad, you'll probably be curious to see what it looks like on Google's search
results. Or you might just want proof that it's actually running. The best ways to do this are by using the Ad
Preview and Diagnosis tool, making sure your ad is enabled, and checking your account statistics.

Tip
If you've just created or changed an ad, remember that Google needs to review and approve your ad

before it can run on the Display Network, search partner sites, and sometimes even on Google. You

can see whether your ad is under review by looking at the "Status" column of your account's Ads tab.

Check on your ad without affecting its performance
We know it's tempting, but it's best to resist the urge to search for your own ad on Google.com. Here's why:

¢ By performing searches that trigger your ad, you'll rack up impressions without clicks, which can lower your
clickthrough rate and prevent your ad from appearing as often as it should.
¢ If you repeatedly look for your own ad using Google search but never click on it, you might stop seeing it

entirely. That's because Google's system stops showing you ads that it thinks you aren't interested in.
Best ways to check on your ad

e Option 1: Use the Ad Preview and Diagnosis tool
See where your ad appears in search results for a particular search query. This is an easy way to check how
your ad appears in context, and the tool provides the exact same results as a Google search without
accumulating any impressions. Just visit http://www.google.com/AdPreview [, or click Ad Preview and
Diagnosis in the Tools and Analysis tab at the top of your AdWords account. After you choose the

appropriate options at the top, you can see exactly which ads are being triggered by the search term you enter
in any location.



Google AdWords

nnnnnnnnnnnnnnnnnnnnnnn

e e T oy costeon (el oot

Tip
If you've targeted your ad to a certain language, location, or device, be sure to specify this information

when using the tool. For example, if you've targeted your ad to only appear to customers in Los

Angeles, you'll need to enter Los Angeles in the "Location" box.

Video: How to use the Ad Preview and Diagnosis Tool

In this video you'll learn how to user the Ad Preview and Diagnosis tool

¢ Option 2: Make sure your ad is enabled
Click your Ads tab and look for a green circle next to your ad. Paused ads will have a "paused" sign next to
them. You can change your ad from "Paused" to "Enabled" status by clicking on the paused sign and

selecting the green circle from the drop-down.

¢ Option 3: Check your account stats
See if your ads are receiving traffic from customers. Sign in to your AdWords account, and click the

Campaigns tab. On each tab, you'll see statistics that show detailed information about your clicks,



impressions, clickthrough rates (CTR), and much more. You can use this information to make sure your ads

are actually running and getting traffic.

¢ Option 4: Visit the Keywords tab
Make sure your keywords are triggering ads. Click the speech bubble icon in the "Status" column | [J |to get

information about whether a keyword is triggering your ads to appear.



Finding your first ads

After you've created your ads, it's important to make sure they're actually appearing to customers. You
can use the Ad Preview and Diagnosis tool, and check your account statistics, to figure out whether your
ads are up and running.

e Option 1: Use the Ad Preview and Diagnosis tool to see exactly what your text ads look like on Google
search results. Just visit http://www.google.com/AdPreview [£ and choose the appropriate options at the top
to see exactly which ads are being triggered by the search term you enter in any given location. You'll get more
specific diagnostic information if you sign in to your AdWords account first, but you can still use the tool

without signing in.
+ | Why use the Ad Preview and Diagnosis tool instead of searching for your own ad on Google.com?

¢ Option 2: Make sure your ad is enabled
Sign into your AdWords account, click your Ads tab and look for a green circle next to your ad. Paused ads will
have a "paused" sign next to them. You can change your ad from "Paused" to "Enabled" status by clicking on

the paused sign and selecting the green circle from the drop-down.

e Option 3: Check your account stats to see if your ads are receiving traffic from customers. Sign into your
AdWords account, and click the Campaigns tab. On each tab, you'll see statistics that show detailed
information about your clicks, impressions, clickthrough rates, and much more. Remember, though, AdWords
reporting isn't real-time. This means you may not see clicks and impressions you've received in the last three

hours.



¢ Option 4: Visit the Keywords tab
Make sure your keywords are triggering ads. Click the speech bubble icon in the "Status" column | [J |to get

information about whether a keyword is triggering your ads to appear.

¢ Option 5: Troubleshoot
Use our troubleshooter to find other reasons why you might not be able to see your ad.

Tip

It's normal for your ad to not show every time. We'll typically spread your ad views over the course of
the day. Once you start to reach your daily budget, we'll slow or stop your ad delivery. If you want the
ad to show more often, consider increasing your budget. Learn more about setting a budget for your

campaign.
More considerations when you're trying to find your ad

There are many things that determine when and where your ad appears. Here are some of the main ones:

Targeting: Your ad will typically show only to people you've targeted, generally meaning people who are searching
for your keywords in the language and location you've selected. If you're trying to find your ad, you may not see it if
your settings are different from the ones you're targeting. For example, if you're searching from a computer in San
Francisco but your ad targets Los Angeles, your ad won't appear in your search. By using the Ad Preview and

Diagnosis tool, however, you can choose any location targeting settings to successfully preview your ad.

Ad approval review: While some ads may run on Google Search Network pages before being reviewed to see if



they comply with our advertising policies [Z, others may not run at all until they've been reviewed. If your ad is
approved, it'll begin to run and you'll see impressions in your account statistics. You can check the approval status

of each ad by looking at the Status column on the Ads tab of your AdWords account.

Google AdWords

Ad position: If your ad rank isn't high enough, your ad might not appear on the first page of Google search results.
Your ad rank is determined by the quality of your ad (your Quality Score) and the maximum cost-per-click bid
you've set. Google doesn't show the same ads on each page, so your ad may appear on the second or third or

subsequent page. Learn more about how ad position is determined.
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About AdWords Editor

AdWords Editor is a free, downloadable desktop application for managing your AdWords advertising
campaigns. You can use AdWords Editor to download your account information, edit your campaigns
offline, and then upload your changes to AdWords.

AdWords Editor allows you to make changes to your account quickly and conveniently, whether you're editing one
keyword or adding hundreds of text ads. With AdWords Editor, you'll be able to:

¢ Add, edit, and delete campaigns, ad groups, ads, keywords, and placements in bulk.
¢ Manage multiple accounts or My Client Center accounts.

¢ Perform advanced searches and edits.

¢ Export account data and import changes via CSV or Excel files.

¢ Work offline on your Mac or PC -- then upload changes when you're online.

Google AdWords advertisers with accounts of any size can use AdWords Editor. It's particularly useful if you want
to make changes to long lists of keywords or ads, or if you manage multiple accounts. AdWords Editor can help
you save time and make it easier to make changes in bulk -- for example, if you want to search for items across
your entire account, make multiple changes quickly, or export and share your proposed changes before you upload
them.

When you use AdWords Editor, you can still sign in and make changes to your AdWords account at any time at
http://adwords.google.com [ . If you update your account online, you can then download those changes to
AdWords Editor.



Add, Edit, and Delete

Add individual items

You can add an individual campaign, ad group, ad, keyword, or placement several ways. The two simplest ways

are:

¢ Go to the Data menu and select the type of addition you want to make. For example, to add a keyword to
Campaign #1, go to the Data menu > Add New Keyword.

¢ Click the Add button on the appropriate tab. For example, to add an ad group to Campaign #2, select
Campaign #2 in the tree view. Next, go to the Ad Groups tab and click Add Ad Group.

When you add a new item to your account, a plus sign (+) appears next to it.

If you want to create a draft version of your additions, without posting them, you can create a draft campaign. Draft
campaigns aren't posted to your account until you change the status of the campaign to 'Active.' To create a draft

campaign, go to the Data menu > Campaigns > Add Draft CPC Campaign or Add Draft CPM Campaign.

Add multiple items

The Add Multiple tools enable you to add large numbers of keywords, placements, ads, or ad groups at once.
These tools are available from the Data menu or on the tab tool bars. Simply type or paste a list of items into the

tool to add them to the locations you specify.

For example, the Add Multiple Keywords tool enables you to add keywords to a single ad group, to all campaigns
and ad groups, or only to the ad groups you specify. After you type or paste your keyword information, click Next

to review your keywords, and Finish to apply the changes.

The other Add Multiple tools work much the same way as the Add/Update Multiple Keywords tool. You can find

detailed instructions for each tool in the AdWords Editor Help Center.

Edit individual items

To make a single change, such as updating your campaign budget or editing a keyword bid, follow these basic

steps:



1. Select the appropriate context in the tree view. This could be your account name or a specific campaign or ad
group containing the item you want to edit.

2. Click the relevant tab above the data view.

3. Select the item you want to edit in the data view.

4. Make your changes in the edit panel or directly in the data view.

For example, to edit a keyword destination URL in Ad Group #1, select the ad group in the tree view, then click the

Keywords tab. Select the keyword you want to edit, then type your new destination URL in the keyword row.

You can revert any change in AdWords Editor that has not been posted. Select one or more items in the data view
and click Revert Selected Changes. Note that reverting changes removes any unposted change, not just the latest
change. For example, suppose you add a new ad group, then add keywords and ads to that ad group. If you
select the ad group and click Revert Selected Changes, the ad group and all the new ads and keywords will be

removed.

Edit multiple items

To edit multiple items at once, you can enter a list of changes in the Add/Update Multiple tools, or you can select

items and edit them directly.
Add/Update Multiple tools

These tools are ideal for making long lists of specific changes to CPC or CPM bids, destination URLs, or ad group
settings. To use the Add/Update Multiple tools (available for keywords, placements, ads, and ad groups), go to the

Data menu and select the tool you want to use. Then enter your list of changes.
Select and edit specific items

¢ To select more than one item, hold the Control or Command key and click the items you want to edit.

¢ To select a consecutive list of items, select the first item, then hold the Shift key and select the last item in the
list.

¢ To select all items in the data view, go to the Edit menu > Select All.

Once you've selected the items to edit, you can edit them in two ways:

¢ Enter your changes in the edit panel below the data view. Any changes made to a given field will apply to all
selected items.

e Use the Advanced URL Changes or Advanced Bid Changes tools. (See the next section, entitled 'Advanced
Editing Tools.")

Advanced editing

The Advanced Bid Changes and Advanced URL Changes tools enable you to change large numbers of CPC
bids, CPM bids, and destination URLs quickly.



To use one of these tools, select the items in the data view that you want to edit, then click Advanced Bid
Changes or Advanced URL Changes at the bottom of the edit panel. Within the tools, you have the following

options.
Advanced Bid Changes:

¢ Increase or decrease your bids by a percentage.
¢ Remove bids at the keyword or placement level so they use the ad group default bid
¢ Constrain any of these changes so that bids do not fall below or exceed certain values.

Advanced URL Changes:

e Set a specific URL for all selected keywords, placements, or ads.
e Append text to each URL.

¢ Remove a specific URL parameter.

Find and replace

The Replace Text feature enables you to find and replace text in keywords, placements, ads, and destination
URLs. Simply select the items you want to search, then go to the Edit menu > Replace Text in Selected Items.
Advanced users may also wish to use formula words to insert campaign or ad group names into the selected

items. Learn more about formula words.

You may also wish to use the Append Text tool to add text before or after existing text in a particular column, for
all selected rows. For example, you could use this tool to add the word 'new' at the beginning of selected
keywords or ad headlines, or add 'Order now' at the end of your text ad description lines. To use this tool, select

the rows you want to edit, then go to the Edit menu > Append Text to Selected ltems.

Delete items
As with adding and editing, you can delete items individually or delete multiple items at once.

To make individual deletions, select the items to delete in the data view. For keywords, ads, or negative keywords
or sites, click the Delete button in the tab tool bar. For campaigns or ad groups, change the status to Deleted in

the edit panel. A minus sign (-) will appear next to deleted items in the data view.

To delete a list of keywords, placements, negatives, or text ads from various locations, use the appropriate Delete

Multiple tool. These tools are available via the Data menu or in the tab tool bars.

To find and delete a list of items that meet specific criteria (such as underperforming keywords or text ads that

contain a certain word), use advanced search. You'll learn more about advanced search later in this lesson.

Copy or cut and paste



You can copy or move items within an account, or between two different accounts.
Basic copy or move

1. In the data view, select the rows you want to copy or cut.

2. Go to the Edit menu > Copy or Cut.

3. In the tree view, select the new destination ad group or campaign. If you're moving something to a different
account, go to the File menu > Open Account, then select the new location in the tree view.

4. Go to the Edit menu > Paste.

Drag and drop

To move something quickly, select it in the data view and drag it to the new location in the tree view. To copy it,
hold the Control key.

For example, to move text ads to a new ad group, select the ads in the data view of the Text Ads tab, then drag
your selection to the destination ad group in the tree view. The original ad group will show those ads as deleted,

and the new ad group will show them as added.
To copy or move ad groups, you can drag and drop them within the tree view.
Copy options

¢ Copy just the keyword text or placement URL.
¢ Copy just the campaign targeting.
e Copy campaign or ad group 'shells' enables you to copy a campaign or ad group without the items inside,

then paste the duplicate campaign or ad group into a new location.
All of these options are available from the Edit menu > Copy Special.

Paste to multiple locations

To paste ads, keywords, or placements into multiple ad groups, select the destination ad groups in the data view
of the Ad Groups tab. Next, go to the Edit menu > Paste Special > Paste Into Selected Ad Groups. To paste
campaign negative keywords or sites into multiple campaigns, select the destination campaigns in the data view of

the Campaigns tab. Next, go to the Edit menu > Paste Special > Paste Negatives Into Selected Campaigns.

Cost and budget settings
You can make the following changes to your cost and budget settings in AdWords Editor:

¢ Change your campaign budget.
¢ Change your ad group default bids.

¢ Change the bids for individual keywords or placements.



It isn't possible to change your campaign bidding option (such as enabling the Conversion Optimizer, or switching
from automatic to manual bidding). It also isn't possible to change your account-level billing preferences. To make

these changes, please sign in to your AdWords account at https://adwords.google.com.

Get recent changes

After you download an account to AdWords Editor, the contents of the campaigns are stored on your computer.
Before you begin a session of editing a previously downloaded account, it's a good idea to make sure you're

working with the most recent version of your campaign information.

To download and review any recent changes that might have been made since the previous download, click Get
recent changes in the tool bar. Choose either the basic option (faster) or more data (slower). The "more data"

option includes top of page bid estimates, first page bid estimates, Quality Score, and approval information.

Try it now: sync account

When there are several people making changes to an account, it's important that you're always

working off of the most recent version of the account.

Follow these instructions to learn how to download and review recent account changes.

1. Open Adwords Editor.

2. Select an account to open.

3. Click Get Recent Changes (Basic).
4. Click All campaigns.

Questions to consider:

1. Why is it important to get recent changes before working on an account?
2. There are two other options when you click Get Recent Changes (Basic). \What are some reasons
why you might want to update select campaigns or update campaigns you just downloaded?



View and sort information

Symbols and colors
Here are some symbols, colors, and other visuals you'll see in AdWords Editor:

¢ Plus (+): added item

¢ Delta (A): edited item

e Minus (-): deleted item

¢ Red circle: error that will prevent posting (such as a potential advertising policy violation or a structural issue,
such as a daily budget of zero for a campaign)

¢ Yellow circle: warning

¢ Green circle: item that has passed AdWords Editor checks but hasn't been posted

¢ Pushpin icon: item with a comment (to see all items with comments, go to the View menu > Items with
comments)

e Bold: unposted change

¢ Gray: paused or deleted campaign or ad group

 Strikethrough: deleted item

View or hide deleted items

You can set your preferences to view or to hide deleted items in your account. To change your preferences, go to
the Tools menu > Settings. Check or uncheck the appropriate boxes under Hide all deleted and ended items. To
view the contents of deleted or ended campaigns and ad groups, check the box next to Download deleted and
ended campaigns and ad groups. The next time you download your account or click Get Recent Changes, the
deleted items will appear in AdWords Editor.

Show performance statistics

To download and view performance statistics such as clickthrough rate, cost, position, and conversion information,
select a date range with the View Statistics button in the tool bar. It may take a few moments for the information to

download.

Once the download is complete, click through the tabs to see performance statistics for each level of your account.

You can control which columns are visible with the column chooser, located at the top right corner of the data view.



The statistics you download will remain in AdWords Editor until you select a new statistics interval or download

your account again. You'll receive a warning before your previously downloaded statistics are removed.

Search and custom views

AdWords Editor provides several ways for you to search and filter the information in your ad groups and

campaigns:

¢ Use the Search box above the data view to perform a simple word or number search within your account or a
specific campaign or ad group.

¢ Use the View menu to filter the information that appears on each tab.

e Click Advanced search to perform a more detailed search for items that meet specific criteria, such as
performance statistics or keyword match type. When you use advanced search, the results are called a

custom view.
For example, use advanced search to find all poorly performing keywords:

1. In the tool bar, use the View Statistics menu to download your recent account statistics.

2. In the tree view, select your account name.

3. Click Advanced search next to the search box.

4. In the Performance statistics section, use the drop-down menus to select specific metrics. For example, to
find all keywords with a clickthrough rate lower than 0.5%, select "CTR" from the first drop-down menu, and
"is less than" from the second drop-down menu. Then type "0.5" in the text box.

5. If you think you'll want to perform this same search later, check the box next to "Save this search for reuse"
and enter a name for your search.

6. Click Search.

7. To view the keywords that match your search, select the account or a specific campaign in the tree view, then

select the Keywords tab.

To view your entire keyword list again, go to the View menu > All. You can return to your last custom view at any
time by going to the View menu and selecting Last unnamed custom view or the named search of your choice

under Saved custom views.

Sort the data view

To sort the rows in the data view, click a column header. For example, to sort by maximum cost-per-click (CPC)
bid, click the Max. CPC column header. To reverse the order of rows, click the column header again. To return the

rows to their original order, click a third time.

To sort by multiple columns at once, go to Data > Sort. Select up to three columns, then click OK. The columns
available for sorting are only those you already have showing in the data view. For example, if you haven't

downloaded performance statistics, you won't be able to sort by performance statistic columns, such as clicks



and impressions.

Once you've sorted by multiple columns, numbers appear in the column headers to indicate which columns you've

used in the sort. If you click on any other column header, you'll undo the multiple column sort.

Add and view comments

You can add comments to any item in AdWords Editor. Comments can be helpful personal reminders, or they can

explain your changes when you share your changes with other AdWords Editor users.

To add a comment for an item, select the item in the data view and click Add comment at the bottom of the tab.
Type your comment in the text box. (If you collaborate with other people, you may wish to include your initials to

distinguish your comments from others.)

A red pushpin icon appears to the left of items with comments in the data view. To view all comments, go to the

View menu > Iltems with comments.

Find duplicate keywords

Use the Find Duplicate Keywords tool to locate keywords that are repeated throughout your account. To access

this tool, go to the Tools menu > Find Duplicate Keywords.

The duplicate keywords will appear in a list on the Keywords tab, where you can edit or delete them as necessary.
To then select specific duplicate keywords quickly, Click the Select duplicates by button on the tab tool bar.
Choose one of the menu options, such as CTR > Lowest, and the keywords meeting your chosen criteria will be

selected. You can then edit or delete them as needed.

Keyword tools

AdWords Editor includes several tools for getting keyword ideas and organizing keywords within an account. These

tools are available in the Tools menu.

Keyword Grouper: The Keyword Grouper breaks up your keyword list into groups of related terms and allows you
to create new ad groups with the related keywords. Your keywords will be copied automatically into the new ad

groups and deleted from their original locations.

Keyword Opportunities: This tool includes several features for finding new keywords for your account and adding

the new keywords directly to new or existing ad groups. The Keyword Opportunities features include:

+ Keyword expansion: Generate keyword ideas based on descriptive words or phrases. For example, enter the
term "gourmet coffee" to see other related terms, along with the estimated search volume and competition for
each keyword.

¢ Search-based keywords: Find new keywords that are relevant to your website. Based on your website URL,

this feature generates a list of relevant user queries that have occurred on Google search properties with some



frequency over the past year. The keyword suggestions won't overlap with any of the keywords currently in
your campaigns.

Keyword multiplier: Combine lists of terms to form a new keyword list. For example, your first list could
contain adjectives, such as "cheap" and "discount." Your second list could contain products or services, such
as "hotels" and "motels." The tool will then show you combinations of those terms, so you can select the

appropriate ones for your account. Keywords with low search traffic are automatically excluded from the
combined list.



Share and Post Changes

Export and import account information

You can export a snapshot of an account, campaign, or ad group any time to review or to share with colleagues.

AdWords Editor offers the following export formats in the File menu.

e Export spreadsheet (CSV): Generate a comma-separated values (CSV) file that you can view or edit in a
spreadsheet program.

+ Export spreadsheet with images (ZIP): With this option, a CSV file is packed into a ZIP file with any images
you have in your account.

¢ Export summary (HTML): View a clean summary of your account with your keywords, placements, and ads
together.

¢ Export backup (AEA): Create a backup that you can import later to restore your account to its current state.
This export option is the only export option that includes draft campaigns. Backups are in the AdWords Editor
Archive (AEA) format.

¢ Export changes for sharing (AES): Share your changes with other AdWords Editor users. They'll be able to
import your changes to AdWords Editor, review your changes, and add comments. Share files are in the
AdWords Editor Share (AES) format.

You can also import several kinds of files into AdWords Editor. All options are available in the File menu.

¢ Import a backup (AEA): When you import a backup file, you restore your account to the state it was in when
the backup file was created. There are two kinds of backup files:

o Manual backups: These are created when you choose the File > Export Backup option.
o Automatic backups: AdWords Editor automatically creates backup AEA files during version upgrades and
when you run "Get Full Account." These files are automatically stored in a file called "auto-backup" on your

computer. Learn more about importing backups.

¢ Import CSV: If you have changes or additions to your account in a spreadsheet, you can import those updates
with the Import CSV option. Spreadsheets must include correct column headers and be saved in CSV
encoding. Learn more about importing CSV files.

¢ Import share file (AES): View proposed changes and accept or reject them. Before importing an AES file, be

sure you've downloaded the most recent version of the account (using Get Recent Changes). The import is



likely to fail if your view of the account is older or newer than the exported version. Also note that files can only

be imported into the account for which they were created. Learn more about importing share files.

Try it now: export account information

Learn how to export account information from Adwords Editor into Microsoft Excel. This feature

provides a way to share your account information with someone who doesn't use AdWords Editor.

Follow these instructions to export an account.

1. Open Adwords Editor.

2. Select an account to open.

3. From the File menu, select Export Spreadsheet (CSV).
4. Select Export Whole Account.

Questions to consider:

1. There are a few other options for export in the drop-down menu. What are some reasons you might
want to use Export Backup?

2. You can also Export Changes for Sharing. How could this option be useful when working with other
team members?

Review an imported file

When you import a file, the Review Proposed Changes panel appears. The panel contains a key to the highlighted
changes in your account: proposed changes are green, unposted local changes are purple, and conflicts between
proposed changes and unposted changes are red.

To view only the proposed changes in the data views of each tab, go to the View menu > Proposed changes
only. To view only the unposted changes that overlap with the proposed changes, select Unposted changes with
proposed changes only.

Accept or reject changes

When you review changes that you've imported in AdWords Editor, you have the option to reject any changes you
don't want to apply to the account.

To reject a proposed edit entirely, select the row containing the edit you want to reject, then click Reject Selected
Proposals in the tab tool bar. This option is also in the Edit menu. In the case of a new proposed ad group or

campaign, this will also reject any of the proposed edits within that ad group or campaign.

To reject aspects of a proposed edit that conflict with your own unposted local changes, select the row containing



the edit you want to reject. Go to the Edit menu > Reject Selected Conflicting Proposals.

If instead you want to revert your unposted change in the selected row and keep the proposed change, simply click

Revert Selected Changes in the tab tool bar.

Once you've reviewed the proposed changes, you can take the following actions to clear away the merge panel
and signal that the merge is finished:

1. Click Keep Proposed Changes to accept all proposals that you haven't explicitly rejected.
2. Click Reject Proposed Changes to clear away every proposed change. This action won't affect any edits
you've made since importing the proposal.

At this stage, you can either post the edits to the account, or export and share with another AdWords Editor user.

Check changes

When you click Check changes in the tool bar, AdWords Editor reviews all your unposted changes, helping to

ensure the changes comply with AdWords policies. To check your changes, follow these steps:

1. Click Check changes on the tool bar.

2. Review the count of changes that will be checked.

3. Click Check changes to proceed with the editorial checks.

4. If you need to pause while your changes are checking, click Pause in the dialog. Then click Resume when
you're ready to begin.

5. Click Close when checking changes is complete.

After the check is complete, items that fail checks have a red circle with an exclamation mark in the data view. To
see specific errors, select the item in the data view. A red box below the data view shows explanations of
violations and suggestions for how to fix them.

AdWords Editor also includes a spell-check feature for certain languages (English, French, Italian, German, Spanish,

Brazilian Portuguese, and Dutch). To spell-check a field, right-click the field and select Spell check this field.

Errors and Warnings

AdWords Editor displays red and yellow splats (circles) when it detects issues that may prevent your campaigns
from posting properly, such as editorial issues or missing maximum cost-per-click (CPC) values. To review errors
and warnings for your changes, follow these steps:

1. Go to the View menu > Errors and warnings only, Errors only, or Warnings only.
2. The items that match your selection will appear in the data view. Click on the tabs to see the errors for
keywords, ads, etc.

3. To see details for a specific error or warning, select the item in the data view. An explanation of the error will



appear in the edit panel, with instructions to correct the violation or submit an exception request.

4. To return to the normal view, go to the View menu > All.

Post changes

To post your changes to your AdWords account, click Post Changes in the tool bar. If you have a large number of
changes, it may take some time to post everything. If you need to pause while your changes are posting, click

Pause in the posting dialog. Then click Resume Post when you're ready.

The changes you've made through AdWords Editor will be reflected in your account immediately. However, as with
any changes to your account, there may be a slight delay before the changes are reflected on the Google Network.



Best practices

Here are ten best practices for using AdWords Editor, followed by a few of users' favorite tips and features. These
are merely ideas for making the most of AdWords Editor that you can adapt for your own account. For detailed

instructions, visit the AdWords Editor Help Center.

1. Copy or cut and paste between ad groups, campaigns, or across accounts. You can use the Edit menu

commands or the keyboard shortcuts (Control or Command + X, C, and V). For example:

¢ Copy 6 ads from one ad group to 15 other ad groups.
¢ Select 10 keywords and copy them into another ad group.
¢ [f you manage multiple accounts, copy campaigns between accounts and customize campaign settings for

each account.

2. Make bulk changes to keywords or destination URLs using the Add/Update Multiple tools or Advanced
URL Changes. For example:

¢ Add 100 keywords to one ad group using the Add/Update Multiple Keywords tool under Make Multiple
Changes on the Keywords tab.
¢ Use Advanced URL Changes to edit the destination URLs for 20 ads in 10 different ad groups.

3. If you need to edit your keywords or ads in a spreadsheet, you can then bring those changes back to

AdWords Editor. For example:

¢ Copy the items to edit from the data view and paste them into a spreadsheet. Make your changes, then paste
the contents of the spreadsheet directly into the appropriate Add/Update Multiple tool.

e Export your whole account or selected campaigns as a CSV file, make your changes, then import the CSV file
back into AdWords Editor.

4. Find duplicate keywords quickly in your account or in selected campaigns and ad groups, then select one

of each set of duplicate keywords to delete or edit.
5. Search your account quickly and perform bulk changes on the results of your search. For example:

+ Type a keyword into the search box to locate all instances of that keyword in the account, then append text to

that keyword or otherwise edit it.



6. Use advanced search to find items that meet the multiple criteria that you specify. Note that you need to

download statistics before you can search for performance criteria. For example:

¢ Filter performance status of keywords (CTR higher than 2%) and increase their bids to improve their position
and performance.

¢ Find all keywords with an average position lower than 1%. Review these keywords and delete them or use
Advanced bid changes to increase their bids.

¢ Find all keywords with O clicks. Make a note of keywords that have many impressions but no clicks. These
keywords may be less relevant and are therefore lowering your overall CTR. You may wish to use one of the
Make Multiple Changes tools on the Negatives tab to add any irrelevant terms as campaign or ad group

negative keywords.
7. Once you've specified criteria for an advanced search, save that search to reuse in the future. For example:

¢ Do a fast sanity check on a daily basis. Run Get recent changes, then use saved searches to view the best

or worst performing keywords.
8. Make bulk edits inline. For example:
¢ Select 3 out of 10 campaigns in one account and change the budgets for all of them at once.

9. Drive more traffic to your site and improve your ROI by using the Keyword Opportunities tool. For

example:

¢ Use the keyword expansion tab to find new keyword ideas based terms that are currently performing well for
your account.

¢ Use the search-based keywords tab to find and add 10 relevant keywords to a new ad group.

¢ Use the keyword multiplier tab to combine lists of words into new keywords, and the tool will make sure you

only add the ones that will bring traffic to your site.

10. Combine AdWords Editor tools with the search query reports available in your AdWords account online.

For example:

¢ Sign in to your AdWords account, then run a search query report for one ad group. Download the report as a
CSV file. Take the 5 keywords that have received the most clicks and add them as positive keywords to this
ad group.

¢ Sign in to your AdWords account, then run a search query report for your account. Download the report as a
CSV file. Open the spreadsheet, and remove any exact match queries from your list. Then sort by descending
CTR. Copy the best performing queries into the Add Multiple Keywords tool in AdWords Editor, either for a new

or existing campaign.
Other favorite tips and features:

¢ Download selected campaigns if you want to focus your work on a subset of campaigns.



Undelete and activate previously deleted text ads.

Automatically organize your keywords into ad groups based on common themes, using the Keyword Grouper.
Submit multiple exception requests at once.

Save a snapshot of your account for archiving or for sharing. Later, you can import the archive file to restore

your prior account settings.



Navigating adwords editor

You can navigate through your account in AdWords Editor using the tree view of your account on the side of the

screen, along with the tabs for the different items in your account.

Tree view: The tree view displays the account name, followed by the campaign names and the ad groups within
them. Click the plus and minus signs to expand and collapse the tree view and see the campaigns and ad groups

in the account.

Tabs: Once you've selected the account name or a particular campaign or ad group in the tree view, use the tabs
to choose what you want to view or edit. Each tab shows a part of your account, such as keywords, ad groups, or
campaigns. For example, to view the ad groups in Campaign #1, select Campaign #1 in the tree view and click the
Ad Groups tab.

Columns: You can customize the columns that appear on a particular tab. Click the small square that appears after
the last column header, then select or deselect the columns you wish to show. Note that performance statistics
columns only appear after you've downloaded statistics. Double-click a column header to fit the width to its
contents, or right-click the column header and select 'Auto-size Column.' To auto-size all columns at once, click the

column chooser and select 'Auto-size All Columns.'

Tool bars: The tool bar contains buttons for account-level actions, such as Post Changes and View Statistics. In
addition, each tab has a tool bar with buttons for functions within the tab. For example, the Keywords tab has
buttons for adding and deleting keywords, making multiple changes, and reverting changes. The adding and editing

options are also available in the Data menu.

Data view and edit panel: The data view is the large part of the screen below the tabs that displays the details of
the selected tab. When you select a row in the data view, you can edit it directly in the row or in the edit panel

below the data view.



AdWords Editor Settings

You can specify the following settings under the Tools menu > Settings:

e Enable usage tracking and send anonymous data to Google to help improve AdWords Editor.

¢ Choose whether to hide deleted items in your account, and whether to include deleted and ended items when
you download your account.

¢ Enable diagnostic logging. When diagnostic logging is enabled, AdWords Editor automatically saves reports
containing messages sent between AdWords Editor and the AdWords server. If you encounter technical
problems, AdWords Specialists may request that you send us the logs to help our engineers troubleshoot the
issue.

¢ Choose your locale, which determines the currency and interface language in AdWords Editor.

¢ Choose your default campaign targeting. When you create new campaigns in AdWords Editor, they'll

automatically use the default language and location targeting you choose here.



Downloading accounts or campaigns

You can download your entire account or specific campaigns. Once you've downloaded account information to
AdWords Editor, you can refresh it any time with the "Get Recent Changes" feature. If you've downloaded only

some of your campaigns, you can change the set of campaigns any time.
To download an AdWords account in AdWords Editor, follow these steps:

Go to File > Open Account.
Click Add Account.

Enter your AdWords username and password, and click Next.

Eal

Select the part of your account you'd like to download.

If you manage several AdWords accounts, AdWords Editor can store them all for easy viewing and editing. Only
one account at a time may be edited, but you can easily add more accounts or switch between accounts that
you've downloaded. If you have a My Client Center account, you can use AdWords Editor to make changes to
client accounts through your MCC account.
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Introduction to AdWords Reports

Generate fully customizable reports on specific topics such as campaigns, keywords, and ad text. These reports let you identify important trends over weeks,
months, or years. And because each report can be customized with configurable columns and performance filters, they provide just the information you need to

help you identify your strengths and areas of low performance.

You can view your reports online or download them to your computer and open them with a spreadsheet application, such as Microsoft Excel. You can also

schedule reports to run on a regular basis and have them be emailed to you.

Report Types

You can download any data table on each of the tabs in your account to generate reports. Customize the table using columns, segments, and filters, so that the
report contains just the data that you want to see. Here are some of the most frequently used reports:
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Keyword performance: The table on the Keywords tab displays details on selected keywords and organizes statistics by keyword.

Ad performance: The table on the Ads tab presents relevant statistics for ad variations, such as text ads, image ads, video ads, and local business ads.
Destination URL performance: The "Destination URL" view on the Dimensions tab displays statistics and measures the performance of destination URLs.
Ad group performance: The Ad groups tab shows statistics for each of your ad groups.

Campaign performance: The Campaigns tab shows statistics for each of your campaigns.

Account performance: The views on the Dimensions tab display statistics for your entire account.

Geographic performance: The "Geographic" view on the Dimensions tab shows the geographic origin of your visitors.

Demographic performance: The "Demographic" view on the Dimensions tab displays the age and gender of your visitors.

Search term performance: The Keywords tab shows performance data for the search terms that triggered your ads.

Product Listing Ads performance: The Auto Targets tab shows performance data for Product Listing Ads

Dynamic Search Ads performance: The Auto Targets tab shows performance data for Dynamic Search Ads.

Performance per Label: The views on the Dimensions tab display statistics per Label.

Time segmentation: The views of the dimension tab show statistics per time period: Hour, day, week, month, quarter, year and per day of the week.
Auction Insights: The Keywords tab shows performance data for a specific keyword compared with other advertisers who competed in the same auctions.



Exploring your data options

The Campaigns tab is your first stop for understanding the performance of your ads. Here, you can track overall statistics to gauge the success of
entire campaigns, or view more specific data for ad groups, ads, and keywords. You can customize how you view your data so that you can easily see
what's most important to you.

Within your AdWords account, take a look at the tabs that appear after you click the main Campaigns tab at the top of your screen. Each tab "specializes" in a
different view of your data, and you'll probably use some of them more than others depending on what you want to know.

For example, if you're interested in how specific ads are performing, you'll want the Ads tab, where you can compare the performance of individual ads

against one another. Or, if you want to adjust settings that affect an entire campaign, such as budget, bidding options, or location and device targeting, the the
Settings tab is the place to go.

Here's an overview of what you'll find on each tab:
1. Campaigns

The Campaigns tab is a great starting point for analyzing the performance of your campaigns. Like most of the tabs, you can customize your view of the data
on the Campaigns tab. This means you can add columns to your statistics table to display the data that's most useful to you. You might want to start with
clicks, impressions, and CTR to compare the success of your campaigns. If you want more specific information, you can click individual campaigns for more
details.

2. Ad groups

Use the Ad groups tab for insight into how your individual ad groups are performing. You can use this information about what's working best to refine current
ad groups and specific ads, and to plan for future campaigns.

3. Settings

The Settings tab lets you adjust settings that affect an entire campaign, such as budget, network, and bidding options; language; location targeting; device
targeting; campaign end date; and ad scheduling.

4. Ads

The Ads tab is where you can view data about each individual ad in your account. This allows you to compare ads, see which ones are most successful, and
use that information to create even better ads. You can also edit, pause, or delete ads that aren't performing as well as others.



5. Keywords

The Keywords tab is a one-stop keyword management shop. You can see keywords that you've selected for all of your campaigns, or just those for a single
ad group. You can also get performance and quality information about your keywords that can help you decide whether to create more keywords, or edit,
pause, or delete the ones you've already created.

6. Ad extensions

Ad extensions help people easily find out more about your business and its offerings by providing additional information such as an address and phone number,
more page links, and product images. If you've opted to use ad extensions to maximize the impact of your campaign, the Ad extensions tab is where you can
track how effective they are.

7. Dimensions

The Dimensions tab lets you slice and dice your data by the dimension of your choice across an ad group, a campaign, or your entire account. You can use
Dimensions to view statistics that cut across other AdWords tabs. For example, you can view your total stats by month, hour, or geographic region in a single
report. You could run a report to compare your total clicks in January across ad groups, or see individual cities where your clicks came from.

8. Display Network

The Display Network tab is where you can manage your display campaigns and see performance data about your ads on the Display Network. Manage your
display campaigns by adding or editing targeting methods like keywords, placements, topics, interests and remarketing lists, gender, and age. See
detailed information about how your ad groups perform, use data to optimize, manage bids, and remove low performing targeting methods. You can view your
targeting methods within a single campaign or across all campaigns that target the "Display Network only" or "Search & Display Networks."



Customize your performance data

You can customize your latte (triple shot, extra foam) and your burger (no onions, please!), so why not
your data? By adjusting your date range, columns, segments, filters, and graphs, you can customize your
statistics tables to see only the data that interests you. Think about your AdWords goals and what statistics
are most important for measuring progress toward those goals, and then customize your tables
accordingly. If you then choose to download a table as a report, the report contains the same data that's
displayed in your table.

Here's how to customize your statistics tables:

= Adjust the date range

Click the date range near the top of the page. Choose from a group of preset ranges or set your own custom
date range. The table, and the performance graph, automatically adjust to show you the data for the date
range of your choice.

You can also use the “on/off” slider button at the bottom of the date range drop-down menu to display data
in the performance graph for two date ranges. To do so, make sure “on” is selected next to “Compare

dates” in the drop down menu. Then you’ll be able to select the dates you’d like to compare.

Once you click Go, you'll be able to see data in the performance graph for both selected date ranges.
However, it’s important to note that the rest of your metrics (those in the table below the graph) will display
data for only the later range you’ve selected.



Add or remove columns

Columns provide a variety of statistics about your account, and your column choices vary depending on
which statistics table you're viewing. You can choose which columns you'd like to see, rearrange them, and
save them in the order you prefer.

To add or remove columns from the table, click the Columns button in the toolbar above the statistics table.

When you're done, click Save.

Google AdWords

After you've added the columns that interest you, you can click any column name to sort by that topic. For
instance, click the Ad group column to sort alphabetically by ad groups, or click the Impressions column to

sort your ad groups from most impressions to least. Try clicking Impressions again to reverse the order and
see your statistics from least impressions to most.

Once you've chosen a set of columns, you can save the set for easy access in the future by selecting the
"Save this set of columns" checkbox.



Apply segments to break down your data

Segments split your view of data into separate parts. There are many different segments that you can apply

to your data, such as device, click type, network, and time period.

To use a segment, click the Segment button in the toolbar above the statistics table and select the level of

detail you'd like to apply to the data in your table.

Which segmentation options are available to you depend on whether you're viewing your keyword, ad group,

or campaign tables.

| Example

Here's some insights you might gain about your data using segments:

1. ldentify your key customers by breaking down your keywords by device. This way you can
figure out whether you're getting a better ROI from ads showing on mobile phones or on
desktops and laptops.

2. Compare your performance on Google and search partner sites to your performance on the
Display Network by breaking down your campaign and ad group data by network.

3. Isolate changes in your performance using time segmentation options (day, week, or day of
week, month, quarter, or year). For example, if you segment your data according to the day of
the week and find that your ad performance is significantly different on Saturdays, you can

modify your bids to account for the change in visitor behavior.



Use filters to search your data

Use filters to search your table for specific information, such as keyword text, bids, and clickthrough rates.

To create a filter, click Filter in the toolbar above the statistics table. You can save your filters for easy
access in the future.

Google AdWords
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View or hide deleted items

You can either include or hide deleted campaigns, ad groups, ads, keywords, and networks in your

statistics tables. The first menu on the toolbar above the table lets you control the display of deleted items.

1. To hide deleted items, click the first button on the toolbar and select All but deleted.
2. To show deleted items, click the first button on the toolbar and select All to see all enabled, paused,

and deleted items. For the campaign and ad group tables, you can also select All enabled to see only
active items.

Google Adwords




View performance summary graphs

If the performance graph isn't visible above your data table, click the graph icon | |~# | on the toolbar above

the table to make it appear. (You can click the icon again to make the graph disappear.)

You can compare two metrics using the drop-down menus just above the graph on the left. Click each drop-
down menu and select the metric you’re interested in. For example, if you wanted to gauge the effectiveness
of a particular keyword, you could choose to view impressions and clicks at the same time.

You can also compare two date ranges for these metrics by selecting “Compare dates” from the drop-down
date range menu in the upper right corner of the page. For example, you could view your total clicks and

impressions from this week alongside your total clicks and impressions from last week.

You can also change the level of detail for your graph by selecting “Daily,” “Weekly,” “Monthly,” or
“Quarterly,” from the drop down menu above the graph.



Tip

Once your statistics table displays exactly what you want, you can download the data as a

report in a variety of formats by clicking the download button | &, | in the toolbar.



Use columns to find specific performance
data

Columns in your statistics tables provide a variety of information about your account. Your column choices
vary depending on which statistics table and tab you're viewing. You can choose which ones you'd like to
see, and rearrange and save them in the order that you prefer. This way you can have all the data that’s
most important to you available at-a-glance in your statistics table.

Here's how to add or remove columns in your statistics table:

1. Sign in to your AdWords account at https://adwords.google.com [£ .

2. Click the Campaigns tab.

3. To see data for a specific period, click the date range menu on the top corner of the page and select the time
period you'd like to analyze.

4. Click one of the tabs that appear in the middle of the page, such as the Campaigns, Ad groups, Ads, or
Keywords tabs.

5. Click the Columns button above the statistics table.

6. Select "Customize columns" from the drop-down.

7. Choose which columns you'd like in your table. You can add or remove all of the columns in a single category

by clicking "Add all columns" or "Remove all columns."
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8. Drag and drop the columns to arrange them in the order you prefer.
9. If you want to save the columns for future use, select the "Save this set of columns" checkbox and enter a title

in the box that appears. Your saved columns will now appear in the "Customize columns" drop-down.
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10. Click Save. If you've added columns, you'll see them appear in your statistics table.



11. Once your statistics table looks the way you want, you can download the data in a report. Just click the
download button | #, |
Tip
After you've added the columns that interest you, you can click any column name to sort by that topic.

For instance, click the "Ad group" column to sort alphabetically by ad groups, or click the

"Impressions" column to sort your ad groups from most impressions to least.

Common columns

Certain columns can be found on almost every tab in your AdWords account.

— | Status columns

The "Status" column on the Campaigns and Ad groups tabs displays information about the current state of

individual campaigns or ad groups, and whether they're paused, deleted, limited by budget, or other states.

¢ On the Ads tab, the "Status" column shows you whether or not your ad is running and, if not, whether it
is paused, deleted, or disapproved.

¢ On the Keywords tab, it shows you whether each keyword is eligible to trigger ads, or is marked
paused, deleted, disapproved, or another status.

Get more information about campaign, ad group, ad, and keyword statuses.

= Performance, Conversions, and Call Details columns

Performance columns



¢ Clicks - When someone clicks your ad, like on the blue headline of a text ad, we count that as a click.

¢ Impressions - An impression is counted each time your ad is shown on a search results page or other
site on the Google Network.

¢ CTR - A ratio showing how often people who see your ad end up clicking it. CTR can be used to gauge
how well your keywords and ads are performing.

¢ Avg. CPC - The average amount that you've been charged for a click on your ad.

¢ Avg. CPM - The average amount you've been charged per 1,000 views of your ad (if you're using CPM
bidding).

e Cost - Cost is the sum of your cost-per-click (CPC) and cost-per-thousand impressions (CPM) costs.

¢ Avg. Position - Avg. Position describes where your ad typically appears on the search results page

compared with other ads.

Conversions columns

If you've set up Conversion Tracking on your website, these columns can give you insight into your

conversion performance. Hover over the questions mark iz} at the top of each column for a definition.

Assist and assisted-conversion data from Search Funnels

These columns can help you understand the role your keywords play in the Google.com searches leading up
to a conversion. Often, the "last click" before a conversion gets all the credit because that's the click that
leads directly to the sale, acquisition, or sign up that you're trying to get. But there are also helper keywords
that might have guided your customers toward that conversion along the way. The assist and assisted-
conversion data from Search Funnels can give you a more complete picture of the value of your individual
keywords when it comes to generating conversions. As with the conversions columns, you'll need to have

Conversion Tracking set up on your website to view assist data.

Call details columns

These columns provide reporting for calls from ads showing a Google forwarding phone number on
desktops/laptops, tablets, and high-end mobile devices, and can be found on the Ad Groups and

Campaigns tabs. Find out which statistics are available in the Call details columns.

Columns that only appear on certain tabs

Some columns can only be found on certain AdWords account tabs. Here's what they can tell you about your

performance:

= Adtype



This column is available on the Ads tab, and it indicates which type of ad you're running: text, image,

mobile, or video.

Dest. URL

The Destination URL column can be found on the Keywords tab, among others. If you set a keyword-level
destination URL, it will take priority over the destination URL that you set for each ad. Let's say you choose

the following:

¢ Ad destination URL: www.example.com
¢ Keyword: apple

e Keyword destination URL: www.example.com/apple

If your ad is triggered by the keyword "apple," then the ad will use www.example.com/apple instead of

www.example.com as its destination URL.

Est. first page bid / Est. top of page bid

The "Est. first page bid" and "Est. top of page bid" metrics approximate the cost-per-click (CPC) bid
needed for your ad to reach the first page or top of Google search results when a search term exactly
matches your keyword. The estimates are based on the Quality Score and current advertiser competition for

that keyword.

In rare cases, the "Est. top of page bid" may exceed US$100 and be denoted as >=US$100. Currently,
estimated bids greater than US$100 are not shown. When viewing "Est. top of page bid" in other currencies,
you may see a similar annotation for the equivalent of US$100 in your preferred currency.

Note that these estimates aren't a guarantee of placement. Ad position is influenced by many factors,
including other advertiser activity, search user activity, account settings, and account activity such as
budget changes. For all of these reasons, your ad may not show on the first page or at the top of the page,

even if you meet the estimates.

These columns are available on the Keywords tab only.



This is the individual ID number of your ad. This column is available on the Ads tab only.

Image URL

If you've chosen to run image ads on the Display Network, the images are stored on Google's servers and

referenced from this URL. This column is available on the Ads tab only.

Impression share, Lost IS (rank), Lost IS (budget), Exact match IS

Impression share is the percentage of impressions you received divided by the estimated number of
impressions you were eligible to receive. Eligibility is based on your current ads' targeting settings,
approval statuses, bids, and Quality Scores. Get more details about impression share, Lost IS, and Exact
match IS.

This column is available on the Campaigns and Ad groups tabs. Impression share data is also available on

the Dimensions tab "Time" reports.

Invalid clicks / Invalid click rate

These columns indicate the number and percentage of clicks that were classified as invalid and
automatically filtered from your account. You aren't charged for these clicks, and they don't affect your
account statistics. Data for invalid clicks is only available after January 1, 2006. Learn more about invalid
clicks.

This column is available on the Campaigns and Dimensions tabs only.

Match type

For campaigns targeting the Google Search Network, you can use the following keyword match types: broad
match, phrase match, exact match, or negative match. These keyword matching options help you control
who sees your ads. You might see more ad impressions, clicks, and conversions with some match types, or
fewer impressions and more narrow targeting with others. The "Match type" column on the Keywords tab
indicates which setting you chose for each keyword, and allows you to change the setting. Learn more about

keyword match types.



This column is located on the Keywords tab.
Additional "match type" metrics are also available in AdWords:

Search terms match type segment: See your keyword data segmented by search terms match type,
which are the broad, phrase, and exact match search terms that triggered your keyword. This allows you to
compare statistics such as clicks, impressions, clickthrough rates (CTRs), or conversion rates for search
terms that triggered your ad. Use this segmentation option to identify which keywords are driving the best
performance for a particular search term match type.

"Match type" column in the search terms report: This column in your search terms report tells you which
match type allowed the user to see your ad when they searched on a particular term. Use this information to

improve your keyword list.

Served

This column indicates the percentage of time your ad has been shown in relation to the rest of the active ads

within the same ad group. This column is available on the Ads tab only.

Tip
When you're comparing % served between two ads, make sure to adjust your date range to a

period of time when both ads were running to produce an accurate comparison.

It's normal for the ad served percentage or the number of impressions accrued for each ad in your ad group

to be different. The following factors influence how often a given ad appears:
¢ Ad Rotation

By default, all campaigns are set to optimized ad serving. This means that if one ad has a higher
clickthrough rate (CTR), it will show more frequently than the other ads in your ad group. This system
automatically favors better-performing ads that drive more traffic to your site.

You can opt out of optimized ad serving if you'd like the AdWords system to rotate your ads roughly
evenly. If you do so, note that your ads still may accrue different ad served percentages or numbers of
impressions. This is because the AdWords system considers an ad's Quality Score when ranking it on
a search result page. An ad with a high Quality Score may appear on the first page of search results,
where it accrues an impression every time it's served. On the other hand, an ad with a low Quality
Score may appear on the second page of search results, where it will only accrue an impression if the
user clicks through to that page.



¢ Time

If an ad is created late in the day, it will have a lower ad served percentage at the end of the day than

the existing ads. This difference will decrease over time.
¢ Approval status

If an ad has yet to be reviewed and approved, it'll only appear on Google. If it isn't yet generating

impressions on the Google Network, an ad will have a lower ad served percentage.

= Quality Score

This column displays your keyword's Quality Score, which is a measurement of how relevant and useful
your ads and landing page are to a person seeing your ad.

This column is available on the Keywords tab only.

— | Relative CTR

Relative CTR is a measure of how your ads are performing on the Display Network compared to other

advertisers' ads that are appearing on the same websites.

We calculate Relative CTR by dividing your clickthrough rate by the average clickthrough rate of all
advertisers on the placements where your ads are shown. Because this is a competitive metric, it's not

static. It will change based on the websites where your ad appears and what other advertisers do.

This column is available on the Campaigns and Ad groups tabs only.

Example

Let's say that an advertiser who sells digital cameras is getting a Display Network CTR of
0.05%. The advertiser is appearing on a single page about photography on the Display Network
with three other advertisers. The other advertisers are getting CTRs of 0.005%.

The first advertiser is getting a CTR that is 10x larger than the competitors’ CTR (0.05%/0.005%
= 10). Because people are more interested in this advertiser's products, this advertiser has a
very high Relative CTR (10).

— | Total cost



The total costs that a campaign has accrued during the time frame you selected.

This column is available on the Campaigns tab only.

Tip

It’s possible to compare performance across date ranges and see those results inside the columns of

your statistics table. Learn how to compare performance across two time periods.



Create, save, and schedule reports

You can find the specific performance data that interests you by customizing the statistics tables of your
AdWords account using columns, segments, and filters. Once the table looks exactly how you want, you
can download it as a report in a variety of formats, and AdWords will automatically save it for you. You can
also set up the report to run at specific intervals, and schedule it to be emailed to you or other people who
have access to your account.

With AdWords, you always have two easy options to view and analyze your performance data:

¢ Customize your statistics tables in the Campaigns tab using columns, segments, and filters to get the data
you need at a glance.

» Create one-time or recurring reports from the data in your statistics tables that you can download, schedule,
and share with others.

Follow the steps below to create and download a report, and schedule it to be emailed on a recurring basis.

Customize your statistics table to create a report

1. Sign in to your AdWords account at http://adwords.google.com [ .

2. Click the Campaigns tab.

3. Go to the tab containing the statistics table you'd like to download. Make sure that the table contains the date
range, columns, filters, and segments you'd like to include in your report. Segments that you've applied to the

data in the table show up in your report as columns. Learn how to create a customized view of your data

Download the table as a report

1. Click | #, |in the toolbar above the table to open the download panel.

2. In the download panel, name your report.

3. Use the "Format" drop-down to select the file type for your report.
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Email and schedule your report

1. To email your report to yourself or others who have access to the account, click the Email and schedule
report link in the downloads panel. Select the recipients for the report and how frequently you'd like to

generate the report.

Google Adiio

2. Click Create. One-time reports will download immediately.
3. You don't have to save your reports. We automatically save any report you've downloaded in the Reports

section of the side panel of your AdWords account for future access.

= | Change the frequency of existing reports

Sign in to your AdWords account at http://adwords.google.com [£.
Click the Campaigns tab.

Click Reports on the left, below your list of campaigns.

E

Find the report you want to modify and click its setting in the "Frequency" column.



5. Select a new frequency from the menu that appears. To cancel recurring downloads, select One time.

Cancel report emails or change email recipients

Sign in to your AdWords account at http://adwords.google.com £ .
Click the Campaigns tab.
Click Reports on the left, below your list of campaigns.

To choose new email recipients for your report, click the setting in the "Email" column.
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Select another option from the menu that appears. To cancel report emails, select "No one." This will
reset the "Frequency" column selection for your report to "One time."
6. Click Save.

Want to send the report to someone else who doesn't have access yet? Add users to your account.

Tip
In addition to adjusting the frequency and recipients of your reports as described above, you can also

easily create variations of existing reports with a Create similar option, and edit your existing report



names, formats, and date ranges. Just click Reports in the left panel of your AdWords account, below

your list of campaigns, to make these types of changes.

When reports will run

Reports for individual accounts begin running at 1 a.m. in your designated time zone. Reports for My Client Center
(MCC) begin running at 5 a.m. in your designated time zone. Reports for accounts without a designated time zone
will begin running at 1 a.m. PT for individual accounts and 5 a.m. PT for MCC accounts.



Find, edit, or delete reports

We save your reports to save you time. After you've created and downloaded reports from the Campaigns tab, you can see them in a list. From
this list, you can run the same reports whenever you want, or use them to create similar ones.

You can also make changes to your report settings directly from the list. You can change the name, format, email recipients, date range, or
frequency. If you no longer want the data, you can also delete the report entirely.

See a list of your reports
Follow these steps:

1. Sign in to your AdWords account at https://adwords.google.com.

2. Click the Campaigns tab.

3. Click Reports on the left side of the page, below your list of campaigns and the shared library.
4. If you've downloaded reports already, you'll see the list in a table in the center of the screen.

Click Run now to see the report of your choice. Or, click Create similar (if available) to build a new report by modifying an existing one.

Edit report settings from your reports list
Before you click Run now to crunch the latest numbers on your favorite report, review your report settings and update them (if you like) directly from the list.
You can update the following settings from the list of reports:

1. Format: choose to view your information in different formats (e.g., Excel or a .pdf file).
2. Email: email the report to yourself and/or others.

3. Date range: change the timeframe.

4. Frequency: create an ongoing schedule to run the reports automatically.

Follow these steps:

1. Sign in to your AdWords account at https://adwords.google.com.

2. Click the Campaigns tab.

3. Click Reports on the left side of the page, below your list of campaigns.

4. Find your report and click its settings -- name, format, email, date range, or frequency -- to edit them directly on the page.

To create a variation of the report (by adding new report recipients, different date ranges, or campaigns, for example), click Create similar (if available) in
the "Actions" column for the report.




Delete a report
Follow these steps:

1. Sign in to your AdWords account at https://adwords.google.com.

2. Click the Campaigns tab.

3. Click Reports on the left side of the page, below your list of campaigns.
4. Check the box for the report you'd like to delete and click Delete.

Tip

e Sort your list of reports by clicking the column headings.
» If you're trying to cancel emails for scheduled reports, you can simply change the report's email frequency without deleting the report. Click the
selection in the "Frequency" column for the report and select One time in the menu that appears.



Account, campaign, and ad group
performance

AdWords is organized into three layers (levels): account, campaigns, and ad groups. By familiarizing
yourself with the different levels of your AdWords account, you can easily find the exact performance data
you're looking for.

Keeping the three levels in mind, you can customize your view of your performance data to make it as broad or
specific as you want. To help you navigate, the side panel of your AdWords account starts with the broadest level -
- "All online campaigns" -- and narrows in focus as it moves downward. After clicking on an individual campaign,
you'll see the ad groups contained in each one.

Your account is associated with a unique email address, password, and billing information. For reporting
purposes, though, it's helpful to think of your account as a collection of campaigns. If you want to see performance
data for your entire account, click All online campaigns in the side panel of your AdWords account. Totals for all of

the rows are listed at the bottom of your statistics table.

= See data for your entire account

See statistics for your entire account to get a quick overview of your overall AdWords performance.

Sign in to your AdWords account at http://adwords.google.com £
Click the Campaigns tab.
Click the Dimensions tab.

Click the View button to select the time period that you'd like to use to organize your statistics.
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Once your statistics table looks the way you want, just click the download button | #, ' to download it

as a report.

An individual ad campaign has its own budget and settings that determine where your ads appear, and is made
up of a collection of ad groups. Each of your campaigns is listed in the side panel of your AdWords account, and

they also appear when you click the Campaigns tab in the middle of your screen.
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- See campaign data

1. Sign in to your AdWords account at http://adwords.google.com [

2. Click the Campaigns tab.

3. Click the name of the campaign that interests you to see how its ad groups are performing. To view
specific campaigns for your report, click the Filter button to set up a campaign filter.

4. Once your statistics table looks the way you want, just click the download button | #, | to download it

as a report.

Your ad group contains a set of similar ads and the words and phrases, known as keywords, that you want to
trigger your ads to show. When you click on a campaign, AdWords will show you a view of the campaign's
performance broken out by its individual ad groups. You can also see ad group data by clicking the Ad groups tab
in the middle of your screen.

Google AdWords

- See ad group data



1. Sign in to your AdWords account at http://adwords.google.com [4
2. Click the Campaigns tab.
3. Pick the ad groups that interest you.

o To include all the ad groups from a specific campaign, click the campaign name in the table. You'll be
taken to the "Ad groups" tab for that campaign.

o To include all the ad groups in your account, click the Ad groups tab while viewing "All online
campaigns.”

o To include specific ad groups from different campaigns, first click the Ad groups tab while viewing "All

online campaigns." Then click the Filter button to set up an ad group filter.

Example

Let's look at how a business might set up its AdWords campaigns and ad groups. The account

belongs to a chocolate maker (yum!) who wants to advertise its products to increase online sales.

The owners decide to organize their advertising efforts into two campaigns. One campaign promotes
their new line of chocolate bars, and the second promotes their holiday gift boxes. They split each
campaign into targeted, relevant ad groups. One of the ad groups for the chocolate bar campaign is
dedicated to the company's popular raspberry bar. Another is dedicated to a caramel bar, and a third

to a chocolate bar infused with ginger. Here's what this account looks like:
Account:

Chocolate Maker

Campaign 1: Campaign 2:

Chocolate bars  Valentine's Day gift boxes

Ad groups: Ad groups:

Raspberry bar  30% off gift boxes

Caramel bar Free shipping on gift boxes
Ginger bar Luxury Valentine's chocolate

Each ad group can have multiple ads within it. This helps the chocolate maker compare performance
for different ad text, for example, and see whether one version resulted in more clicks or sales than
another.

Once you're familiar with the structure of your AdWords account, you can view and customize the data in your
statistics table, and download reports to monitor the performance of your campaigns, individual campaigns, and ad

groups -- as well as your ads and keywords.



Fvaluating ad performance on the search
network

You've created your ad, and it's up and running. Your next step is to find out how it's performing. Tracking
statistics like clicks, impressions, and clickthrough rate is a great way to start. It's also important to think
about what you're trying to accomplish with your campaign, so you can focus on the statistics that can
help you achieve your goals.

If you're new to tracking your performance, start by clicking the Campaigns tab in your AdWords account. The
statistics tables on your Ads and Keywords tabs under the Campaigns tab provide a complete, customizable view
of all of your data. You can keep the reporting simple or dig deeper for more detailed insights into the success of

your campaigns.

Clicks, impressions, and clickthrough rate

To help you get comfortable tracking data for your ads running on the Search Network, we suggest monitoring the
clicks, impressions, and especially the clickthrough rate (CTR) of your ads and keywords. CTR is the percentage
of people that clicked on your ad after they saw it. By tracking it, you can make sure that your ads and keywords
are attractive to customers. Find these statistics listed in columns in your account's statistics table. If you don't

see them, click the Columns button and select the ones you'd like to enable.

Google Ad




AdWords: Measure your success

Learn to measure the success of your AdWords ads and use this information to improve your AdWords

performance.

This video explains the importance of clicks, impressions, and clickthrough rate for measuring success in your
Google AdWords account.

You may also want to keep an eye on the following information about your ads and keywords:

= Ad performance

o Status: In the "Status" column of the statistics table on your Ads tab, you can see whether each of your
ads is running.

¢ Average position: Look for the "Average position" (Avg. pos.) column in the statistics tables on your
account tabs to find out exactly where your ad is appearing on Google's search results page. Positions
one through 10 usually appear on the first page of search results. This is the best way to check on the

positions of many ads at once.

If you don't see the column in your statistics table, you can add it by going to your Keywords tab, then
clicking the Columns button and choosing "Customize columns" from the drop-down. Click

Performance, then add "Avg. pos."

¢ Ad variations: If you have more than one ad in an ad group, your ads will be rotated and take turns
showing. By comparing the performance of your different ads, you can find out what your customers
find the most compelling. For example, see which ad has the highest CTR and improve those ads with
the lowest CTR. We suggest testing between two and four ads in an ad group at a time.

= Keyword performance

¢ Keyword status: The Status column of the statistics table on your Keywords tab tells you whether
each of your keywords is triggering ads to run. Click the speech bubble icon| [J | to read a summary of
each keyword's status. Or, click the Keyword details drop-down button, then select Diagnose
keywords to see multiple keyword statuses at once.

¢ Quality Score: This column helps you monitor the Quality Scores of your keywords. The column is



disabled by default in new accounts, but you can make it appear in your statistics table by going to
your Keywords tab, then clicking the Columns button.

e Search terms: You can see the actual search terms that drove traffic to your ads on your Keywords
tab. From the Keyword details drop-down button, in the "Search terms" section, select All to see a list
of the searches that triggered your ads. You can use this information to identify which keywords are the
most successful and to find new keywords to add to your account. If you see that irrelevant terms are
triggering your ad, you can add these as negative keywords to prevent your ad from showing on these
terms.

Track statistics based on your campaign goals

It's always important to keep your own campaign goals in mind when you look at your account statistics.
Depending on what you want to achieve, certain statistics will be relevant and helpful to you, while others

may not be as useful. Choose a goal from the list below to see more suggestions of what to track:

¢ Return on investment

¢ Brand awareness

Traffic to your website

e Sales and conversions

Track statistics for mobile ads on high-end devices

Use the Segment button to see the data in your campaign segmented by device. This allows you to
compare statistics such as clicks, impressions, CTRs, or conversion rates for desktop computers and high-
end mobile devices. Segmenting your data can help you identify which campaigns, ad groups, ads, or
keywords are driving the best performance for a particular type of device, especially for campaigns
combining desktop computer and mobile devices.

Tip
Here's some data you might not know about. You can see how your destination URLs are performing

for your entire account, or specific campaigns and ad groups. Just click the Dimensions tab, then

click View, and select "Destination URL" from the drop-down.



Fvaluate ad performance on the Display
Network

If you’ve ever owned a car, then you’re already familiar with the mindset of a display advertiser. Your
display campaigns will run when there are bids and budgets to fuel them, but every so often they’ll need a
tune-up where you evaluate your ad and display targeting to ensure that everything’s running smoothly.

The Display Network and Ads tabs provide the statistics to help you evaluate your ad performance, whether
you’re new to display advertising and just want the basics or have been doing display advertising for awhile and

want to delve into your performance and audience stats to get even more out of your campaigns.

Basic insights: Determine Performance and

= ©

A = - @. : -
# whether your ads are ; r..\“. demographic stats: Find
# showing and the sites ' N ‘. out how your ads and ad
’ where they’ve appeared. . targeting are performing
= and who is seeing your

ads.
Tip

It's up to you how often you evaluate your ad performance. If you’re new to display advertising, try to

spend an hour or more each week.

= | Confirm that your ads are showing

Check whether your ads are running or paused from your Ads tab.

Sign in to your AdWords account at http://adwords.google.com [£.
Click the Campaigns tab and select your campaign.

Click the Ads tab.
Under the "Status" column, point to the speech bubble icon next to the status of any of your targeting

E



methods. You should see a confirmation that your ad is or isn’t running and the reason for its status.

What to look for:

¢ Pinpoint which ads aren’t running.

¢ Understand why your ads aren’t running and what you can do to fix them.

Get a list of sites where your ads appeared

See which websites, videos, and apps have displayed your ads from your Placements tab.

’
2
3.
4

. Click the Placements tab.

. Sign in to your AdWords account at http://adwords.google.com £ .

. Click the Campaigns tab and select your campaign.

Click the Display Network tab.

a.

Note

Look at your managed placements to see where your ads appeared based on specific websites
you've added. Look at your automatic placements to see where your ad appeared based on
targeting methods such as display keywords and topics.

Click the "See details" drop-down to see a list of site URLs where your ads have shown. (For a
complete list of your automatic placements across your entire account or specific campaigns, go to

the Dimensions tab, click the "View" drop-down menu, and select "Automatic placements.")

Some of the URLs that you see may be incomplete. It could be that the URL is too long or that it contains

private information about the person viewing the placement, like a username or password. When this

happens the URL is shortened with an ellipse and may be partly stripped, potentially taking you to a

page that’s different from where your ad was shown.

What to look for:

¢ Placements that have performed well and could do better with an increased bid.

¢ Irrelevant or poor-performing placements to exclude.

"

Example

An outdoor company has a Yosemite Hikes campaign. They’ve been using managed

placements and want to find additional sites to target.

Placement Status Campaign Impressions  Conversions



half-dome-hikes.com Managed Yosemite Hikes 1,500 20

adventure-hikes.com Automatic  Yosemite Hikes 1,500 25
yosemite-power-drinks.com  Automatic = Yosemite Hikes 3,000 2
hikes-for-kids.com Automatic  Yosemite Hikes 2,000 0

In the Placements tab, the automatic placement half-dome-hikes.com is performing well,
so the account manager adds it as a managed placement to the campaign. On the other hand,
the yosemite-power-drinks.com and hikes-for-kids.com automatic placements are
performing poorly. These placements are also geared toward people outside their target

audience, so the account manager excludes them.

See if your ads are getting impressions and clicks

Find out whether your ads have earned any impressions, clicks, and more from your Ads tab.

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click the Campaigns tab and select your campaign.

3. Click the Ads tab to see performance statistics for your campaign’s ads.
What to look for:

¢ How different ad creatives compare in their performance
¢ Which creatives perform better on certain placements.

¢ Which ad formats (image, video, text) perform better.

Example

This Yosemite Hikes campaign has two different ad creatives.

Ad Campaign Clicks Conversions

Yosemite Hikes 150 20

i &

Half dome

Yosemite Hikes 150 5



Hiker

The Half dome ad gets more conversions than the Hiker ad, so the account manager
decides to remove the latter from this campaign.

Identify the ad targeting that's getting results.

Scan the tabs under your Display Network tab to see how your ad targeting methods perform.

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click the Campaigns tab and select your campaign.

3.
4

Click the Display Network tab.

. Click any of the sub-tabs: Display Keywords, Placements, Topics, Interests & Remarketing, Age,

and Gender.

What to look for:

Remove targeting methods that don't perform well or that restrict your audience too much.

Identify the targeting methods that get your ads on the most appropriate placements and in front of your
intended audience.

Example

An account manager has been using topics like Hiking & Camping to target ads for his
Yosemite Hikes campaign. However, the automatic placements where these ads appear based
on his topic targeting aren’t as relevant as he’d like. So, he decides to use display keywords
like half dome hikes and hike Yosemite to target his ads as well.

Get insights into why your ads were matched to a specific placement
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Sign in to your AdWords account at http://adwords.google.com [£.
Click the Campaigns tab and select your campaign.
Click the Display Network tab.

Click the Placements tab.



5. Click the "Segment" drop-down menu and select "Targeting mode." You’ll see your placements broken

out into the following categories:

o Auto-targeted: the placement was matched due to automatic targeting found by the Display

Campaign Optimizer.

o Other display targeting match: the placement matched your managed placements, interests and

remarketing, topics, gender, or age targeting.

Find out which demographic groups are seeing your ads

Discover the demographic groups you’re reaching from your Age and Gender tabs. You'll see these stats

even if you haven’t added demographic targeting.

Click the Display Network tab

What to look for

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click the Campaigns tab and select your campaign.

3.
4

. Click the Age or Gender tabs to see performance statistics.

Demographic groups with high conversions

Demographic groups with low cost-per-acquisition.

Age groups or a gender outside of your target audience that you can exclude.

Certain groups that you want to target with ad creative and targeting methods that are a better audience

fit.

Example

This Yosemite Hikes campaign advertises tours that are relevant to all age groups.

Age

18-24

25-34

35-44

45-54

55-64

Campaign

Yosemite Hikes

Yosemite Hikes

Yosemite Hikes

Yosemite Hikes

Yosemite Hikes

Clickthrough Rate

.26%

.20%

.16%

.16%

14%



Unknown  Yosemite Hikes .15%

The account manager notices a higher clickthrough rate amongst people in the 18 - 24 age
group. Since people in this age group tend to click ads in this campaign more often than other
age groups, he decides to revisit the ad creative and targeting to make it appealing to other age
groups.

Note

If you exclude people in the "unknown" category you may be excluding some of your target audience.

More about how to reach people of specific age and gender.



About Search Funnels reports

Once you've set up Conversion Tracking, you'll have access to a handy set of reports about your
conversions (those important actions your customers take on your website, such as a purchase or email
signup).

These reports are called Search Funnels. "Search," of course, refers to people searching on Google. "Funnels"
refers to the series of steps your customers take before completing a conversion. Think of it as a passage (or

funnel) through which your customer reaches the conversion.

Search Funnels can give you more detailed information about ads, clicks, and other elements that are part of your
online campaign. This gives you a better sense of your customers and, ultimately, the effectiveness of the ads and
keywords you've created. Here’s an example:

Example

The conversion rate for one of your keywords, shoes, is low. So you’re not sure if it’s contributing to
your business. But by looking at your Search Funnels report, you see that the keyword shoes is
responsible for assisting with a high number of conversions for your other keywords. You realize the

keyword shoes is playing an important role in your business afterall.

Use My Client Center? You can also use Search Funnel reports to see how keywords across all of your accounts
interact to drive conversions. Just follow the steps below to access the reports.

— | Find your Search Funnels reports

1. Sign in to your AdWords account at https://adwords.google.com £ .
2. Click the Tools and Analysis tab.
3. Select "Conversions."
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4. On the bottom left-hand side of the page, click the Search Funnels link.

5. You'll now see a series of reports that you can click on to learn more about your clicks and conversions.

— | Find your Search Funnels reports in an MCC account

Sign in to your My Client Center [ account.
Click Conversions in under the My Client Center button.
Select “Search Funnels.”
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You'll now see a series of reports that you can click on to learn more about your clicks and conversions.

Follow steps in your account

Search Funnels can easily be viewed inside of your regular report tables. Click this link to go to your account

and see a guided tour that walks you through each step to enable Search Funnel columns in your account.



Or, you can read the instructions

below.

= | Add Search Funnels data to tables on your Campaigns tab

Sign in to your AdWords account at https://adwords.google.com [ .
Click the Campaigns tab.

Click the Columns drop-down button.

Select “Customize columns.”

In the “Select metrics” section, click Search Funnels.
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Click to Add all columns, or Add only certain columns.

Reports and data

Along with the Overview and Top Conversions report you'll see on the Search Funnels page, you'll also find

several more detailed types of reports.

If you use Cross-account Conversion Tracking

Search Funnels will show you data for how all the keywords across all your accounts interact with one
another. But if you're in Search Funnels for one of your individual accounts, keywords from other
accounts won’t be shown. To see the full data and all keywords, read the Search Funnels reports

within your MCC account.

Read on to learn more about the different reports available. And keep in mind: Conversion reports are based on

many-per-click conversions unless stated otherwise.

Report on customer search patterns

The Top Paths report shows you the most common paths your customers take to complete a conversion. It
provides this information based on the ads that were shown or clicked, or both, before a conversion took place.

Within this report, there are four more specific reports. Click the links below to learn about each one:



Top Paths (Clicks) report

Understand your customer's conversion journey with this report. Specifically, this report shows the
sequence of keywords that customers clicked before completing a conversion, and how frequently that

sequence happened.

You can examine the most common paths your customers are taking .(Do they research first, then search for
reviews, before searching for your brand?)

And you can dive into the path data to understand which keywords are typically the first-step on your

customers’ journey. These keywords are introducing customers to your website, so they hold significant

value as a gateway to your business.

May 2,201 -Apr 1, 2012

For example, the fourth row of this Top Paths (Clicks) report shows that there were 24 conversions in which
the customer first clicked on an ad for the keyword "interesting blogs to read," then an ad for the keyword
"read blogs," and then an ad for "funny blogs to read," before completing a conversion. This report is
available at campaign, ad group, and keyword levels.

Top Paths (Impressions) report

This report shows the numerous related keywords customers searched with before completing a conversion.
It also shows the sequence of keywords where your ads appeared for customers as they searched,

regardless of whether they clicked.



For example, the top row of this Top Paths (Impressions) report shows that there were 199 conversions in
which the customer first searched and saw an ad for the keyword "funny blogs," then searched again and
saw an ad for the same keyword before completing a conversion. For each of these paths, the customer

could've clicked on either ad, or both. This report is available at campaign, ad group, and keyword levels.

Keep in mind, this report is cut off at a frequency of 10 or fewer conversions.

Top Paths (Query Paths) report

This report shows actual customer searches. This is different than Keyword Paths in Search Funnels, which

reflect the keywords that were matched by the customer's search.

May 2,201 -Apr1,2012 -

For example, this report shows that nine conversions were preceded by two clicks from the query "famous

blogs."



Query Paths will only reflect clicked search ads, not search impressions. A small number of conversions --

where certain data couldn't be detected -- may be filtered from the Query Paths report.

— | Top Paths (Transitions) report

This report also shows paths, but collapses any keywords that were repeated along the way. This is useful

for seeing conversion paths that consist of different keywords, and how customers move between

keywords.

For example, the top row of this Top Paths (Transitions) report shows that there were 30 conversions where
the customer first searched and clicked on an ad for the keyword "funny blogs" one or more times, then
searched and clicked on an ad for the keyword "funny blog" one or more times before converting. This

report is available at keyword, ad group, and campaign levels.

Reports on assist clicks, assist impressions, and assisted conversions

Often, the "last click" before a conversion gets all the credit. But there are also little helpers that might've also
guided your customers toward that conversion. Specifically, these are:

¢ Assist clicks: All the clicks leading up to a conversion — except for the last click — for each keyword.

¢ Assist impressions: The search ads that showed but weren't clicked by a customer as they searched.

The Assist Clicks and Impressions report identifies these little helpers, so you can see how useful they are to your

campaigns. Click the link below to see more details about this report:

— | Assist Clicks and Impressions report
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This report shows you the assist clicks and impressions that might've helped users get to that last click

before they purchased your product or signed up for your newsletter.

It also show you ratios for assist click/last click and assist impressions/last clicks. These ratios further help

identify keywords that otherwise might not be noticed if you only looked at last clicks.

This report is based on one-per-click conversions.

Assisted Conversions report

Google Adords
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The Assisted Conversions report can help you quickly identify which keywords are helping to drive the most
conversions. You might find that some keywords are the last click for very few conversions, but actually
assisted many conversions. In those instances, you might want to try increasing investment for these

keywords to see whether you can drive more conversions for your business.

This report includes a helpful metric: Assisted Conversions / Last-click Conversions. This number helps you



see how high in an upper funnel a keyword is. And that makes it a great and easy starting point to

understand whether a keyword has a lot more value than previously thought.

For example, if a keyword has a ratio of 2, it means that for every last-click conversion it provided, it also
assisted 2 more. Consider testing increased bids for these keywords, to see if you can drive a higher return-

on-investment.

Example

You own a spa for dogs, and you're running an online campaign. One of your keywords, free
paw massage, gets a lot of last clicks before customers finally buy. Another one of your
keywords, dog pampering, doesn't get a lot of last clicks. But then you look at an Assist
Analysis report and see that this keyword has an assisted-conversion/last-click ratio of 2. That
means that for every last-click conversion, this keyword assists two more. Because of this, you

invest more in dog pampering, which brings even more traffic to your site.

Reports on first and last clicks

The First click Analysis report can help you see which keywords introduce customers to your site, while the Last
Click Analysis report can help you see what completed the conversion. Think of these as different salespeople in a
department store: one salesperson might be the person who first spoke to the customer, while another salesperson

closed the deal.

Reports on timing

These reports can give you a sense of the steps your customers take or the pages they visit as they complete a
conversion. This process is often called a funnel, which leads to a conversion or business goal. These reports can

also give you a sense for how long a funnel takes.

Click the links below to learn more about each report:

= Path Length

This report gives you a high-level look at the steps your customers take or pages they look at on their way to

completing a conversion.

Here's one that focuses on clicks:



This shows that most of your conversions happen after multiple clicks, which tells you that there might be
some opportunities to refine your keywords and ads. Keep in mind, unless you’re using Cross-account
Search Funnels reports, this report only reflects the keywords and ads in your account, so if these paths of

clicks seem shorter than you might expect, that's why.

You can also use the Path Length report to look at impressions. For example, you can see whether most

conversions happen after the customer searches multiple times or the first time he or she sees your ad.

= Time Lag

As you probably guessed, this report has to do with time. Specifically, it's how much time it takes for a

customer to complete a conversion after the following:

e The first impression of a search ad
¢ Their first click on your website

¢ Their last click on your website

With this report, you can explore whether it takes several days or more for your customers to convert.
Ensure that your search advertising is on all days of the week and times of the day, so that you are present
throughout your customers’ research cycle.

If you're tracking the value of your conversions, you can also use this report to identify whether customers

that take longer to convert spend more with you and are more valuable for your business.

Because it might take some time to learn the Search Funnels terminology, here's a quick list of terms and their
definitions.

— | Conversion terminology cheat sheet



Assist Clicks: Any search ad click that happened prior to the "last click" before a conversion.

Assisted Conversions: The number of conversions that were assisted by a particular campaign, ad
group, or keyword. Assisted conversions don't include last click conversions.

Assist Clicks / Last Clicks: The ratio of assist clicks / last clicks for a particular campaign, ad group, or
keyword.

Assist Impressions: Any search ad impression that wasn't clicked and happened prior to a conversion.
Assist Impressions / Last Clicks: The ratio of assist impressions / last clicks for a particular campaign,
ad group, or keyword.

Last Clicks: Any search ad click that happened just before a conversion.

Last Click Conversions: The number of conversions that had a particular campaign, ad group, or
keyword as the immediately preceding search ad click.

Path Length (Impressions): The total number of search ad impressions that preceded a conversion.
These could've been clicked or not clicked.

Path Length (Clicks): The total number of search ad clicks, including the "last click," that preceded a
conversion.

Time Lag (from first impression): The total amount of time from when the viewer first sees one of your
search ads (clicked or un-clicked) until conversion. The upper bound is 30 days.

Time Lag (from first click): The total amount of time from when the user first clicks on one of your
search ads until conversion. The maximum time that can be measured is 30 days.

Time Lag (from last click): The total amount of time from when the "last click" happened, until
conversion. There can be significant lag from last click, as AdWords will count a conversion happening
up to 30 days after the last click.

Top Paths (Clicks): Describes the sequence of search ad clicks leading up to conversion. Can be at
the keyword, ad group, and campaign level.

Top Paths (Impressions): Describes the sequence of search ad impressions leading up to conversion.
Can be at the keyword, ad group, and campaign level.

Top Paths (Clicks, Transition Only): Collapses consecutive "repeat clicks" on a conversion path.

Top Paths (Impressions, Transition Only): Collapses consecutive "repeat impressions" on a
conversion path.

View-through conversion data

A View-through Conversion happens when a customer sees an image or rich media ad, then later completes a

conversion on your site. This is different from a Click-through Conversion, which happens when a customer had

previously clicked on an ad (such as on the Google Search or the Google Display Network) and then completed a

conversion on your site.



The data you see in your reports can be affected by how you're tracking view-through conversions. Here's how,

depending on whether or not the feature is enabled or disabled in your account:

¢ Disabled: If a customer views your display ad, doesn't click it, and then later clicks on a search campaign ad,
we'll count one view-through conversion and one click conversion.
« Enable: If a customer views your display ad, doesn't click it, and then later clicks on a search ad, we'll count

only the last conversion type (the click conversion, for example).
Benefits of view-through conversions

View-through conversions is a helpful way to track the value of your display ad campaigns on the Google Display
Network. That's because it measures the conversions where a customer saw -- but didn't click -- a display ad on
the Google Display Network before completing a conversion. In turn, this can help determine the best places to

advertise.

= | Set up view-through conversions

To review or set up your view-through conversion settings for a particular conversion, follow these steps:

1. Sign into your AdWords account.

2. Click the Tools and Analysis tab, then select conversions.
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3. Click the conversion you'd like to edit, then click the Advanced tab.

4. Click Disable or Enable view-through conversion tracking.



Google AdWords

Low conversion data

Sometimes, conversion numbers are lower than you might expect on your reports. This can happen for a few
reasons. Here are the most common ones:

¢ Conversions counted within 30 day window
Google AdWords conversion tracking only records conversions that happen within 30 days from the time an
AdWords ad is clicked. So, if your customer completes a conversion after that time, it's not recorded.

¢ Customer disabled cookie
If a customer disabled cookies in her web browser before visiting your website, or blocks Google's conversion
tracking cookie, we can't record her conversions -- there's no cookie to record the information.

¢ Customer didn't get to your site through Google

If a customer reached your site through a search engine other than Google, his conversions won't be recorded.

Tips

¢ You can select between 30 (default), 60, and 90 days of history data leading up to a conversion using
the conversion history window. For any time span you select, you'll be able to see the search ad
impressions and clicks within that time period prior to a conversion. The information will be included
in each Search Funnels report, with the option to toggle between time spans.

¢ You can compare Display Network conversion and search conversion rates in your reports down to
the ad group level.

e Pausing your campaign or capping your budget can cut off potential customers who're in the middle
of researching your products.

¢ If you know customers are visiting multiple times before conversion, consider re-engaging these

repeat visitors -- say, with targeted website content or a discount.



Measure keyword performance on the
Search Network

Just like all good managers evaluate their employees' performance on a regular basis, you probably want
to review your keywords' performance to see which ones are helping you meet your advertising goals for
your campaigns that target the Google Search Network. To do so, you can view and download your
keyword performance from a specific time period, or customize your AdWords statistics table to track how
your keywords are performing by match type. You can also run a keyword diagnosis to review your
keyword Quality Score.

= View and download your keyword performance

1. Sign into your AdWords account at https://adwords.google.com &

2. Click the Campaigns tab.

3. Click the Keywords tab. Make sure your statistics table contains the date range, columns, filters, and
segments you'd like to include in your report. Segments that you've applied to the data in the table
show up in your report as columns. Learn how to create a customized view of your data.

4. Click the Download button | #, .

5. You'll see a Download and schedule report panel above your statistics table.



6. Name your report, and then choose the type of format.
7. Click Create.

Note

Due to the large amount of information that must be collected to create the reports, complete data for a

given day is not available until 3 p.m. PT the following day.

Use specific segments, columns, or filters to track keyword statistics

You can customize your statistics table to view keyword data by the following:

¢ Segments: Split your data into rows by the options you select (such as date, click type, or device).
¢ Columns: Add specific types of data to your statistics table.

¢ Filters: Search for statistics you'd like to see.

Use segments to see performance of search terms match type

You can see your keyword data segmented by search terms match type, which are broad, phrase, and
exact match search terms that triggered your keyword. This allows you to compare statistics such as clicks,
impressions, CTRs, or conversion rates for search terms that triggered your ad. Use segmentation options to

identify which keywords are driving the best performance for a particular search term match type.

To segment your data by search terms match type, click the Segment button above your statistics table

and select "Search terms match type" from the drop-down.



Use columns to track your Quality Score

Quality Score is a measure of how relevant your ads, keywords, and landing page are to a customer. Each

keyword gets a Quality Score on a scale from 1 to 10, where 1 is the lowest score and 10 is the highest.

To enable your Quality Score column, go to the Keywords tab and click the Columns button above your

statistics table, then choose Customize columns. In the Attributes section, click the Add link next to Qual.

score.

Use columns to view your first page and top of page bid estimates

Your first page bid estimate and top of page bid are the approximate cost-per-click (CPC) bids needed for
your ad to reach the first page of Google search results or the top of the page when a search term exactly
matches your keyword. The estimates are based on your Quality Score and current advertiser competition
for that keyword. If your first page bid estimate is very high, it may mean that your keyword's Quality Score

is poor.

To see your first page bid estimate or your estimated top of page bid, go to the Keywords tab and click the
Columns button above your statistics table, then choose Customize columns. In the Attributes section,

click the Add link next to Est. first page bid or Est. top page bid.

Use columns to view your keyword match type

Your keyword match types are the keyword matching options -- broad, phrase, exact -- that we use to
determine which Google searches can trigger your ads to appear. You might see more ad impressions,
clicks, and conversions with some match types, or fewer impressions and more narrow targeting with

others.

To monitor how a particular keyword match type is performing, go to the Keywords tab and click the
Columns button above your statistics table, then choose Customize columns. In the Attributes section,
click the Add link next to Match type.



Use filters to sort your keyword data

Filters allow you to search for specific types of data so you can easily evaluate the performance of your
keywords. You might filter your data to see which keywords are eligible to trigger ads, or maybe you'd like

to see which keywords have a good return-on-investment.

To create a filter, go to the Keywords tab and click the Filter button, then choose Create filter. In the filter

panel, select which filter you'd like to use from the drop-down menu.

Diagnose your keywords

If you'd like to know whether your keyword is showing ads or if you'd like to get a snapshot your keyword's
Quality Score, you can easily diagnose your keywords. Follow the steps below whether you'd like to

diagnose individual keywords or multiple keywords at once.
Diagnose individual keywords:

1. Click the Campaigns tab.

2. Click the Keywords tab.

3. Hover over the speech bubble next to the status of your keyword to see whether your keyword is
showing ads and its Quality Score. If your keyword isn't showing ads, we'll explain why and help you
solve the problem. You'll also see a breakdown of your Quality Score, which includes your keyword

relevance, landing page experience, and landing page loading time.

Diagnose multiple keywords at once:

1. Click the Campaigns tab.
2. Click the Keywords tab.



3. Click the "Details" drop-down menu.

4. Select Diagnose keywords.

5. You'll see a Diagnose keywords panel where you can customize your diagnosis to answer specific
questions about your ad's visibility. For example, you can test whether people on specific Google
domains, those using Google in a particular language, or those in particular countries are seeing your
ads. Choose which attributes you'd like to test.

6. Click Run test.
7. Once you receive results from your diagnosis, the information in the Status column will change. To see

results for a particular keyword, hover over the speech bubble in the Status column. Click the Close

link above the table to clear your diagnosis.



Note
The results of your diagnosis are only applicable at the time when you run the diagnosis and may quickly
become outdated. Your most recent diagnosis will be indicated by a timestamp above your statistics

table ("Diagnosis complete - -"). Run a new keyword diagnosis when you want to see fresh data.



Measuring reach and frequency

By analyzing reach and frequency data, you can find out how many people saw your ads and how many times they saw them over a certain period of
time. Reach is the number of unique customers exposed to a particular advertisement during a specified period of time. Frequency is the minimum
number of times a unique user saw your ad over a given time period.

Daily, weekly, and monthly reach and frequency data is available for all Display Network Cost-per-thousand impression CPM campaigns, as well as Display
Network Cost-per-click (CPC) campaigns that are using interest-based advertising and/or frequency capping. Reporting is available from September 1, 2011
to the present.

See reach and frequency data

1. Sign in to your AdWords account at https://adwords.google.com.

2. Click the Campaigns tab.

3. Click the Dimensions tab. If you want to run the report for a specific campaign or ad group, click its name in the side panel.

4. Click View in the toolbar above the table, then click Reach and frequency. You can choose whether to view daily, weekly, or monthly statistics.

5. To download the data in a report, click the download button | &, |in the toolbar above the table.

How does Google calculate reach and frequency?

Google calculates the estimated frequency by obtaining data from a sample group. This data is then applied to the full set of impressions to determine the
estimated reach.

For example, let's say customers from the sample group saw the ad an average of two times each, and there were 500 total impressions for the ad. The reach
is calculated by dividing 500 by two to determine a reach of 250 unique users. (Note that AdWords minimizes the possibility that anyone is counted twice,
including those who reset their cookies.)

Did you know...
You might be surprised to see decimals in your Unique users, Clicks, and Conversions columns, like this:
1,809,601.18

Because the estimated frequency is based on sample group data, the estimation of unique users, and their subsequent clicks, isn't always a whole
number.

About frequency capping

If you turn on frequency capping for a campaign, you specify a limit to the number of impressions you'll allow per day, per week, or per month for an individual
on the Google Display Network. You also choose whether the limit applies to each ad, ad group, or campaign. Frequency capping doesn't apply to the Search
Network. Setting a frequency cap can be helpful if you want to limit the number of times someone sees your ad, or if you want to focus more on gaining
exposure to new people. You may want to note the following:

* A change to frequency capping, such as a change from a cap of two to three, can take up to a day to take effect.
o Although it's uncommon, a slight server delay can result in the frequency cap that you've set being exceeded.
e You can use data from the CTR and Conversion rate columns of your frequency report to help guide you on where to set the cap.



Measuring geographic performance

Much like how snhorkeling is popular in Hawaii and sledding is in Alaska, you may find that your business
flourishes in particular parts of the world. Performance data in your AdWords account can help you
identify those geographic areas, so you can decide where to focus more of your advertising efforts and
budget.

See performance by geographic location

If you already set your location targeting and your campaigns have been running for awhile, you can track your

account, campaign, and ad group performance by geographic location in the Dimensions tab.
Two types of data are available for geographic location:

¢ Geographic: Your Geographic data shows your customers' physical locations or locations that they had shown
interest in through searches on Google or Google Maps.
¢ User location: Your User Location data shows only your customers' physical locations, regardless of any

locations they may be interested in.

You can pull both of these reports and overlay them to get an idea of where your customers are located, even if

they had been interested in a location different than their physical location.

Example

Mindy owns a bookstore in Sacramento. She pulls a geographic performance report (which includes
physical location and location of interest data) and finds that she's gotten 70 ad impressions in

Sacramento and 30 ad impressions in San Francisco.

She then pulls a user locations report (which includes only physical location data) and finds that she's

received 10 ad impressions in Sacramento and 90 impressions in San Francisco.

Mindy draws the conclusion that most people searching for her business are located in San Francisco,

and she decides to allocate more of her advertising budget there.

— | See your geographic data



1. Click the Campaigns tab.
2. Select the campaign or ad group you'd like to see in the side panel. You can also see statistics for your

entire account by clicking All online campaigns in the panel.

Google AdWords

3. Click the date range menu on the top right corner of the page and select the time period you'd like to

analyze.

4. Click the Dimensions tab.



Google AdWords

5. Click the View menu in the toolbar and select "Geographic" or "User locations" from the drop-down

menu, depending on which type of data you're interested in. Your statistics table will update with

geographic data.

Google AdWords

Allonline campaigns

6. By default, the Geographic view on the Dimensions tab will show country-level stats. To view data by

region, metro area, or city, follow these steps:

o Click the Columns button in the toolbar above the table and select "Customize columns" from the drop-

down.



o Click Level of detail, and add the geographic regions you'd like to view in your stats table.

Google AdWords

o Click Save.

7. To download the data in a report, click the download button | #, | in the toolbar above the table. When
downloading, you can also choose to segment your data by device.

Google AdWords e




Types of geographic performance data

When you view geographic data in your statistics table, you may also see the following columns and details:

= Location type

In the Location type column, we record the location type for the ad impression. AdWords allows you to

target customers by two different location types:

¢ Physical location: Location where the customer was physically located when the ad impression was
recorded.

¢ Location of interest: This can be the location that a customer searched for on Google, an area that was
searched on Google Maps, the default location applied to Google search results, or a location related to

the content someone viewed.

In addition, if someone performs a search on a country-specific domain (such as google.fr, google.co.uk) but
her IP address shows that she is located in a different country, then we'll record her location of interest

based on the country-specific domain.

Location type statistics aren't available before November 15, 2011, which will be indicated by "--" in the

report.

Get more details about location types and advanced location options.

Tip

Geographic reports can only show data about locations you can target within the country. For
example, in India, advertisers can target at the region level, so geographic reports will only
show data for regions that they can target in India. In countries that don't have region or city-

level targeting, geographical data is only available at the country level.

= Most specific location

The Most specific location column shows the most detailed information we have about the location that

was used to show your ads. This location may either be your customer's physical location or a location that



she showed interest in. The most specific location varies by country depending on the level of geographic
targeting available. For example, in India, only regional targeting is available at this time, so geographic
reports will not show data more specific than the regions that can be targeted in India. In the U.S., the most

specific location may be available at the postal code level.

Most specific location statistics aren't available before November 15, 2011, which will be indicated by "--"

in the report.

Unspecified areas

You may notice data from "Unspecified" areas. There are a number of reasons why an area where your ad
showed might be unspecified:

¢ Country-specific domains: If someone performs a search on a country-specific domain (such as
google.fr, google.co.uk) but her IP address shows that she is located in a different country, then we'll
record her location based on the country-specific domain, but we won't be able to identify the city or
region.

+ |IP address or search query: We can't determine the location from the IP address, and the search
query didn't indicate interest in a recognized location.

¢ Multiple cities/regions in Google Maps: The search was performed on Google Maps within a large

geographic area that included several cities or regions.

Variation in geographic reporting numbers

The geographic data in your AdWords statistics table may vary somewhat from other data in your account or

sources such as third-party tracking or web logs. Click the section below to see a few possible reasons.

— | Reasons for data variation

e Campaign or billing summary: Performance data may vary slightly from data in your campaign
summary or billing summary because our data collection techniques can vary. For invoicing and
campaign spend, use the reports in the billing summary tab.

¢ |IP addresses: IP addresses are routinely re-assigned, and AdWords updates its IP data
regularly to reflect these changes. Third-party tracking providers may update their IP data on a
different schedule.

¢ Invalid clicks: AdWords filters out invalid clicks, so the number of clicks per geographic area
may differ from that shown by other data sources.

¢ Location of interest: AdWords may pick up on locations that a customer is interested in, which
other data sources may not be able to detect.



Other sources of traffic: Third-party tracking providers may count all sources of traffic to your
site, instead of just AdWords traffic. For example, let's say AdWords generates 50 visits to your
site, but your site has a total of 100 visits from all sources. AdWords will only report on the 50
clicks from AdWords traffic.



Measuring performance by periods of time

Curious whether your ad is clicked more often on Fridays than Sundays? Want to easily compare ad group impressions by quarter?
Compare performance across two time periods

Let's say you want to know how your campaigns did last week compared with the week before. Or maybe you want to see data for the current month
compared with this month last year. You can see all this by using the “compare date” option in the date range drop down menu.

1. Sign in to your AdWords account at https://adwords.google.com.
2. Click the Campaigns tab.

3. Click the down arrow in the date range in the upper right corner of your screen.

Aot campaigns

4. Make sure the “Compare dates” option in set to "ON".

5. In the top section of the menu, select the date range you're interested in. Then, in the section below "Compare dates” select whether you'd like to
compare the “previous period” or the “same period last year” or create a custom comparison.

6. If you select custom, you'll be prompted to enter a specific date range.

7. Click “Go".
8. Next you'll see see results for both time periods charted in your performance graph.
9. To see the comparison metrics in your statistics table, you'll need to click on the “+" icon that has now appeared in each of your column headers. Doing so

will expand a column to in show four columns: the current time period, the previous time period, the numerical change between the two periods, and the
percentage change.

IERRERRRR}

Once you chose a time period, both alone and as part of a comparison, those dates apply across your account (until you change them).

The “compare dates” feature is useful for comparing performance across two time periods, but not more than two. For example, if you want to look at
performance per day over the last month, it's better to use segments, which we describe below.



Segment your data by time

Segments are helpful because they can provide a more granular view of your data. For example, say you used the date range box and selected “Last week” in
order to look at overall performance for the last week. But then you decided you wanted to see that week broken out by day. For this, you would use segments.

As you can see in the table below, once you created a “Day of the week” segment, your single row of data became eight rows of data: the original row plus
one new row for every day of the week.

‘Al onine campaigns =
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Click the Segment button above your statistics table and select "Time" from the drop-down. This splits your statistics table into rows based on the period of
time you select.

Options include:

o Day of the week (e.g., Monday, Tuesday, Wednesday)
o Day (e.g., Wed., December 21, 2011)

e Week

e Month

e Quarter

e Year

.

Hour of day

Next step

Get detailed instructions on how to segment and download your data.

Use the "Time" view in the Dimensions tab

The Dimensions tab lets you slice and dice your data by period of time across an ad group, a campaign, or your entire account. For example, you might want
to track an ad group's performance on an hourly basis to see how well it's performing at different times throughout the day. Then you can use these insights to
schedule your ads for the hours when they're most likely to receive the greatest number of impressions and clicks.

For example, you could run a report to compare your total clicks in January across ad groups, or find out whether a certain campaign has a better CTR at 10
a.m. or 2 p.m. How you view your data is up to you!

Here's how to see performance by time period in the Dimensions tab:

1. Sign in to your AdWords account at https://adwords.google.com.
2. Click the Campaigns tab.

3. Select the campaign or ad group you'd like to see in the side panel. You can also see statistics for your entire account by clicking All online campaigns in
the panel.

4. To see data for a specific period, click the date range menu on the top right corner of the page and select the time period you'd like to analyze.

5. Click the Dimensions tab.

6. Click the View button in the toolbar above your statistics table.

7. Select Time from the drop-down, then choose Day, Week, Month, etc. Your statistics table will update with time data.

8. Once your statistics table looks the way you want, you can download the data in a report. Just click the download button | &, .




Tip

You can also view performance by geographic location and see reach and frequency data on the Dimensions tab.



Using auction insights to compare
performance

The Auction insight report lets you compare your performance with other advertisers who are participating
in the same auctions that you are. With the Auction insights report, you can see how often your ads rank
higher in search results than those of other advertisers, and how your share of total possible impressions
compares with theirs. This information can help you make strategic decisions about bids, budgets, and
keyword choices by showing you where you are succeeding and where you may be missing opportunities
for improved performance. This report is available at the keyword, ad group, and campaign levels.

AdWords essential

The auction: how Google decides which ads to show and their order

Auction insights statistics

The Auction insights report provides five different statistics: impression share, average position, overlap rate,
position above rate, and top of page rate. You can generate for one or more keywords, ad groups, or campaigns,
as long as they meet a minimum threshold of activity for the time period selected.

¢ Average position

Average position is a quick way to gauge how high your ads are ranking compared with those of other
advertisers competing in the same auctions. Average position is the average rank of the ad in the auctions,
which determines the order of the ads on the search results page.

For example, if one of the other participants in your Auction insights report is showing a “5” in the Average
position column, this means that participant’s ad showed, on average, in 5th place on search results pages
where your ad also showed.

¢ Impression share

Impression share is the number of impressions you received divided by the estimated number of impressions

you were eligible to receive. Eligibility is based on your current ads' targeting settings, approval statuses, bids,



and Quality Scores. In the Auction insights report, impression share also tells you the impression share of

other advertisers as a proportion of the auctions in which you were also competing.
Overlap rate

Overlap rate is how often another participant's ad received an impression when your ad also received an

impression.

For example, if one of the other participants in your Auction insights report is showing “60%” in the Overlap
rate column, this means that in six out of every 10 times your ad showed, an ad from this participant showed
as well.

Position above rate

Position above rate is how often the other participant’s ad was shown in a higher position than yours was,

when both of your ads were shown at the same time.

For example, if one of the other advertisers in your Auction insights report is showing “5%” in the Position
above rate column, this means that the other participant’s ad showed in a position above yours in 5 out of

every 100 times your ads showed at the same time.
Top of page rate

Top of page rate tells you how often your ad (or the ad of another participant, depending on which row you are

viewing) was shown at the top of the page, above the unpaid search results.

Note

This report provides information on other advertisers who participated in the same auctions as you. This does

not indicate that the other advertisers have the same keywords, match types, or other targeting settings as you.

The other advertisers' metrics shown are based only on instances when your ads were also estimated to be

eligible to appear. This report will not reveal the actual keywords, quality, bids, or settings from your

campaigns, and it will not give you insight into the same information for others.

While this information is already available by searching on Google -- and many already attempt to estimate this

data by scanning the ads that appear -- this report will make it easier to access and understand this information.

It's free to advertisers whose keywords, ad groups, and campaigns have a minimum threshold of activity.

Find your Auction insights reports

Find your Auction insights reports

Auction insights data is available for campaigns, ad groups, and keywords that meet a minimum threshold



of activity. The instructions below are for finding Auction insights reports for keywords. If you would like to
find Auction insights data for your campaigns or ad groups, go to the respective tab and follow the
instructions below starting with Step 3.

Sign in to your AdWords account at https://adwords.google.com £

Click the Campaigns tab.

Click the Keywords tab.

If you'd like to select a specific keyword or set of keywords (rather than running a single report for all

Eal s

your keywords together), click the box next to the keyword or keywords you're interested in. Note: you
can only select keywords on a single page at a time (unless you run a report for “All”).

5. Click the "Details" box at the top of the statistics table.

6. In the dropdown menu, under “Auction insights,” click “All” or “Selected."

7. You'll now be taken to your Auction insights report. Note: only keywords that meet a minimum threshold
of activity will have the Auction insights report.
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See how to create the Auction insights filter

The Auction insights filter allows to you see at-a-glance, which of your keywords, ad groups, or campaigns
have Auction insights reports available to view. You can create an Auction insights filter at the campaign, ad
group and keyword levels. Below are instructions for creating a filter from the Keyword tab. To create the
Auctions insights filter for Campaigns or Ad groups, go the respective tab and follow the instructions below
starting with Step 4.

Sign in to your AdWords account at https://adwords.google.com [ .
Click the Campaigns tab.

Click the Keywords tab.

Click the "Filter" button above your statistics table.

Click "Create filter."

o M 0 b
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6. Click the dropdown menu in the panel that appears to see a list of conditions for new filters. Select

"Auction insights" and click the circle next to "Available." (Click "Unavailable" to create a filter for for



keywords which haven't yet had enough activity for an Auction insights

report.)

Google Adiords g

7. Save this new filter by checking the "Save filter" box and clicking "Apply." The table automatically

updates to show you your keywords with available Auction insights reports.



Tracking performance on the Home tab

As you might know, the AdWords Home tab is a one-stop shop for much of your account information. Once you're familiar with it, you can customize
some of the modules on the page to better monitor your performance.

Choose or remove your modules

When you sign in, you can see as many or as few of the modules -- those boxes on the page that show information about your account -- as you'd like. Just
follow these steps to pick the ones that are most important to you:

1. Sign in to your AdWords account at https://adwords.google.com.
2. If you're not already on the Home tab when you sign in, click the Home tab.
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4. Under "Select modules," you'll see the modules you can choose from. Next to each one, check or uncheck the box in the Show? column, depending on
whether or not you'd like to see it when you sign in.
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5. Click Save.



Customize preset modules

We've created some preset modules for you, based on what many advertisers like to see. You'll see a performance graph, for example, that shows your clicks

over time.
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Still, you might find that impressions -- not clicks -- are more interesting to you. Or maybe you'd like to see both your costs and your clicks on the Performance
graph shown here. If that's the case, you can just customize the preset modules. Here's how:

1. Sign in to your AdWords account at https://adwords.google.com.
2. If you're not already on the Home tab when you sign in, click the Home tab.
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4. Below the "Select modules," you'll see all your preset modules. From there, click the drop-down menu to choose which area you'd like to customize. If you
choose "All campaigns," for instance, this means that this will affect the modules below that focus on all your campaigns overall, such as the Performance
graph.
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5. In the next drop-down, choose a metric -- or statistic -- you'd like to filter by. If you choose "Cost," for example, the Performance graph will show your
costs instead of your clicks over time.
6. Next, if you'd like, choose another metric to compare to the first metric. For example, if you choose "Cost" for the first metric, and then you choose



"Clicks," in this second drop-down menu, your Performance graph will show both your clicks and costs over time.

Google Adorcs

 enset o 2 S Mg )

7. When finished, click the Save button above the preset modules.

Create a custom module

Want to see which ads always have more than 100 impressions? Or which of your ads have less than 50 clicks? You can create custom modules that show you
specific information each time you sign in. Here's how:

1. Sign in to your AdWords account at https://adwords.google.com.
2. Click the Campaigns tab.

3. Asin our example, you'll see several sub-tabs: Campaigns, Ad groups, Ads, Keywords, Networks, Audiences, Ad Extensions, and Dimensions. If
you don't see some of these but would like to, click the drop-down button at the end of the tabs to add more.

Google Aiord

4. Click a tab -- that is, a category -- you'd like to create a custom module for. If you'd like to create one for keywords, for instance, click Keywords. Then,
in the grey bar below the tabs, click the drop-down menu that says Filter.

Google Adiords




5. From here, you can remove an existing module (by clicking Remove next to any listed module) or Create filter to create a new module.

Google Adiords

6. After clicking Create filter, you'll see a drop-down menu with several choices for areas you can filter by. For example, if you want to create filters for
keywords, you can filter by clicks, impressions, or Quality Score.

7. After making your choice, you'll see a second drop-down menu where you can further filter your choice. These options will depend on which selections
you've made in the previous tab. If you choose clicks, for example, you'll be able to choose whether you want clicks that are greater, less than, or equal to
a certain number.

Google Ador

8. Enter the amount you'd like to filter by in the empty box.

9. If you'd like to filter this further, click the +Add another link. You'll then follow the same steps of selecting a category, a filter type, and entering a value.
10. Click the Save filter box, give your filter a name, and click the Apply button. Then, to add this new filter to your Home tab, click the Home tab.
11. Click the Customize modules link in the top left-hand corner.
12. Find the name of your new filter in the list of modules, and click the box under the Show? column.

Google AdWords -
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13. Click Save. You'll now see this new custom module on your Home tab!



Using labels in AdWords

With labels, you can organize the elements in your account into meaningful groups so you can quickly and
easily filter and report on the data that is of most interest to you. You can apply labels to keywords,
campaigns, ad groups, and ads, which enables you to see how the custom categories you create are
performing relative to each other and to the unlabeled entities in your account.

Bob is an online retailer that sells apparel and accessories for men and women. He has campaigns for shoes,
clothes and bags for each of his three major markets (New York, Massachusetts and Pennsylvania) and within the
campaigns has separate ad groups for generic and brand keywords. This structure (ex: New York - Shoes - Generic
and Massachusetts - Shoes - Generic) means that he has the same ads and keywords in different parts of his
account. Without labels, Bob can't easily sort his account or run a report to see how well sneakers are selling in
New York compared to Massachusetts. With labels, however, Bob can create the label "sneakers" and apply it to
all sneaker-related keywords across his account. He can then filter by this label on the Keywords tab to only see
sneaker keywords, or can use the Dimensions tab labels reports to aggregate performance by label. These reports
allow him to the compare, for example, how sneakers perform against all other shoes, or how the label "sneakers"

compares with other individual labels.

Understanding labels

The diagram below illustrates how you can use labels to gauge the performance of custom categories across your
account. In this example, you've applied two labels, "Favorite" and "Brand" to different elements in your account.
It's important to know that labels aren't inherited down throughout the campaign. This means that if you apply a
label to a campaign, the label only applies to that campaign, not the ad groups and keywords that are within that
campaign. If you want a label to apply to an ad group or individual keyword as well, you'll need to specifically
apply the label to each.



Favorlte

Campaign #1

Favorlte

Ad Group #1 Ad Group #2

Fawvorlte
Brand

Keyword A

7 Clicks 7 Clicks 2 Clicks

My Account

2 Clicks

Brand

Campaign #2

Ad Group #3

Favorlte

Keyword E

10 Clicks

Brand

Keyword F

5 Clicks

There are four kinds of labels reports you can run, one for each element-type: campaigns, ad groups, ads, and

keywords. They're located on the Dimensions tab in the "labels" view.

. Campaign-level Reporting

When you run a labels report for your campaigns, you see the label "Favorite" is associated with 18 clicks. That's
because the total clicks for all the keywords under the Campaign #1, which has the "Favorite" label applied to it,
was 18. The label "Brand" is associated with 15 clicks because the keywords in Campaign #2, which has the

"Brand" label applied to it, received 15 clicks. The "Everything Else" row is blank because there are no campaigns

in this account without labels.

Label Clicks
Favorite 18

Brand 15



Everything Else 0

. Ad Group-level Reporting

But, because labels are not inherited, things look different when you run a report at the ad group level. In this
account, there is only one ad group with a label applied to it: Ad group #2 in Campaign #1. The keywords under
this ad group received a total of four clicks. So, when you run a labels report for your ad groups, the label
"Favorite" is credited with four clicks. The label "Brand" received zero clicks at the ad group level because there
are no ad groups in this account with the label "Brand". The "Everything Else" has 29 clicks because that's how

many clicks there were on keywords in unlabeled ad groups.

Label Clicks
Favorite 4
Brand 0

Everything Else 29

. Keyword-level Reporting

Reporting at the keyword level provides a different view. Here, "Favorite" received 17 clicks (keywords A and E),
and "Brand" received 12 clicks (keywords A and F) because those are the total clicks on keywords with those
labels. Note that the seven clicks for keyword A are counted in both rows because keyword A has both labels
applied to it. Because it's likely that many of your keywords will have more than one label, it's unlikely that the
number of clicks in each row will add up to the total number of clicks. In this report, "Everything Else" has 11 clicks

because that's the total number of clicks triggered by unlabeled keywords in this account.

Label Clicks
Favorite 17
Brand 12

Everything Else 11

Managing labels

There's more than one way to manage the labels in your account. You can create, add, and remove labels directly
from the labels drop down menu above your statistics tables on the Keyword, Campaign, Ad groups, and Ads
tabs. However, if you want to add or delete labels as well as edit your label names, description, and colors, or see

how many elements are designated with a particular label, you can visit the Labels admin page by clicking on the



link on the left side of your screen.

Click the links below for steps on how to do the following:

© Apply and delete labels using your Campaigns, Ad groups, Ads, and Keywords tabs.

1. Click the Keywords tab (or the Ad groups, Ads or Campaigns tab).

2. Using the "Customize columns" button, add the "Labels" column to your statistics table if it's not there

already.
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3. Select the keyword you'd like to apply a label to.

Google AdWords

| Alloniine campaigns

4. Click the "labels" drop down menu.



5. Select the labels you'd like to apply, or create a new one in the drop down menu.

Google AdWords
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6. Click "Apply".



Applying labels in bulk

To apply a label to all entities in a table, including the ones on subsequent pages that aren’t shown on the

first page, follow the steps below:

1.
2.

Click the Keywords tab (or the Ad groups, Ads or Campaigns tab).
Using the "Customize columns" button, add the "Labels" column to your statistics table if it's not there

already.
Check the box on the upper left corner of the table. This will select all of the keywords (or ads, ad

groups, or campaigns) currently visible in the table.

4. Click the message at the top of the table that says “Select all rows across all pages.”

5. Then click the “Labels” button above the table and select the label you want to apply (or create a new

one).

6. Click “Apply.”
7. You'll see a message that your labels are being applied. If it's a large job, this may take some time.

Click “Run in background” if you’d like to leave this page. To monitor the progress, you can check on
this request by clicking “Bulk Operations” and selecting “Bulk Edit.” Here you can view the status of all

your bulk editing requests. Learn more about Bulk edits

Filter by label using your Campaigns, Ad groups, Ads, and Keywords tabs.

1.
2.

Click the Keywords tab (or the Ad groups, Ads, or Campaigns tab)

In the "Filter" drop down menu, select "Filter by label"

3. Using the additional drop down menus, select the label or labels you would like to filter by



4. Click "Apply"
5. In the statistics table, you can see all the keywords (or ad groups, or ads, depending on what tab you
are working under) with that label (or combination of labels) as well as the other labels applied to each

entity.

Manage labels from the Labels admin page

You can get to the best place for managing your labels by clicking "Labels" in the left panel of your
AdWords account. Here you can see all your labels, and how many campaigns, ad groups, ads, and
keywords are designated with each. If you click on a number in either the campaigns, ad groups, ads, or

keywords columns of this table, you'll be taken to a new table filtered for just that label and entity.

You can also add and delete labels as well as edit label names, descriptions, and colors.

[

To change the name of a label, or its color, or to add or edit a description, click the label name or the color

square and a pop-up box will appear allowing you to type in a new name, or select a new color.

View your performance data by label

Here's how to view your Labels performance data on the Dimensions tab:

o > b =

Click the Dimensions tab

Click "View"

In the drop down menu, select "Labels"

Then select whether you'd like to view Labels data by keyword, ad, ad group, or campaign.

In the statistics table you'll see your performance data broken out by label at the level you selected for the
date range you've specified. The last row, called the "Everything Else row" shows a summary of performance

for all elements that are not associated with the labels in the table.

Tip



The "Everything Else" row shows a summary of performance for all elements that are not associated
with the labels in the table. In the case of an unfiltered labels report, the Everything Else row will
contain the total performance for all keywords without a label. But, if you filter the report to show two

of five labels, the Everything Else row will contain results for all keywords without those two labels.

This row comes in handy, for instance, when you are labeling branded vs non-branded keywords.
Since your branded keywords likely represent 10-20 keywords, you do not need to create a label for
the thousands of non-branded keywords in your account. Rather, you can simply run a report on the
branded label and see the results from the non-branded keywords reflected in the Everything Else

row.



Use segments to view performance data

Use segments to split your data into rows based on the options that matter most to you, such as periods of
time, click type, or device. This makes it easier to view the data by isolating exactly what you want to see.
Your segment choices vary depending on which tab of your AdWords account you're viewing.

Here's how to add or remove segments from the rows in your statistics table:

1. Sign in to your AdWords account at https://adwords.google.com [£ .

2. Click the Campaigns tab.

3. To see data for a specific period, click the date range menu on the top right corner of the page and select the
time period you'd like to analyze.

4. Click one of the tabs that appear in the middle of the page, such as the Campaigns, Ad groups, or Ads tab.

5. Click the Segment button above the statistics table.

6. To add a segment, select a segment from the drop-down. To remove a segment, select "None."

Google AdWords

7. Although you can only apply one segment at a time in your statistics table, you can apply multiple segments to
your data if you choose to download a report. Once your statistics table looks the way you want, just click the

download button | #, to create a report.

8. In the panel that opens, add additional segments by clicking +Add segment.



9. Click Create.

Available segments

Some segments can be found on almost every tab in your AdWords account, while others are only available on

particular tabs. In some cases, you may need to download a report to apply a particular segment to your data.

— | Click type

Use this segment to see which clicks resulted in visits to your website, or clicks on your phone number

when your ad is shown on a mobile device (also called click-to-call).

Note

Click type may apply to multiple aspects of the same impression (for example, a click-to-call impression
may show alongside a headline impression in the same ad). In this situation, you'll see "--" instead of
summary totals in your downloaded report. A sum total would be inaccurate because it would double-

count some of the impressions.

Here's how to add a phone number to your ad.

— . Conversions

If you've set up Conversion Tracking on your website, the segments "Conversion action name" and



"Conversion tracking purpose" can give you insight into conversion performance by individual action or

conversion type.

Device

Use this segment to compare performance across devices: computers, mobile devices with full browsers,

and tablets with full browsers.

Experiments

If you're running a Campaign Experiment, you can segment your data by experiment or control groups, or
both, on the Keywords, Ads, or Ad group tabs. You'll also have aggregate "control" and "experiment" data

on your Campaigns tab.

Keyword / Placement

Use this segment to compare how individual keywords are performing for particular ads.

This segment is available on the Ads tab only.

Network

Use this segment to compare Google search and Google Display Network performance. This is frequently

used to compare individual ads on the Ads tab.

Network (with search partners)

Use this segment to compare Google search, search partners, and Google Display Network performance.

This is frequently used to compare performance by network for individual ads on the Ads tab.

+1 Annotations

Use this segment to see how customers are interacting with +1 buttons on your ads.



Search terms match type

Segmenting a keyword by search terms match type can help you understand how actual search terms relate
to the keyword you have. This type of segment can show you how your keyword performs in its broad,

phrase, and exact matches.

You could use the segment to see the clicks, impressions, or CTR from each search term match type to a
certain keyword. Then you could make changes to your keyword match type to improve performance.

Example

Let's say you have a keyword, dog toys, that you've set to broad match, and a customer
searches for toys to buy for dogs. The search term match type will be broad. If the customer
searches for buy dog toys or buy dogs toys, the search term match type will be phrase. If the

customer's search is simply dog toys or dogs toys, the search term match type will be exact.

Your keyword Search term Search terms match type
dog toys toys to buy for dogs Broad match
dog toys buy dog toys Phrase match

buy dogs toys

dog toys dog toys Exact match
dogs toys

Now, let's say you add the segment to your statistics table, and you see that your broad match
keyword dog toys shows your ad for each search term match type (broad, phrase, and exact).
Based on how dog toys performs for each search term match type, you might decide to

increase or decrease your bid for the keyword.

Keep in mind

Even if you choose not to show your ads for close variants of your exact match and phrase match
keywords, you might still see an increase in the number of exact and phrase search term match types.
For example, if your keyword list includes the broad match keyword dog toys, and someone searches for

dog toy, we'll identify that search term match type as exact since dog toy is a close variant of dog toys.

Special category



The "Special category" segment is available when you download a report for your automatic placement
performance on the Google Display Network. It displays two types of pages that have shown your ads:

error pages and parked domain sites.

Time

Use this to split your statistics table into rows based on the period of time you select. If you're requesting a

substantial amount of data, you may get a message instructing you to download a report.
Options include:

¢ Day of the week (Monday, Tuesday, Wednesday...)
¢ Day (Wed., December 21, 2011 for example)

e Week

e Month

e Quarter

e Year

¢ Hour of day

Tip

You can also use the Dimensions tab to view performance by periods of time.

Top vs. Other

Apply the "Top vs. Other" segment to your statistics tables to find out where your ad appeared on Google's
search results pages and search partners' pages. Segmenting your data by "Top vs. Other" can help you
optimize your search campaigns to serve your ads on the parts of the page that perform best for you.

How to interpret the data

e Google search: Top -- Your ad ran above the organic Google search results.

¢ Google search: Other -- Any AdWords text ads that don't appear directly above Google search results
are categorized as "Google search: Other."

¢ Search partners: Top -- Your ad ran above the partner's organic search results on a search partners'
page.

¢ Search partners: Other -- Ads that don't appear directly above partner search results are categorized



as "Other."
¢ Google Display Network -- Your ad ran on the Google Display Network.



Understanding the Search terms report

Use the Search terms report to see how your ads performed when triggered by actual searches within the
for search terms that aren't as relevant to your business, and add them as negative keywords. This can
help you avoid spending money showing your ad to people who aren't interested in it.

What's the difference between a search term and a keyword? A search term is the exact word or set of words a
customer enters when searching on Google.com or one of our Search Network sites. A keyword is the word or set of

words AdWords advertisers create for a given ad group to target your ads to customers.

Example

David is looking to buy a Valentine’s Day bouquet online. He types “red roses” into the search box on
Google.com. “Red roses” is the search term. Let's say you're the owner of an online flower business.
Because you have included the word “roses” as a keyword in your AdWords campaign, your ad may

be eligible to show on David’s search results page.

View your search terms data

How To See Search Terms on AdWords

In this video we'll show you how to review the search terms users entered before seeing your AdWords ad. You
can use this knowledge to create more effective campaigns. Read more about how to improve your keywords for
search at http://goo.gl/e48tM. Subscribe to AdWords Help on YouTube http://www.youtube.com/learnwithgoogle.

1. Sign in to your AdWords account at https://adwords.google.com [£ .
2. Click the Campaigns tab.
3. Click the Keywords tab.



4. Click the "Details" button above your statistics table.

Google Aditiords -

o Select "All" from the drop-down menu to analyze the search terms for all your listed keywords.
o To only see search terms for specific keywords, first select the checkboxes for the keywords you're

interested in, then choose "Selected" from the menu.

Google Adwords et sanan

5. Now you'll see data on which search terms triggered impressions and clicks. To download the data in a report,

click the download button ¥




Keep in mind that you’ll only see search terms that were used by people at least 24 hours ago and have either
received clicks in the past 30 days or were searched for by a significant number of people. Any search terms that
did not meet this criteria will be summed up in the 'Other search terms' row.

Understanding your search terms data

— | Understanding the "Keyword" column

The "Keyword" column tells you which one of your keywords matched someone’s search term and triggered
your ad. This information can help you see your keywords “in action” by showing you how they are matching
to actual searches.

You can use the data in the "Keyword" column to improve your keyword list. For example, let’s say you sell
tulips. When you look at your Search terms report, you see that your broad match keyword flowers triggers
your ad to show when people search for red roses and purple orchids -- flowers you don’t sell. So, you
decide to refine your keyword list to focus on terms and phrases more specific to the products you do offer:
tulips.

To enable the "Keyword" column, click the Columns drop-down menu and choose "Customize columns."

Then, click the Add link next to "Keyword" and click Apply.

= Understanding the "Match type" column

The "Match type" column in your search terms report tells you how closely the search terms that triggered
your ads on Google are related to the actual keywords in your account.By seeing which match types are
working well for which keywords and searches, you can refine match types for all your keywords to better
hone in on the right customers.

How search term match type is determined

To help you understand how the search term match type is determined, we'll use the following example:

Ad group Keyword

Ad group A Exact match keyword [purple flowers]
Ad group B Phrase match keyword "purple flowers"

Ad group C Broad match keyword purple flowers

Keeping these ad groups and keywords in mind, we'll use the following table to show you how different



search terms that triggered your ads on Google are related to your keywords. Note that when the search

term match type is a close variation, this includes misspellings, singular and plural forms, acronyms,

stemmings (such as floor and flooring), abbreviations, or accents.

It's important to keep in mind that a search term match type listed in your report might not be the same as

the match type you’ve selected for the keyword that triggered the ads. This is because keywords with

broader match types can still match search terms in narrower ways. For example, if someone searched for

purple flowers, and your broad match keyword purple flowers triggered your ad, the search terms match

type would be exact match, even though in your ad group, purple flowers is broad match.

Your
keyword

[purple
flowers]

[purple
flowers]

"purple

flowers"

"purple

flowers"

"purple

flowers"

purple
flowers

purple
flowers

purple
flowers

purple
flowers

Customer's
search
term

purple
flowers

purple
flowrs

purple

flowers

free purple

flowers

free purple

flowrs

purple
flowers

free purple

flowers

pink flowers

send

flowers

Search
term
match

type

Exact

match

Exact
match
(close

variant)

Exact

match

Phrase

match

Phrase
match
(close
variant)

Exact

match

Phrase

match

Broad

match

Broad

match

Reason for search term match type

The search term exactly matches your exact match keyword

from ad group A.

The search term is a close variant (misspelling) of your exact

match keyword from ad group A.

The search term exactly matches your phrase match

keyword from ad group B.

The search term contains your phrase match keyword from

ad group B.

The search term is a close variant (misspelling) of your

phrase match keyword from ad group B.

The search term exactly matches your broad match keyword

from ad group C.

The search term contains your broad match keyword from

ad group C.

The search term is a variation of your broad match keyword

from ad group C.

This match type indicates that other search terms from the

user's search session were considered when the system



(session- showed your ad for this search term. Because the user
based) searched for "purple flowers" earlier in his or her search
session, the search term is considered a variation of your

Broad match keyword from ad group C.

Keep in mind that if you've chosen not to show your ads for close variants of your exact match and phrase
match keywords, you might still see the "Exact match (close variant)" and "Phrase match (close variant)"

search term match types for searches that were triggered by your broad match keywords.

For example, if your keyword list includes the broad match keyword tennis shoe and someone searches for
tennis shoes, we'll identify that search term as a "Exact match (close variant)" since tennis shoes is a close
variant - plural - of tennis shoe.

Manage your keywords based on search terms data

Use your search terms data to make changes to your keywords that can have a positive impact on your
performance. Here are some ideas:

¢ Add high-performing search terms to your ad group as keywords. Consider adjusting your bids as well, since
search terms appearing in the search terms report are already receiving traffic. Therefore, adding those terms
as keywords shouldn't do much unless paired with changes to bids, ad text, or both.

¢ [f a search term isn't relevant enough to the products or services you offer, add it as a negative keyword
instead. This will help keep your ad from showing to people who are looking for something you don’t sell. For
example, if you sell eyeglasses, and you see that the search term “wine glasses” is triggering your ads, you
might want to add “wine” as a negative keyword.

¢ Select the correct match type (e.g. broad, phrase, exact, or negative) for existing keywords. The "Match type"

column (see above) can help you understand how keyword match type is affecting your ad performance.

Tip

You can also use the Dimensions tab to see the list of search terms that triggered your ad for your
entire account, or specific campaigns or ad groups. Just click Dimensions, then click View and select
"Search terms" from the drop-down. Note that while the same information for individual keywords is
available when viewing the Search terms report this way, you can’t add keywords or negative

keywords directly from the report like you can when viewing the report from the Keyword tab.



Measure ad extension performance

If you've added extensions to your ads -- a phone number, for example, or a link to your website -- you
can see how these extensions are performing. Just visit your AdWords account to see how many clicks
and impressions your ad extension has received, its related costs, and other statistics. This data can help
you decide which types of ad extensions work best for your ad, and when it's time to add or remove an

existing ad extension.

Find your ad extension statistics

You can see statistics for any of your campaign's ad extensions on the Ad extensions tab. You can also manage
your ad extensions on this tab. An exception is social annotations, a new version of social extensions which are

fully automated in enhanced campaigns.

Tip
Keep in mind that when you make changes to any of your extensions, this will delete the extension

and reset its statistics to zero.

If you've enabled ad extensions in at least one campaign, this tab automatically appears in your account.

To find statistics about your ad extensions, or to make the Ad extensions tab appear or disappear, follow these

steps:

1. Sign into your AdWords account at https://adwords.google.com [ .

2. Click the Campaigns tab.

3. If you don't see an Ad extensions tab but would like to, click the drop-down button at the top right of the table
and check the box next to Ad extensions. If you prefer not to see it, uncheck the Ad extensions box in the

drop-down menu.



4. To see statistics about your extensions, click the Ad extensions tab.

Clicking this link will take you to the top level of your account and automatically enable the Ad extensions tab for
your campaign tables. Once you've clicked the Ad extensions tab, you can narrow down which kinds of

extensions you'd like to see statistics for.

L Example

If you select "Location Extensions," the tab will display all location extensions for that campaign in the

campaign details page, or all campaigns in the "All online campaigns" overview.

= | Available ad extension statistics

Now that you've found or enabled the Ad extensions tab, here's the information (in columns) you can find

for your ads:

a. Status: You'll see whether your ad extensions are considered Eligible or Disapproved. Eligible ad

extensions will only appear with your ads when they're relevant and the associated ad is also eligible to



run. You also can see whether your ad extensions have earned impressions in the statistics table.

b. Clicks: You'll see how many clicks your ad received when it was displayed with a particular extension
type. This includes clicks on the ad headline as well as on the ad extension, if this applies. Keep in
mind that it's not yet possible to see click statistics for only your ad extensions -- clicks on your ad

headline aren't filtered out.

o Impressions: The number of times your ad appeared with the ad extension. Impressions are only
counted when your ad extension is actually triggered and appears with an ad.

o Clickthrough rate (CTR): The number of clicks your ad received divided by the number of impressions.

o Cost: The total cost of all clicks on your ad.

o Avg. Position: The ad's average position on search results pages when it's shown.

o Avg. Cost-per-Click (CPC): The average amount you pay each time someone clicks your ad extension.
Average CPC is determined by totalling the cost of all clicks and dividing it by the number of clicks

received.

Ad extension statistics are available for ads that appear on Google Search, Google's search partners for
mobile (including Google Maps for mobile), and, in some cases, the Google Display Network. We'll add new

statistics in the future!

Data by ad extension type

When you look at statistics for any of your campaign ad extensions on the Ad extensions tab, you can
choose to see "All" or "All but deleted" extensions, and you can also choose the type of ad extensions to
view, such as location extensions. For example, if you select "Location Extensions," the tab will display all
location extensions for that campaign (in the campaign details page) or all campaigns (in the "All online

campaigns" overview).

The data shown depends on the type of ad extensions associated with your campaigns. Ad extensions
without any statistics (meaning, they were not shown or clicked on) will still appear in the statistics table. In
addition to basic performance metrics, you'll see the following data for each ad extension type:

o Locations: Each address that is either manually entered or automatically retrieved from a linked Google
Places account will be in a separate row.

o Phone: Each phone number will be in a separate row with its specific data.

o Ad Sitelinks: Each set of sitelinks will have its own row of data. Data at the individual link level isn't
currently supported. Also, if you modify the link or link text of any one of your sitelinks, this will reset the
ad extension's statistics to zero.

o Product: Each merchant account will show aggregate statistics for the linked Google Merchant account.
Data at the individual product level isn't currently supported. Also, if you activate or deactivate a

product extension feed, this will reset the ad extension's statistics to zero.



Example

Let's say an ad extension is shown with an ad 10 times. Out of the 10 times the ad and extension
appear together, the ad headline receives two clicks and the ad extension receives three clicks. The

numbers reported would be:

o Clicks =5
o Impressions = 10
o CTR =50%
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About Campaign Experiments

AdWords Campaign Experiments allow you to test changes to your account on a portion of the auctions
that your ads participate in. Like putting a bit of hot sauce on just part of your meal, Campaign
Experiments give you a taste of the results so you can figure out whether you want to pour on the heat!
This way, you can test changes to your keywords, bids, ad groups, and placements.

The results from experiments can help you make better decisions and help you increase your return on

investment.

AdWords Campaign Experiments: Introduction

To improve your AdWords experience, we're testing a new tool that helps you optimize your account. AdWords
Campaign Experiments, or ACE, does this by letting you accurately test and measure changes to your keywords
and bids, ad groups and placements. This video describes what ACE is, the benefits of using it, different use
cases and walks through an example. For more information and links to the six how-to videos, please visit the
Help Center at http://adwords.google.com/support/aw/bin/topic.py?&topic=28565.

How experiments work

When you create an experiment, you decide what sort of change you want to test -- new keywords, a higher bid,
new ads, or different placements, for example. Then, you decide what percentage of your auctions should have
this experimental change. Keep in mind that AdWords experiments are random-auction, meaning every time a user
conducts a search on Google.com or our Search partners, or a new user loads a webpage on our Content partners,
we'll randomly decide to make either your control or experimental split active for the auction (based on the

percentage you set within experiment settings).

After the experiment has been running for a short while, you can view the results on any page you normally use to
view your campaigns and ads. These pages will also let you know if your experimental changes are performing

significantly better or worse than the ads without changes.



At any point, you can choose to end the experiment, cancel the experimental changes, or enable the experimental

changes for all relevant ad auctions.

Example

Let's say you're advertising in your city for hot sauce, and you're wondering if you should increase
your bids to get more traffic. You'd like to see how such a change would affect your auctions, but a

spicy food festival is scheduled to start in your city just two days from now.

If you simply raise your bid and you see that your clicks and impressions increase substantially, you
won't know whether that increase came from the changes you made to your bid, or if the increase
occurred because there are more people who love habaneros in town.

However, you can set up a campaign experiment to simultaneously use two different bids on the same
keywords -- a portion of your auctions will use one bid and the rest will use another bid. This means
that when you look at the performance of these two bid sets, the only significant difference will be the
bid amount. You'll then be able to tell if the increased traffic was the result of your higher bid or just an

unrelated upswing in interest in hot sauces.

Common goals and elements of experiments
While your experiment goal will depend on your business, some common goals for advertisers include:

¢ Increasing conversions

¢ Increasing clicks or impressions
¢ Improving return on investment
¢ Improving campaign quality

¢ Improving ad text

To experiment with these goals, here are some things you can test:

— | If using the Google Search Network

¢ New keywords

¢ New ad text

¢ New ad groups

¢ Negative keywords at the ad group level

¢ Most keyword match types

¢ Ad group default bids, including max CPC

¢ Max CPA if campaign is using Conversion Optimizer

e Keyword insertion



To test some of these elements, you might need to copy an ad group
first.

— | If using the Google Display Network

¢ Bids on managed placements

¢ Additional placements

¢ Additional keywords for contextually-targeted ad groups
¢ New text ads or display ads

¢ New ad groups

e Ad group default bids, including max CPC and max CPM
e Max CPA if campaign is using Conversion Optimizer

¢ Remarketing options

¢ Site exclusions

To test some of these elements, you might need to copy an ad group first.

= Things you can't test

Any campaign settings you choose for your campaign while running an experiment will apply to the entire

campaign, not just your experiment or control group. This means you essentially can't test:

e Targeting of any kind, including geographic targeting, language targeting, network targeting, and device
targeting

e Bidding features

¢ Daily budget

e Ad extensions

¢ Ad scheduling

¢ Frequency capping

¢ Negative keywords at the campaign level

In addition, you can't set up experiments with automatic bidding or enhanced CPC because these features
work on the campaign level. You'll need to disable these features to run an experiment, and you won't be

able to turn them on for any campaigns that are already running an experiment.

Costs of experiments

While campaign experiments don't cost anything to enable, experiments are treated as changes to your account

and will be billed like any other campaign. If you raise your bid, for example, you'll need to pay the costs



associated with using that increased bid for whatever portion of traffic it affects.

Success stories
Here are stories of two companies that used campaign experiments to improve their business goals:

Belnick Inc.
Belnick Inc. (www.bizchair.com) tested their ad creatives and increased their conversion rate by 50 percent. They
also reduced their cost-per-conversion by more than 50 percent.

See the case study

SEER Interactive
SEER Interactive ran a landing page experiment for WidsomTree® and saw a conversion boost of 400 percent.

See the case study

Campaign experiments and Quality Score
Campaign experiments influence your Quality Score for any keywords involved in your experiments.

Running an experiment might negatively impact your Quality Score in the short-term because you might test ads or
bids that perform worse than your current ads or bids. However, in the long term, running an experiment and finding

high quality ads or a better bid should raise your quality score, making up for this short-term drop in performance.

Campaign experiments and AdWords Editor

Some aspects of campaign experiments can be managed through AdWords Editor.

— | What you can do through AdWords Editor

¢ Download existing experiments

¢ Change experimental bids

¢ Apply and edit an experiment status (e.g. "control only", "experiment only", "control and experiment") at
the ad group, ad, or keyword level

e Apply and edit a default max. CPC, Display Network max. CPC, or max. CPM bid multiplier at the ad
group level

e Apply and edit a max. CPC bid multiplier at the keyword level

e Change the maximum CPC bid and destination URL, add new keywords, change keyword text, and
change keyword match type

¢ Download and upload experiment status and bid multipliers in CSV and XML

= What you cannot do through AdWords Editor



¢ Create, pause, or delete a campaign experiment
¢ Display segmented statistics for experiment and control groups

Campaign experiments and bid management tools

Not all bid management tools can be used to work with campaign experiments. Let's say you use tools that aren't
set up for experiments. You change your bid on a keyword that has an experimental bid and is active in both
control groups and experiment groups. The result is that the bid change will be applied to the control group, and
the experimental group will be changed a certain percentage that you previously set.

If you make changes to a keyword that has no experimental bid and is active in both the control and experiment
groups, the bids will update normally. Similarly, if you make changes to a keyword that's active only in either the

control or experiment group, the bid will update normally.

If your bid management software hasn't yet fully integrated with AdWords Campaign Experiments, we suggest

contacting your software provider for more information.

Campaign experiments and bid multipliers

Advanced ad scheduling bid multiplier is applied at the campaign level, so this multiplier is applied first. If you've

made any experimental bid changes in your campaign experiment, those will be applied second.

com—
» Example

Let's say your ad group level default bid is $1.00. On Tuesdays, you have advanced ad scheduling
applying a bid multiplier of 50 percent, so all day Tuesday, your bids are $1.50. You then turn on an
experiment for this campaign with an experimental bid of +10 percent. On Monday, and Wednesday
through Sunday, your bids will be $1.00 in the control group and $1.10 in the experiment group.
However, on Tuesdays your bids will be $1.50 in the control group and $1.65 (+10 percent of $1.50) in
the experiment group.



Set Up experiments

Tip
You may see different options in your campaigns' Settings tab. This is because different campaign

types support different features. To see which features are available by campaign type, read Choose

the campaign type that's right for you [4

You can run one experiment per campaign at a time, testing the performance of different keywords, ads,
and ad groups. Your experiment can include existing keywords, ads and ad groups, new keywords, or
both. When you set up your experiment, you can choose how long you want it to run and what percentage
of searches will see your experimental changes. Whether you want your experiment to start on a
scheduled date or start manually is up to you.

Creating an experiment and setting its scope and duration

To set up an experiment, start by defining the experiment's name, how much of your traffic should see your

experimental changes, and how long your experiment should run:

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click Campaigns.




Click on the campaign you want to use for your experiment.
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Under "Advanced settings" near the bottom of the page, click Experiment. Note that the availability of certain

settings, like this one, may depend on the campaign type you choose. Compare campaign types in detail.
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7. In the section that appears:

o Enter a name for your experiment. We suggest your experiment name describes what you're trying to test.

o Choose how many of your auctions should be using your experimental changes by selecting one of the
control/experiment splits from the drop-down menu. The fastest way to collect results is a 50-50 split, but
if your experimental changes are risky or expensive, such as doubling your bid, you might want to have
fewer auctions use your experiment. You can't change this setting after you start your experiment.

o Choose whether you'd like to start your experiment manually or at midnight on a specific date. If you
choose today's start date, the experiment will start immediately.

o Choose whether you'd like to end your experiment after 30 days or on a certain date. We suggest your
experiment runs two to four weeks. At any time after you start your experiment, you can extend it up to

three months from that day.

Google AdlWords

Advanced setings




AdWords Campaign Experiments: Defining your experimental changes

To improve your AdWords experience, we're testing a new tool that helps you optimize your account. AdWords
Campaign Experiments, or ACE, does this by letting you accurately test and measure changes to your keywords
and bids, ad groups and placements. This video describes step 2 of running an experiment: defining your
experimental changes. For more information, please visit the Help Center at
http://adwords.google.com/support/aw/bin/topic.py?&topic=28565 To learn about step 3: monitoring your
experiment, visit http://www.youtube.com/watch?v=90orYdG_Vybg.

Choosing your experimental changes

You can make up to 1,000 experimental changes to your campaign's keywords and bids. You can also define

entire ad groups to be a part of an experiment and set an experiment bid for the ad group.

Make sure that the settings for your keyword or ad are the same as the settings for the ad group they're in -
otherwise, they won't show. For example, if an experiment-only keyword or ad is in a control-only ad group, it will
receive no impressions. To receive impressions, the experiment-only keyword or ad will need to be in an ad group

set to either experiment-only or experiment and control.

AdWords Campaign Experiments: Monitoring your experiment

To improve your AdWords experience, we're testing a new tool that helps you optimize your account. AdWords
Campaign Experiments, or ACE, does this by letting you accurately test and measure changes to your keywords
and bids, ad groups and placements. This video describes step 3 of running an experiment: monitoring your
experiment. For more information, please visit the Help Center at
http://adwords.google.com/support/aw/bin/topic.py?&topic=28565. To learn about step 4: applying or deleting your

experimental changes, visit http://www.youtube.com/watch?v=KohSg1bxc1U.

© Selecting existing keywords, ads, or ad groups for your experiment

By default, existing keywords, ads, and ad groups will appear in both your control and experiment groups. If

you want existing keywords, ads, and ad groups to appear in just your control or experiment groups:

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click Campaigns.



Google AdWords -

3. Click on the campaign you're using for your experiment.
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4. Click Keywords, Ads, or Ad Groups depending on what you want to include.

Google AdWords e e

5. In the status column next to the keyword, ad, or ad group you want to include, select whether you'd like
the keyword, ad, or ad group to be in &, both the control and experiment, [, the control only, or § the

experiment only.



Adding new keywords to your experiment

Each keyword you add individually will be counted toward your maximum of 1,000 changes per experiment.

To add experimental keywords:

1. Sign in to your AdWords account at http://adwords.google.com [ .

2. Click Campaigns.

Google AdWords Jrg—

3. Click on the campaign you're using for your experiment.
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5. Click + Keywords.

Google AdWwords [

6. Select the ad group you'd like to use for your experimental changes.
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7. Add any keywords you'd like to use for your experiment.

Google AdWords

8. Click the checkbox next to "Add as experiment only keywords."



9. Click Save.

AdWords Campaign Experiments - Control vs. Experiment

AdWords Campaign Experiments (ACE) lets you run split tests (experiments) for a campaign. These tests
help you measure the impact of changes to keywords, bids, ad groups, and placements before you apply
them to all auctions. In this video, we'll give you guidelines on when to use the control and experiment

splits when you create an AdWords Campaign Experiment.

¢ |

AdWords Campaign Experiments - Match Type Experiment Demo

AdWords Campaign Experiments (ACE) lets you run split tests (experiments) for a campaign. These tests
help you measure the impact of changes to keywords, bids, ad groups, and placements before you apply

them to all auctions. In this video, we'll use a Broad Match Modifier example to demonstrate how to run a



match type experiment in ACE.

Adding a new ad group to your experiment

Each ad group you add, regardless of the number of ads and keywords within the group, will only count as

one change. To add an ad group:

1. Sign in to your AdWords account at http://adwords.google.com [ .

2. Click Campaigns.

3. Click on the campaign you're using for your experiment.

Google Adlt

4. Click Ad groups.



Click + Ad group.

Google Adords

Give your new ad group a name.
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8. Add keywords for which you'd like this ad to show. You can add more keywords after you create the ad

group.
9. Enter a default bid for your ad group.

Google AdWords

Create ad group

Name this 34 roup,

10. Click the checkbox next to "Add as experiment only ad group."
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11. Click Save ad group.
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AdWords Campaign Experiments - Ad Group Experiment Demo

AdWords Campaign Experiments (ACE) lets you run split tests (experiments) for a campaign. These tests
help you measure the impact of changes to keywords, bids, ad groups, and placements before you apply
them to all auctions. In this video, we'll use an example of comparing one large ad group to two more

tightly-themed ad groups to demonstrate how to run an ad group experiment in ACE.

Making experimental bid changes to keywords

You can change the bid amount for any keyword in your experiment:

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click Campaigns.

3. Click on the campaign you're using for your experiment.
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4. Click Keywords.
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5. From the Segment menu, click Experiment to show the control and experiment details for each
keyword.

6. In the "Max CPC" column, click on the bid amount in the "Experiment" row for the keyword whose bid
you want to modify.
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7. Select whether you'd like to increase or decrease the bid amount, and enter the percentage you'd like to

change your bid.
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8. Click Save.

AdWords Campaign Experiments - Bid Experiment Demo

AdWords Campaign Experiments (ACE) lets you run split tests (experiments) for a campaign. These tests
help you measure the impact of changes to keywords, bids, ad groups, and placements before you apply

them to all auctions. In this video, we'll show you how to run an example bid experiment in ACE.

Making experimental bid changes to ad groups

You can change the bid amount for any ad group in your experiment:



1. Sign in to your AdWords account at http://adwords.google.com [£.
2. Click Campaigns.
3. Click on the campaign you're using for your experiment.
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5. From the Segment menu, click Experiment to show the control and experiment details for each ad



group.

Google Adwords e sanau

6. In the "Default Max CPC" column, click on the bid amount in the "Experiment" row for the ad group

whose bid you want to modify.

Google Adwords o S

0 0 omx sm sw o
0 0 oms sw s o

0 o omx sw sw o
-0t 0% oot wmd sws 00

©2012 Guag | Adtors o | Edorsl Gusines. | Py Poley

7. Select whether you'd like to increase or decrease the bid amount, and enter the percentage you'd like to

change your bid.



8. Click Save.

— Making experimental changes to your ads

1. Sign in to your AdWords account at http://adwords.google.com [ .

2. Click Campaigns.

Google AdWords
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3. Click on the campaign you're using for your experiment.
4. Click Ads.

Google Adwords

5. Click + Ad.



Google AdWords

6. From the drop-down menu, select the type of ad you'd like to create.
7. Select the ad group you'd like to use for your new ad.

8. Enter the text and URLs for your new ad.

9. Click the checkbox next to "Add as experiment-only ad."



10. Click Save.

In addition to testing the effect of changing the text of your ad, you can also use this process to test

changes to the display or destination URLs.

AdWords Campaign Experiment - Ad Creative Experiment Demo

AdWords Campaign Experiments (ACE) lets you run split tests (experiments) for a campaign. These tests
help you measure the impact of changes to keywords, bids, ad groups, and placements before you apply

them to all auctions. In this video, we'll show you how to run an example ad creative experiment in ACE.

Tracking your experiment traffic

If you have Google Analytics or use other traffic tracking, you can add a ValueTrack tag to your keyword's or ad's

tracking destination URL to see whether a click is coming from the experiment or control split.



For example, If your web site is www.example.com, you can change the destination URL for keywords or ads in

your experiment 1o www.example.com?type={aceid}.

A number corresponding to either the control ID or the experiment ID will show in the referral URL in your weblogs or
within your tracking software. When you first create an experiment in your campaign, you can find your experiment
and control IDs for your experiment in the My Change History tool. These will be the same IDs that are referred to in
your ValueTrack tag.

Starting your experiment
If you didn't set a start date for your experiment, you'll need to start it manually:

1. Sign in to your AdWords account at http://adwords.google.com [ .
2. Click Campaigns.

3. Click on the campaign whose experiment you want to start.

Google AdWords o sma

4. Click Settings.
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5. Under "Advanced settings" near the bottom of the page, click Experiment if the experiment section is not
open. Note that the availability of certain settings, like this one, may depend on the campaign type you

choose. Compare campaign types in detail.

Google AdWords v senea

6. Click Start running experiment.



Monitor your experiments

Once your experiment is running, you can begin viewing data for your experiment within your campaign
and compare it to your control data. You'll find arrow icons in your account performance data that'll help
you figure out how certain you can be that the change in data is due to the changes you've made. You
can also download your data or set up your account so that people you choose can receive regular
emails with the experiment report.

= Viewing your campaign data during experiments

As soon as you start your experiment, we'll collect data for your control and experiment results.

View your overall results

1. Sign in to your AdWords account at http://adwords.google.com [ .

Google Adwords

Advertise your business on Google
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You attract customers
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2. Click Campaigns.
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3. Click the date menu and select Custom date range.
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4. Select a date range.
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5. From the Segment menu, click Experiment to show the control and experiment details for each
campaign. Data for your experimental changes will appear in the "Experiment" row and data for your

control group will appear in the "Control" row.

Google AdWords

Jul 3. 2012 - Jul 9, 2012

See how individual keywords, ads, or ad groups performed in your experiment

1. Sign in to your AdWords account at http://adwords.google.com [ .

Google Adwords

Advertise your business on Google
S — Start now °

Your ads appear on Google
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You attract customers.
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2. Click Campaigns.
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3. Click the date menu and select Custom date range.
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4. Select a date range.
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5. Click on the campaign you're using for your experiment.
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6. Click Keywords, Ads, or Ad Groups depending on what you'd like to see results for.

Google AdWords
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7. From the Segment menu, click Experiment to show the control and experiment details for each

keyword, ad, or ad group. Data for your experimental changes will appear in the "Experiment" row and
data for your control group will appear in the "Control" row.
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AdWords Campaign Experiments: Monitoring your experiment

To improve your AdWords experience, we're testing a new tool that helps you optimize your account.
AdWords Campaign Experiments, or ACE, does this by letting you accurately test and measure changes to
your keywords and bids, ad groups and placements. This video describes step 3 of running an experiment:
monitoring your experiment. For more information, please visit the Help Center at
http://adwords.google.com/support/aw/bin/topic.py?&topic=28565. To learn about step 4: applying or

deleting your experimental changes, visit http://www.youtube.com/watch?v=KohSg1bxc1U.

If you can't see your experiment data

Make sure:

¢ Your date range includes time when your experiment was running.
¢ The ads in your experiment have been approved to show.

e That any experimental bids are above first page bids.



Understanding the experiment report

If your experimental data is statistically significant, meaning that it's likely that any differences in
performance aren't due to chance, we'll display an % up arrow or iz down arrow next to that data depending
on whether your performance has increased or decreased. As many as three arrows can appear in the same
direction, and the more arrows in the same direction, the more statistically significant the results are. One
arrow means that we're 95 percent certain that the change is not due to chance, two arrows means we're 99
percent certain, and three arrows means we're 99.9 percent certain. Two gray arrows £ in opposite

directions mean the results are not statistically significant.

The more statistically significant the results, the more likely that the results you see in your experiment will
continue if you apply these experimental changes. The more traffic you have on a keyword, ad, or ad group,

the faster you're likely to get statistically significant results.

VIDEO

AdWords Campaign Experiments: Understanding your experiment results and statistical significance

To improve your AdWords experience, we're testing a new tool that helps you optimize your account.
AdWords Campaign Experiments, or ACE, does this by letting you accurately test and measure changes to
your keywords and bids, ad groups and placements. This video discusses understanding your experiment
results and statistical significance. For more information, please visit the Help Center at

http://adwords.google.com/support/aw/bin/topic.py?&topic=28565.

Understanding your experiment's results

How you read the results of your experiment directly relates to what your advertising goal is and how you
operate your business. For example, a higher clickthrough rate might not be worthwhile for you if you haven't
seen an increase in conversions on your website. Conversely, a higher average CPC might be worth the

extra cost if you're attracting more high-quality clicks.
Here are some general tips for evaluating your experiment's results:

1. Evaluate your campaign as a whole



Even if the performance of particular keywords, ads, or ad groups declined, you might be doing better
overall in your campaign — or vice versa. For example, you could have been using keywords that were
competing with each other for the same traffic — having multiple keywords with lower clickthrough rates

could mean more traffic for other, perhaps less expensive, keywords in your campaign.
2. Statistical significance doesn't necessarily mean it's important

For example, you can have a clickthrough rate in your experiment that has three upward arrows next to it —
meaning its performance compared to your control is almost certainly not due to chance - but the rate might
only be 0.01 percent higher, a trivial amount to you. Moreover, maybe your advertising goals center more
around average CPC or impressions than clickthrough rate.

3. Choose a longer time frame

Try to look at larger time periods in one-week chunks, instead of one day at a time. This will help you get a

bigger picture of the data that's less affected by the fluctuations in traffic caused by the day of the week.
4. Wait for experiment results to become significant

Some things just take more time to develop. That's why making conclusions based on results that are not
statistically significant can be misleading or just plain incorrect. Because larger date ranges include more

data, you're more likely to see subtle variations the longer you wait.

Understanding differences in impressions between control and experiment groups

Even if you create an experiment that uses 50 percent of your auctions for experimental changes and 50
percent for your control, these groups might get different amounts of impressions. This can happen because

the performance of keywords, ads, ad groups, and bids might be causing fewer or more impressions.

For example, if you create an experiment with an experimental bid that's 50 percent higher than your bid in
your control group, that higher bid might result in your ad receiving many more impressions because it's

winning more auctions.

Downloading your experiment report and scheduling regular email reports

You might want to download a report from a current experiment or have emails sent to people regularly with

your experiment results:

1. Sign in to your AdWords account at http://adwords.google.com [&
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3. From the Segment menu, click Experiment to show the control and experiment details for each

campaign.
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4. Click the | #, download button.
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5. Give your report a name.
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6. Select what format you'd like for your report.
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7. Choose which segments you'd like to apply to your report. You can use this to evaluate data from a
certain time period, or to look at just a subset of your data.



8. If you want to email reports, click Email and schedule report. You can then specify who should receive

the report and how often they should receive it.

Google Adviords

9. Click Create.



Google Adiords

o som o o .

02512 Geol | Adios o | ot utinas | Py Prcy

"~ Ending your experiment

You can stop your experiment at any time:

1. Sign in to your AdWords account at http://adwords.google.com [
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Click on the campaign whose experiment you want to stop.
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4. Click Settings.

Google AdWords
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5. Under "Advanced settings" near the bottom of the page, click Experiment if the experiment section
isn't open.
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When you stop your experiment, your campaign will keep your experiment data unless you delete or apply
the experimental changes. However, your experimental changes will no longer affect your keywords, ads,

campaigns or bids.



The Opportunities tab

The Opportunities tab is an entire section of your AdWords account dedicated to helping you improve your ad campaigns. It's like a personal
assistant who can help you discover more keywords and make the most of the budget you're comfortable with. People who've managed their
AdWords account long enough to have developed some goals and an account history should try the tab.

How the Opportunities tab works

The Opportunities tab looks for ways to make reasonable changes that could have an impact on your account if you choose to accept the changes. You start by
choosing a goal. Then the Opportunities tab runs with your goal, looking over your historical campaign data, Google search volume and trends, and your
campaign settings to automatically generate ideas for you to consider.

The goals that you can tell it to work with are:

« Increase traffic: Increase impressions and clicks, even if costs rise
* Balance cost and traffic: Raise impressions and clicks with moderate cost changes
« Maintain or decrease cost: Get as much as possible with your current budget

What the Opportunities tab helps you do
If you have an account history to work with, the tab can help you:
* Make improvements without spending a lot of time and money

The Opportunities tab looks for opportunities for you so you so that you can focus on making decisions instead of conducting research. And you'll keep
costs in check because the Opportunities tab works to make small improvements with what you're willing to spend.

o Keep your campaigns fresh

Have you been using the same keywords for awhile? When's the last time you changed your bids? The Opportunities tab can help you keep your account
fresh.

* See performance estimates based on historical data

While the Opportunities tab doesn't predict whether your ads will do well, it does tap into a lot of data from the past like your campaign performance and
what people search for on Google, to show you possibilities.

VIDEO

The AdWords Opportunities Tab: Custom tips, just for you

Learn how the AdWords Opportunities Tab can help you with new ideas customized to your business. Read more about the AdWords Opportunities Tab at
http://goo.gl/r3xZU Subscribe to AdWords Help on YouTube http://www.youtube.com/learnwithgoogle



Get ideas to improve your account

Using the Opportunities tab in your AdWords account, you can get suggestions tailored to your specific account -- ideas that can help you get
more out of AdWords. These include suggestions specific to keywords, bids, budgets, sitelinks, and call extensions.

You can also model campaign and account level bid changes using the Campaign Bid Simulator.

And finally, you can use the Analyze competition tool to see how you're performing compared to other advertisers and make more informed decisions about
which types of optimization changes are right for your account.

Keyword Ideas

The keyword ideas on your Opportunities tab can help extend your advertising reach by targeting additional customers. You might gain additional impressions
and clicks when you add relevant keywords to an ad group.

How we generate keyword ideas
Keyword ideas are generated by our automated tools. By analyzing Google search data related to your campaigns, our system can often find new keywords that
are relevant to your ads and that don't currently exist in your account.

How you can assess their potential impact
If keyword ideas have been generated, you'll see the potential impact on your Keywords tab. If a keyword idea doesn't have potential estimates, we may
instead show an approximate search volume. This shows the estimated number of searches each month that match the new keywords proposed for your ad

group.

Before you apply a keyword idea, evaluate whether the potential clicks and impressions you could earn and the estimated cost of the idea meet your advertising
goals. Also keep in mind that there's more to keywords than volume -- what's critical is their relevance to your products and services.

How to edit keyword ideas

Click the set of ad group ideas to see each proposed keyword. These new keywords are automatically set to use your ad group's default cost-per-click (CPC
) bid and destination URL. Click "Show settings" to see what's set for each keyword. In the drop-down menu for a particular keyword, just select "Use
proposed CPC and URL" to see the automated bid values and URLs. You can also click these cells in the table to edit the settings in-line:

o Click the ad group cell to move that keyword into a different ad group.

e Click the max CPC cell to change that keyword's maximum bid. The proposed value and the ad group's default are both listed.

[——



e Click the destination URL cell to enter a unique landing page URL for that keyword.

Keyword ideas might use broad, phrase, or exact match. The match type is selected based on a variety of factors including the match types and traffic of your

current keywords.

Keyword relevance

Review all ideas carefully before you apply them. Since these keyword ideas are automated, it's possible that you'll see some that aren't relevant or that don't
suit your business goals. You can help us improve these ideas by clicking the face next to each keyword and reporting whether the keyword idea fits, isn't a
quite a fit for that ad group, or appears to be completely irrelevant. We'll use that feedback to improve the quality of these ideas for you.

Bid Ideas

This section refers to the ad group and keyword level bid ideas in the Opportunities tab. To model bids at a campaign or account level, use the Campaign Bid

Simulator.

Your Opportunities tab may show ideas for changing two types of CPC bids: maximum CPC bids at the keyword level and default CPC bids for an entire ad
group. Ideas include increased bids (to help capture more clicks) and decreased bids (to help lower your costs). While we don't know enough about your
advertising goals to make specific bid recommendations, we try to identify which of your keywords and ad groups seem to be good candidates for bid changes.
You can use the ideas to help make your bidding decisions.

Bid ideas related to your goal

The first step is to decide what your goal is so that you can see bid ideas related to this goal. You can select your goal -- "Increase traffic," "Maintain or
decrease cost," or "Balance cost and traffic" -- from the drop-down menu at the top of your Opportunities tab. If you've already selected your goals, bid ideas
focused on these goals will appear.

Types of bid ideas

» Keyword bid ideas: This type of idea shows changes to a keyword's maximum CPC bid. If you've selected the goal "Increase traffic" or "Balance cost and
traffic," and your ad has the potential to appear above the Google search results rather than on the side of the page, we'll show you keyword bid ideas that
might increase your top-of-page impressions.

o Ad group bid ideas: This type of idea shows changes to an ad group's default bid. If a keyword of a particular ad group already has its own bid, the
keyword bid supersedes the ad group bid idea just as it would the ad group default bid.

Bid amounts and estimates

We use the bid simulator to estimate the cost, clicks, and impressions that the keyword or ad group could have received during a period of a week if you had
used a different bid. When you click a bid idea, you'll see a range of bid amounts and the bid simulator's estimated impact of each. You can learn more below
about the technical details of how bid ideas are selected.

The estimates you see are variations on your past performance and are not attempts to predict or estimate future performance. Also, traffic patterns are
always subject to fluctuation, so keep in mind that your future performance is likely to shift over time. If you have reason to believe that next week's traffic will
be significantly different from the last week's, such as for seasonal reasons, then it's a good idea to incorporate that information when you choose your bids.

Choosing a bid amount
The bid amount you decide to use is entirely up to you. When you click an idea, you'll have the option to choose from a range of bid amounts or to enter the



amount of your choice. To decide on an amount, review the cost, click, and impression estimates.

» If you're raising a bid, consider whether the extra clicks and impressions are worth the potential added cost.
o If you're decreasing a bid, consider whether the saved cost is worth the potential loss of clicks and impressions.

Like all ideas we offer on the Opportunities tab, you should review bid ideas carefully. We suggest that you use the data we provide to gain insight into how
different bids could affect your performance. Use that insight, along with other data (such as your return on investment (ROI) to help you choose bids that
will support your advertising goals.

If you don't feel comfortable with a certain bid change, you can easily remove it from your list of ideas.

If you don't see bid ideas
You won't always see bid ideas. Here are a few common reasons why you won't see a bid idea:

e The keyword or ad group doesn't have bid simulations available (such as its campaign isn't eligible for the bid simulator).
o A bid idea was recently applied to the keyword or ad group (we'll wait at least a week before showing another idea for that keyword or ad group).

Bid ideas are refreshed daily, so check the Opportunities tab regularly.

Budget Ideas

Your AdWords account shows budget ideas when a campaign is repeatedly meeting its daily budget. When your campaign is in this situation, your budget is
limiting your potential traffic and clicks. Each budget idea shows a recommended daily budget for that campaign as well as the predicted impact of using that
budget. These are the same budget recommendations as you sometimes see in your campaign settings.

Where to find budget ideas

o Opportunities tab: Click the ideas in the Budgets tab.
o Campaigns tab: Click the icon or the text "Limited by budget" in the Status column.

Budget ideas are only available for campaigns limited by budget, so you may not always see them in your Opportunities tab.

VIDEO

Budget Ideas

Budget Ideas for your AdWords campaign.

Potential impact of budget changes

With a higher budget, your limited campaign could gain additional impressions and clicks that it's currently missing. Once you click the idea, you'll also see a
graph showing how that budget might perform for your campaign. For example, if you'd been using the proposed amount as your daily budget during the noted
time period, we estimate that you could've received the number of clicks and impressions shown in the graph. Our system compares the proposed budget and
your actual CPCs to see how many clicks could fit into this budget. Since we know how many Google searches are available for your keywords, and we know
how often your ad impressions result in clicks (your clickthrough rate), we can estimate how many clicks you could receive using this budget.

Estimates are based on the past performance of your campaigns and aren't attempts to predict future performance. Google search patterns do fluctuate, so
keep in mind that your budget needs are likely to shift over time. If you have reason to believe that future traffic will differ from past traffic, such as based on
seasonal trends, then it's a good idea to consider that information before you apply a budget idea.

Choosing a budget amount

Click the budget idea to see a graph of various budget amounts and corresponding performance estimates. To help you choose an amount, consider whether
or not the potential increase in clicks and impressions is worth the extra cost. Once you have an amount that you're happy with, click "Apply now" to change
your campaign's budget.

When considering the recommended budget, you should also understand how we calculate this amount and what happens if you choose a lower budget.

Sitelinks Ideas

If you have ads that are eligible to show sitelinks (links to pages in your website), we may provide this as another optimization idea in the Opportunities tab.
As you add sitelinks to your campaign, we'll show you a preview of how these links could look in your ads. You can also check the "Potential impact" tab for
details on how much uplift you might get by adding different numbers of sitelinks.

Visit our ad sitelinks help article for more information on how to write good sitelinks and where sitelinks appear in Campaign Management.



Call Extension Ideas

If you have ads that could benefit by showing phone numbers in the ad (also called call extensions), we may provide this as another optimization idea in the
Opportunities tab. As you add call extensions to your campaign, we'll show you a preview of how these phone numbers could look in your ads. You can also
check the "Potential impact" tab for details on how much uplift you might get by adding phone numbers (note that sometimes you may not see estimates; this
happens if we don't have reliable estimates for your selection).

Visit our call extensions help article for more information on how call extensions work and where they appear in Campaign Management.
Notes on Applying and Saving Ideas

e To see ideas for a single campaign at a time, click a campaign name on the side navigation bar. The All online campaigns link will take you back to the
page showing all available ideas for your entire account.

e You can click Apply now to immediately make the changes to your account.

* Or click Save to pending changes to review the changes again later before applying them to your account.

e When you apply or save any keyword ideas, all other keyword ideas in that ad group that are not selected will be discarded. So before you apply or save
any ideas, make sure you've selected all the ones you like.

o If you don't like an idea, select the box next to the idea and click Remove to dismiss it entirely.

Remember that these are automatically generated ideas, so please review them carefully. If an idea doesn't seem relevant to your ad campaign or appropriate
for your advertising goals, we suggest that you don't apply that idea. Also remember that we won't necessarily have ideas for every campaign at all times. If
you don't see ideas, check back in a few weeks since ideas are periodically generated.

How the changes you apply go into effect

Applied changes usually take effect right away. As soon as you click one of the Apply now buttons on your Opportunities tab, all of the changes you've applied
will immediately go into effect in your campaign. When you next visit your campaign page, you'll see it has been updated to reflect the changes you applied.

The one exception is with some keyword changes. All keywords have to comply with the AdWords policies, so some new or edited keywords may need to await
review and approval before they are eligible to trigger your ad.

Tip

We recommend running the campaign with your changes for at least two weeks in order to see the impact of the changes on your campaign
performance. This ensures that your ad groups accrue enough performance history to contribute to your keywords' Quality Score, position, and
conversion rate. We also suggest you track the results of your changes using the performance reports in your Campaigns tab or one of our free
reporting tools such as conversion tracking and Google Analytics.

Also keep in mind that there's no automatic "undo" function on your Opportunities page. Once you decide to apply the proposed changes, there's no way to
automatically revert back to your previous campaign.

However, you can make changes manually to your campaign at any time.

All of the approved changes that are applied to your campaign will be shown in your account's My Change History. This can help you determine what has
changed in your campaign. Visit your Change History now

Evaluating Ideas as Experiments
How you can monitor your experiments from the Opportunities tab

You can use the 'Experiments' table to monitor the performance of one or more experiments that you run on the keyword or bid ideas in the Opportunities tab.
Active experiments metrics can help you determine whether to fully apply the ideas to 100% of your traffic or to delete them from your account.

Each active experiment is organized by campaign. In other words, keyword and bid ideas are put in the same experiment if they affect the same campaign.

Each row of an active experiment shows the experiment's performance and the percentage change. The percentage change compares 50% of your campaign
traffic with the new ideas you enabled (the experiment) to the 50% of traffic without the new ideas enabled (the control). Let's say you run an experiment and
your overall campaign earns 100 clicks. If 60 of those clicks are attributed to your experiment and the remaining 40 clicks came from your control, then you'll
have achieved a 50% improvement when you compare your experiment to your original campaign.

You can use the percentage change to determine whether the positive, negative, or neutral impact of your experiment merits adopting these ideas or deleting
them before the experiment ends. At the end of your experiment, AdWords promotes these ideas to 100% of your traffic if you haven't deleted the experiment
from your 'Experiments' table.

Although you'll want to regularly monitor the results of your experiment over the period of time that it's active, it's best to wait for a few days after you've
activated an experiment. Begin to interpret results after several days or a week so that your experiment has time to gather enough traffic that you can then
evaluate.



What the experiments in the Opportunities tab are

Experiments in the Opportunities tab are based on the same technology as AdWords Campaign Experiments and let you evaluate any of the keyword and bid
ideas in your account. When ideas are applied as experiments from the Opportunities tab, their settings only affect a portion of a campaign's traffic, allowing
you to evaluate the impact of these ideas before their settings are applied to a// traffic.

See the difference in performance with and without ideas

When you apply ideas as experiments, the changes in your keywords or bids affect only 50% of your traffic for the duration of the experiment. To help you
compare the 50% of your campaign traffic with the new ideas you enabled (the experiment) to the 50% of traffic without the new ideas enabled (the control),
you'll see the percentage change of impressions, clicks, CTR, average CPC, and cost in the 'Experiments' table of the 'Ideas’ page. If you use AdWords
Conversion Tracking, you'll also see the percentage change of conversions.

Run campaign-based experiments in your Opportunities tab

Experiments in the Opportunities tab are campaign-based such that all keyword and bid ideas that apply to the same campaign are grouped into a single
experiment. You'll only be able to run one experiment per campaign at a given time, although a single experiment can contain multiple ideas.

Control when your experiments run

You can choose when to start and end the experiment as long as it runs for at least one week and doesn't exceed 90 days. Ideas are automatically applied to
all traffic when your experiment ends, unless you take action by either canceling the experiment or applying it earlier than the end date. Cancel or apply active
experiments from the 'Experiments' table in your Opportunities tab.

How you can apply ideas as experiments in the Opportunities tab
If you'd like to test the keyword and bid ideas in your Opportunities tab, follow these steps to set up an experiment:
e Choose a keyword or bid idea to test.

o Select the checkbox next to the idea and click the Evaluate ideas button.
o Or, click the idea to see details and select the 'Evaluate this idea' checkbox.

e Select a start and end date for your experiment. Choose an end date that is at least seven days from the start date, but no more than 90 days.

Monitor you performance from the Experiments table of the 'Ideas' page as long as it's active. You can cancel or apply an experiment to all traffic any time
before the end date from the 'Experiments' table. If an experiment ends before you take action, the ideas will be automatically applied to all traffic.

AdWords sends an email reminder as a campaign maintenance alert for any active experiments that are approaching their end date.

To ensure that you receive this email, check that Campaign maintenance alerts is set to 'All' from the 'Notification settings' section under 'My account.'
What statistical significance means

Statistical significance means that it's unlikely that the outcome of an experiment is a chance event or accidental.

In the Opportunities tab, we report three different scenarios on the experiments that you run:

e Green: The percentage change is statistically significant and may have a positive impact on the campaign
o Red: The percentage change is statistically significant and may have a negative impact on the campaign
e Gray: The percentage change isn't statistically significant

If the percentage change in clicks, impressions, and other metrics isn't statistically significant, it's possible that the experiment didn't have an impact on your
campaign.

If, near the beginning of your experiment, you see a change that matters to you but isn't statistically significant, let your experiment remain active for the 30
day trial period. This will give your experiment more time to accrue data such that the percentage change may or may not become statistically significant. Even
statistically significant changes might not be important to your business, so consider these factors when you evaluate your results.

Campaign Bid Simulator

The Campaign Bid Simulator has similar functionality to the bid simulator that's currently available at the keyword and ad group level. But, using the Campaign
Bid Simulator you can model and apply bid changes across your account and view details at the campaign level.

Here are a few benefits of the Campaign Bid Simulator:

e You can view bid changes in aggregate and model changes even when keywords or ad groups might not have enough data for this on their own.
Bid scaling is available, so you can see what might happen if you increased or decreased all your bids by a specific percentage (10%, for example).

.

e Because campaign-level bid changes can increase traffic significantly, we'll tell you whether you need to increase your budget and, if so, what to change it
to.

.

You can model what happens if you changed all your bids in the campaign to a fixed value (if you choose to apply one of these campaign-wide bid
changes, your ad group default bids will be changed to this fixed value, and your keyword-level bids will be erased).



e You can download the bid-simulation data at the account or campaign level.
e You can download an AdWords Editor-compatible file with the bid amounts to which ad groups and keywords must be set.

For information about how simulation data is calculated, see our article on using the bid simulator.

The "Analyze competition" tool

On your Opportunities tab, there's an "Analyze competition" link in the side panel. You can use this feature to see how you're performing compared to other
advertisers and make more informed decisions about which types of optimization changes are right for your account.

Watch a video about this feature
Here are some of the key benefits of having competitive data:

e Understand whether your performance is in the normal range for advertisers like you.
o Identify areas of your performance that might be improved by optimization changes.
e Explore new opportunities to grow your account and become more competitive in your market.

How it works
On the "Analyze competition" page, discover whether your performance is below, at, or above average for advertisers like you. Here's how:
1. Choose a metric.

You can compare your performance in terms of impressions, clicks, clickthrough rate (CTR), and average position. Choose one of these metrics to focus on
first, though we encourage you to later review all of the metrics to get a comprehensive idea of your performance.

2. Review each category.

You'll see a list of categories in which we think you're advertising based on your keywords and other factors. By using categories, we can benchmark your
AdWords performance against that of other advertisers who advertise similar products or services. For each category shown, your ads have appeared for
searches on that topic. If a category is blue, you can click it to explore sub-categories within that topic.

See search terms from each category

You can see the Google search terms that triggered your ad for each of the most specific sub-categories in your account. Click a category name to see more
specific sub-categories. When the category name is no longer a link, you know you're at the most specific sub-category -- this is where you'll see a See
Search Terms link that leads to a list of actual searches that are identified as relevant to that category. If you don't think that the category is appropriate for
you, consider adding negative keywords or refining your existing keyword list to help prevent your ad from showing on those irrelevant searches.

3. Review the data for the metric you selected.
There are two sections of data, each with their own way of comparing data:

o The "competitive range" shows how your performance compares to that of all other advertisers in the category. The range of performance is broken
into five segments, so you'll see if you perform in the top portion of advertisers, the bottom portion, or somewhere in between.
e The bar graph shows how you compare to the advertisers who perform in that same range for the metric you've chosen to look at.

To see a more specific analysis, there are several ways to further refine the data you see:

e Narrow down the category you're viewing by clicking the category name.

e See data for just one of your campaigns or ad groups by selecting it from the list in the side panel.

o See data from competitors targeting a specific region. Click the Flter competition button above the table, select which location you'd like to see data
from, then click Apply. Your performance will be compared to advertisers in the category whose ads were targeted to that location.

4. Consider where you'd like to improve.

Use this data in conjunction with other reports and statistics to understand if changes are right for your campaigns. If you think that you can gain some
competitive advantage with keyword, bid, or budget changes, click the Explore ideas button to see some customized ideas for your ad groups and campaigns.

It's important to remember that it's not always a bad thing to compete below your competitors for a certain metric. Based on your specific advertising goals,
make sure to focus on the metric that best reflects what success means to you.

What data you can see about your competitive performance
Here are a few additional details about what kind of data you'll find.

Metrics

You can choose which metric you'd like to use to compare your performance.

o Impressions: The number times your ads were shown for searches in that category



o Clicks: The number times your ads were clicked during searches in that category

o Clickthrough rate (CTR): The number times your ads were clicked divided by the number of times your ads were shown

¢ Average position: The average slot (between 1-8) where your ad was shown for searches in that category (a lower slot number is a higher position on
the page)

Basics about the data

* Anonymous data: Know that the competitor performance data that you see is aggregated and averaged, so all performance data is anonymous. You
won't be able to know exactly who is in the auction with you, but you will be able to see how you're performing compared to your general competition.

« Search performance only: The analysis only uses your performance data from Google search and the Search Network. Your performance on the Google
Display Network isn't taken into account.

« Time range: The data used in competitive analysis is refreshed once a week so that you'll always see relatively current data. The time range above the
table shows the dates that are included in your performance data.

Comparison data
Here's a bit more about the two ways we compare your performance data to that of other advertisers:
* Competitive range (shown in the five-section panel)

The panel of competitive ranges shows how your performance compares to that of all other advertisers in the category. For each category, we create a
histogram that shows the distribution of performance levels across all advertisers in the category. We then break the histogram into ranges.

o Your range: The range of performance is broken into five segments, so you'll see if you perform in the top portion of advertisers in the category, the
bottom portion, or a range in between. For example, your range might be 21-40% or 90-100%.

o Detailed comparison data (shown in the bar graphs and hover-over panel)

The bar graph and accompanying data show how you compare to just those advertisers who perform in the same range for the metric you've chosen to
look at.

o Bottom of range: For the metric you've chosen, this is the lowest recorded statistic within your range. If you're looking at CTR, for example, this
statistic will show the lowest CTR in that category for all advertisers in your range.

o Median: This is the number that falls in the middle of your range, meaning that there is an equal number of advertisers above and below this number
within your range.

o Average: This is the sum of all statistics in your range, divided by the total number of advertisers in that range.

o Top of range: This is the highest recorded number in your range. If you're looking at clicks, for example, this statistic will show the highest number
of clicks in that category that was received by an advertiser in your range. If you see "n/a" for the highest range, it means that we've omitted the
statistic to protect the identity of the individual advertiser.

Who you're compared to

There are several sets of advertisers who you're compared to: those in your advertising category and then, within that group, those who have performed
similarly to you. Here are the details of how we determine these groups.

1. Advertising categories
For the competitive range data (shown in the five-section panel), you'll be compared to all other advertisers in that category.

First, we analyze your performance in comparison to all other advertisers that we think are in the same category as you. Categories are themed groups that
generally describe what we think is the subject of your advertising.

How to narrow down the category

If a category is blue, you can click it to explore more specific sub-categories within that topic. There are five levels of categories, each level being more specific
than its parent. For example, the top-level category "Computers & Consumer Electronics" has the sub-category of "Computers" which in turn can be narrowed
down even further to "Laptops" and so on.

How categories are formed

We reviewed all of the search terms that have triggered any AdWords ad. From that information, our machine-learning algorithm identified themes and used
them to create a set of 7000 categories (with about 50 top-level categories) that are related to the products and services that we've seen from our advertisers.
In addition to these search queries, we look at other signals like your ads' landing pages, keywords, and ad text when categorizing each ad group. It's possible
that the chosen categories are ambiguous for a search term (for example, "apples" could be categorized as "Computers & Consumer Electronics / Computers"
or as "Food & Groceries / Food / Produce / Fruit"). In this case, we use the context of the ad group, campaign, or account to influence which category that
search term should be assigned to for the particular advertiser.

A few more details about categories:

* We compute benchmarks for each category in each country so you can see how targeting affects the market.



o All keywords that don't fit into one of these categories are aggregated into a section called "Uncategorized." This is essentially an "other" bucket for
performance data that doesn't fit into one of the defined categories.
o We'll show a category if you've had at least one impression in the last two weeks in a category that we think that you're advertising in.

2. Similar advertisers

For the detailed comparison (shown in the bar graphs), you'll be compared to a narrower set of advertisers: only the advertisers in that category who
performed in the same range as you did.

Within the group of advertisers from your category, we identify those that have performed similarly to you. We use this subset of advertisers to create the bar
graphs and accompanying data. This way, you can see how you compare to just those advertisers who are similar to you and are likely to have a similar
budget and scope of advertising.

How you should use the "Analyze competition" data

Competitive benchmarks give you a unique view of your advertising ecosystem, helping you make more informed account optimization decisions based on your
performance in the market. While this data can be illuminating and powerful, it's important that you use it as another piece of information to hone your
advertising strategy.

Know your goals
Like with all automated ideas and analyses, it's important that you know your advertising goals and only make changes that can contribute to those goals.

* Look at the right metric. Based on your specific advertising goals, make sure to focus on the metric that best reflects what success means to you. If you
value clicks and traffic to your website, for example, you might not need to worry about how you compete in average position.

« Filter the data. If you care most about your success in a certain location or from a certain campaign, focus on just that data. Click a campaign or ad
group to hone into its performance. Click the Filter competition button above the table to see data from competitors in your region only.

* Winning isn't everything. It's important to remember that it's not always a bad thing to compete below your competitors for a certain metric. Sure, it's
tempting to want to beat all your competitors in every metric, but make sure to focus on areas that you value the most and pay less attention to areas that
don't affect your goals.

Understand the data

o If you perform below your competitors: If you're performing below your competitors for a metric that you value, consider making improvements to
your campaigns. Click the Explore ideas button to get ideas on how to improve your performance. While you consider improvements, it's important to
understand the cost of each of the changes you make in your account. Some changes can get you more traffic or better competitive performance, but it's
up to you to decide if that boost adds sufficient value to your business.

o If you performin the middle: Continue to monitor the competitive analysis to see if you stay in the middle. Since your performance is probably close to
the norm, use other indicators to judge whether you are meeting your advertising goals. For example, review your conversion data to see if your
performance is yielding the number of sales or leads that you'd like.

o If you perform much better than your competitors: Make sure that you compare your performance for every metric. For example, you might lead
the pack in impressions, but perform below average in clicks. Decide which metrics are most important to you and then aim to perform above average in
those comparisons. You also want to consider the value you receive from performing well in one area. For example, if you outperform everyone in clicks
but receive many valuable sales from those clicks, it doesn't really matter how your competitors perform.

Improve your campaigns

After reviewing the data and considering your goals, you might decide that you want to improve your performance in a certain area. If you think that you can
gain some competitive advantage with keyword, bid, or budget changes, click the Explore ideas button to see some automated ideas for your campaign.

You can also follow some of our optimization tips to improve your performance in a particular area.

e Clicks: You might get more clicks by adding keywords, improving your ad text to make it more compelling, increasing your bids to help your ad show in a
higher position, and increasing your budget so that your ad can show more often.

o Impressions: If your goal is to have more ad views, consider adding relevant keywords so that your ad can show for a wider range of searches,
expanding your targeting to help reach more customers, or increasing your budget so that your ad can show more often. See more tips for increasing
impressions.

e CTR: For better clickthrough rate, focus on improving the quality of your ad text, ensuring the relevance of your keywords, and organizing your campaign
into tightly themed ad groups. See more tips for improving CTR.

o Ad position: A better Quality Score can help improve your ad position, so consider increasing the relevance of your keywords and ads. Higher bids might
also improve your ad position. See more tips for improving ad position

VIDEO




Making 10 Minutes Count On Your AdWords Account

Learn how you can turn 10 minutes a week in your AdWords account into more customers for your business. For the busy business owner, this is a video you
can't miss.



Using custom ad scheduling

Tip
You may see different options in your campaigns' Settings tab. This is because different campaign

types support different features. To see which features are available by campaign type, read Choose
the campaign type that's right for you [4

Timing is everything, so you want to make sure your customers are awake and online to see your ads. By
default, your AdWords campaigns are set to "Show ads all days and hours," which means that we'll
automatically try to spend your entire daily budget during each calendar day that your ad is active.

But if you want to reach your customers within a special "window of opportunity," then ad scheduling is

for you. It lets you specify certain hours or days of the week when you want your AdWords ads to show.

Note that ad scheduling won't change your overall daily budget -- we'll try to spread the spending evenly
across any segments you've scheduled in that calendar day.

If you're running an enhanced campaign, you can set bid adjustments to increase or decrease your bids for
specific days, times, and more, and view reporting from the Ad schedule subtab in your campaign settings. Any
legacy campaign type other than "Standard" can also set ad schedule bid adjustments. You'll find instructions

below for both enhanced and legacy campaigns.

Example
Suppose you run a dog-sled touring business in Alaska. By viewing your "Hour and day of the week"
performance on the Ad schedule subtab, you've noticed that your ads get the best results between 8
and 11 a.m. on Tuesdays, when Extremely Cold Places is playing on television. You decide to adjust
your ad schedule so that on Tuesdays, your ads only appear during that time.

Create an ad schedule for an enhanced campaign

Here's how to schedule your ad to run at specific times and days:

1. Sign in to your AdWords account at https://adwords.google.com [£ .



Click the Campaigns tab at the top.

Under All online campaigns, click the name of the campaign to be scheduled.
Click the Settings tab, then click the Ad schedule subtab.

Click the + Ad schedule button.

Make your selections for specific days and times.
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Click Save. You'll see your changes reflected in the Ad schedule statistics table.

Set bid adjustments for an enhanced campaign

You can set bid adjustments for specific days and times in the Ad schedule subtab in your campaign settings. If
you also opt to set bid adjustments for mobile devices and locations, all of your adjustments will be multiplied
together to determine the resulting bid adjustment. By setting bid adjustments, your spending on individual clicks

may vary, but your overall daily budget won't change.

L Example

Let's continue our earlier example. You run a dog-sled touring business in Alaska, and you have an
existing ad group max CPC bid of $1.00. You've scheduled your ad to show on Tuesdays between 8
and 11 a.m. You decide to set a bid adjustment of +10% on Tuesdays between 8 and 10 a.m. So,
your bid for that time period would be $1.00 x (+10%) = $1.10.

You also decide to set a +20% adjustment for Anchorage, where many of the customers that love your
dog-sled tours live. Your resulting bid for a search that occurs on Tuesdays at 9:30 a.m. for a customer

in Anchorage will be $1.32. Here's how it works:

Starting bid: $1.00

Tuesdays, 8 to 10 a.m. adjustment: $1.00 x (+10%) = $1.10
Anchorage adjustment: $1.10 x (+20%) = $1.32

Final bid for Tuesdays, 8 to 10 a.m., in Anchorage: $1.32

How to set a bid adjustment

To adjust your bids for a certain time, just follow steps 1-4 above. Then:

1. Click the cell in the "Bid adj." column of the row whose bid you want to adjust.
2. Choose "Increase by" or "Decrease by" from the drop-down, and enter a number.
3. Click Save.

Notes



The bid adjustment affects all bids in the campaign. When the time period of your bid adjustment is over, your
normal campaign bids will be restored unless you've set other adjustments (for devices or locations, for
example). Using the example above, at 10:01 a.m. on Tuesday, your bid will become $1.00 x (+20%), or $1.20
for a search that occurs in Anchorage, until your ads stop showing at 11 a.m.

You can stop using ad scheduling so that your ad appears every day of the week by adding all days as
targets.

Create an ad schedule and adjust bids for a legacy campaign

Here's how to schedule your ad to run at specific times and days:

Sign in to your AdWords account at https://adwords.google.com [ .

Click the Campaigns tab at the top.

Under All online campaigns, click the name of the campaign to be scheduled.
Click the Settings tab.
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In the "Advanced settings" section, click Schedule: Start date, end date, and ad scheduling.

Google AdWords
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6. Next to "Ad scheduling," click Edit.
7. In the window that appears, click any day of the week under the Time period column to set the hourly

range for when your ads should run (or shouldn't run). Click Add another time period to create up to six



running time periods in a single day.

8. Click OK to save your ad schedule, and you'll see the changes reflected in the time blocks. The green
blocks show the hours when ads are scheduled to run, while the gray blocks show when they aren't.
9. Click Save.

How to set a bid adjustment for a legacy campaign

The "Ad schedule" window in the steps above includes a Bid adjustment mode, too. You can specify bid
adjustments to raise or lower your bid during certain hours or on different days of the week. Here's how:

1. In the ad scheduling window, click Bid adjustment.
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Click a row to set a bid adjustment (% of bid) for a Time period, then click OK.
When you're finished and the green and gray blocks reflect your changes, click Save.
To stop using the bid adjustments, click Basic at the top of the ad scheduling window. Your time

settings will be saved, but your bid adjustment settings won't be saved.




Adjusting for time zone differences

The ad schedules you set are based on the time zone you selected when you initially created your AdWords
account. So you'll need to adjust your ad schedule to account for any difference in your target customers' time

zone. To verify your account's time zone setting, click the My account tab and select Preferences.



Using keyword insertion

Keyword insertion allows you to dynamically update your ad text with the keyword that's used to target
your ad. Keyword insertion can help make your ads more relevant to potential customers, while making it
easier for you to create unique ads for a large number of keywords.

To use keyword insertion, you just need to add a snippet of code to your ad text. Then each time your ad
shows, we'll automatically replace the code with the keyword that triggered the ad.

Using keyword insertion with your ads

You can use keyword insertion with any text-based ad, including a standard text ad, an ad with a location
extension, or a mobile ad. Keyword insertion works for campaigns that target the Search and Display Networks,

Search Network only, or the Display Network only.
Here are a few things to keep in mind:

¢ Your ad can be dynamically updated with any of the keywords in that ad group. Keeping that in mind, make
sure all of the keywords in your ad group would make sense inserted in your ad.

e For each ad that you're using keyword insertion with, make sure your destination URL directs customers to a
landing page that's relevant to any potential variation of your ad. That way customers are directed to a page on

your website that relates to the ad they clicked. Learn more in the Next Step at the end of this article.

£ I Did you know...

We've found that people searching are more likely to think an ad is useful if it mentions a specific
product, rather than a more generic ad. This means that keyword insertion can help improve the
clickthrough rate (CTR) of your text ads because it makes your ads more specific to what customers

are looking for.

Using the keyword insertion code

How to add the keyword insertion code to your ad



You can add the keyword insertion code with any component of your text ad: headline, description lines, display
URL, or destination URL. And, you can use the keyword insertion code multiple times within an ad and across

several ads at once.
Here's the snippet of code that you'll use: {keyword:default text}

In this code snippet, simply replace default text with a word or phrase that you'd like to appear in your ad.
The word or phrase that you use as your default text will appear when a keyword can't be dynamically inserted in
your ad (for example, when the keyword would make your ad text exceed the character limit).

When you insert the snippet of code in your ad - let's say the headline - here's what the ad would look like in your

account:

Headline: Buy {keyword:Dark chocolate}

Display URL: www.example.com
Description line 1: Artisan candy from San Francisco

Description line 2: Free shipping orders $50 more
Here are a few things to keep in mind when using keyword insertion:

» Make sure your default text is short enough to keep your ad within the character limits [ . If your keyword is

too long and would cause the ad text to exceed its character limit, the ad's default text will be used instead.

¢ The keyword, not the search term that triggered your ad to show, will be inserted into your ad. For example, if
a customer searches for organic dark chocolate and your ad group contains the keyword dark chocolate, your
ad could appear with the headline Buy Dark Chocolate. For Search Network campaigns, if a phrase match

keyword triggers your ad, the keyword will still be used in the ad.

— | How to use keyword insertion with your ad text

Let's say you're running a campaign to advertise your candy store and you have an ad group that promotes
your chocolate candy products. You'd like to use keyword insertion in your ad's headline so that it's
dynamically updated with the keyword that triggers that ad - making the headline more relevant to what
customers are looking for.

The snippet of code that you'll insert in your ad text might look like the following: {KeyWord:Chocolate}

In this example, we replaced the default text with Chocolate. This means that when a keyword can't be

inserted in your ad, we'll insert Chocolate instead.

Here are the keywords and ad text that you might create for your Chocolate candy ad group:

Keywords Ad text



dark chocolate
sugar free chocolate

gourmet chocolate truffles

Headline: Buy {KeyWord:Chocolate}

Display URL: www.example.com
Description line 1: Artisan candy from San Francisco

Description line 2: Free shipping orders $50 more

Depending on which keyword is triggered by a customer's search, the above ad could look different. Here

are some examples of how your ad could look for customers:

Customer searches for:

dark chocolate

sugar free chocolate

gourmet chocolate truffles

Your ad could look like:

Buy Dark Chocolate

www.example.com

Artisan candy from San Francisco

Free shipping orders $50 more

Buy Sugar Free Chocolate

www.example.com
Artisan candy from San Francisco

Free shipping orders $50 more

Buy Chocolate
www.example.com

Artisan candy from San Francisco

Free shipping orders $50 more

Note that in the last example, the default text is used in the ad's title since the keyword is too long to fit.

How to use keyword insertion with your display URL

We'll use the same ad group as in the example above to help you understand how to use keyword insertion

with your display URLs. By using keyword insertion with your display URLs, you can help make your ads

more relevant to what customers are looking for (and hopefully more likely to click your ads).

The snippet of code that you'll insert in your display URL might look like the following:

{KeyWord:Chocolate}

Note that in this example, we replaced the default text with Chocolate. This means that when a keyword

can't be inserted in your display URL, we'll insert Chocolate instead.

Here are the keywords and ad text that you might create for your Chocolate candy ad group:



Keywords Ad text

dark chocolate Headline: Buy Chocolate Candy

sugar free chocolate Display URL: www.example.com/{keyword:Chocolate}
gourmet chocolate truffles Description line 1: Artisan candy from San Francisco

Description line 2: Free shipping orders $50 more

Depending on which keyword is triggered by the customer's search, the above ad could look different. Here
are some examples of how your ad could look for customers:

Customer searches for: Your ad could look like:

dark chocolate Buy Chocolate Candy

www.example.com/dark+chocolate
Artisan candy from San Francisco

Free shipping orders $50 more

sugar free chocolate Buy Chocolate Candy

www.example.com/sugar+free+chocolate
Artisan candy from San Francisco

Free shipping orders $50 more

gourmet chocolate truffles Buy Chocolate Candy

www.example.com/chocolate
Artisan candy from San Francisco

Free shipping orders $50 more

Tips

e For Search Network campaigns, see how your keyword insertion ad will appear to potential customers
by using the Ad Preview and Diagnosis tool, making sure your ad is enabled, and checking your

account statistics.

e If you're using ads from the shared library, consider using keyword insertion with those ads. That

way, your ad text will be more tailored to what people are searching for.

¢ To ensure that all browsers show ads properly when using keyword insertion, special characters are
not fully supported within your Destination URL. For example, if your URL contains the letter "e" with
an acute accent (é), the URL will appear with '%C3%A9' instead. To avoid this, we recommend that

you don't include special characters in your Destination URL.



- Keyword insertion guidelines

Ads using keyword insertion must adhere to the following guidelines or they'll be disapproved:

¢ When a keyword appears in an ad, the ad should reflect correct grammar and punctuation. It should

also be accurate, clear, and directly relevant to your site, service, or product. Read about our policy on

relevance, clarity, and accuracy [ to make sure ads using keyword insertion meet the requirements.

e When you create a text ad that uses keyword insertion, you must follow our trademark policies. Learn

more about how keyword insertion works with trademarked terms [ .

e Keyword insertion ads can't promote adult content.

e As with any ad you create, you must follow our advertising policies [Z when creating a text ad that uses

keyword insertion.

= Keyword insertion and capitalization

You can change the capitalization of the keyword when it's inserted in your ad. To do so, simply modify the

"keyword" portion of the code as show in the chart below. In the following examples, let's assume the

keyword ABC triggered your ad to show when a customer searched for ABC, your trademarked chocolate

candy bar.

Your ad's title

Buy
{keyword:Chocolate}
Candy

Buy
{Keyword:Chocolate}
Candy

Buy
{KeyWord:Chocolate}
Candy

Buy
{KEYWord:Chocolate}
Candy

How the ad title
appears to
potential

customers

Buy abc Candy

Buy Abc Candy

Buy Abc Candy

Buy ABC Candy

What part of the keyword is capitalized?

No part

The first letter of the first word only (sentence

capitalization)

The first letter of each word (initial capitalization)

The entire first word and the first letter of each

additional word



Buy Buy Abc Candy The first letter of the first word and the entirety of each

{KeyWORD:Chocolate} additional word

Candy

Buy Buy Abc Candy The first letter of each word (initial capitalization). Note
{KEYWORD:Chocolate} that this works the same way as the "Buy

Candy {KeyWord:Chocolate} Candy" example above.

Here are a few things to keep in mind as you use capitalization with keyword insertion:

¢ AdWords editorial standards still apply, which means that an ad can't include excessive capitalization
such as BUY DARK CHOCOLATE. Full capitalization may only be used when the natural spelling of a
word requires it, such as in acronyms, technical terms, and trademarked terms, which is shown in the
example above.

¢ Make sure to choose a capitalization option that's consistent with the rest of your ad. That way, your ad
will look the way you'd like it to when a keyword is inserted. For example, if you wanted the headline of

your ad to look like Buy ABC Candy, your snippet of code would look like {KEYWord:Chocolate}.

¢ The default text will appear how you write it and isn't affected by how you capitalize keyword in your
snippet of code. In each example above, the title would always read Buy Chocolate Candy if the default
text were used.

Using keyword insertion effectively

When you use keyword insertion, make sure that all of your keywords in your ad group are closely related
and fit well in each ad that contains the snippet of code. Otherwise, your ad could appear confusing or
irrelevant to potential customers if there are some keywords that wouldn't work well with keyword insertion.
For example, if you have the keyword hardy candy in an ad group that mostly contains keywords about

chocolate, you may want to move that hardy candy keyword to an ad group about hardy candy.

To get an idea of how to create an effective ad group when using keyword insertion, take a look at the

examples below. In general, the more narrowly focused your ad groups, the more successful they'll be.
Example of a good ad group

Let's say you own a candy store and sell a wide assortment of sweet treats. You create an ad group with a
range of keywords covering each type of candy. You also create general ads that are relevant to all the
keywords in your ad group.

Ad group name Candy



Keywords candy bars, lollipops, taffy, gummy candy, sour candy, hard candy

Ad text Headline: Buy {KeyWord:Chocolate}

Display URL: www.example.com
Description line 1: Artisan candy from San Francisco

Description line 2: Free shipping orders $50 more

Example of a better ad group

Alternatively, you might want to create a separate ad group for each type of candy. Each ad group could
contain keywords only about that candy, and the ads could be specific to that type of candy.

Ad group name Sour candy
Keywords sour gummy bears, extreme sour candy, sour sweet candy

Ad text Headline: Buy {KeyWord:Sour Candy}

Display URL: www.example.com
Description line 1: Artisan candy from San Francisco

Description line 2: Free shipping orders $50 more

Keep in mind

If your keyword insertion ads are well-written and separated into well-organized ad groups, they'll be
more relevant to potential customers and more likely to get you clicks. This also means that keyword
insertion might help improve the Quality Score for your ads and keywords over time through improved

clickthrough rates (CTRs) and overall performance.

Keywords aren't showing in approved keyword insertion ad

Your keywords might be approved for your ad group, but it's possible that they aren't appropriate for us to
insert them in your ad text. In this case, your keywords are conditionally approved, with the restriction that
they shouldn't be inserted into your ad. In other words, your keywords can show your ad to customers, but

they won't appear in your ad text.

To help you get a better idea of why your keywords aren't showing in your ad, here are some common
reasons why your keywords might be restricted:

 Too many characters: Ads can't contain more than 25 characters in the headline, or more than 35
characters in each of the two description lines. The display URL in your ad can show up to 35

characters. If your URL is longer than 35 characters, it will appear shortened when your ad is displayed.



Ads targeting certain countries: For text ads targeting certain countries, the character limit can vary.
Ads in languages with double-width characters (such as Chinese (simplified or traditional), Japanese, or
Korean) can contain the following number of characters, including spaces: 12 characters in the headline,
17 characters in each of the two description lines, and 17 characters in the display URL. Certain Eastern
European and Asian countries support longer text ads that can contain up to 30 characters in the

headline and 76 characters in the rest of the ad text.

¢ Unclear ad text: Your ad text must make sense. For example, central europe might be appropriate as
one of your keywords. However, if we insert that keyword into the headline "Buy {KeyWord:Products}",
the resulting ad text would read "Buy Central Europe."

¢ Incorrect grammar: Your ad text shouldn't use incorrect grammar. For example, red shoe might be
appropriate as one of your keywords. However, if we insert that keyword into the headline "Buy
{KeyWord:Products}", the resulting ad text would read "Buy Red Shoe." This headline is grammatically

incorrect, and should read "Buy Red Shoes."

¢ Misspelled words: Keyword insertion shouldn't be used when ad groups contain misspelled keywords.
For example, ipodd might be appropriate as a keyword that's used to target your ads. However, per our
advertising policies, misspellings are not permitted in ad text, so it's inappropriate to use keyword

insertion with ad groups that contain misspelled keywords.

¢ Unacceptable content: The keywords that we insert can't promote unacceptable content. For example,
keywords that are related to certain restricted content or products, like firearms or tobacco, may initially
be appropriate as keywords for your ad groups. However, if we insert one of those keywords into the

body of your ad text, your ads wouldn't comply with our advertising policies.

¢ Adult content: Keyword insertion shouldn't be used when ads promote sexual content or adult
material. For example, an ad promoting a strip club may initially be appropriate to include in an ad
group. However, per our advertising policies, ads using keyword insertion can't promote sexual content
or adult material. This requirement helps us maintain a positive experience for all our customers and
AdWords advertisers overall.

Keep in mind

Any ad text that's the result of a keyword being inserted into your ad text is subject to our advertising

policies [ .

Disapproved keyword insertion ad

If you use keyword insertion with your ad and it gets disapproved, the default text might not meet our



advertising policies 2 or your ad might use the snippet of code incorrectly. Below are examples of two

common situations when using keyword insertion can lead to an ad being disapproved.

Incorrect default text
Let's say you've inserted the snippet of code in your ad's headline like the following examples:

Headline: Buy Gourmet {Keyword:Default Text} Here

Headline: Buy Gourmet {Keyword:Blank} Here

The default text used in the examples is meaningless to potential customers. Instead, the default text should
describe the product or service you're providing. For instance, the following default text would be

acceptable:

Headline: Buy Gourmet {Keyword:Chocolate} Here

Landing page URL error

The ad's landing page URL should still function when the default text is inserted instead of a matched

keyword.

Let's say the website is expecting a URL that ends with ?kw=nil only, it can't recognize ?kw=chocolate.
Therefore, potential customers would arrive at an error page, not a working webpage. You should only use
keyword insertion in your destination URL if the final URL the customer will be taken to will be a working

webpage. For instance, the following destination URL would be acceptable:

Destination URL: http://www.example.com/?kw={keyword:chocolate}



Performance, Profitability, and Growth

Budget Growth

Understand budget impact on profit

Scaling budget by performance

Growing a profitable campaign

Growth in Practice

Improve performance when daily budget is depleted

Learning the basics of online budget strategy

Bidding for Performance
Learn the basics of performance-based bidding

Selecting metrics to maximize profit

Profitability and Lifetime Value
Achieving profitability

How to estimate conversion value



Understand budget impact on profit

The graph below illustrates the impact of budget limitations on a profitable campaign, and why it often makes sense to optimize budgets before CPC bids.

o Point (a): A sample starting point; profit is missed due to limited budget
e Point (b): Profit possible by optimizing CPC bids within a limited budget

e Point (c): Profit achieved by optimizing budgets first

o Point (d): Maximum profit achieved by optimizing CPC bids after budget

Here’s how to interpret the graph:

[l Daily Profit (with budget) [l Daily Profit (without budget)
$800.00 d

Profit

CPC Bid

o The vertical y-axis represents profit after advertising expenses.
o The horizontal x-axis represents lower CPC bids on the left and higher CPC bids on the right.
e Actual profit curves vary by keyword, ad text, landing page, and your profit-per-conversion.

So, in order to fully maximize profit, optimize your budget first (in other words, reach point c), then test different CPC bids to optimize profit (point d).



Scaling budget by performance

With this combination of measurability and control, many businesses may opt for a flexible marketing budget that scales upward with good performance. Think
about a campaign that returns $2 in profit for each $1 in advertising spend. If the business can handle more customers, it makes sense to increase budget to a
point where it captures all of the profitable traffic available.

Best Practice: Even for campaigns that are scalable by performance, we recommend setting your AdWords daily budget at a level low enough to limit your
spending if something unexpected happens, like a sudden shift in traffic quality of one of your keywords due to a news event.

Example: If you're running a profitable campaign with an average cost of $750/day, you don’t need a daily budget limit of $10,000/day. A daily budget limit
between $1,000-1,500/day allows for flexible traffic growth while helping protect you from dramatic increases in spend.

A campaign that scales by performance can work for many advertising goals, including:

o Selling goods or services directly via an e-commerce site
e Generating leads for a sales team
e Driving signups for a monthly subscription service

If you can estimate the value of a conversion for your business, a scalable budget is worth exploring.

Campaigns that scale with performance usually meet the following conditions:

e You can estimate your conversion value (e.g., you make an average of $50 profit per sale)

e You understand how much time is needed before profits will be available to reinvest (e.g., you know that sales leads convert to deals in 3-5 weeks)

e Your costs of servicing new customers remain stable or decrease as you grow (e.g., the more customers you gain, the lower the costs of supporting each
new customer)

Here are some conditions that can make it more difficult for a campaign to scale with performance:

e You have high fixed costs that make it difficult to estimate the profit value of a conversion (e.g. significant manufacturing costs)
e You have supply or customer service limitations (e.g., you can’t serve additional customers if you grow)

e You have cash flow limitations (e.g., you have a $100 CPA for new signups worth $500 over 5 years)

e You have sales tracking limitations (e.g., most of your sales are difficult to track because they're offline)



Growing a profitable campaign

To achieve success with AdWords, it's important to understand when a campaign is profitable and how to help it grow. ROI-driven campaigns generally follow
three stages of growth: testing, growth, and maturity.

Stage 1: Testing
New campaigns start out in the testing stage. You'll gather performance data to understand which CPC bid, keyword, and ad combinations are working well for
you. In this stage, your primary goal is to establish profitability by comparing costs to revenues.

Once you achieve profitability, it's time to grow.

Stage 2: Growth

In the growth stage, your goal is to reach more customers while remaining profitable. You may be able to achieve this by increasing your AdWords campaign
budget while leaving your CPC bids, keywords, and ad text the same. If parts of your campaign are no longer profitable after you increase your budget, try
adjusting your CPC bids, keywords, or ads to regain profitability before you continue to grow.

By gradually increasing your AdWords campaign budget over time, you'll reach a point where it no longer limits your exposure. For an estimate of this amount,
check your recommended budget in the “Budget” section of the Settings tab of any campaign.

Stage 3: Maturity
If your costs don't reach your AdWords daily budget and you're profitable, you've successfully scaled up to the traffic available. Congratulations!

Here are some characteristics of this stage:

e Your AdWords budget is high enough to show at all times so you don’t miss an eligible impression.
e Your daily costs, profits, and sales rise and fall with regular fluctuations in search volume.

Tip: Even if your ads are able to show for every impression, you can still optimize CPC bids, keywords, and ad text to achieve even greater profit. See the
AdWords Bidding Tutorial for more detail.



Growth in Practice

You can often grow profit more rapidly by identifying smaller parts of a campaign that are profitable and giving them a separate budget before you're able to
confirm the success of the entire campaign.

For example, say you're managing an e-commerce shop that sells a wide range of bicycles and accessories. After running a new campaign for a few weeks,
you notice that 20 ad groups have gotten enough traffic to confirm profitability, while another 50 ad groups haven't.

If you wait for all 70 ad groups to become profitable before starting to work on growth, it might take months. On the other hand, if you raise your AdWords
campaign budget now before you're certain that the majority of your campaign is profitable, you risk over-investing in parts of your campaign that might not be
working.

By creating another campaign for the profitable ad groups, you can set a separate AdWords campaign budget and start to focus on growth. With two
campaigns, you can keep the original budget and limit the risk from the ad groups where profitability is still unclear, while steadily growing parts of the

campaign that you know are working.

Over time, you can continue to move profitable ad groups from the original campaign into the growth campaign until you've completed profitability testing.



Improve performance when daily budget is depleted

When your AdWords daily budget is depleted, it's often a sign you can improve performance. Your business objectives will determine the best approach to take.
Campaigns that focus on profit

Example: You run a bicycle e-commerce website that measures profitability by using Conversion Tracking.

o If your campaign is unprofitable, your AdWords budget limits your losses. You can improve performance by optimizing your bids, keywords, and ads until
the campaign is profitable.

« If your campaign is already profitable, depleting your AdWords budget prevents you from getting additional profitable conversions. You can improve
performance by gradually increasing your budget while making sure your campaign remains profitable.

Campaigns that focus on exposure

Example: You own a restaurant, and you're using AdWords to increase your website’s impressions and visitors.

o If you prioritize increasing your clicks over improving your ad’s position, and you find that you're consistently meeting your daily budget, then this frequently
indicates that some of your CPC bids may be too high. Testing lower CPC bids may increase clicks while allowing you to stay within your budget.
« If you prioritize improving your ad’s position over getting more clicks, depleting your budget is normal.

Notice that you can improve performance by optimizing your bids and AdWords campaign budgets in every situation listed above except the last. It's not always
this straightforward to balance different business objectives in real life, but understanding the basic principles that have been outlined here can help guide you

in the right direction.

How to budget strategically by business goal
If your business objectives include maximizing both profit and exposure, you can budget strategically by creating different campaigns for each goal.
Example: You run an e-commerce website that sells toys. You have a $5,000 marketing budget to create a campaign that will increase exposure for a new

game. You create a second campaign that's focused on maximizing profit for your existing product lines. You can grow this campaign with a flexible budget
based on the profitable traffic available.



Learning the basics of online budget strategy

You can set your marketing budgets for online campaigns the same way you would for any other form of media. But sometimes it pays to use a different
approach that’s tailored to the unique strengths of online advertising. In this section, we'll identify some of the key advantages of online campaigns, and explain
how some campaigns are able to run without budget limitations as long as ROI is positive. Then we'll define the three stages of campaign growth, and show
you how to improve your campaign performance when limited by budget.

Online campaigns: easy to measure and control
Have you ever heard this saying about traditional advertising?

“Half the money I spend on advertising is wasted; the trouble is I don't know which half.”

-- John Wanamaker

Happily, this is often not a problem with online advertising, because success is much easier to measure. You can isolate which parts of a campaign are
profitable and which aren’t, and then refine or remove the parts that aren’t working.

Also, online campaigns offer a much shorter time between initial investment and measurable return. For example, you might be able to establish profitability
with a new e-commerce site within the first day of an online campaign, and revise your budget the next day.



Learn the basics of performance-based bidding

When your campaign is focused on performance, it's important to understand how adjusting your bids impacts each performance metric. This article covers the
basic principles of bidding to maximize performance, and explains how to balance your bidding strategy for different business objectives.

Bidding to balance sales volume and profitability

Given that conversion rates don't vary much with ad position, the following trends are important to remember:

o Increasing bids generally results in more conversions at a higher average cost-per-acquisition (CPA).
o Decreasing bids generally results in fewer conversions at a lower average CPA.
o Increasing bids while limited by daily budget generally results in fewer conversions at a higher average CPA.

Prioritizing business objectives

In order to achieve your goals most effectively, it's helpful to prioritize your business objectives. You can optimize your AdWords campaigns to achieve many
different goals, but tradeoffs are often necessary.

For example, consider managing a campaign with the following objectives:

e Aim for ad positions 1-3
o Maximize profit

e Maximize conversions
e Maximize clicks

You might discover that your most profitable CPC bids come from ad positions that are outside the top three.

As another example, consider pairing any of the objectives listed above with the objective below:
o Keep CPA below $10

The CPC bids necessary to keep the CPA below $10 may be lower than the CPC bids that maximize profit, clicks, or preferred ad positions.

Tip: When managing a campaign for someone else, make sure they also understand the tradeoffs involved so everyone is clear on expectations. For example,
is their business objective to keep CPA at a certain level, or is it to maximize profit? If it becomes clear that two objectives are conflicting with one another,
which is more important to them?



Selecting metrics to maximize profit

With so many options, which AdWords metrics are most effective to help you reach your business goals? Here we'll discuss two metrics that are important to
consider if you're interested in maximizing profit, and point out some common pitfalls to watch out for.

Value-per-Conversion
Value-per-conversion is the amount of expected profit or value you gain from each conversion. If you can estimate value-per-conversion for a given product or
service, it’s a useful benchmark to define the upper limit that you can invest in advertising per conversion before becoming unprofitable.

CPA Targets
CPA targets can be helpful for establishing or maintaining profitability, and are usually set below your value-per-conversion.

Example: If a remote-control helicopter sale is worth $50 profit and any CPA below that is profitable, a $10 CPA target can help achieve a consistent $40 profit-
per-sale (after advertising costs).

The Conversion Optimizer allows you to automate CPC bidding for a desired CPA target.

A note about maximizing profit
It's easier to pick a CPA target that will be profitable than one that maximizes profit. To understand why, consider the example above where any CPA target
below $50 is profitable. Which CPA target is most likely to maximize profit: $20, $30, or $40?

In practice, you can’t know in advance. By testing different targets, you can learn which one achieves the optimal balance of profit-per-sale and sales volume.
For a visual illustration, see the AdWords Bidding Tutorial.

Common ROI targets that are unlikely to maximize profit

o Targets decided in advance of a campaign (e.g., “With $50 profit per conversion, $10 is a good target.”)
e Targets based on traditional rules of thumb (e.g., “Ad spend should be 9% of revenue."”)
e Targets based on other marketing channels (e.g., “E-mail and Search should have the same CPA.")

While the approaches described above may achieve profitability, they don't take into account changes in sales volume at higher or lower targets. Measure
profitability achieved, then try testing a few different targets to see if you can find a path to better results!



Achieving profitability

Knowing how to accurately assess whether a campaign is making or losing money is key to success and normally a prerequisite to growth. If you determine
that your campaign isn't profitable, achieving profitability is often possible by comparing your cost-per-acquisition (CPA) with your expected profit-per-
conversion and adjusting keywords or CPC bids to a profitable point.

Finding your CPA is easy with AdWords Conversion Tracking. You can easily find costs for specific actions such as purchases, signups, sales leads,
subscriptions, and a variety of other actions.

To start with a simple example, say you are selling downloadable music-mixing software for $50. Your costs are minimal, so virtually all of the $50 is profit for
each sale you make.

In your AdWords campaign, you can use this $50 benchmark to assess the profitability of various parts of your account.
Example 1: Ad group level profitability
Say you have three ad groups, each with its own CPA:

o Ad group 1: ‘Music mixing software’ CPA: $35
e Ad group 2: ‘Music production’ CPA: $85
o Ad group 3: ‘Music editors’ CPA: $53

At a glance, you can see that the first ad group is profitable with a cost of $35 for a profit of $15 ($50 - 35). If your campaign is reaching its budget, this ad
group is a good candidate for growth.

The latter two ad groups have a cost-per-sale higher than your expected profit of $50. You'll want to take a closer look at their keywords, ads, bids, and other
settings to bring them to profitability.

Example 2: Keyword level profitability
Let's take a closer look at the *Music production’ ad group to see if you can make it profitable. This ad group has the following keywords:

e Keyword 1: music production CPA: $42

e Keyword 2: music production software CPA: $28

e Keyword 3: learn music production CPA: $65

e Keyword 4: music production companies CPA: $230
e Keyword 5: music production packages CPA: $39

Looking at the keyword level, you can see three keywords in this ad group that are actually profitable. It's the two unprofitable keywords ‘learn music
production” and ‘music production companies’ that are making the average CPA for the ad group appear to be unprofitable.

Take a closer look at the unprofitable keywords:

e ‘music production companies’ is clearly unprofitable: $50 profit - $230 cost = $180 lost per sale. Removing this keyword may bring the ad group to a point
of profitability.

o ‘learn music production’ is unprofitable, but there might be hope. Users interested in learning music production may want to use your software. It'd be a
great idea to break this keyword off into a separate ‘learn music production’ ad group with supporting keywords, ad text, and a landing page. If you don't
have time to fully optimize, testing lower CPC bids may bring the CPA below $50.

Notice that in the above examples, profitability was calculated at the conversion level for a given product or service. This is often more practical than trying to
make an assessment at the campaign or account level.

For example, a campaign that costs $5,000 in advertising across a variety of products or services may be more difficult to establish as profitable. Calculating an
expected profit-per-conversion for each product or service gives you a simple benchmark for profitability.



How to estimate conversion value

When estimating value-per-conversion, it's often strategic to factor in things like repeat business, word-of-mouth, and lifetime customer value. Factoring in
these values can give you the flexibility to bid higher while confidently bidding below your value-per-click.

Let’s look at a fictional business-to-business machinery company named Example Machines to see how this works. Rather than sell directly online, Example
Machines uses AdWords to generate leads for its sales team. We'll factor that in too.

Short-term conversion value for Example Machines

e Average deal revenue: $3,000

o Profit margin: 45%

e Leads that convert to a deal: 20%

o Value-per-conversion (short-term): $270 ($3,000 * 45% * 20%)

Factoring in word-of-mouth

Example Machines has data showing that for each customer they usually gain 15% in additional business through word-of-mouth. Here’s how we factor that in:

o Value-per-lead (short term): $270
e Gain from word-of-mouth: 15%
o Value-per-conversion (+word-of-mouth): $310.50 ($270 * 115%)

Note that we multiply by 115% instead of 15%. This is because we are amplifying a gain as opposed to a loss.
Factoring in lifetime customer value

Lastly, Example Machines knows that each new customer makes repeat purchases worth approximately $5,000 in revenue over their lifetime. It's easiest to
factor this into initial deal value.

o Average deal revenue: $3,000

o Repeat business over lifetime: $5,000

o Profit margin: 45%

o Lifetime profit-per-customer: $3,600 ($3,000 + $5,000)* (45%)

Then we can factor back in how many leads convert to a deal and word-of-mouth gains:

o Lifetime profit-per-customer: $3,600

e Leads that convert to a deal: 20%

e Gain from word-of-mouth: 15%

o Lifetime value-per-conversion: $828.00 ($3,600 * 20% * 115%)

How this enables more strategic bidding
Let's assume 5% of clicks convert to a sales lead and see how this affects our value-per-click:

o Value-per-click (short term): $13.50 ($270.00 * 5%)
o Value-per-click (+word-of-mouth): $15.53 ($310.50 * 5%)
o Value-per-click (lifetime): $41.40 ($828.00 * 5%)

Notice how factoring in full conversion value enables Example Machines to consider a broader range of profitable CPC bids.



Conversion value challenges
Many factors can make it difficult to estimate conversion value in practice. Some examples include:

¢ A hotel chain where inventory is limited by time and available rooms

e An e-commerce site where customers search for one product, then purchase another

e Business services where deal sizes can vary from thousands to millions of dollars

e Subscription services where a new customer may enroll in a range of offerings over time

Even in cases where estimating conversion value is difficult, it still may be possible to use an estimated range for your likely conversion value, or conservative
estimates for factors that are difficult to track. For example, if you're intuitively confident that gains from word-of-mouth represent an additional 20-30% of
value but you lack definitive tracking, using a 15-20% conservative estimate is often more helpful than using no value at all.

Choosing your conversion value

It's important to use a method that makes sense for your business and advertising objectives. Short-term conversion values can be useful when you want to
maximize immediate profit or customer acquisition as cash flows allow. Lifetime conversion values can be more useful when trying to maximize long term
growth. When choosing a conversion value, it's important to opt for a method that aligns with your goals.
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AdWords Application Programming Interface (API)

The Google AdWords Application Programming Interface (API) is designed for developers representing large, tech-savvy advertisers and third parties.
This includes agencies, search engine marketers (SEMs), and other online marketing professionals who manage multiple client accounts or large
campaigns.

The Google AdWords API lets developers build applications that interact directly with the Google AdWords server. With these applications, advertisers
and third parties can more efficiently and creatively manage their large or complex AdWords accounts and campaigns.

How you can use the API

Because implementing the AdWords API takes technical know-how and programming skills, best results can be achieved by advertisers who employ software
developers.

The APl is flexible and functional -- you can use it to build an application that meets your needs. Using the API, you can:

o Automatically generate keywords, ad text, destination URLs, and custom reports.
« Integrate AdWords data with your inventory system to manage campaigns based on stock.
» Develop additional tools and applications to help you manage accounts.

And you can even develop in the language of your choice. The AdWords API SOAP interface is supported by all popular programming languages, including Java,
PHP, Python, .NET, Perl, and Ruby.

Getting started with the API

Signing up is easy. All you need is an active AdWords account. Once you've registered as a developer, you can access the AdWords API Center to manage your
token and budget settings. Your developer token is a unique combination of letters, numbers, and characters that identifies your AdWords API activity. It's your
key to talking to the AdWords server and your clients' AdWords accounts.



Benefits and languages

AdWords API benefits

With the AdWords API, you can employ programs that help you interact with your AdWords account more efficiently. You have many development and
integration opportunities -- from simply pulling reports automatically to creating complex applications that integrate with existing databases and enterprise
systems.

Depending on your programming talents and advertising needs, the possibilities are practically limitless. Some possibilities include:

e Generating automatic keyword, ad text, URL, and custom reports
o Integrating AdWords data with other databases, such as inventory systems
o Developing additional tools and applications to help you better manage AdWords accounts

Programming languages supported
The AdWords API uses SOAP 1.1 and WSDL 1.1.

o SOAP is the Simple Object Access Protocol. It's used for information exchange and RPC, usually (but not necessarily) over HTTP. More information can be
found at SoapRPC.com g.

e WSDL is the Web Service Description Language. It provides a formal description of a web service, much like CORBA's IDL. The WSDL file is all you need to
know how to call the web service; toolkits can generate proxy code from a WSDL file directly.

All messages are sent via SSL (https) to protect our user's privacy, and are authenticated via embedded passwords. We do not currently use any of the higher-
level WS-* specifications.

Our goal is to be interoperable with SOAP toolkits in any customer development environment. Currently we support Java, PHP, Python, .NET, Perl, and Ruby.



About AdWords API Versioning

The AdWords API is frequently updated, with the goal of feature parity with the online AdWords interface. We assign it a new version number each time it's
updated. To allow developers time to migrate to new versions, old releases and documentation remain available and updated for four months after a new
release.

When new versions eliminate or alter functionality available in previous (still available) releases, the Release Notes and Reference sections of the Developer's
Guide will annotate these changes:

o The Reference section features version-based documentation, accessible through version-numbered links in the upper right corner of each page. To view
differences between versions, click the "DIFF" link on the same navigation bar. Elements that have been removed from the earlier version will be shown
with a strikethrough.

o Read the Release Notes for updates on features and functions. A blog post will also explain updates to newly released versions.
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Getting Started with AdWords API

Signing up for the AdWords API

To sign up for the AdWords API, you'll need a My Client Center (MCC) account. Read our FAQ to learn more about
MCC. If you already have an MCC account, you can sign up for the AdWords API directly from the My Account
tab. Click on "API Center" and follow the instructions to apply for AdWords APl access. Make sure your information
is correct and the URL you provide for your company is functioning. If the website is not a live page, we will not be
able to process your application. During AdWords API registration, you'll be asked to provide developer,
application, and user information. You'll also need to agree to our Terms & Conditions and provide billing

information for API charges.

Please note that invoicing for the AdWords APl is separate from other AdWords payments you may make for other
charges (such as advertising costs). However, AdWords API charges will be applied to your total company credit

line with Google. You can read our FAQ for more information on billing for the AdWords API.

You'll be assigned a Developer Token once your application is approved. This unique text string of letters, numbers
and symbols is your key to accessing the API. Your token will be sent to your account email address and will also

be available through your AdWords API Center -- accessible through your My Account tab.

Once approved, your token will be activated and you'll be able access the API by including it in your request

headers when interacting with our system. Here are some resources you can use to help you get started:

¢ Developer's Guide
¢ Developer's Forum

¢ Sample Code

About AdWords APl web services

Using the AdWords API, you can create and manage campaigns, ad groups, keywords, and ads. You can also
generate keyword suggestions, get traffic estimates for predicted impressions, receive clicks and clickthrough

rates, and retrieve reports on actual performance.

To access and manage your AdWords account using the AdWords API, you build a client application that connects
to one or more of the provided web services. While each service can be used independently, most real-world

scenarios (such as adding a new campaign that has ad groups, ads, and keywords) require a client application to



use multiple services.

The core messaging technology for the AdWords API is Simple Object Access Protocol (SOAP), which is an XML-
and HTTP-based protocol with wide support in the industry. The AdWords APl uses document/literal style SOAP
1.1.

AdWords API capabilities by version are listed in the Developer's Guide. The full list of web services available are

listed in the documentation.

AdWords APl user requirements

The AdWords API has its own Terms and Conditions that a developer must agree to, which are separate from (and
in addition to) the standard AdWords Terms and Conditions. These can be found on the AdWords API site.



Tools and Resources

Overview of AdWords API tools and resources

The AdWords API Service has a wealth of resources in addition to code documentation, to help developers get
started quickly. We provide open source client libraries and existing applications that can serve as the foundation
for new applications. Further, we offer a sandbox environment so developers can experiment without making

changes to their account or using AdWords API units.

AdWords APl information sources
You have five sources for AdWords API information:

¢ The AdWords API Developer Guide is the technical reference for individuals building AdWords API applications.

e The AdWords API Help Center answers frequently asked questions about the AdWords API offering.

¢ The Developer Forum offers a place to discuss the AdWords API with fellow developers and members of the
Google AdWords API team.

¢ The AdWords API Blog hosts all AdWords APl announcements, tips, and program updates. All product changes

and new version launches are announced on the blog.

About the AdWords APl sandbox

The sandbox is a testing and development environment that replicates the functionality of the AdWords API web

services. You can use the sandbox to:

» Develop and test applications without spending API units (calls made in the sandbox are free)

¢ Test logic that would modify your AdWords campaigns (changes in the sandbox never affect live campaigns)

¢ Develop an AdWords API client library without having an AdWords account (using the sandbox only requires a
Google account)

¢ Develop against new or changed AdWords API methods before the changes go live on the production service

Learn about AdWords APl Sandbox best practices.

About AdWords API code resources

For faster AdWords API development, the AdWords API Developer Guide includes multiple client code libraries and



samples. The client libraries provide a high-level view of AdWords API functionality, making it easier to quickly

develop applications.

Using these resources allows you to accelerate your development and focus on your business needs.



